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Medical Device Directive
Medical Device Directive
These products conform with the requirements of council directive 93/42/EEC
concerning medical devices, when they bear the following CE Mark of Conformity:

This equipment generates, uses, and can radiate radio frequency energy. The
equipment may cause radio frequency interference with other medical and non-
medical devices and radio communications. To provide reasonable protection
against such interference, the:

GE Signa MR/i Systems

comply with emissions limits for (Group 2, Class A) Medical Devices as stated in
EN 60601-1-2. However, there is no guarantee that interference will not occur in a
particular installation.

If this equipment is found to cause interference (which may be determined by
turning the equipment on and off), the user (or qualified service personnel) should
attempt to correct the problem by one or more of the following measure(s):

• reorient or relocate the affected device(s);

• increase the separation between the equipment and the affected device;

• power the equipment from a source different from that of the affected device;
and/or

• consult the point of purchase or service representative for further
suggestions.

The manufacturer is not responsible for any interference caused by using
interconnect cables that are not recommended or by unauthorized changes or
modifications to this equipment. Unauthorized changes or modifications could
void the user’s authority to operate the equipment.

Do not use devices that transmit RF Signals (cellular phones, transceivers, or
radio controlled products) in the vicinity of this equipment as they may cause
performance outside the published specifications. Keep the power to these types
of devices turned off when near this equipment.

The medical staff in charge of this equipment is required to instruct technicians,
patients, and other people who may be around this equipment to fully comply with
the above requirement.

Immunity/Emissions Exceptions: Note the exceptions from the EMC test results.
Check with the business EMC engineer for this information.



Medical Device Directive
In accordance with the international safety standard IEC 601-1, this system is a
Class I device, acceptable for Continous Operation, having ordinary protection
against ingress of water with type B applied parts and is not for use in the
presence of flammable anesthetics.

CAUTION: User to call or contact the local authorities for disposal of the MR
System at the end of its useful life.
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Where Am I?
About This Guide

Introduction
This section explains the purpose and design of the Learning and
Reference Guide. It provides the information necessary to
understand the layout of the material in this guide.

Purpose of This Guide
This guide is written for health care professionals (namely, the MR
technologist) to provide the necessary information relating to the
proper operation of this scanner. The guide is intended to teach you
the scanner components and features necessary to use it to its
maximum potential. It is not intended to teach magnetic resonance
imaging or to make any type of clinical diagnosis.

This guide should be kept with the equipment at all times. It is
important for you to periodically review the procedures and safety
precautions. It is important for you to read and understand the
contents of this guide before attempting to use this product.

Prerequisite Skills

Since this guide is not intended to teach magnetic resonance
imaging, it is necessary for you to have sufficient knowledge to pass
the ARRT Magnetic Resonance Imaging Examination. This
knowledge is gained through a variety of educational methods
including clinical working experience, hospital based programs, and
as part of many college and university Radiologic Technology
programs.
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Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
How The Guide is Organized

This guide contains four volumes with chapters within each part
covering a multitude of topics. The current section, About This
Users Guide, is an introduction to the manual providing
information on the purpose, prerequisite skills, manual
organization, chapter format, and graphic conventions, which
identifies the visual symbols used throughout the manual.

• Volume 1: Beginning MR Imaging

– Chapter 1, Working Safely, provides information about
safety features of the scanner. This chapter should be
reviewed prior to all other chapters.

– Chapter 2, Getting Started and Basic Problem
Resolutions, provides information regarding the system
components, interface, startup and shutdown
procedures, and mouse basics. It is essential to review
this chapter along with chapter one before moving on to
the other sections, as it provides the necessary
information on the system components and interface that
the other sections will refer to.

– Chapters 3-11, provides an introduction to scanning, as
well as coil selection/positioning, building and saving
protocols, and scheduling/entering patient information.
These chapters also provide information regarding
scanning with a protocol, optimization of image quality
with pre-scanning, displaying, filming and managing
images.

• Volume 2: Concepts of Specific Pulse Sequences

– This volume provides information of pulse sequences
that may be available on your LX Scanner. It is essential
to review this chapter prior to developing any site original
protocols, as it provides the necessary information on
pulse sequence compatibility with imaging options and
contrast producing information.

• Volume 3: Optimizing Images with Imaging Options

– Chapter 1, Improving Image Quality, provides the
necessary information to use various imaging options to
control artifacts, enhance resolution, contrast as well as
minimize motion.

– Chapter 2, Gating and Triggering, provides the
necessary information to safely use gating and triggering
methods when scanning. It is essential to read this
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chapter before attempting any gating/triggering
procedures.

– Chapter 3, Triggering CEMRA with SmartPrep, provides
the necessary information to set up and scan using the
SmartPrep option.

– Chapter 4, Bolus Chasing with SmartStep, provides the
necessary information to set up and scan using the
SmartStep option.

– Chapter 5, Imaging Real-time with iDrive, provides the
necessary information to set up and scan using the
iDrive option.

• Volume 4: Post-Processing and Analysis

– Chapter 1, Sharpening and Smoothing Images with
ClariView, provides information on how to use the
ClariView filtration option.

– Chapter 2, Editing Patient Information, provides the
steps necessary to successfully edit patient information
after the patient has already been scanned.

– Chapter 3, Adding and Subtraction Images, provides the
steps necessary to add or subtract images that have
already been scanned.

– Chapter 4, Defining a Region of Interest with MIROI,
provides information on how to use the MIROI option.

– Chapter 5, Creating Vascular Projections-IVI, provides
the necessary information on how to create and
manipulate MRA vascular images.

– Chapter 6, Reformatting Images, provides the necessary
information on how to create and manipulate reformat
images.

– Chapter 7, Analyzing Images with FuncTool, provides the
necessary information on the use of the FuncTool
post-processing option.
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Chapter Format
Each chapter contains a consistent format. This consistency
provides uniformity for content delivery and a better learning
environment for you. Listed below are the components for each
chapter.

Introduction

The Introduction provides a short introduction to the chapter
and a list of tasks to be presented. There are pre-questions
related to the concepts and tasks of the chapter. These
pre-questions will help you think about the concepts and tasks
as you go through a particular chapter and to help reinforce the
learning of the material covered.

About...

The About... section lists and explains concepts necessary to
perform the tasks within the chapter.

How To...

The How Do I... section provides the detailed steps necessary
to complete a given task. These detailed steps not only provide
the steps to complete a task, but also provide additional
information, as needed, related to a step.

On the first page of each task, there is an In Brief table in the
outer margin. The In Brief table is intended to be used as a
quick reference and provides only the steps necessary to
complete a task.
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About This Guide
Graphic Conventions and Legend

The format of the page is such that you have room in the outer
margin to make notes as needed, except in the area where the
In Brief table is located in the How Do I... section. Table
About-1 describes the terminology used for the various mouse
functions. Table About-2 describes the conventions used when
working with menus, buttons, text boxes and keyboard keys.

Table About-1 Conventions for mouse actions

Mouse Action Description

Click

Clicking the left mouse button to
select a button or icon. The button
can be pressed in, not pressed in, or
popped in/out.

Right-click Clicking the right mouse button.

Middle-click Clicking the middle mouse button.

Click and drag
Clicking and holding the left mouse
button down while dragging the
cursor to the desired location.

Right-click and drag
Clicking and holding the right mouse
button down while dragging the
cursor to the desired location.

Middle-click and drag
Clicking and holding the middle
mouse button down while dragging
the cursor to the desired location.

Double-click Clicking the left mouse button twice
in rapid succession.

Triple-click Clicking the left mouse button three
times in rapid succession.
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Table About-2 Conventions for menus, buttons, text boxes,
and keyboard keys

Example Describes

Select Selecting an option in a check box or
radial button and selecting a tab.

Press Enter Pressing a hard key on the
keyboard.

Press and hold Shift Pressing and holding down a hard
key on the keyboard.

Click [Viewer] A button label or Interface button
name.

Click
(Exam prior)

Selecting an icon-based button.

In the Matrix text
box,...

The name of text box in which you
can select or type text.

Type supine in the
Patient Position text
box (different font
and bold)

Text you enter into a text box.

Select Sort > Sort by
date

The pathway of selecting option(s) in
a pull-down menu.
About-6 2292261-100 Rev. 0 (03/01)



About This Guide
Safety Notices

The following safety notices are used to emphasize certain
safety instructions. This guide uses the international symbol
along with the danger, warning, or caution message.

DANGER: Danger is used to identify conditions or actions
for which a specific hazard is known to exist
which will cause severe personal injury, death, or
substantial property damage if the instructions
are ignored.

WARNING:Warning is used to identify conditions or actions
for which a specific hazard is known to exist
which may cause severe personal injury, death,
or substantial property damage if the
instructions are ignored.

CAUTION: Caution is used to identify conditions or actions
for which a potential hazard may exist which will
or can cause minor personal injury or property
damage if the instructions are ignored.

NOTE: A Note provides additional information that is helpful to
you. It may emphasize certain information regarding
special tools or techniques, items to check before
proceeding, or factors to consider about a concept or
task.
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Where Am I?
Volume 1

Chapter 1

Working Safely

Introduction

This chapter focuses on the visible and invisible sources of hazard
and concern in the MR environment and emphasizes the need to
work safely. This chapter provides brief guidelines for working in a
magnetic field, as well as, key concepts regarding magnet hazards,
quench hazards, RF hazards, laser light hazards, metal sliver
hazards, acoustic hazards, peripheral nerve stimulation hazards,
patient alert system and equipment hazards. It contains the
step-by-step instructions to help you learn how to:

• Eliminate Magnet Hazards

• Respond to Patient Emergencies

• Respond to Magnet Emergencies

• Respond to a Quench with Vent Failure

• Protect the Patient from RF Burns

• Protect the Patient’s Eyes and Ears

• Check Cryogen Levels

• Handle Contact with Liquid Cryogens
1-1



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
NOTE: This chapter is extremely important. There is important
safety information that you and the physician must
understand thoroughly before using the system.
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In addition, this chapter answers the following questions:

1. What is the security zone? What effects does magnetic flux
have on ferromagnetic materials?

2. What is the exclusion zone? What effects does magnetic
flux have on certain biomedical implants?

3. What hazards are associated with cryogens?

4. What hazards are associated with RF?

5. What risk does the laser alignment light pose?

6. What is the risk of metal slivers in the eye?

7. What risks do the gradients pose?

8. What causes peripheral nerve stimulation?

9. What is the patient alert system?

10. What are the sources of general equipment hazards?
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About... Working Safely

This section presents the concepts necessary to successfully
complete the working safely process. Specifically you need to
understand:

• Safety Information

° Indications for Use

° Restrictions on Use

° Contraindications for Use

° User Training

• Magnet Hazards

° Security Zone

° Exclusion Zone

• Quench with Vent Failure Hazards

• Liquid Cryogen Concerns

• Hazard Warnings

° Laser Alignment Light Hazard

° Peripheral Nerve Stimulation

° Burn Hazards

° Metal Heating Warnings

° Thermal Stress

° RF Power

° Clinical Hazards

° Acoustic Hazards

° Equipment Hazards

• Patient Alert System

• Patient Emergencies

• MR Compatibility

• Safety Review
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Safety Information

The safety information described in this chapter is very
important. You and your physician must understand it
thoroughly before you begin to use the system. You will find
additional safety information throughout your training guides. If
you need additional training, seek assistance from qualified GE
Medical Systems’ personnel.

Make sure your training guides are readily available at all times.
Be sure to review the procedures and safety precautions
periodically.

Indications for Use

The Signa® system is indicated for use as a diagnostic imaging
device to produce transverse, sagittal, coronal, and oblique
images of the internal structures of the internal structures and
organs of the entire body. The images produced by your MR
system reflect the spatial distribution of protons (hydrogen
nuclei) exhibiting magnetic resonance. The Nuclear Magnetic
Resonance (NMR) properties that determine image
appearance are proton density, spin-lattice relaxation time (T1),
spin-spin relaxation time (T2), and flow. When interpreted by a
trained physician, these images provide information that can be
useful in formulating a diagnosis.

Restrictions on Use

CAUTION:Federal law restricts the sale, distribution and use of
this device to or on the order of a physician.

CAUTION:This device is limited by federal law to investigational
use for indications not in the “Indications for Use”
statement. Under federal law, this device should only
be used for the functions set forth in the “Indications
for Use” statement.
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WARNING:The Signa MR Imaging System is not designed to
provide information for clinical stereotactic use. The
spatial accuracy obtainable with Signa may not be
adequate for stereotactic procedures and can vary
depending on the patient, the pulse sequence used
and the system itself. We therefore recommend that
Signa images not be used for stereotactic
applications.

NOTE: Clinical stereotactic use refers to being used in
localization for surgical procedures.

Contraindications for Use

The use of the your MR system is contraindicated (i.e., not
advised) for:

• Patients with electrically, magnetically or mechanically
activated implants (e.g., cardiac pacemakers and
ferrous/electrically activated cardiac catheters), because
the magnetic and electromagnetic fields produced by the
your MR system may interfere with the operation of these
devices.

• Patients with intracranial aneurysm clips.

Implant and Prosthesis Hazards

WARNING:The magnetic field of the MR system can cause a
ferrous implant (e.g., aneurysm clip, surgical clip,
cochlear implant, etc.) or prosthesis to move or be
displaced, resulting in serious injury. Patients should
be screened for implants and those patients with
implants are not to be scanned. Prostheses should
be removed before scanning to help prevent injury.

WARNING:Induced electrical currents and heating can occur in
the region of the metallic implants. Patients with
implants are not to be scanned.
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WARNING:Electrical discharges between conductive devices
with points or sharp edges and the MR coils can
panic a patient, causing the patient to injure
him/herself. To help avoid such reactions, avoid
placing any metal objects (e.g., limb braces, traction
mechanisms, stereotactic devices, etc.) into the MR
magnet.

User Training
GE provides a training program in Milwaukee for one system
operator from each new Signa site. You may arrange to
participate through your local sales representative.

In addition, GE provides on site training by an MR Applications
Specialist. Anyone who operates the system must attend this
session after reading the Learning and Reference Guides and
related training materials.

We strongly recommend that physicians who prescribe studies
and reviews images on the your MR system attend at least two
full days of professional meetings dealing with MR medical
imaging each year. Such meetings include RSNA, the Society
of Magnetic Resonance and the American Roentgen Ray
Society. In addition, Signa user groups present symposia and
workshops throughout the year that provide additional learning
opportunities.

You are to train outside emergency personnel (e.g., fire
department and other outside ambulance or emergency
personnel) not to bring any ferrous fire fighting equipment,
including axes, ferrous stretchers, or oxygen tanks into the MR
scan room. Be sure to show such outside emergency personnel
where the Emergency Magnet Run-Down switch is located.
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Anchor Magnet Hazards
A magnet produces invisible lines of force that extend beyond
the magnet that are called the fringe field. The size of the fringe
field depends on the strength of the magnet and whether it is
shielded. Active and inactive shielding are used to reduce or
tighten the fringe field.

The magnetic field exerts force on susceptible materials and
biomedical implants that create hazards. There are two critical
zones, the Security Zone and the Exclusion Zone. Each zone
has specific restrictions regarding people and materials.

Security Zone
The security zone is the magnet room and the walls of the
magnet room.

The attractive force of the magnetic field in the security zone
can cause ferromagnetic items (e.g., items that contain
substances such as iron, nickel, cobalt and various alloys) to
become projectiles and contraindicated biomedical implants to
fail. In short, ferromagnetic items and contraindicated
biomedical implants CANNOT enter the security zone. The
security zone warning sign must be posted at the entrance to
the magnet room.

Magnet Room
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WARNING:The security zone warning sign must be posted on
the entrance to the magnet room.

Non-ferrous oxygen tanks, wheelchairs, gurneys, IV poles,
ventilators, etc. should be used in the scan room. Be sure
anyone who has access to the MR suite is aware that only
non-ferrous items are allowed in the scan room and that a
policy and procedure for bringing medical devices and other
equipment into the scan room is in place.

Something to Think About...

• Ferromagnetic is a substance such as iron, that has a
large positive magnetic susceptibility.

• Ferrous means an item that can posses intrinsic
magnetic fields and reacts strongly in an applied
magnetic field. (Example: Iron, nickel and cobalt.)

• Common hospital equipment may be adversely affected
when in proximity to the magnetic field or image quality
may be affected by the presence of this equipment.
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Exclusion Zone
The exclusion zone begins at the 5 gauss line. Magnetic
shielding may, however, restrict the 5 gauss line to the magnet
room, making the security and the exclusion zone the same.

Gauss Line is a line that all personnel should be aware of and
actively screening the changing conditions of the environment.
There are gauss lines and equipment that must remain outside
certain limits. Consult your GE Service Engineer to know where
these gauss lines are located in your facility.

WARNING:The exclusion zone warning sign must be posted at
the 5 gauss boundary; locate and read the exclusion
zone sign(s) at your facility.

WARNING:The fringe field can cause injury by interfering with
the normal operation of biomedical devices.

5 Gauss Line
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Quench with Vent Failure Hazards

A superconductive magnet uses cryogens to super-cool the
electrical conductor that creates the magnetic field. Liquid
helium is used, although some systems also require liquid
nitrogen. Temperatures as low as 269°C (-452°F) are achieved
to create the proper environment within the magnet.

On rare occasions the magnets may lose their
superconductivity so that the energy stored in the main coil
rapidly dissipates as heat, and boils off the magnet’s reservoirs
of liquid helium and nitrogen. This is called a quench.
Quenches are indicated by a loud noise, warning message, or
the tilting of an image on the image screen.

A quench is a hazard only if the vent fails, resulting in the
release of white clouds of cryogen vapor into the scan room.

The decay characteristics of the magnetic field in case of a
quench or from activation of the Emergency Field Shut-Down
Unit to the moment at which the field strength in the center of
the magnet has fallen to 20 mT or 200 gauss is 2 minutes.

WARNING:In the unlikely event of a quench and the vent fails, a
procedure needs to be in place to evacuate the
patient and all personnel from the magnet room.
Failure to follow these precautions can result in
serious injury (e.g., asphyxiation, frostbite, or injuries
due to panic).

Liquid Cryogen Concerns

Cryogens come in large vacuum containers called dewars.
Liquid helium is used although some service procedures also
require liquid nitrogen. Nitrogen dewars weigh from 400 to 500
pounds when full, helium from 700 to 800 pounds. In addition to
large dewars, there may be smaller helium gas cylinders
present. This helium gas is used to fill the magnet to proper
cryogen levels. Some special considerations should be
observed when dealing with cryogens.

QUENCH
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CAUTION:The following information defines the proper handling
of cryogens.

• Dewars and cylinders should not be tipped or
heated nor should the valves be tampered with.

• The cryogens boil off as they cool the magnet wires
and must be replenished periodically by qualified
personnel. You or your service representative
should monitor the rate of boil-off by the by
checking the cryogen level with the meter found on
the system cabinet.

• Contact with the cryogenic liquids or gas could
result in severe frostbite; care should be taken when
in proximity to these substances.

• Dewars should be stored in a well-ventilated area.
Accidental release of cryogens from the containers
could be in gaseous form, resulting in an
asphyxiation hazard.

• Gas cylinders should be stored upright and secured
to the wall with a chain with the metal protective top
in place. (If the a cylinder falls over or the valve is
knocked off, the container may act like a rocket; a
full cylinder has enough power to penetrate walls.)

• Because the cylinder’s metal cap may be magnetic,
it should always be removed before bringing it into
the scan room.

• If possible, all personnel should stay out of the scan
room when a qualified service engineer is filling
cryogens in the magnet. If personnel must be
present, be sure to wear proper gloves, a face
shield, and ear protectors.

• A qualified service engineer should be present any
time cryogens are transported within the hospital or
added to the magnet.

• It is crucial that ventilation and cryogenic systems
be kept in good repair and checked regularly to be
sure they are performing properly.

• Flammable materials must not be brought near the
cryogen containers.
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Hazard Warnings

You need to be aware of the hazards that are associated with
the MR magnet to ensure a safe environment.

Laser Light Hazards

Your MR system uses a semiconductor laser alignment lights
for patient landmarking. This type of alignment light casts a thin
red light on the patient for the purpose of positioning and
landmarking. The laser lights can cause eye injury.

The following label is the warning label for laser products and is
located on the bottom of the magnet front cover.

The eyes must be protected from laser radiation. The patient
needs to be instructed to close their eyes when landmarking
and the laser light is turned on. Exposing eyes to the laser
alignment lights may result in eye injury.

CAUTION:Do not leave the laser light on after you position the
patient.

The label below is the laser aperture label and is located in the
patient bore adjacent to the windows where the laser beams
exit.

Peripheral Nerve Stimulation

The gradients produce rapidly changing magnetic fields during
scanning that can produce peripheral nerve stimulation (PNS)
or a tingling sensation in some patients.

Labels such as this
provide warnings
about laser radiation.
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Signa typically operates in the 45 T/s range—PNS can occur in
the 60 T/s range.

CAUTION:Due to the rapid rate of change of the magnetic fields
(dB/dt) used during some EPI scans, a percentage of
patients may experience a tingling or touch sensation.
The above chart indicates the type of sensations
caused at different dB/dt. This means a percentage
of patients may experience PNS at 45 T/s. If this
sensation is bothersome or uncomfortable to the
patient, stop the scan. Change to a non-EPI pulse
sequence to continue scanning the patient.

CAUTION:To reduce the possibility of PNS, make sure the
patient’s hands are not clasped or touching and feet
are not crossed which could form a conductive loop.
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NOTE: Please report to GE Medical Systems all complaints of
patient discomfort that may be associated with PNS
during MR exams (e.g. muscle twitches, tingling
sensations, or headaches). Use The Report of Patient
Peripheral Nerve Stimulation form and forward when
completed to: GE Medical Systems, Attn: QSR Programs,
P.O. Box 414 (W709), Milwaukee, WI 53201-0414 USA
(See form below.)

Report of Patient Peripheral Nerve Stimulation

Report Date

Date of MR Exam

Hospital Name

Telephone Number

Name of Reporting Health Care
Professional

Patient Age

Patient Weight

Patient Height

Patient Pathology

Patient Medications

Exam Number

Series Number

PSD (GRE, SE, FSE, EPI, IR)

TR (ms)

TE (ms)

FOV (cm)

Slice Thickness (mm)

Interslice Spacing (mm)

Slew Rate (T/m/s)

Frequency Encoding Direction
(RL, AP, SI)

Were Patient’s Hands Clasped?

dB/dt (% peripheral nerve or T/s)

Stimulation Severity (1=very mild,
2=mild, 3=uncomfortable, 4=very
uncomfortable)

Stimulation Description & Site

Please Duplicate Before Use
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Burn Hazards

Patient Positioning Warnings

Positioning of the patient can affect the safety of the scan
procedure. To help prevent a patient burn from closed loops
formed by clasped hands or by hands touching the body, or
from thighs contacting over a small area, insert non-conducting
pads at least 0.25 inches thick between touching parts.

WARNING:Contact point heating warning information.

• RF can cause localized heating at contact points
between the patient/bore and patient/RF coil
causing discomfort or burns.

• Place foam between the patient and the bore
wherever a portion of the body comes in contact
with the magnet opening.

• Always place a sheet or pillowcase between the
surface coil and the patients skin to prevent burn
injuries.

Patient Comfort Module

A sensor located in the bore of the magnet monitors bore
temperature. The sensor posts appropriate messages for you in
the System Status Display area of the monitor (upper left
portion of the operator’s monitor) that notify you when the
magnet bore wall is becoming warm.

The temperature inside the room should be set at less than
70°F and the bore fan should be turned on at all times to keep
air flowing inside the bore of the magnet.
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WARNING:Bore heating warning information.

• RF can also raise the magnet bore temperature and
cause thermal stress; medical conditions can
reduce a patient’s ability to cope with external
temperature increases.

• If the temperature continues to rise, the scan stops
until temperature within the bore is lowered. When
the sensor detects temperatures that may cause
patient discomfort, the system posts this message
on the screen:

° “The patient comfort level is warmer than
normal.”

° “The patient may be uncomfortable during the
scan.”

° “The bore cooling system or magnet room
temperature may not be normal.”

° “Further increases in temperature will inhibit
scanning.”

• When the temperature drops to a comfortable level,
the message is cleared from the screen. If the
temperature continues to rise, a second message
appears on the screen:

° “Scan inhibited. Patient comfort sensor trip.”

• To facilitate a return to scanning, make sure:

° Patient fan is ON.

° Room temperature is normal, 21C° (70F°).

° Air flow through the bore is unobstructed.

• When the magnet opening temperature decreases,
the system posts this message:

° “New scans can be initiated, but the patient
comfort level is still warmer than normal.”
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Cable/Connector Warnings

WARNING:Cable/conductor heating warning information.

• RF can heat non-compatible surface coils/gating
cables, damaged surface coils/gating cables,
surface coils that are not properly plugged in, and
improperly routed cables can cause burns.

• The use of cable-connected surface coils, the
original peripheral gating probe, (consult your GE
Service Engineer for questions), or ECG gating
accessories for patient scanning can result in local
heating, leading to a burn or fire if proper scan
preparation features are not followed. The cables
often extend into the high intensity region of the RF
field and it is possible that induced electrical
currents in the cables may cause arcing and
heating.

Surface Coil Warnings

WARNING:For Signa Horizon systems: use only Signa Horizon
coils. Older Signa Advantage coils are not
compatible with Signa Horizon systems and should
not be used. Signa Horizon coils can be identified by
this label. (This label is located on the coil itself and
on the head carriage where the coil connector plugs
in.)
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WARNING:Observe the following warnings when using surface
coils.

• Remove unplugged surface coils or unused
accessory devices from the magnet bore; a patient
burn can result.

• When using the Breast Coil, make sure the patient’s
back and arms do not touch the magnet bore. Use
thermal resistant material or padding between the
patient and the magnet to prevent burns that could
be caused by patient contact with the interior of the
magnet bore.

• Use only GE or GE-authorized accessory coils and
cables.

• Do not use surface coils with exposed coils or
damaged insulation. Skin contact with metal
conductors can cause burns.

• Use only accessories that are in good condition. If
you suspect that an accessory is not in good
condition, discontinue its use and contact your GE
Service Engineer.

• Keep the length of cable in the bore to a minimum.
Avoid bending the cable 180° and route cables out
of the bore in the most direct way.

• Route cables through the center of the magnet bore.
Place cables under the cushion whenever possible.
Routing near the sides of the bore increases the
likelihood of cable heating (from induced currents).

• Do not cross or loop cables; arcing and patient
burns can result.

• Do not allow the surface coil cable to touch the
patient; patient burns can result. Use a thermal
resistant material or pad to keep the cable from
touching the patient.
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ECG Gating Warnings

WARNING:Observe the following warnings when using ECG
gating.

• Remove unplugged or unused accessory devices
from the magnet bore; a patient burn can result.

• Do not use monitoring equipment when conductors
are in the bore and touching the patient; burns can
result.

• Use only GE or GE-authorized cables.

• Always bring the cable directly out of the magnet
bore with no slack. Place cables under the cushion
whenever possible.

• Keep the length of cable in the bore to a minimum.
Avoid bending the cable 180° and route the cables
out of the bore in the most direct way.

• Route cables through the center of the magnet bore.
Place cables under the cushion whenever possible.
Routing near the sides of the bore increases the
likelihood of cable heating (from induced currents).

Peripheral Gating Warnings

WARNING:Observe the following warnings when using
peripheral gating.

• Remove unplugged or unused accessory devices
from the magnet bore; a patient burn can result.

• Do not use monitoring equipment with conductors
in the bore and touching the patient; burns can
result.

• Use only GE or GE-authorized cables.

• Do not use leads with broken shields or exposed
conductors. Use only accessories that are in good
condition. If you suspect that an accessory is not in
good condition, discontinue its use and contact
your GE service engineer.
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• Keep the length of cable in the bore to a minimum.
Avoid bending the cable 180° and route the cables
out of the bore in the most direct way.

• Check to see that the cable does not touch the sides
of the magnet bore. Place cables under the cushion
whenever possible. Routing near the sides of the
bore increases the likelihood of cable heating (from
induced currents).

• Check to see that the cable does not pass under or
near the surface coil or surface coil cable.

• Check to see that only the sensor touches the
patient. Keep cables from coming in contact with
the patient.

Metal Heating Warnings

To maintain a safer scan environment, determine each patient’s
work history and thoroughly screen for any metal containing
accessories.

WARNING:Eye makeups that contain metal flakes can cause eye
and skin irritation during MR scanning. Instruct
patients to wash off removable makeup before the
exam to avoid the risk of eye injury. Before scanning,
warn patients with permanent eyeliner or other
metallic ink tattoos about the risk of skin irritation and
instruct them to get prompt medical attention if they
experience severe discomfort following an MR exam.

WARNING:Metal fragments/slivers can deflect and/or heat in a
magnetic field, damaging surrounding tissues.
Patients at risk for metal fragments in the eye should
receive an eye exam to detect and remove any metal
fragments that could deflect and damage the eye.

WARNING:Jewelry, even 14 karat gold, can heat and cause
burns. RF can heat (even non-ferrous) metal and
cause burns.
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Thermal Stress
The actual increase in tissue temperature caused by exposure
to RF radiation depends on a variety of factors associated with
the thermoregulatory system of the individual and the
surrounding environment. Thermoregulatory is the ability of the
body to maintain regulated heat capacity levels.

WARNING:Observe the following warnings concerning tissue
heating.

• RF can heat the patient’s tissue, if you deliver RF
faster than the patient’s tissues can dissipate it. The
amount of tissue heating depends on the patient’s
weight, type of pulse sequence, timing factors,
number of slices and the use of imaging options
such as saturation.

• A rise in body temperature can be a hazard to a
patient with reduced thermoregulatory capacity.
Reduced thermoregulatory capacity can be caused
by pre-existing conditions, such as cardiac
impairment, that result in reduced circulatory
function, hypertension, diabetes, old age, obesity,
fever, or an impaired ability to perspire. A patient
with these complications must be carefully
monitored at all times.

• The RF power monitor and SAR limitations help
prevent excessive RF exposure to the patient; SAR
values are calculated based on the patient’s weight.
To help avoid injury, enter the patient’s correct
weight to set operating limits and prevent excessive
RF exposure.

RF Power
The RF pulses used in magnetic resonance causes tissues to
absorb RF power. Under certain conditions, this may cause
tissue heating. The amount of heating depends on several
factors, such as patient size and pulse-sequence timing.

Before the patient is scanned, the computer estimates the level
of heating and compares it to the predetermined exposure
limits. If the scan exceeds these limits, the system then adjusts
the scan parameters before starting the scan. The complete
estimate is based in part on patient weight. Therefore, take care
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to enter the patient’s weight correctly to prevent excessive RF
exposure or scan abort.

NOTE: The Signa RF power monitor helps prevent excessive RF
exposure due to equipment failure. Since the monitor
protects the patient, it must be operational at all times,
even when a scan is not in progress. If it detects an
equipment failure, it immediately disables the RF system.
This system must be repaired or adjusted by qualified
service personnel.

Clinical Hazards

CAUTION:The confining conditions of the MR system can
precipitate claustrophobia in some patients. To
prevent injuries due to panic, provide instructions and
comfort the patient as needed to alleviate anxiety.

Pregnant or Infant Patients

CAUTION:The safety of MR scanning has not been established
for imaging fetuses or infants. Carefully compare the
benefits of MR versus alternative procedures before
scanning to control risk to the patient. A physician
needs to determine the decision to scan pregnant or
infant patients.

Biomagnetic Hazards

CAUTION:Subtle genetic or molecular changes could be caused
by the magnetic fields used in MR. Carefully compare
the benefits of MR versus alternative procedures
before scanning to control risk to the patient.
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CAUTION:It is prudent to minimize the time spent near the
magnet to only that necessary to attend to the needs
of the patient.

High Risk Patients

WARNING:Patients having the following conditions are at
greatest risk for complications during MR scanning:

• Likely to develop seizure or claustrophobic
reaction.

• Greater than normal potential for cardiac arrest.

• Unconscious, heavily sedated, or confused patients
with whom no reliable communication can be
maintained.

• Since direct observation from the operator’s
console is usually partially obscured by the magnet
enclosure, be sure to closely monitor these patients
at all times to quickly identify and respond to
medical emergencies. In some cases, emergency
personnel should remain with the patient or be on
standby alert to help prevent serious complications
or death.

SAR Limits

WARNING:The International Electrotechnical Commission (IEC)
has the following requirements regarding SAR.

• The examination room temperature is not more than
21°C and the relative humidity is not more than 60%.
Temperatures above 21°C and the relative humidity
above 60% could result in the limits in the definitions of
the operating modes for whole-body SAR shall be
reduced.
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• Whole-body SAR is the value of the SAR averaged over
the entire body of the patient.

Three operating modes with regard to whole-body SAR
are defined, namely normal operating mode, first level
controlled operating mode, and second level controlled
operating mode:
° The normal operating mode comprises values of

whole-body SAR not higher than 1.5 W/kg averaged
over any 15 minute period. The Signa’s maximum
allowed is 2 W/kg.

° The first level controlled operating mode comprises
values of whole-body SAR not higher than 2 W/kg
averaged over any period of 15 minutes. The Signa’s
maximum allowed is 2 W/kg.

° The second level controlled operating mode
comprises values of whole-body SAR that may
exceed 2 W/kg averaged over any 15 minute period.
When operating in this mode you need to click the
[Accept] button to go from operating at 1.5 W/kg to
2.0 W/kg. The Signa’s maximum allowed is 2 W/kg.

• Head SAR is the value of the SAR averaged over the
head of the patient.

Two operating modes with regard to head SAR are
defined, normal operating mode and second level
controlled operating mode:
° The normal operating mode comprises values of

head SAR not higher than 3 W/kg averaged over any
period of 10 minutes.

° The second level controlled operating mode
comprises values of head SAR that may exceed 3
W/kg averaged over any period of 10 minutes. When
operating in this mode you need to click the [Accept]
button to accept these values if operating in second
level controlled operating mode.

• The SAR algorithms for the Signa product calculate
SAR values and set a limit on the number of
slices/echoes per second in order to limit RF power
deposition. The Signa power monitor and SAR
algorithm limit SAR, regardless of the patient weight or
pulse sequence used. The limits are conservatively
estimated from worse case patient positioning as a
function of weight.

In addition, a power monitor module limits the RF
amplifier output power to limit the patient SAR in case
of a catastrophic failure. This module monitors peak
power based on patient weight, and duty cycle based
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on the pulse parameters. The peak power limits prevent
you from using incorrect patient weights.

Acoustic Hazards
The gradients produce noise during scanning that can exceed
99 dBA in the bore. The sound level at the operator’s console is
in compliance with national regulations.

WARNING:Hearing protection is required to prevent hearing
impairment.

GE Medical systems offers the following disposable ear
protection of various noise reduction ratings that can be ordered
through the GE accessories catalog.

The following table describes the available types.

Equipment Hazards
There are also general equipment concerns in the MR
environment. You need to become very familiar with the
location and proper use of certain emergency buttons and
releases.

Emergency Stop

The Emergency Stop button is located on the keyboard and on
both the right and left sides of the magnet enclosure.

The Emergency Stop button disables the following systems:

• RF

• Gradient Power Supply

Description dB

E8801BA EAR Disposable Foam Earplugs 29

E8801BB EAR Taperfit2 Foam Earplugs 32

E8801BC Max-Lite Foam Earplugs 30
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• Scan Room Unit

• Table and Patient Support Subsystem

WARNING:The Emergency Stop button does not remove the
magnetic field, turn off the computer cabinets,
operator’s console, or camera. Refer to Safety
Review to know when to use this button.

Emergency Off

The Emergency Off button is located on the wall next to all
computer equipment, and next to the MRI magnet room doors.
It disconnects all incoming power to the power distribution unit,
with the exception of the magnetic field.

Use this button only in a major emergency in the computer or
MRI magnet room. For example, use this button when you
notice fire, sparks, or loud noises not associated with normal
operation of the system. Use the following procedure if this
button is activated:

1. Press the Emergency Off button.

2. Evacuate the patient.

3. Call the fire department, if appropriate. When the fire
department arrives, evaluate the need for an emergency
MRI magnet quench. If the fire-fighters need to take
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ferromagnetic equipment into the MRI magnet room,
quench the magnet.

4. Contact a service engineer before restoring power.

NOTE: To restore power after emergency off, the main circuit
breaker must be reset before rebooting the system.
Always contact a service engineer before restoring
power.

WARNING:The Emergency Off button does not turn off the
magnetic field. To avoid personal injury or equipment
damage, do not bring any ferromagnetic equipment
into the magnet room. Assume that equipment is
magnetic unless it is clearly labeled otherwise. Refer
to Safety Review to know when to use this button.

Emergency Magnet Run-Down

The Emergency Magnet Run-Down operates as follows and is
located inside the Magnet Room:

• Rapid reduction of the magnetic field in about two minutes.

• Boil-off of cryogens, accompanied by loud hissing sound.

• Several days of down time to replace the cryogens.

• Several days of down time to replace the cryogens.
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WARNING:The Emergency Magnet Run-Down should only be
used to free someone pinned to the magnet or to
remove a large ferromagnetic object captured by the
magnetic field when injury to persons is imminent. A
controlled magnet rundown should be performed in
non-emergency situations by a GE Service Engineer.
Refer to Safety Review to know when to use this
button.

Table Transport Emergency Release

The Table Transport Emergency Release is used in the event
the undock pedal on the patient transport does not function.

To release the transport with the Emergency Release:

• Make sure the cradle is fully retracted from the magnet bore
at the home position.
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• Grasp the handle on the red lever and pull straight out to
release the table.

Patient Alert System

Your MR system has a patient alert system that enables the
patient to alert the technologist at the console by squeezing a
bulb. Squeezing the bulb causes the control box to light up and
emit an audible signal. A switch on the control box allows you to
set the signal for intermittent or constant light and sound.

Your MR system also has an intercom system that enables you
to maintain verbal contact with the patient throughout the exam.

CAUTION:The patient alert squeeze bulb contains latex. If the
patient is aware of a sensitivity/allergy to latex or if the
patient is unsure and concerned about the possibility
of an allergic reaction, cover the bulb with a towel,
cloth, or plastic bag to shield the patient from the latex.
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Patient Emergencies

Before you begin any scanning procedure, explain the use of
the patient alert system to your patient. Make sure he or she
understands its purpose and use. Remember that implants,
pacemakers, and ferromagnetic life support systems cannot be
brought into the scan room.

Be sure to closely monitor patients with a greater than normal
potential for cardiac arrest, seizure or claustrophobia, or
patients who are unconscious or morbidly ill. Always maintain
visual contact with the patient. In some cases, you might need
to alert emergency personnel to remain on standby.

The patient table can be detached from the magnet system. It
can also be lowered and raised. In the event that a patient
needs emergency medical attention during the scanning
session, use the undock pedal or the emergency table lever
release for quick transportation of patients outside the scan
room.

MR Compatibility

The potential magnetic force on an object must be evaluated
before the object is brought into the magnet room. A set of
procedures and standards to be used to evaluate MR
compatibility of hand-held, non-electronic equipment to be used
in the magnet room is located in the Appendix: MR
Compatibility Guidelines and Tests.

There are three criteria by which a device can be considered
compatible. A device shall be considered MR compatible if and
only if:

1. MR Safe - The presence in the magnet room does not pose
an increased safety risk to the patient or personnel from
three areas of concern:

• Magnetic Forces - the device must not be attracted to
the magnet with sufficient force as to be a projectile or
sufficient torque as to cause personal injury.

• Heating from RF or gradient field induction - the device
must not be able to cause burns.

• Induced voltage from RF fields - the device must not
cause nerve stimulation.
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WARNING:The attractive force of the magnetic field of the MR
system can cause ferrous objects to become
projectiles that can cause serious injury. Post the
security zone warning sign on the entrance to the
magnet room and keep all hazardous objects out of
the magnet room.

2. Device Safety and Effectiveness - The device cannot have
its functions altered by the magnetic field nor can it cause a
safety risk when in the magnetic field. The large static
magnetic field, the rapidly changing gradient magnetic
fields, and the RF energy may affect a device.

WARNING:GE shall not be responsible for assessing the proper
function of any device. The manufacturer of the
device must make arrangements to test their device
in the MRI environment. Written certification that the
device functions as intended in the MRI environment
shall be provided before the device shall be
considered MR compatible.

3. Scanner Compatibility - The device cannot adversely affect
the function of your MR system (SNR, artifacts, image
distortion, etc.) in the following areas:

• Static magnetic field homogeneity - the device must not
cause significant changes in the shim.

• RF interference - the device must not distort the RF
transmitted by your MR system, nor can it generate RF
in the sensitive, pick-up range of the MR coils.

• Dynamic field homogeneity - the device must not create
significant time dependent field distortions.

The degree of compatibility required depends on the devices
usage and the materials used in fabrication. For example, a
scalpel made of a non-ferrous metal might be zone 3, while one
made of ceramic material could be zone 1. A device will be
classified as compatible in one of four zones.
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NOTE: Refer to Appendix: MR Compatibility Guidelines and
Tests.

Zone Description Typical Devices

1 Suitable for use in the imaging
volume, potentially in contact with
the patient.

Biopsy needle
Endoscopes

2 Suitable for use in the imaging
volume, only if the device is at least
5 cm away from any anatomy for
which spatial accuracy is required.

Positioners
Microscopes

3 Suitable for use in the imaging
volume only when scanning is off.
Spatial distortion and artifacts occur
during scanning.

The majority of MR
Safe hand-held
surgical
instruments.

4 Suitable for use in the scan room
when kept more than 1.0 m from
isocenter.

Furniture
Carts
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Safety Review

In all cases, notify a GE Service Engineer as soon as possible.

Situation Procedure

Fire, sparks, a loud noise or other
emergency condition in the scan
room not associated with normal
operation of the system.

Press an emergency off button at either
the computer equipment room or scan
room door. Remove the patient from the
scan room.

Magnet quench, indicated by a
loud noise, warning message,
dense white vapor with vent
failure, helium meter dropping
considerably or the tilting of an
image on the image screen.

Evacuate the patient and personnel
from the scan room and close the scan
room door. Follow the usual overnight
procedure. All helium vapor should
automatically be vented outside of the
scan room.

Magnetic-field emergency, e.g., a
person pinned between the
magnet and a ferromagnetic
object.

Press the emergency magnet run down
button in the scan room. Remove the
patient from the scan room.

Fire, sparks or a loud noise,
indicating a severe system
malfunction in the computer
equipment room.

Press an emergency off button at either
the computer equipment room or scan
room door. Remove the patient from the
scan room.

Fire or severe condition relating to
the power distribution unit (PDU) or
service outlets.

Press an emergency off button at either
the computer equipment room or scan
room door. Remove the patient from the
scan room.

Overtemp indicator lights up at the
remote power panel (RPP) or at
the PDU, and an error message
appears on the scan console’s
System Status Display area.

Remove the patient from the scan room.
Check the PDU vent for obstructions. If
the vent is obstructed, or if the overtemp
light or message remains on, perform a
system shutdown and then press an
emergency off button at either the
computer equipment room or the scan
room door.

Patient needs medical attention. Press the emergency stop button on the
console or magnet and remove the
patient from the scan room.

Table hydraulic failure. Make certain that the cradle is fully
retracted on the transport (the home
position) before undocking the transport.
Check for oil leaks. If the table latch is
stuck and the table cannot be removed,
pull the transport emergency release.
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How to Work Safely
This section provides the step-by-step instructions for working
safely in a Magnetic Field environment. Specifically, it describes
how to:

• Eliminate Magnet Hazards
° Eliminate Ferromagnetic Items from the Security Zone
° Limit Access to the Exclusion Zone
° Screening Form

• Respond to Emergencies
° Patient Emergencies
° Magnet Emergencies
° Quench with Vent Failure

• Protect the Patient from RF Burns

• Protect the Patient’s Eyes and Ears

• Check the Cryogen Levels
° Systems with a Helium Level Meter
° Systems with a Magnet Monitor Unit

• Handle Contact with Liquid Cryogens

NOTE: You should understand the following definitions before
continuing.

• Ferromagnetic is a substance such as iron, that has a
large positive magnetic susceptibility.

• Ferrous is a item that can posses intrinsic magnetic
fields and reacts strongly in an applied magnetic field.
(Examples are Iron, nickel and cobalt.)
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Eliminate Magnet Hazards

Eliminate Ferromagnetic Items From
The Security Zone
1. Keep the door to the magnet room closed.

2. Limit and monitor access to the magnet room.

3. Supervise non-MR personnel when working in the magnet
room or the vicinity of the magnet room.

4. Test all items for ferromagnetic properties before taking
them into the magnet room.

• Use a hand magnet to test items.

5. Remove ferrous items from the immediate vicinity of the
magnet room.

• Reduces the chance that someone might carry a ferrous
item into the magnet room.

6. Replace ferrous items that must remain in the vicinity of the
magnet room with non-ferrous versions whenever possible.

7. Tag ferrous items that remain at the facility so that all
personnel know the item cannot be taken into the magnet
room.

• Tag all ferrous items with the same label to be
consistent in identifying items that are not to be in the
magnet room.

8. Do a pocket check before entering the magnet room.

• Check for loose metal objects, such as keys, and
remove.

9. Keep the door in sight at all times.

• When working in the magnet room, do not stand
between the door and the magnet or turn your back to
the door.

10. When working in the magnet room, do not turn your back on
the patient or anyone else in the magnet room.

In Brief:

In Brief: Eliminate
Ferromagnetic Items
From The Security
Zone

1. Keep magnet room door
closed.

2. Limit and monitor access
to magnet room.

3. Supervise all patients and
personnel when in vicinity
of magnet room.

4. Test all items for
ferromagnetic properties
before taking them into
magnet room.

5. Remove all ferrous items
from the immediate area
of the magnet room.

6. Replace ferrous items that
must remain in vicinity of
magnet room with
non-ferrous versions.

7. Tag ferrous items that
remain at facility so that all
personnel know the item
cannot be taken into
magnet room.

8. Do a pocket check before
entering magnet room.

9. Keep magnet door in sight
at all times.

10. Do not turn your back on
patient or anyone else in
the magnet room.
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Limiting Access to the Exclusion

Zone--Screening

Eliminate Magnet Hazards

Limit Access to the Exclusion Zone—
Screen Patients and Personnel
There needs to be a screening procedure in place before
patients and personnel enter the exclusion zone. The exclusion
zone begins at the 5 gauss line. All personnel must be aware of
and comply with the screening procedure.

1. Use a Patient Screening form routinely before bringing
patient’s or other personnel into the exclusion zone.

• MR is contraindicated (not indicated for use) in certain
patients; every patient and every employee must be
screened prior to admission to the magnetic field.

• See sample screening form.

2. Evaluate the patient/personnel prior to entry.

• Identify circumstances that contraindicate admission to
the exclusion zone or items that need to be removed
before entering the security zone.

3. Discuss and review all items on the screening form.

• Make sure that the patient understands each question
he/she is answering.

4. Have patients who are at risk for metal eye slivers examined
and/or x-rayed.

• Follow your departmental policy.

5. Require patients to change clothes.

• Provide clothes without pockets so items are not
transferred.

• Patients should not wear shoes into the magnet room as
they may have collected metal on the soles.

6. Wash off non-permanent make-up.

• Follow the precautions for patients with permanent
make-up such as permanent eyeliner which can cause
tissue heating.

7. Keep metal out of the bore.

• A metal free bore prevent burns and image artifacts.

In Brief: Limit Access
to the Exclusion Zone

1. Use a Patient Screening
form before bringing a
patient or other personnel
into the exclusion zone.

2. Evaluate the
patient/personnel prior to
entry.

3. Discuss and review all
items on the screening
form.

4. Have patients who are at
risk for metal eye slivers
examined and/or x-rayed.

5. Require patients to
change clothes.

6. Wash off non-permanent
make-up.

7. Keep metal out of the
bore.
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Eliminate Magnet Hazards

Patient Screening Form:
Patient Screening Form:

Date:

Patient Name:

Birthdate:

Weight (lbs):

Last menstrual period (if applicable):

Allergies:___________________________________________________
____________________________________________________________
____________________________________________________________

What have you eaten in the last four
hours?_____________________________________________________
____________________________________________________________

Have you ever worked in a machine shop or similar environment
where you may have been subjected to small metal slivers, particularly
in the eyes? (Please Circle)
YES
NO

Previous MR study? (Please circle)
YES
NO

Date and type of MR study:
1.__________________________________________________
2.__________________________________________________
3.__________________________________________________

Recent X-Ray studies? (Please circle)
YES
NO

Date and type of X-Ray study:
1.__________________________________________________
2.__________________________________________________
3.__________________________________________________
4.__________________________________________________

Have you ever had surgery other than dental surgery? (Please circle)
YES
NO

Date and Type of Surgery:
1. Head____________________________________________
2. Neck____________________________________________
3. Chest___________________________________________
4. Abdomen________________________________________
5. Extremities______________________________________
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Patient Screening Form: Part 2The following items can interfere with MR imaging and some can actually be
hazardous to your safety. Please check if you have any of these items:
Yes No
___ ___Cardiac Pacemaker or (Pacemaker lead wires)
___ ___Brain aneurysm clips
___ ___Aortic clips
___ ___Implanted neurostimulators or lead wires
___ ___Artificial heart valve
___ ___Insulin pump
___ ___Electrodes
___ ___Hearing aids
___ ___IUD
___ ___Shunts
___ ___Joint replacements
___ ___Fractured bones treated with metal rods, plates, pins, screws,nails

_or clips
___ ___Harrington rod
___ ___Bone or joint pins
___ ___Prosthesis
___ ___Metal mesh
___ ___Wire sutures
___ ___Shrapnel
___ ___Dentures
___ ___Metal slivers in the eyes
___ ___Cochlear implants
___ ___Tattoo eyeliner
___ ___Others (please list)
_____________________________________________________________
Do not enter the scan room with any metal or magnetic-sensitive items.
Check the items below if you have one of the following:
___Glasses
___Removable dental work
___Hearing aid
___Jewelry
___Watch
___Wallet or money clip
___Pens or pencils
___Keys
___Coins
___Pocket knife
___Metal zippers or buttons
___Belt buckle
___Shoes
___Magnetic strip cards (credit cards, bank cards)
___Hairpins or barrettes
___Metal bra hooks
___Bra and girdle underwire support
___Sanitary belt
___Safety pins

On the drawing above,
please mark the location of
any metal inside your body.
2292261-100 Rev. 0 (03/01) 1-39



Working Safely
Respond to Emergencies

Patient Emergencies
Dealing with patient emergencies requires special planning in
the MR environment because of the magnetic field. Certain
equipment used for resuscitation will not function in a magnetic
field, and ferrous items can become projectiles. If a patient
needs emergency medical attention during the scanning
session, follow these steps:

1. Press [Emergency Stop].

• Located on the operator’s console or magnet enclosure.

• The scan aborts.

• The power disables the patient handling and scan
related equipment.

2. Notify emergency personnel, if necessary.

• Since ferromagnetic life support and related equipment
cannot be brought into the scan room, it must await the
patient outside the scan room.

3. Squeeze the cradle release handle and pull the cradle all
the way out to home.

• The cradle releases.

° If the cradle does not release, give it a strong tug.

4. Move the side rails of the transport into the vertical position.

5. Make sure that the cradle is fully retracted onto the
transport.

• The transport does not undock if not at home position.

6. Undock the transport.

• Use the unlock pedal or emergency release handle.

7. Keeping the patient on the transport, remove from the scan
room as quickly as possible.

8. Follow hospital emergency protocol.

In Brief: Respond to
Patient Emergencies

1. Press [Emergency Stop].

2. Notify emergency
personnel, if necessary.

3. Squeeze the cradle release
handle and pull the cradle
all the way out to home.

4. Move the side rails of the
transport into the vertical
position.

5. Make sure that the cradle is
fully retracted onto the
transport.

6. Undock the transport.

7. Keeping the patient on the
transport, remove from the
scan room as quickly as
possible.

8. Follow hospital emergency
protocol.
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Respond to Emergencies

Magnet Emergencies
In addition to patient emergencies, magnetic field emergencies
can also occur. A magnetic field emergency is when the
presence of the magnetic field is threatening harm or if
someone is pinned between the magnet and ferromagnetic
object, for example. All personnel should be familiar with how to
respond to magnet emergencies.

A magnet run-down results in several days of downtime and
may jeopardize your magnet. Your facility needs to define the
specific circumstances that would require a magnet run-down
so that no one makes an expensive mistake.

1. Press [Emergency Magnet Run-Down].

• Located in the scan room.

• Results in rapid reduction of the magnetic field in about
two minutes.

• There is a boil-off of cryogens, accompanied by loud
hissing sound.

• Expect several days of down time to replace the
cryogens.

• Expect several days of down time to replace the
cryogens.

2. Plan and rehearse for a magnet run-down that results in
venting of cryogen vapor into the scan room.

• Do not activate the Emergency Magnet Run-Down
switch during practice.

In Brief: Respond to
Magnet Emergencies

1. Press [Emergency
Magnet Run-Down].

2. Plan and rehearse for a
magnet run-down that
results in venting of
cryogen vapor into the scan
room.
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Respond to Emergencies

Quench with Vent Failure
A magnet quench can result in the release of cryogen vapor into
the scan room if the vent fails; white clouds of vapor appear in
the scan room. Cryogens during a quench can cause
asphyxiation, frostbite, or injuries due to panic. Magnet
quenches are indicated by a loud noise, warning message or
the tilting of an image on the image screen. This procedure
guides you through steps to follow in case of a sudden cryogen
release into the scan room.

1. Do not panic.

2. Using the intercom, ask the patient to stay calm and remain
on the table.

• Tell them that someone will be in shortly to offer
assistance.

3. Turn on the scan room exhaust fan.

• Some systems vent automatically and there is no fan to
turn on.

4. Prop open the door between the operator room and hallway.

5. Prop open the door to the scan room.

• If helium is venting in the room, the scan room door may
not open.

• If the door cannot be opened break the window to the
scan room to relieve pressure.

6. Enter the room and help the patient exit the scan room.

• If a gurney or wheelchair is needed to remove patient,
make sure it is a non-ferrous type.

7. Evacuate all personnel from the area until the air is restored
to normal.

In Brief: Respond to a
Quench with Vent
Failure

1. Do not panic.

2. Using the intercom, ask
the patient to stay calm
and remain on the table.

3. Turn on the scan room
exhaust fan.

4. Prop open the door
between the operator
room and hallway.

5. Prop the door open to the
scan room.

6. Enter the room and help
the patient exit the scan
room.

7. Evacuate all personnel
from the area until the air
is restored to normal.
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Protect the Patient from RF Burns

There are important things that all personnel should be aware
of to protect a patient from burns and peripheral nerve
stimulation. The following steps should be followed by all
personnel that position patients for scanning.

1. Position the patient properly.

• Make the patient comfortable with cushions and/or
blanket, if needed.

2. Do not allow the patient’s skin to directly contact the surface
of the bore, or the RF surface coil.

• Use non-conductive padding that is at least 0.25 inches
thick.

3. Use only approved RF coils that are not damaged.

4. Position RF cables down the center and directly out of the
bore.

5. Do not loop or cross cables.

• Use the cable holders provided to route the cables so
there are no loops in any cables in the magnet.

In Brief: Protect the
Patient from RF Burns

1. Position the patient
properly.

2. Do not allow the patient’s
skin to directly contact the
surface of the bore or the
RF surface coil.

3. Use only approved RF
coils that are not
damaged.

4. Position RF cables down
the center and directly out
of the bore.

5. Do not loop or cross
cables.

6. Use the appropriate
gating cable for surface
coil imaging.

7. Turn on the bore fan and
light.

8. Show the patient how to
use Patient Alert System.

9. Test patient intercom is in
working order.

10. Enter the correct patient
weight.

11. Respond to bore
temperature messages.

Labels such as this
provide warnings
about working with
RF coils.
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• Cable holders are located near the edges of the cradle,
on either side.

6. Use the appropriate gating cable for surface coil imaging.

7. Turn on the bore fan and light.

8. Show the patient how to use the Patient Alert System.

• Patients experiencing uneasiness or concern press the
Patient Call Button. The patient holds a small wand-like
device. When the button is pressed, an alarm emits a
signal to you.

9. Test the patient intercom.

• Make sure that the patient can hear you and you can
hear the patient.

10. Enter the correct patient weight.

• Correct weights help prevent excessive RF exposure.

11. Respond to bore temperature direction messages.

• The temperature messages are located in message
window on your console.
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Protect the Patient’s Eyes and Ears
The gradients produce noise during scanning that can exceed
99 dBA in the bore. Hearing protection is required to prevent
hearing impairment. The patient must close their eyes when the
alignment light is on during positioning. Follow these guidelines
to ensure proper eye and ear protection for your patient.

1. Provide the patient with hearing protection.

• Earplugs or a headphone system with stereo music.

• Earplugs reduce the intensity of the sound, while
allowing your patient to hear normal conversations.

2. Make sure that the hearing protection device is properly
applied.

• Earplugs are comfortable and inserted fully. Pliable
earplugs compress when they are rolled between the
fingers and conform to the ear after they are inserted.

• Headphone system is audible and comfortable.

3. Instruct the patient to close his/her eyes when the alignment
light is on.

• The laser alignment light for patient positioning can
cause eye injury.

In Brief: Protect the
Patient’s Eyes and
Ears

1. Provide the patient with
hearing protection.

2. Make sure that the
hearing protection device
is properly applied.

3. Instruct patient to close
his/her eyes when the
alignment light is on.
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Checking Cryogen Levels Check the Cryogen Levels

Systems with a Helium Level Meter
It is very important to check and record the helium level.
Sufficient helium is necessary to avoid accidental quench. If the
helium falls below 50% or the level your service engineer says
is acceptable, contact a service engineer immediately. Follow
the following procedure to check cryogen levels.

1. Turn the helium meter power switch [on].

• Located at the system cabinet.

2. Press [Update].

• Located at the system cabinet.

3. Record the percent of helium reading.

• A logbook should be kept with daily recordings.

• It is crucial that cryogenic systems be checked regularly
to be sure they are performing properly.

4. Turn the power switch [off] when completed.

In Brief: Check the
Cryogen Levels for
Systems with a
Helium Level Meter

1. Turn the helium meter
power switch [on].

2. Press [Update].

3. Record the percent of
helium reading.

4. Turn the power switch
[off] when completed.
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Check the Cryogen Levels

Systems with a Magnet Monitor Unit
It is very important to check and record the helium level.
Sufficient helium is necessary to avoid accidental quench. If the
helium falls below 50 percent or the level your service engineer
says is acceptable, contact a service engineer immediately.
Follow the following procedure to check cryogen levels of a
system with a Magnet Monitor Unit.

1. Push the button on the Magnet Monitor Unit and hold it for
approximately 10 seconds.

2. Record the value that is displayed in the LED when the
LHe% light is illuminated.

• A logbook should be kept with daily recordings.

• It is crucial that cryogenic systems be checked regularly
to be sure they are performing properly.

In Brief: Check the
Cryogen Levels for
Systems with a
Magnet Monitor Unit

1. Push the button on the
Magnet Monitor Unit and
hold for 10 seconds.

2. Record the value that is
displayed in the LED
when the LHe% light is
illuminated.
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Handle Contact with Liquid Cryogens
In the unlikely event that someone comes in contact with a
liquid cryogen, you should immediately follow these steps.

1. Immediately flush the area with large volumes of tepid
water.

• Tepid water is 105° to 111°F or 41° to 46°C.

2. Cover the area with a sterile dressing.

• May also use a clean sheet if the exposed area is large.

3. Notify a physician without delay.

In Brief: Handle
Contact with Liquid
Cryogens

1. Immediately flush the
area with large volumes
of tepid water.

2. Cover the area with
sterile dressing.

3. Notify a physician without
delay.
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Problem
Resolutions

Introduction
This chapter explains the Getting Started process. It also describes
some basic problem resolutions. It contains both key concepts and
the step-by-step instructions to help you learn how to:

• Start the system

• Navigate through screens and menus

• Perform a daily QA

• Shut down the system

• Reset the software

• Reset the TPS

• Power down under emergencies

In addition, this chapter answers the following questions:
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1. When does it warrant for an emergency shut down?

2. Name the system and workstation components.

3. What are the names of the menus?

4. Where are the volume controls are located?

5. Where is the patient alert device located?

6. What is the autoview screen?
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About... Getting Started
This section presents the concepts necessary to successfully
Get Started using your MR system. Specifically you need to
understand:

• Various MR system setup

• Mouse button configuration

• Understand what quality assurance and the benefits of
performing it daily.

• Different types of MR interface menus.

Workstation Components
There are several workstation components that need to be
explained. Throughout this section you will become familiarized
with a magnetic resonance suite, the magnet enclosure
features, keyboarding components, mouse use and
configuration of various parts of the MR workstation systems.

Magnetic Resonance Suite
A magnetic resonance suite (MR suite), typically consist of a:

• Magnet room

Computer
Room

Console
Room

Magnet
Room
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• Console room

• System cabinet room (or computer room)

The magnet room houses the magnet, magnet enclosure and
the table or patient transport. All of the equipment in the room
should be equipment that is not harmed by the intense
magnetic field. No other equipment or ferrous materials are
allowed in the magnet room. Example: You should not take a
metal mop bucket into the magnet room.

The magnet is the heart of the system. It is a superconducting
magnet that generates the static magnetic field required for
polarization if the body’s nuclei. What does the magnet consist
of? Well, it includes main coils usually made up of
niobium-titanium (NbTi) wire embedded in a copper matrix that
produce the static magnetic field. Cryogens are refrigerants
which are used to cool the magnet coils. Shim coils are also
used to compensate for in homogeneities in the main magnetic
field. There are also gradient coils that produce the gradient
magnetic fields during imaging, and RF coils that produce the
RF field during imaging.

The magnet enclosure houses the controls used to position
the patient, squeeze bulb or patient end of the patient call
system, and the physiologic acquisition controller (PAC).

The controls used to position the patient are located across the
top of the magnet as well as symmetrical buttons on each side.

LED Display - Located across the top of magnet.

• Emergency Stop - Press to disable power to the patient
handling and scan related equipment.

• Respiratory Display - Bar graph LED which views and
indicates signal return and strength for the respiratory
compensation bellows. Half or better of bar should be
illuminated for indication of good signal.

Emergency Stop Emergency
Stop

Time Display
Patient Position

Respiratory
Display

Cardiac
Display

Peripheral Pulse
Display
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• Time Display/Patient Position - Displays scan time
and table position.

• Cardiac/Peripheral Display - Bar graph LED which
views and indicates signal return and strength for the
peripheral gating lead. Half or better of bar should be
illuminated for indication of good signal. The ECG
symbol blinks when the ECG leads are connected.

Control Panel -Located on the sides of the magnet

• Laser Align Light - Turns all alignment lights on or off.
Alignment lights turn off automatically when Move to
Scan is pressed. When the alignment lights are on, this
button is lit and the landmark on message is posted on
the status panel. Alignment light cannot be used during
scans or emergency stops.

• In Fast - Provides quicker cradle movement by
advancing the transport at 4 inches per second, as long
as the table is docked and emergency stop is not active.
This button can override any other cradle command,
such as Move to Scan.

• In Slow - Provides slower cradle movement by
advancing the transport at .5 inches per second, as long
as the table is docked and emergency stop is not active.

Laser Align Light
In Fast
In Slow
Out Slow
Out Fast

Landmark
Move to Scan
Stop Move

Back to Landmark
Start
Pause Scan

Abort Scan
Home

Light

Fan
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• Out Slow - Provides slower cradle movement by
retracting the transport at .5 inches per second, as the
table is docked and emergency stop is not active.

• Out Fast - Provides quicker cradle movement by
retracting the transport at 4 inches per second, as long
as the table is docked and emergency stop is not active.
This button can override any other cradle command,
such as Move to Scan.

• Landmark - Enters the landmark being defined with the
laser alignment lights. It does not function during active
or paused scans or emergency stops.

• Move to Scan - Advances the defined landmark to
magnet isocenter. It works either before or after a scan
as long as the transport is docked and at maximum
height.

• Stop Move - Halts in-and-out cradle movement. Also
located on the operator’s console, this button overrides
any other cradle motion command, such as Move to
Scan.

• Back to landmark - Returns the table back to last
landmarked position. Back to Landmark cannot be used
during scans or emergency stops.

• Start - Restarts a study if: Pause Scan has been
pressed, the scan room door opens during a scan,
cradle motion exceed 2mm.

• Pause Scan - Temporarily halts scanning. One
consequence of Pause Scan is that image quality can
be affected if the patient moves or breathes differently
when the scan is resumed.

• Abort Scan - Aborts a scan during either prescan, an
active scan, or after Pause Scan is pressed. Once
selected, the scan cannot be restarted using the Start
Scan hard key. [Scan] has to be selected on the display
desktop, which starts the scan from the beginning.

• Home - Returns the table to the home position, fully
retracted on the patient transport.

• Fan - An On/Off switch which controls the circulation of
air within the magnet opening to help reduce the
claustrophobia some patients experience. It should
remain on at all times.

• Light - Controls the light within the magnet opening to
help reduce the claustrophobia some patients
experience. It may remain on at all times. A timer
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automatically turns off the light after one hour if the scan
table is undocked or lowered, or if the cradle is in the
home position. The light automatically turns on again
when the table is re-docked and the cradle leaves the
home position or when the cradle is in use.

PAC (Physiologic Acquisition Control) Unit
The Physiologic Acquisition Control is the system component
from which the ECG leads, peripheral gating device, and the
respiratory bellows are all connected. It can be located on either
side of the magnet. There is a cable routing device attached to
the PAC unit that is designed to keep the cables separated.

• Respiration - The port for the respiratory compensation
bellows.

• ECG - A six pin connection for either the thin film or high
impedance ECG leads.

• Peripheral Gating - A two port fiber optic connection for
the peripheral gating lead.

• Patient Call - A patient activated system that allows a
patient to signal for assistance during a scan.

The patient end of the patient alert system is also located on the
magnet. It plugs into the PAC unit. The patient is given the
rubber ball end of the alert system and when squeezed a loud
audible sound is heard in the control room. This sound pattern
can be changed to either pulsed or steady. A toggle switch on
the control box selects the sound pattern. The control box is

Respiration

ECG

Peripheral Gating

Patient Call
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typically located on the operator’s console, or mounted on the
wall close to the desk.

NOTE: Be careful not to pinch the cable that connects the
squeeze ball to the PAC unit, in the table. This could
resound the patient alarm continuously and cause table
cradle obstruction. Have an engineer check cable if you
feel there might be a tear in the cable. If a tear has
occurred, the patient alarm may not function properly.

MR Table/Patient Transport
The table or patient transport is used for patient positioning. It

can be removed from the scan room to simplify positioning
patients and to speed scan room evacuation in emergency

Control
Box
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situations. The transport supports 350 pounds. The rails in arm
board position support 250 pounds.

The patient transport connects to the base of the MR unit. It
consists of Up/Down pedals, located on both sides of the
magnet. And a transport/emergency release lever, located on
the right side of the magnet.

NOTE: Arm boards need to be raised when using the table to
move patient between rooms

• Someone must assist patient on and off the table.

• The table must be at the proper height.

• When loading the table when it is undocked in another
room, the wheels must be locked.

Console Room

The console room, also called the control room is the room
designed from which the technologist scans from and monitors
the patient. It holds all of the necessary system components
designed to accomplish scanning. Your MR system has several
components in this room.

Up/Down
Pedals Transport/Emergency

Release Lever
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No. Description Function

1 Workstation Monitor Monitor that displays images and scan
display, archive & network program
information. All routine operations are
carried out from this workstation monitor.

2 Keyboard & Mouse Allows for communication to the workstation
monitor and PC monitor.

3 Workspace Cabinet The right side of your workspace cabinet
houses archive devices and CD-ROM for
the MR system.(This CD drive is primarily
used by the GE engineers.) The left side
houses the PC computer, a CD-ROM drive
and a floppy disk port.

4 PC Monitor Displays the CBT (computer based training)
programs, on-line documentation, ECG,
and Peripheral gated and/or respiratory
wave forms. Note that the waveforms are
not to be used for physiological monitoring.
The patient’s condition may not be
accurately reflected, resulting in improper
emergency treatment. Communicate with
this monitor through the keyboard and/or
mouse. Switch between monitors with the
button on the keyboard.

5 DAT tape (optional) Archive device to load images from a Signa
Horizon onto the Signa system. The device
can be placed into the right side of your
workspace cabinet.

6 MOD (optional) This option is an archive device to load
images from a Signa Horizon onto the
Signa system. The device can be placed
into the right side of your workspace
cabinet.

7 Patient Alert Reset
Device

The reset device turns off the patient call
alarm.

8 Computer Desktop computer controls your MR system
operations.
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There are also several buttons to point out on the keyboard:
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No. Description Function

1 Emergency Stop Press to disable all electrical power sources
near the patient. It shuts down the RF,
gradient amplifier, table movement, shim
power supply and main MRI magnet power
supply cabinets. It will not quench the
magnet nor, turn off the computer.

2 Blank Key This key has no function.

3 PC Icon Press this key to transfer keyboard and
mouse control between the PC monitor and
your workstation monitor.

4 Move to Scan Press to move the cradle to scan position.
Release Move to Scan to stop the cradle.
The system often posts a message in the
system status display to prompt the user to
press it.

5 Stop Move Press to stop the cradle if it is moving.

6 Start Scan Press to resume scanning after Pause scan
or during scans for breathed techniques.

7 Pause Press to stop the scan temporarily.

8 Stop Scan Press to abort a scan during prescan, an
active scan, or after pressing Pause scan.
No data is reconstructed.

9 Talk Press to activate the intercom system so
you can speak to the patient inside the
bore. Release Talk button to listen to the
patient.

10-12 Volume Controls These three controls regulate the volume
for the patient communication system. Left
control=MR operator at operator console.
Middle control=patient in bore. Right
control=not active.

13 Function keys Press these keys for short cuts in certain
archive procedures.
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Mouse Basics

The mouse is the primary tool for interacting with the
workstation. It allows selections to be made from the desktop,
window/level adjustments, and image scrolling and
magnification. Because the mouse performs most tasks easily,
the keyboard is not used often. The mouse is a hand-held
device that moves across the surface of a mouse pad. The
mouse should always be operated on its mouse pad. Moving
the mouse to the right causes the pointer on the screen to move
to the right, and so on. If you’ve never used a mouse before, it
does involve physical skill that requires practice - especially
double-clicking.

The mouse has four main functions.

• Moving the pointer to position the cursor in a text box.

• Clicking on an area of the screen by pointing to it and
pressing the mouse button (usually the left). This
single-click function highlights an option, positions a
cursor in a text box, and toggles a toggle button on or
off.

14 Alphanumeric
keyboard

Use the keyboard for entering information in
text box, for annotating images, and for
entering basic information such as
filenames and network commands. Press
Delete or Backspace to erase characters
from the text box. Press Enter to confirm
what is typed or selected. Press Tab to
move across the areas on the current
screen, on the scan and protocol desktops.
Press the Up or Down arrow keys to move
from one text box to the next on the scan
and protocol desktops. Press the Up,
Down, Left or Right arrow keys to adjust the
window width and window level on the
display desktop.

No. Description Function

Right Mouse
Button
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• It is used to double-click on an option or function by
pointing to it on the screen and then clicking the mouse
button twice in rapid succession. In this example, a
single click highlights, and the second (double) click
finalizes, or selects, the highlighted option.

• It is used to press and drag; which means to press and
hold a button while moving the mouse across the pad
(and the cursor across the screen).

• It can also be configured for temporary left handed
operation on your system. You need to change this
every time you boot the system; the system default is for
right handed operation. To change, boot the system all
the way to the Signa ScanRx Desktop; open a
command window and type: mouse. In the pop-up box
change the mouse mapping to left handed. This setting
lasts until changed back or the system is logged out of
Signa scanning software.

Something to Think About...

• The mouse does not respond as expected. For
example, you are using the middle mouse button to W/L
but instead the magnifying glass is enabled, or you
select a single item in the Display Browser and multiple
items are selected.

• Toggle Shift. This problem can occur when Shift is
depressed while the mouse is in the process of
transitioning between the Signa system and the PC.
Press Shift again to put the mouse into the proper
mode.

System Cabinet Room (Computer Room)

The System Cabinet Room houses the power distribution unit,
RF, gradient and system control cabinets. The water chiller,
shield cooler compressor and other equipment are also located
here.

NOTE: The system cabinet room is often still called the computer
room because it used to house the computer; however,
the computer is now located in the console room.

This room is usually kept at very cool temperature, in order to
keep the equipment in here from over heating. If you have any
questions about the temperature settings, or the equipment
kept in this room please consult your local GE Engineer.
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Quality Assurance
Quality control is an important part of the daily start-up
procedure. Performing a daily QA test allows, you to make sure
that your system is operating before you bring a patient in for
scanning.

Document any changes in the operation of the system and list
the changes in the service logbook. To help the service
engineer pinpoint problems with the system, record any minor
system repairs that are needed in the service logbook.
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Desktop Organization

Your system interface is organized into desktops based on
function. There are six main desktops: ScanRx Desktop,
Protocol desktop, Display desktop, Image Management
desktop, Service Desktop, and the InSite Interactive desktop.

The ScanRx Desktop is used for image acquisition
and allows:

• Patient registration

• Protocol selection

• Selection of scan prescription

• Display of scan manager

• Prescanning

• Scanning

• Protocol creation

The Protocol Desktop is used to pre-register
patients, link existing protocols to registered patients and build
new protocols.

The Display Desktop is used for image display,
post-processing applications and image management. The
Display Desktop allows:

• Image display with basic functions

• Post-processing with specialized applications packages

• Archiving

• Networking

• Removing images

The Image Management Desktop is used for
networking of images to and from different system linked to
system.

Service Desktop Manager Menu
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The Service Desktop is used for Utilities functions and
Shutdown functions. The Service Desktop allows:

• GE Service Engineer use

• Calibration and checks

• System Diagnostics

• Install

• Message

• TPS Reset

• System Shutdown

• C Shell

• Monitor Setting

• Restore/Save Protocols

• Configuration of coils

The ilinq Desktop is used to communicate with the
GE OnLine Center about or question regarding your MR
system. This information is sent to an OnLine Center Engineer
or a GE Applications Specialist. This is a purchasable option.

Types of Menus

Your MR system uses three main types of menus.

• The Display Browser screen - list the patient exams, series
and images. The menu bar at the top of the Browser
contains selections that activate sub-menus for:

° Selection mode
° Sort mode
° Removing images
° Networking images
° Archiving images
° Queue management
° Service window
° Message window

• The control menu - contains options for system setup, fault
recovery, service functions and general utility functions.

• The root menu - contains options for system setup, fault
recovery, service functions and general utility functions.
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Basic Problem Resolutions
This section of the chapter lists a few basic problems and their
resolutions. This section is not designed to address all system
problems. If you have any problems not addressed in this
section please contact your local GE Service Engineer.

• If the monitor goes blank - Move the mouse, if screen does
not return reboot the system. If system does not power up
properly contact service.

• If the message screen displays a reset TPS message -
Switch to Service Desktop. Click [Reset TPS] on the
service desktop clipboard.

• If the screen locks or freezes & mouse elicits no response -
Follow the procedure for a system reboot.

• If smoke or odor associated with electrical overheating, or a
series of very loud two-tone blasts, like a foghorn occur-
Press the emergency stop button, evacuate the patient,
evacuate the MRI suite, then call service.

• If there is a fire in the computer room - Press the emergency
off button, evacuate the MRI suite, call the fire department,
then call service.

• If the system message displays "The patient comfort level is
warmer than normal" - Stop scanning and check that bore
fan is on. If the fan is on, contact service.

• If the mouse does not respond as expected. For example:
Window W/L control is expected but depressing the middle
mouse button enables the magnifying glass instead; or you
are unable to select a single item in the Browser, instead,
multiple items are highlighted. Try pressing the Shift key.
This should place the mouse into the proper mode.

NOTE: For more basic problem resolution procedures see the
detailed section of this chapter.

Mobile Site Configuration
The first time you start your mobile system you need to perform
a brief configuration, called the mobile site setup. This is where
data concerning a specific site, such as Facility Name, IP
address, and network DICOM information is input.

This window allows you to configure a mobile scanner for
specific sites. Once the mobile site information has been
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entered, it can be retrieved each time the scanner is at that
location.The data for a facility can also be changed or updated
from this window.

• 1- Hospital Name - Enter the hospital name (up to 30
characters using A-Z, a-z, 0-9, &-only).

• 2 - Hostname - The system’s host name can consist of up
to 30 characters, and is stored in the configuration file. A
service engineer enters the system’s host name initially.

• 3 - IP Address - An IP Address is four integers with three
dots between them that uniquely identifies the computer on
the network. Consult a service engineer for this information.

• 4 - Netmask - Netmask should be in hex digits. Consult a
service engineer for this information.

• 5 - AE Title and Port No. - Host DICOM information is
optional for mobiles that interface with a Network DICOM
device. Consult a service engineer for this information.

1
2
3
4

5

6

7 8 9 10 11 12

13
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• 6 - Network DICOM Devices - Used to add up to 5 Network
DICOM Devices that interface with the mobile. Consult a
GE Service Engineer for a list of IP Addresses, AE Title and
Port No.

• 7 - Add - Click [Add] to add a hospital to the list.

• 8 - Change - Click [Change] to edit or modify previously
stored hospital information.

• 9 - Remove - Click [Remove] to delete a hospital from the
list.

• 10 - Search - Click [Search] to find a hospital on the list.
Search options are executed by either hospital or
hostname.

• 11 - Activate - Click [Activate] to activate the selected
hospital.

• 12 - Done - Click [Done] to exit the Mobile Site Setup
screen.

• 13 - List of Previously Entered Hospitals - Select the
desired hospital from this list to display the data or to
change to a different hospital.
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Save Raw Data
The service engineer may request you to save raw data if an
image reconstructs with an artifact or distortion. Raw data is the
unreconstructed data that is used to create the image.The
service engineer can use this information to help determine the
cause of the artifact or problem.

The system will not automatically save the raw data, you must
direct the system to save the raw data. Later in the chapter, the
steps are provided to save the raw data to the system disk.

Something to Think About...

• Because the raw data resides in the temporary memory of
the system, it is imperative to save the raw data before
downloading the next series in the exam (save raw data
before clicking [Save Series] or [Prepare to Scan]).

• It is only necessary to save raw data to the system disk, if
there is intermittent trouble with artifacts, or if it is requested
by a service engineer.
2292261-100 Rev. 0 (03/01) 2-21



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
How to Get Started Using
Your System
This section provides the step-by-step instructions for getting
started using your MR system. Specifically, it describes how to:

• Configure a mobile site

• Power on the MR system
° Start your mobile system
° Start your stationary system

• Navigate through screens and menus

• Perform a daily Quality Assurance test (QA)

• Shut down your MR system

• Reset the TPS

• Save Raw Data

• Power down under Emergencies

• Get help
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Configure a Mobile Site
The first time you start your mobile system you need to perform
a brief configuration, called the mobile site setup. This is where
data concerning a specific site, such as Facility Name, IP
address, and network DICOM information is input. Entering the
data at this time saves you from re-entering the data each time
you alternate sites.

The data is entered on the Mobile Site Setup window, accessed
from the Service desktop. This window allows you to configure
a mobile scanner for specific sites. Once the mobile site
information has been entered, it can be retrieved each time the
scanner is at that location.

1. Click Service desktop from the control panel.

2. Click [Guided Install].

In Brief: Configure a
Mobile Site

1. Click Service desktop.

2. Click [Guided Install].

3. Select GI: Mobile.

4. Click [Start].

5. Enter the password.

6. Click [Add].

7. Enter the data.

8. Click [Add] to add
another site.

9. Click [Done].
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3. Select GI: Mobile.

4. Click [Start].

5. Enter the password in the command window. Contact your
service engineer to give you this password.

• The Mobile Site Setup window appears.
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6. Click [Add] to start and enter information into the Mobile
Site Setup window.

7. Enter the data, in the text box, that applies to that specific
site.

8. If you need to add another site, click [Add] and enter the
data.

• Before going on to the next step you should continue to
add all other facility names and information to the
system.

9. When all site information has been entered, click [Done] to
close the Mobile Site Setup window.
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Powering on th Power on the MR System

Start Your Mobile System
Once your Mobile sites have been configured, you routinely
start your system this way:

To recall and activate the site use the following steps.

1. Locate and press the On/Off Power Button on the Octane
component.

2. Once Login screen appears type in mobile for the login
name, and adw2.0 for the password.

3. Click [Guided Install].

4. Select GI: Mobile.

5. Click [Start].

6. Enter the password in the command window. Contact your
service engineer to give you this password

7. Select a hospital/facility from the list at the Mobile Site
Setup window.

8. Click [Activate] on the Mobile Site Setup window.

9. Click [Activate Site] on the Mobile Site Activation window.

10. Click [Done] on the Mobile Site Setup window.

In Brief: Start Your
Mobile System

1. Power On the Octane.

2. Type in mobile for the
login name, and adw2.0
for the password.

3. Click [Guided Install].

4. Select GI: Mobile.

5. Click [Start].

6. Enter the password in the
command window.

7. Select a hospital/facility.

8. Click [Activate]

9. Click [Activate Site].

10. Click [Done].

11. Click [Yes].

12. Click [Reboot] and then
click [Enter].

13. Click [Signa] and then
click [Enter].

14. Type in adw2.0 as the
password.
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11. Click [Yes] on the Exit Mobile GUI menu.

12. Click [Reboot] and then click [Enter] on the Login screen.

13. Click [Signa] and then click [Enter] on the Login screen.

14. Type in adw2.0 as the password.

• The system displays the selected facility’s information.
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Power on the MR System

Start a Stationary System
One of the first things you would want to know how to do is,
start your new MR system. The steps listed below describe how
this is done. There are two parts to this section, the first is
starting a stationary system, the second is starting a mobile
system.

NOTE: Mobile systems are defined as systems which are used
to perform scans from more than one institution.

1. The [On/Off] is located within the octane computer. Open
the door to the octane and then press this button.

2. System comes up to the login/password screen. From here
type-in the login name, which is Signa and the password of
adw2.0.

3. When finished entering the information, click on the [Login].
Your system then starts to come up.

NOTE: A message may appear across the screen stating Do not
interact with the system until this message disappears.
You should not at this time use the mouse or the
keyboarding keys as to not delay the start up process.

Anchor

In Brief: Start a
Stationary System

1. Open the door on the
aqua Octane machine.
Press [On/Off].

2. Wait for the log-in
password screen
appears. In login box
type-in signa. In the
password box type-in
adw2.0.

3. Click [Login].

4. Wait and do not interact
with the system until it
has fully powered up. (To
know the system has fully
powered up, look for the
desktop, Rx Manager,
Patient register, and
Autoview windows.)

On/Off
Power Button

Reset Button
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4. The start up process usually takes about 5 minutes. Your
system is ready when the message disappears and the
desktop, Rx manager, Patient register and the Autoview
windows appear.
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Navigate through Screens & Menus Navigate Through Screens and
Menus
This section does not include any quick steps. All steps for
screen navigation is discussed below.

1. To open a desktop, use the mouse to position the cursor on
the icon you wish to open and then click with left mouse key.

2. To change desktops, click on the icon of the desktop that
you want to change to. You do not need to close the
desktop that you’re on.

3. When entering data into a text box:

• Use the mouse to position the cursor in the text box

• Click once using the left mouse key

• Enter your data

• If text is already in the text box, use the mouse to
position the cursor in the text box

• Click and drag the left mouse over the text

• Press the Backspace or Delete key on your keyboard

• Enter your new data

4. When a message box appears, read message, click [OK] to
close the box.

NOTE: Unless you click OK, you will not be able to proceed
otherwise.

5. Right-click the title bar to access the control menu for a
window.

6. Right-click and hold the background to access the root
menu. Drag to the desired item.

7. Use the quit selection to exit the film composer and display
applications. Do not use the iconify function.
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e keys if the system does not seem to be

responding; wait a moment and perform a

software reset if necessary.

Perform a Daily QA Test

For this procedure you need to use a QA phantom. It acts to
simulate the weight of a particular body part. After performing
the procedure it provides useful information about the quality of
your scan. There are two QA phantoms that are being used.
One is simply called the QA phantom and the other is called the
QA 2 phantom. Please be aware when discussing the QA
phantom, either or could be used.

QA Phantom

QA 2 Phantom

In Brief: Perform a
Daily QA Test

1. Select [New Patient].

2. Enter the patient
information.

3. Place head coil on trolley
and attach base to trolley.

4. Position the phantom in
the coil.

5. Slide the head coil cover
over the phantom and
align.

6. Slide the head coil cover
away from the phantom.

7. Press [Laser Alignment
Light].

8. Press [In Slow].

9. Rotate phantom until the
sagittal line and alignment
light are superimposed.

10. Press [Landmark]. Slide
the head coil cover the
phantom.

11. Press [Move to Scan].

12. Now enter in the protocol.

13. Click [Save Series].

14. Select [Auto Prescan].

15. Click [Scan].

16. Perform scan in coronal
and sagittal planes.

17. Examine the images.

QA Phantom Axial Plane Image

Coronal
Superior

Coronal
Inferior

QA 2 Phantom

Axial Plane Image Coronal Plane Image
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1. Click [New Patient].

2. Enter the patient information by typing in Profile for the
patient ID, a weight of 100 and other data deemed
necessary.

3. Remove pads and straps from the head coil base. Place
head coil cover on trolley and attach base of head coil cover
to the patient transport.

4. Position the phantom in the coil base as shown below for
the appropriate phantom.

5. Slide the head coil cover over the phantom and align the
axial black line on the phantom with the top edge of the
head coil cover window.

6. When aligned properly slide the head coil cover away from
the phantom.

7. Press [Laser Alignment Light].

8. Press [In Slow] until the cradle moves into to the bore far
enough so the alignment light is centered over the axial line
on the phantom.

QA
Phantom

QA 2
Phantom

Fill
Screws

Magnet Bore

Fill Screws
(Toward
Bore)

Magnet Bore

Center Line

Head Coil Window Edge

Head Coil Window
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9. Rotate the phantom until the sagittal line on the phantom
and sagittal alignment light are superimposed.

10. Press [Landmark]. Slide the head coil cover into position.

11. Press [Move to Scan]. Cradle now moves to the
landmarked position inside the bore.

12. Now enter in the protocol for the scan:

NOTE: Once protocol has been imputed you can now save this
as your site’s QA protocol by simply clicking on [Save Rx
as Protocol], located in the lower left corner of the
screen. Make sure to name the protocol, something
everyone in the department can remember. Ex. QA Test.

13. Click [Save Series].

14. Click [Auto Prescan]. Once completed, record the R1, R2,
TG and transient frequency values in the service log book
for reference. These records can help service diagnose
system problems in the future.

15. Click [Scan].

16. Perform scan again in the coronal and then the sagittal
planes and record values.

17. Now using the autoview, scroll through images using the left
mouse key and sliding the autoview slide bar to the top.
Verify that each image looks similar to the illustrations at the
beginning of this section for the appropriate phantom image.
If a discrepancy or change in image quality is noted, for
example if the C on the coronal image is backwards, contact
the service engineer.
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Shut Down your MR System
A system shutdown terminates power to the systems
electronics in an orderly fashion so image files are saved. This
procedure does not turn off power to the MRI magnet, safety
rules should still be followed to prevent injury or damage to the
magnet.

1. Before you shut down your system, make sure all images
have reconstructed and are available for display from the
Display Browser.

2. Also make sure you have clicked [End Exam].

3. Wait for all Archive and Network functions to be complete.
Click [Detach], located under Archive on the display menu
bar. Then remove the MOD from the optical disk drive.

NOTE: By removing MOD prior to shutdown, helps to prevent
MOD corruption.

4. Now click on the Service Desktop icon, then click
[System Shutdown].

5. Confirm your selection with the left mouse button. The
Desktop disappears from the monitor and eventually the
startup screen appears.

6. When system reaches this point it is safe to terminate it’s
power by pressing [On/Off] located in the Octane
component. System screen now goes blank.

NOTE: If you only want to shutdown for a few hours, bypass step
6. When step 6 is omitted the screen goes blank after a
short while, as it enters the screen save mode. To view
the screen again simply move the mouse. If having
trouble deciding whether or not to leave system at the
startup screen or terminate power, please consult your
local service engineer.

In Brief: Shut Down
your MR system

1. Wait for image
reconstruction and
archiving to complete.

2. Make sure you have
ended the exam by
clicking [End Exam].

3. Go to the Display
Desktop. Click
[Archive], then select
[Detach]. Remove MOD
from archive device.

4. Click Service Desktop.
Click [System
Shutdown].

5. Confirm your selection.

6. When the startup screen
appears, press [On/Off]
on the Octane
component.

NOTE: Step 6 can be
bypassed if youchoose
to leave system at the
startup screen. Consult
your local service
engineer on which
option you should
choose.

NOTE: All mobile system
should complete step 6
before moving system.
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Mobile systems should always terminate

power before moving the system.

Reset the TPS
Resetting the TPS is one way to safely recover from many
errors and conditions. You need to perform this procedure when
the system prompts you to or when told to by an InSite
Technician.

NOTE: Performing a TPS reset in the middle of a scan or
reconstruction stops the process and image data is lost.
It takes a few minutes for the system to go through the
complex process of resetting itself, and the system
cannot be used until it is finished. If there is a patient on
the table, the patient landmark is lost, and the
landmarking process must be repeated.

1. Select the Service Desktop icon.

2. Click [TPS Reset].

• TPS stands for Transceiver Processing and Storage, it
is a subsystem of your Signa system which oversees
allsprocessing of raw data after its acquisition. The TPS
is housed in your system cabinet, located in your
computer room.

3. Confirm your selection.

4. Check for a "TPS successfully reset" message in the
system status display message box. Now you can
re-landmark and resume scanning.

In Brief: Reset the TPS

1. Select the Service
Desktop icon.

2. Click [TPS Reset].

3. Confirm your selection.

4. Wait for "TPS
successfully reset"
message to appear in the
status display message
box. Re-landmark and
resume scanning.
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Saving Raw Data Save Raw Data

You may be asked by the service engineer to save raw data if
you an image appears with an artifact or distortion. The service
engineer can then use this information to help determine the
cause of the artifact or problem. The following provide the steps
to save the raw data to the system disk the raw data that was
used to create the image.

Something to Think About...

• Because raw data resides in the temporary memory of
the system, it is imperative to save the raw data before
downloading the next series in the exam (save raw data
before selecting [Save Series] or [Prepare to Scan]).

1. Click Service Desktop.

2. Click [Utilities] from the Service Desktop Manager.

3. Select Raw File Manager (1) from the list.

In Brief: Save Raw
Data

1. Click Service Desktop.

2. Click [Utilities].

3. Select Raw File
Manager.

4. Click [Start].

5. Click [Options]:

• Save by pass.

• Save by slice.

6. Select the data.

7. Click [TPS to Disk].

8. Select File > Exit.

1

2
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4. Click [Start] (2).

The Raw File Manager (RawFileMngr) window appears.

5. Click [Options] and then click one of the 2 options to save
raw data:

• Save by pass, to save the entire series.

• Save by slice, to save only selected slices.

6. Select the data from the TPS (1) part of the window.

7. Click [TPS to Disk] (2).

• The raw data is saved to the hard disk of the system,
until it is removed.

NOTE: Raw data uses disk space, and as the disk becomes full
system performance can be degraded.

8. Select File > Exit to close the RawFileMngr window.

1 2
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Power Down Under Emergencies
It is very simple to do an emergency shut down the on your MR
system.

If you experience any system over heating, smoke, or odor
associated with the system, this would be a few good reasons
for emergency power down.

1. Press any [Emergency Stop]. Stops power to the magnet
room.

2. Evacuate the patient. Refer to chapter one on responding to
patient emergencies for more detailed instruction.

3. Evacuate the MRI suite.

4. Call service. After service has examined the system the
correct cause of the emergency should be written down for
future reference.

In Brief: Power Down
Under Emergencies

1. Press any [Emergency
Stop].

2. Evacuate the patient.
Refer to chapter one for
more detail on this.

3. Evacuate the MRI suite.

4. Contact your service
engineer.
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Where Am I?
Volume 1

Chapter 3

Scan Rx Desktop

Introduction

This chapter is an introduction to the scanning operations performed
on the Scan Rx Desktop. It contains key concepts and guidelines on
the user-friendly graphic areas contained in the desktop. This
section describes the basic features of the Scan Rx Desktop and
provides instructions to help you navigate through the required
areas.

The Scan Rx Desktop is designed for one-screen scanning
operation. The desktop provides the means for:

• Patient Registration

• Protocol Selection

• Scan Prescription

• Rx Manager

• Scan Initiation

• Prescan

• Protocol Creation
3-1



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
The Scan Rx Desktop environment provides all the clinical tools
necessary for comfortable, efficient set-up of patient studies.
These tools include patient scheduling and data entry, exam
protocol selection, protocol viewing and editing with graphic
prescription, scan data acquisition, image reconstruction, and
dual AutoView image display layouts.

The Scan Rx Desktop opens when you click on the Scan Rx
icon located in the control panel.

Scan Rx Desktop
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About... the Scan Rx
Desktop
This section presents the concepts necessary to successfully
understand and complete the primary functions of the Scan Rx
Desktop areas and windows. The Scan Rx Desktop opens
progressively. As you complete the information required for
each area, another is available to access and complete.
Specifically, you need to understand the following areas and the
text boxes contained prior to scanning:

• Patient Information
° Abbreviated Patient Information

• Patient Position
° Patient Position
° Patient Entry
° Coil Type
° Series Description

• Imaging Parameters
° Imaging Plane
° Imaging Mode
° Pulse Sequence
° Imaging Options
° PSD Name

• Autoview Window
° Autoview
° Report Cursor
° Update Images
° Auto Window/Level
° Save Window/Level
° Maximize/Minimize

• Scan Timing
° Number of Echoes
° Number of Shots
° Echo Time
° Repetition Time
° Inversion Time
° Flip Angle
° Echo Train Length
° Bandwidth
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• Additional Parameters

° SAT Prescription Screen
° Graphic Prescription Screen
° Vascular Screen
° User CV Screen
° Gating Screen
° Cine Screen
° Multi Phase Screen
° Diffusion Weighted Imaging Screen

• Scanning Range

° FOV
° Slice Thickness
° Spacing
° Start and End Locations
° FOV Center
° Number of Slices or Slabs

• Acquisition Timing

° Acquisition Matrix
° NEX
° Phase FOV
° Number of Acquisitions or Locations Before Pause
° Frequency Direction
° Auto Center Frequency
° Flow Comp Direction
° Autoshim
° Phase Correct
° Contrast

• Rx Manager

° Scan Modes
° Gating Control
° New Series
° End Exam
° Rx Manager List
° View Edit
° Prepare to Scan
° Save Rx as Protocol
° AutoScan
° AutoStep
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• Series Control and Advisory Panel
° Save Series
° Reset Values
° Relative SNR%

• Scan Operations
° STL% or db/dt Level
° Prescan
° Prep Scan
° Scan
° Reference Scan
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Patient Information
The Patient Information area requires detailed information
about the patient. This area opens after you select the [New Pt]
button located in the patient registration area.

NOTE: You cannot leave the Patient Information area unless a
Patient ID is entered.

NOTE: You cannot leave the Imaging Parameters area unless
the patient weight is entered.
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The following table describes acceptable values.

Selection Description

Accession
Number

This is generally related to a number assigned by the hospital, clinic,
or site, and is tied to the patient’s records. Enter the number manually
or by using the optional bar-code reader if applicable. This text box is
limited to 16 characters.

Patient ID Enter any combination of numbers, letters, and dashes followed by
Enter. This text box is limited to 64 characters. If the system finds the
same ID in its memory, it displays all the pertinent data. The entry
must be identical, including the use of upper-case and lower-case
letters. Enter MR and the system re-displays the last (most recent)
patient’s data.

Patient Name Enter the patient’s name. This text box is limited to 64 characters.

Birth Date Type in the patient’s birthday: month # (1-12), day (1-31), and year
(19xx or 20xx) and press Enter.
Valid type-in options are mm/dd/yyyy or mm-dd-yyyy. The year must
be a four digit number. Note that the system can be configured for:
mm/dd/yyyy or dd/mm/yyyy.

Age If the birthday is entered, age is automatically calculated. Enter only
whole numbers for age from 1-123 years. Days (1-90), weeks (1-52),
or months (1-23) can also be entered; for instance, 28D, 4W, or 1M.

Sex Enter M or F.

Weight Enter the patient’s weight in full pounds or kilograms, depending on
how the system is configured. The system automatically calculates
and displays the other figure. Weight limits are 2 to 350 lbs (1 to 158
kg). Precision is important. If inaccurate, the system could abort
the scan or deliver the wrong amount of RF power to the patient.

Radiologist Enter the radiologist’s name.

Referred By Enter the referring physician’s name.

Operator Enter the operator’s initials. This text box is limited to 3 characters.

Status The pre-defined list selections are: None, In, Out, Emergency, and
Referral.

Exam Description Enter the exam description. If this line is left blank, no information
appears on the Exam page.

Patient History Include relevant background information or additional information
here.

[Schedule] Provides access to the ConnectPro option.

[Landmark] Provides access to the Abbreviated Patient Information area to select
a landmark for anatomical reference.
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Abbreviated Patient Information

An abbreviated version of the patient information area appears
in the Patient Information area when the [Landmark] button is
selected in the Patient Information area.

Landmark

Landmark represents the position of the axial and sagittal
alignment lights superimposed over an anatomical area.

• Select a landmark to establish an anatomical point from
which all images in a series are referenced.

• Alignment and landmarking are steps taken to ensure the
Region of Interest (ROI) center is as close as possible to
isocenter. That is, the location within the bore of the magnet
where the field strength is most homogenous.

• A landmark can be selected from the predefined list on the
Abbreviated Patient Information area.

You can also type-in the first letter of the desired landmark,
with the exception of Symphysis Pubis, which requires two
letters. Upper and lower case entries are acceptable. For
example, Nasion (N), Sternal Notch (S), Iliac Crest (I), or
Symphysis Pubis (SY or SP).
3-8 2292261-100 Rev. 0 (03/01)



Scan Rx Desktop
The diagram below shows the landmarks most commonly
used for MR imaging. These are not the only landmarks
which can be used.

• The [Full Info] and [Landmark] buttons on the bottom-right
of the window toggle between the full patient information
and the abbreviated landmark areas.

• Landmarking helps bring the region of interest to isocenter
from the third perspective, longitudinally.

NOTE: Selecting a landmark is not required, but if a landmark is
not entered, the images have no anatomical reference.

Something to Think About...

• An acquisition cannot be started without first
establishing a landmark at the magnet enclosure. The
landmark established should reflect the selection to
ensure accurate image reference.

• Homogeneity decreases as distance from isocenter
increases. Although it is not always possible to place the
anatomy being scanned at isocenter, bring the anatomy
as close to isocenter as possible, keeping the patient as
comfortable as possible.

Patient Position

The Patient Position area opens after you select Patient
Position from the Patient Protocols window. This area indicates

Glabella

Nasion

Sternal
Notch

Symphysis
Pubis

Iliac Crest

Sternal
Notch
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the patient’s position, patient entry, the type of coil being used,
and a description of the scan prescribed.

Patient Position

The Patient Position text box contains four selections
pertaining to the orientation of the patient.

If you have the Abbreviated Patient Information area displayed
(by selecting the [Landmark] button in the Full Patient
Information area,) the patient icon changes its orientation as
you change the patient position information.

• You can select patient position from the pre-defined list or
by typing one of the following shortcuts: (S) for supine, (P)
for prone, (L) for left decub, (R) for right decub. These
entries are not case sensitive.

Supine

Prone

Left Decubitus

Right Decubitus
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WARNING:Ensure that the Patient Position selection matches
the actual patient orientation. Making a selection that
does not match the patient’s actual position results in
incorrectly annotated and/or rotated images, possibly
resulting in improper medical treatment.

Patient Entry

Patient Entry describes the orientation of the patient as head
first or feet first into the magnet bore. If you have the
abbreviated Patient Information area displayed, the patient icon
changes its orientation as you change the patient entry
information.

• This decision is determined by the anatomical area being
scanned. For example, a cervical spine is typically placed
head first and a knee is typically placed feet first.

• In the Patient Entry text box select an entry from the
pre-defined list or type in one of the following shortcuts: (H)
for head first or (F) for feet first. These entries are not case
sensitive.

WARNING:Ensure that the Patient Entry selection matches the
actual orientation of the patient. Making a selection
that does not match the patient’s actual position
results in incorrectly annotated and/or rotated images,
possibly resulting in improper medical treatment.

Coil Type

The Coil text box allows you to select the coil from which the
signal is transmitted and received, or in the case of a surface
coil, only the receiving the signal. Selecting Surface or Phase
Array displays a listing of all coils configured for the system.
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When you select coil from the Patient Position area, the Coil
Names window appears.

• The coil selection must match the coil connected.

• Select a coil that matches the anatomy to be scanned.

• Select a coil from the Coil Names window or by typing in
one of the following shortcuts in the Coil text box: (H) for
head coil, (B) for body coil or the full name of a surface or
phased array coil. These entries are not case sensitive.

Something to Think About...

• The penetration depth of a coil is approximately half the
coil’s diameter.

• The smaller the coil, the better the SNR but less
coverage and/or depth penetration.

• If a prescan failure occurs, make sure the coil key
selection matches the coil in use.

WARNING:Improper use of arrays and coils may cause patient
burns and other hazards. Read and understand all the
surface coil warnings in the chapter Working Safely,
Volume 1, before using an array or coil.
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Series Description

The Series Description text box allows you to enter a brief
description of the series being prescribed.

• This information appears on the series description line that
is part of the series text page, which can be filmed and kept
as part of the patient’s MRI exam.

• The description may be helpful when you are trying to locate
a particular series.

NOTE: If a predefined protocol has been selected, the series
description appears automatically. However, this
description does not change if the scan parameters are
later adjusted.

NOTE: If a description is not entered, the system creates one
based on the current patient entry, position, coil, mode,
pulse sequence, and plane. For example, the default
description could be Body, Cor, 2D, SE.

Imaging Parameters

The Imaging Parameters area provides the selection of the
imaging plane and mode, the pulse sequence, imaging options
for the acquisition, PSD Name, and Protocol.

Imaging Plane

Plane defines the scan plane for the acquisition.
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The planes used in MR imaging that can be selected are axial,
sagittal, coronal, oblique, or 3-Plane.

• Orthogonal planes are perpendicular to one another. Axial,
sagittal, and coronal planes are all perpendicular to each
other and are therefore orthogonal.

• Oblique planes are scan planes prescribed in any
orientation other than the axial, sagittal, and coronal planes.
° A simple oblique is a plane that has been tilted in just

one direction from an orthogonal plane.
° A complex oblique is a plane that has been tilted in two

directions from an orthogonal plane.

• 3-Plane is a localizer that allows the sequential acquisition
of three orthogonal scan planes acquired in a single series
with one scan prescription.
° This feature uses a Fast Gradient Echo (GRE) pulse

sequence and can obtain the three planes in a single
breath-hold.

NOTE: Refer to Volume 2, for detailed information on 3-Plane
Localizer.

• The Plane text box contains a pre-defined list for plane
selection. You can also type in the following shortcuts: (A)
for axial, (S) for sagittal, (C) for coronal, (O) for Oblique, or
(3) for 3-Plane. These entries are not case sensitive.

The following figures show the planes that may be acquired
during MR imaging.
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Something to Think About...

• Orthogonal images cannot be graphically prescribed
from a localizer of the same plane.

• Oblique prescriptions can increase TR, TE, FOV, and
slice thickness, and decrease the matrix selection and
number of slices.

• The system annotates axial, sagittal, and coronal
images as oblique if you select the oblique plane in the
Imaging Parameters area.
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Imaging Mode

Mode defines the image format and type of image information
to be gathered.

The Mode text box has predefined values to select 2D, 3D,
Cine, or MR Spectroscopy. The desired imaging mode may be
selected from the predefined values on the list or you can type
in the following shortcuts: (2) for 2D, (3) for 3D, (C) for Cine, or
MR Spectroscopy (M). These entries are not case sensitive.

2D Mode

2D Mode acquires and reconstructs raw image data into
two-dimensional images whose brightness is proportional to the
intensity of the MRI signal from the corresponding protons.

• The RF pulse and gradient pulse occur at the same time to
excite an individual slice of a specific thickness of tissue.

• An individual slice is the area where the RF pulse frequency
is the same as the resonant frequency created by the main
magnetic field plus the slice-select gradient.

• Additional locations are excited by varying the excitation
frequency of the RF pulse, thereby causing resonance in a
slightly different location.

• Spatial encoding takes place in two dimensions, frequency
and phase axes, to produce an image.

2D images can be acquired as multi-planar or sequential
acquisitions.

• Multi-planar acquisitions acquire multiple images within a
single TR. The order of slice excitation is odd-numbered
images first, then even numbered images. Once all the

2D Slices

Phase
Encoding

Frequency
Encoding
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slices are excited, the number of phase steps multiplied by
the NEX selected determines how many times this process
is repeated.

The following diagram illustrates a multi-planar single
acquisition with five slices.

• Sequential acquisitions acquire all the data necessary for
one slice location before moving on to the next location. An
example of this is a 2D GRE sequence with the sequential
option selected from the Imaging Options window.

The following diagram illustrates a sequential acquisition
with three separate slice locations for a total of three
acquisitions.

3D Mode

3D Mode excites an entire scan volume or slab with a wide RF
pulse. Spatial encoding is done in the phase, frequency, and
slice axes.

Explicit or graphic orthogonal and oblique 3D mode is available.
The oblique 3D feature allows multiple groups of 3D volumes to
be prescribed with different rotation angles and different offsets.
The oblique 3D volumes can be prescribed explicitly and
graphically for 3D Fast GRE/SPGR, 3D TOF, 3D Fast TOF
GRE/SPGR and SmartPrep IA.

1 2 3 4 5

1 2 3
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The diagram below shows the entire scan volume is excited
with a wide RF pulse. Spatial encoding is done in the phase,
frequency, and slice axes.

• The slice-select gradient is applied to create areas with
slightly different phase relative to a point at gradient
isocenter.

• The number of slice encodings affects scan time. TR x
Phase Encodings x Slice Encodings x NEX = 3D scan time.

• The number of slice encodings performed determines the
number of slices obtained from the volume.

• The amplitude of the slice encoding gradients determines
the thickness of the slices to be reconstructed.

• Images are annotated 3D next to the PSD.

The following diagram illustrates a 3D volume prescription
in the head.

The 3D volume can be divided into a minimum of 12 slices for
vascular imaging and 28 for non-vascular up to a maximum of
128 in increments of two. The system acquires four additional
slices, two on each side of the volume, and throws out these

3D
Volume

Slice
Encoding

Phase
Encoding

Frequency
Encoding

3D Volume
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end slices which are aliased data. The number of locations
available depend on the pulse sequence.

NOTE: Whatever value of locations is prescribed, you obtain four
less images, but the graphic volume deposited on the
localizer image shows you exactly your end result. For
example, if 32 locations are prescribed, 24 images
reconstruct, although the images are acquired at the
number of locations seen in Graphic Rx and the number
of locations posted in the Scanning Range area.

3D MultiSlab

3D MultiSlab acquires multiple, overlapping image volumes,
and combines overlapping locations from two adjacent slabs.

MultiSlab minimizes the saturation effects of slowly moving
blood by allowing multiple volumes with decreased slab
thickness. 16 to 32 slices per slab are common. Vessel to
background contrast is improved as compared to 3D TOF by
using larger flip angles and short TRs. MultiSlab provides
coverage of larger volumes with decreased saturation of
slow-moving or in-plane blood flow.

• MultiSlab acquisitions discard four slices from each slab,
just as in 3D single slab imaging, to eliminate aliased image
data.

• MultiSlab imaging also acquires an overlap region. A user
defined area of each slab is acquired during both
acquisitions of adjacent slabs. This overlap provides better
transition between the slabs and decreases a venetian blind
effect in the resulting images.

• MultiSlab images are annotated M3D next to the PSD.

3D Volume Prescription

3D volumes are acquired as prescribed by Explicit and Graphic
Rx, but not all pulse sequences allow volume prescription in
both R-S-A (right-superior-anterior) and L-I-P
(left-inferior-posterior) directions. The following chart can be

Pulse Sequence Min Max

3D Fast GRE/SPGR 8 128

3D GRE/SPGR 28 124

3D Vascular 16 128

3D Fast Vascular 8 128
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used to determine the availability of R-S-A versus L-I-P volume
prescriptions for 3D pulse sequences.

Something to Think About...

• 3D images result in more RF pulses delivered to each
slice in comparison to 2D images. The increased SNR
due to the increased number of RF pulses can be used
to increase the spatial resolution. This can be
accomplished because the SNR is higher, so that you
can afford to increase Matrix, decrease FOV, or
prescribe thinner slices to improve spatial resolution.

• 3D Oblique volumes can be prescribed with different
rotational angles and different offsets. These volumes
can be prescribed explicitly or graphically for 3D Fast
GRE/SPGR, 3D Fast TOF GRE/SPGR, and SmartPrep
IA.

• 3D TOF GRE/SPGR allows prescription of multiple
slabs, but they must be contiguous and at the same
angle and FOV offset.

Pulse Sequence Multi-slab
allowed

Volume Rx Capabilities

3D GRE/SPGR no Explicit Rx can be done in either L-I-P
or R-S-A directions. Graphic Rx (GRx)
can only be done in L-I-P direction for
orthogonal planes (note that oblique
scan planes are not allowed with 3D
GRE/SPGR).

3D Fast
GRE/SPGR

yes Explicit Rx and Graphic Rx can be done
in either L-I-P or R-S-A direction.

3D TOF
GRE/SPGR

yes Explicit Rx and Graphic Rx can be done
in either L-I-P or R-S-A direction.

3D Fast TOF
GRE/SPGR

yes Explicit Rx and Graphic Rx can be done
in either L-I-P or R-S-A direction.

3D Phase
Contrast (PC)

no Explicit Rx can be done in either L-I-P
or R-S-A direction. Graphic Rx (GRx)
can only be done in L-I-P direction for
orthogonal planes (note that oblique
scan planes are not allowed with 3D
PC.

3D FSE yes Explicit Rx and Graphic Rx with no
obliques, can be done in either L-I-P or
R-S-A direction.
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• Images acquired in 3D mode produce no cross-talk
since there is no slice gap.

• As the slice thickness decreases, the slice aliasing
increases. To reduce the aliasing artifact in the anatomy
of interest, either increase the slice thickness or scan a
larger slab.

• Slab overlap is crucial. If no overlap is prescribed
between adjacent slabs, a substantial inter-slab
boundary artifact (venetian blind) is created due to the
decrease in blood-background signal to noise. An
overlap of 25% on each end of the slab is
recommended.

CAUTION:Provide all patients with ear protection before any
scan to help avoid possible hearing impairment.
Acoustic noise levels can exceed 99 dBA in the
magnet bore.

Cine Mode

Cine is an optional software package that lets you generate
images for dynamic views of anatomy such as the heart. This
option employs retrospective gating techniques.

NOTE: For additional information on Cine imaging, refer to
Volume 2.

MRS Mode

Magnetic Resonance Spectroscopy (MRS) is an optional
software package that is an image-guided Proton Brain Exam.
A clinical MRS package is available on 1.5T systems. It
acquires a volume-localized, water-suppressed spectrum from
a single or multiple voxel(s) or a volume of interest (VOI).

NOTE: For additional information on MRS imaging, refer to
Volume 2.

Pulse Sequence

The Pulse Sequence text box provides access to pre-defined
RF pulse sequences for detecting specific types of proton
emissions.
2292261-100 Rev. 0 (03/01) 3-21



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
The Pulse Sequences text box contains a list of pre-defined
available pulse sequences or you may type in the pulse
sequence name in this text box.

NOTE: For specific information on PSDs and pulse sequence
selection, refer to Volume 2.

Imaging Options
Imaging Options provide appropriate image processing or filters
for enhancing anatomical features or reducing noise.

The Imaging Options text box contains a list of predefined
available options or you may type in the name of the imaging
option in this text box. Multiple imaging options can be selected,
but availability may be limited by the pulse sequence or other
imaging options selected.

NOTE: For additional information on imaging options, refer to the
chapter Optimizing Images with Imaging Options, Volume
3.

Pulse Sequence Database Name
Use the Pulse Sequence Database (PSD) Name text box to
select pulse sequences that are not listed in the Pulse
Sequence list.

NOTE: For additional information on PSDs, refer to Volume 2.
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Protocol
The Protocol text box allows you to type in the name of a
protocol to download all the predefined values. Alternatively,
select the humanoid to access the list of predefined protocols.

NOTE: For additional information on protocols, refer to the
chapter Building and Saving Protocols, Volume 1.
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AutoView Window
AutoView Window is located in the upper right-hand corner of
the screen and displays images as they are reconstructed.

• Use the AutoView Window to monitor the images
reconstructing while performing other tasks, such as setting
up for the next acquisition or archiving.

• Images displayed in the AutoView Window are annotated
with the following information:

° Exam number, series number, image number, patient
name

° PSD name, TR, TE, echo number, FOV

° Scan location, report cursor with RAS values

° Window and level values

AutoView

AutoView turns the AutoView feature on or off. When the button
is selected, AutoView is on and the system automatically
displays each image as it is reconstructed.

When AutoView is not selected, you are in the Review mode.
The Review mode allows you to scroll through the images in
AutoView display. When you turn AutoView back on, Review
mode is turned off and the most recently reconstructed images
are displayed.

Auto-
view
"ON"

slider

Click and drag
the slider, or
single click on
the up and
down arrows
to view imag-
es.
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• The AutoView Window buffer holds 256 images.

• AutoView Window holds only one exam at a time. As soon
as the first image from the current exam is reconstructed,
the previous exam’s images are deleted from the AutoView
display.

The image below shows the AutoView Viewport. It displays the
most recently reconstructed image for the current exam. The
viewport’s standard image display is 256x256.

Use the slider to the right of the image for moving within the
image set. Click on the arrows to move through the images one
at a time. You may scroll through the images when AutoView is
on.

Report Cursor
Report Cursor shows the cursor-location RAS (Right Anterior
Superior) coordinates with respect to the cursor’s position on
the image.

• Selecting Report Cursor turns AutoView off.

• Selecting AutoView turns Report Cursor off.

slider
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Update Images

The [Update] button becomes active if images have
reconstructed while Autoview was turned off.

• Click the [Update] button to add these images to the
Autoview memory.

• Use the slider to review these images.

Auto Window/Level

Auto W/L is the window and level feature that automatically
calculates during reconstruction. It toggles on and off.

• The Auto W/L feature is on when the Auto W/L box is
depressed. Manual window/level changes override the
system settings.

• The Auto W/L feature is off when the Auto W/L box is not
depressed. Manual window and level changes do not
override the system settings.

Save Window/Level

Use Save W/L when a particular image needs to be recalled.
The button toggles on or off.

• The window and level settings of the image are saved when
the Save W/L box is depressed. Then, each time you scroll
through the images for later recall, the system holds that
window and level setting.

• The Save W/L feature is turned off when the box is not
depressed. No new window and level settings are saved.
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Maximize/Minimize

Maximize increases the size of the image display to a 512x512
resolution, while minimize displays the images at a 256x256
resolution.

A magnifying glass is available in the AutoView window when
the right mouse button is pressed and held. The moveable
square zone magnifies the image (in the zone) two times.

Something to Think About...

• During AutoView, the images are displayed in the order
of the reconstruction. When using the slider, the images
are viewed in order of series, image, and echo number.
In addition, the image viewed has its image number
noted to the left of the slider.

• Moving the slider temporarily pauses the display of any
newly reconstructed images. Image display resumes
once the slider activity is completed.

• When images from series one of the current exam
reconstruct, images from the previous exam are deleted
from the AutoView buffer.

• Changing the window level with the middle mouse
button temporarily pauses the display of images. Image
display resumes once the middle mouse button is
released.

• Save W/L overrides Auto W/L.

• During a SAT or Graphic prescription, the AutoView
Window is moved to the left and overlays the area
reserved for Patient Register or Patient Information. The
AutoView Window is returned to its original location
once the prescription is complete for the SAT or Graphic
prescription.

Scan Timing

The Scan Timing area defines the time to echo (TE) and time to
repeat (TR) scan timing parameters as well as the number of
echoes, echo train length (ETL), number of shots, inversion
time (TI), flip angle, and receive bandwidth (RBw). An advisory
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area to the right of each text box displays the minimum and
maximum values allowed.

You can enter values in this area in one of three ways:

• Select text from the pre-defined list.

• Click on the up or down arrows to increase or decrease
values already in the text boxes.

• Delete the text and type in a new text value.

Number of Echoes
Number of Echoes determines the number of images produced
from each slice location.

• Each echo yields an image.

• The number of echoes allowed is dependent on the pulse
sequence.
3-28 2292261-100 Rev. 0 (03/01)



Scan Rx Desktop
° In late echo images, SNR decreases and T2 contrast
increases.

• Acquisitions with different numbers of echoes can result in
different contrast weighting.

Something to Think About...

• Choosing two echoes requires choosing two echo times,
TE and TE2. When [1] or [4] are selected, there is no
TE2 selection because four echo studies use multiples
of the first echo.

• The Flow Compensation option allows a maximum of
two echoes.

• If Flow Compensation and POMP are applied to a
two-echo study, Flow Compensation is applied to the
second echo only.

• For 2 or 4 echo acquisitions, two bandwidths must be
defined. Bandwidth is for echo 1, while Bandwidth2 is for
echoes 2 to 4.

Number of Shots

Number of Shots selection determines the number of TR
periods to be repeated for an echo planar acquisition. The

# of
Echoes

Contrast

T1 PD T2 T2*

1 SE or SPGR Usually FSE Usually FSE GRE

2 NA SE or FSE SE or FSE Seldom
acquired

4 NA SE #1 PD/SE
#2 early T2

SE #3 middle
T2/SE #4 late

T2

NA

Echo # 1 2 3 4
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number of shots selection replaces the Number of Echoes
selection when an Echo Planar pulse sequence is chosen.

• To calculate the scan time for an EPI sequence, use the
following formula:

Scan Time = TR x Number of Shots x NEX

• A single shot EPI sequence is one in which all the required
phase encoding steps are collected within one TR period.
Single shot [1] is the only selection for DW EPI.

• The fewer the number of shots, the shorter the scan time,
however, geometric distortion increases as the number of
shots decrease.

• EPI protocols that use more than one shot to complete the
image acquisition are referred to as multi-shot EPI.
Multi-shot EPI fills K-space lines in an interleaved manner.
The interleaved K-space yields a reduced effective echo
spacing.

• The number of shots is annotated SH.

Something to Think About...

• The number of shots determine the speed and image
quality of an EPI sequence.

• As the number of shots are increased, the effective echo
spacing decreases and blurring in the image decreases.

• As the number of shots decrease, scan time decreases.

NOTE: The number of shots selection is valid only if the EPI
option is purchased and installed on your system.

NOTE: For additional information on EPI imaging, refer to
Volume 2.

Echo Time

Echo Time determines the time between the center of the first
excitation pulse and the peak of the echo, which usually occurs
at the center of the readout gradient.
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TE2, available for two echo sequences, is the time between the
center of the first excitation pulse and the center of the second
readout.

The following pulse sequence diagram displays a 90° excitation
pulse and 180° refocusing pulses that generate the echo.

• Entries for the echo time (TE) are in milliseconds.

• The TE text box contains a list of predefined selections for
the scan TE value, or you may enter a value in the text box.
The arrows can also be used to change the TE.
° Minimum obtains the minimum TE, whether it is a full or

fractional echo. With fractional echoes, SNR may
decrease because only a portion of the echo is read. The
loss in SNR may be offset by the shortened TE which
allows less T2 decay and therefore greater SNR. The
smaller the FOV, the longer the minimum TE.

° Min Full provides the shortest possible TE times without
setting a fractional TE. This selection may increase SNR
over a shorter TE acquired with a fractional echo
technique.

• The TE2 text box is available only for two-echo sequences.

Fractional Echo

Fractional Echo is a technique that shortens the time in which
the readout gradient (Gx) is applied so that shorter echo times
can be achieved. Because it is turned on for a shorter time, not
all of the rephase portion of the echo is read which, in turn,
affects the SNR.
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The following diagram illustrates the pulsing differences
between a fractional and full echo. Note the timing differences
where the Gx is applied.

The following tables demonstrate the effects TE has on
contrast, imaging parameter, and artifacts.

Something to Think About...

• Fractional Echoes are annotated FR after the echo time.

• When GRE is selected with a fractional echo, the
system only reads about 60 percent of the echo.

• When a Spin Echo (SE) is selected with a fractional
echo, the system uses a sliding scale from 60% to 100%
for the amount of signal it reads. As the TE gets closer
to a full echo, the system has more time to read the
signal and therefore it approaches reading 100% of the
echo.

• The longer the TE, the greater the magnetic
susceptibility artifacts. This is especially true in GRE and
EPI imaging.

• Using Fractional Echo with lower bandwidths may
compensate for SNR loss. As bandwidth decreases,
SNR increases.

• Fractional Echo may affect the minimum values allowed
for FOV, slice thickness, and matrix size.

T1 PD T2

As TE ⇓ ⇑ ⇑ ⇓

# of
Slices

Scan
Time

SNR Res. Flow
Artifact

Mag Susc RBw

As TE ⇓ ⇑ NA ⇑ NA ⇓ ⇓ ⇑
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Repetition Time

Repetition Time represents the interval between successive
excitation pulses of a slice.

TR controls the amount of transverse magnetization that
recovers to the longitudinal plane. If full recovery for any given
tissue does not take place, it eventually becomes saturated.

• In a T1-weighted image, a short TR is programmed to
achieve saturation effects. The shorter the TR, the more
saturation (T1) effects are seen in the contrast.

• In a PD or T2-weighted image, a long TR is programmed to
minimize the saturation effects. Other effects such as
dephasing (T2) or the number of protons in tissue (PD) can
then predominate the image contrast.

• Entries in TR are expressed in milliseconds.

The following tables demonstrate the effects TR has on
contrast, imaging parameter, and artifacts.

T1 PD T2

As TR ⇓ ⇑ ⇓ ⇓

# of
Slices

Scan
Time

SNR Res. Flow
Artifact

Mag Susc

As TR ⇓ ⇓ ⇓ ⇓ NA ⇓ NA

TE TR

T1-weighted Short ≤ 30 Short ≤ 600

PD-weighted Short ≤ 30 Long TR ≥ 2000

T2-weighted Long TE ≥ 80 Long TR ≥ 2000
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Different anatomy exhibit different characteristics, depending on
the TR and TE selected, which in turn determines the weighting
of the image (T1, PD, or T2). The following table illustrates
some of these differences.

Inversion Time
Inversion Time (TI) primarily controls the contrast in an IR pulse
sequence. It is the time between the first (180°) inverting pulse
and the middle of the second (90°) refocusing pulse in an IR
pulse sequence.

NOTE: This text box indicates the Prep Time when SPECIAL is
selected on the User CVs page, or when IR Prepared or
DE Prepared imaging options are chosen.

TI affects the number of slices.

T1- Weighted PD-Weighted T2-Weighted

CSF Dark Intermediate Bright

Gray Matter Dark Gray Light Gray Intermediate

White Matter Light Gray Dark Gray Dark

Edema Dark Intermediate Bright

Fat Bright Bright Dark

Muscle Gray Intermediate Dark

Bone Marrow Gray Intermediate Intermediate

Cyst Dark Dark Bright
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The following table shows example TI times for 1.0T and 1.5T
field strength systems.

NOTE: For additional information on an IR pulse sequence, refer
to Volume 2.

Flip Angle
Flip Angle determines the rotational angle of the magnetization
vector produced by an RF pulse relative to the longitudinal axis
of the static magnetic field.

SE uses enough RF to move the longitudinal magnetization into
the transverse plane. A standard 90° flip angle is used for the
excitation pulse.

GRE sequences allow the flip angle to be varied. The amount of
longitudinal magnetization moved to the transverse plane
changes, based on the GRE flip angle. Select the flip angle

Inversion Time T1-Weighted Fat
Suppression

CFS
Suppression

1.0T ~750 ms ~120 ms ~2000 ms

1.5T ~900 ms ~150 ms ~2200 ms
2292261-100 Rev. 0 (03/01) 3-35



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
based on the contrast and SNR results desired. The flip angle
affects the total amount of signal that recovers over time.

• As flip angles increase, T1 contrast increases.

• As flip angles decrease, T2* contrast increases.

• Flip angle selection range is 1° to 180° for most pulse
sequences. If the system prompts you that there is a
limitation, check the Advisory Panel.

Something to Think About...

• GRE Images may exhibit a lower SNR than
conventional SE pulse sequences.

• The saturation effects of short TRs in fast SPGR/GRE
scans limits the usable range of flip angles. Some
sequences may prevent you from using large flip
angles.

• SPGR does not automatically produce T1 weighting.
Low flip angles and low TEs are likely to result in proton
density weighted images. However, the optimal flip
angle for achieving T1 contrast can also be exceeded by
selecting a flip angle that is too high.

• When a GRE is acquiring data in the steady state, the
TR is less than the T2 of the tissue and the Ernst angle
effects SNR. In general, keep the flip angle and TR
within ten points of one another to get maximum SNR.

Echo Train Length

ETL is the number of echoes per TR that you prescribe. ETLs
can contribute from two to sixteen times more image data per
TR, thereby decreasing acquisition time. ETL is available for
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Fast Spin Echo (FSE) and Fast Inversion Recovery (Fast IR)
pulse sequences.

• In FSE, the initial 90° pulse is followed by the acquisition of
2 to 128 echoes within a single TR (depending on the
system configuration).

° FSE acquisitions can be used to produce high resolution
images with ultra long TRs in reasonable scan times.
Ultra long TRs can be used to enhance myelographic
effects, increase T2-weighting on brains, increase SNR,
yield PD information for tissues with long T1 times, and
increase the number of slices available.

• Long TR acquisitions can be performed in reasonable scan
times because the scan time is divided by the ETL.

• The time between each echo in the echo train is called the
echo space.

The following figure demonstrates that each echo is acquired
with a different phase-encode gradient and each echo fills a
unique line of K-space.

For Example, If you prescribe a 32 ETL, the scan time is
already reduced by a factor of 32. For example, a 256x256
image with a 32 ETL requires 8 repetitions to obtain the
required data. This is calculated by the following formula: TR x
256 ÷ 32 = 8.

The following table shows how various factors are affected as
the ETL increases.

PD T2 #of Slices Scan Time Edge Blurring

ETL ⇑ ⇓ ⇑ ⇓ ⇓ ⇑
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Bandwidth

Bandwidth is a range within a band of frequencies that an MRI
system is tuned to receive. The RBw of an image determines
the number of frequencies sampled in an image.

As the RBw is narrowed, a smaller range of frequencies is
sampled, thereby reducing the amount of aberrant frequencies
detected. The result is an improved Signal-to-Noise Ratio
(SNR).

The following figure shows that varying the bandwidth can
narrows the system’s receiver bandwidth to increase SNR.

• The system default is ±15.63 kHz for a 256 frequency matrix
or ±32 kHz for a 512 frequency matrix. This means that the
system detects signal from protons resonating at
frequencies in the range of ±16 kHz, or ±32 kHz, from the
Center Frequency.

• In the Scan Timing area, you have the following choices:

° Bandwidth- which provides the bandwidth selection for
one echo sequences.

° Bandwidth2- which provides the bandwidth selection for
echoes 2 and 4 in multi-echo sequences.

• The system annotates bandwidth in kHz in the lower
left-hand corner of the image.

° The minimum and maximum bandwidths depend on the
TE, matrix, and FOV selected.
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° The area lists the minimum achievable bandwidths for
the first (RBw) and subsequent (RBw2) echoes.

° If a bandwidth is entered manually and the entry falls
outside the minimum and maximum bandwidth values,
the MRI system requests a different selection.

• Decrease the RBw to improve SNR.

• Increase the RBw to decrease the minimum TE.

There are many trade-offs associated with narrowing the
receive bandwidth. The following table shows the effect
decreasing RBw has on some parameters.

Additional Parameters
The Additional Parameters area contains settings for
Presaturation Pulses, Graphic Prescription, Vascular Imaging,
User Control Variables, Gating, Cine, and Multi Phase, and DWI
Imaging. These icons become available when a pulse
sequence or imaging option that requires additional parameters
to be defined.

SNR Sampling
Time

TE # of
Slices

Motion Chem
Shift

Echo
Spacing

As RBw ⇓ ⇑ ⇑ ⇑ ⇓ ⇑ ⇑ ⇑
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SAT Prescription Screen
The SAT Additional Parameter screen provides functions for
graphically and explicitly prescribing presaturation pulses
and/or suppression techniques for an exam. Saturation pulses
are used to saturate (and thereby eliminate signal from) tissues,
a selected area, or across the FOV when suppression SAT
pulses are used.

SAT pulses can be applied spatially to saturate an entire area of
tissue or chemically to saturate specific chemical components
(fat and water suppression).

Clicking the SAT icon in the Additional Parameters area opens
the SAT screen.

SAT Additional Parameters Screen
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The following table gives a description for each selection on the
SAT screen.

Selection Description

S, I, A, P, L, R Defines a SAT pulse in the selected plane.

Location Defines the location of the leading edge of the SAT pulse. Leave the
text boxes empty for default positioning of SAT outside FOV or enter
a positive or negative numerical value to explicitly prescribe the SAT
location.

Thickness Defines the thickness/width of the SAT band. The default thickness is
defined by the PSD and in most cases is 80 mm. Enter a value from
10 to 200 in steps of 1.

Concat SAT Enables “walking SAT” for slice-select direction SAT pulses in
concatenated acquisitions.

Fat/Water To suppress either FAT or Water using spectral or chemical saturation
pulses. Center Frequency must be set to FAT when Water is selected
and vice-versa.

[ALL OFF] Turns all selected SAT directions OFF.

Graphic Rx icon Toggles to Graphic Rx screen and accepts current SAT entries.

[Copy Rx] Copies SAT prescriptions for a previously prescribed series to current
series. All SAT selections must be deselected to use copy Rx. Click
on the desired series followed by [Accept]. The SAT bands appear
on the currently displayed image. A double click on a series from the
series list displays the image on which SAT bands were prescribed in
the copied series, and the SAT bands for that series are posted.

[Accept] Enters the prescribed values for the series and exits SAT.

[Display
Normal]

Returns the localizer image to the original state.

Zoom Adjusts magnification factor for displayed images using the slider bar.

Text Box Enters series and image number for the image displayed in the SAT
viewport.

[Select Series] Lists all valid series from which a localizer image can be selected.

[Select Image] Lists the images for the selected series.

[-] [+]
(prior/next)

Displays the previous or next image in the series of the currently
displayed image.

Image View Port Displays the middle slice of the most recent series which could be
used as a localizer for Graphic SAT prescription.

Auto W/L Selects the Auto W/L option.
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The Additional Parameters SAT icon indicates the SAT pulses
applied within the current prescription.

• Spatial SAT pulses applied at the default location and
thickness are shown in upper case letters beneath the SAT
icon, e.g., S, I.

• Spatial SAT pulses applied with a change to their thickness
or location are shown in lower case letters, e.g., a. i.

• If Fat or Water suppression has been selected, the selection
is indicated as FAT or WATER.

• If no SAT selections are made, the icon label reads “SAT”.

• The icon only indicates if SAT has been turned on at its
default value or if the SAT pulse location/thickness has been
altered. It does not indicate the actual thickness or location.
To view the thickness and location of SAT pulses, enter the
SAT screen.

Graphic Prescription Screen
Graphic Rx Additional Parameter screen is used to graphically
define the scan locations on a localizer image using the same
landmark.

Graphic Rx can be used to prescribe single or multiple groups
of:

• 2D orthogonal slice locations from an orthogonal localizer

• 2D oblique slice locations

• 2D oblique slice locations with multiple angles

• 2D FSE-XL, FastCard, and SSFSE radial slice locations

• 3D orthogonal or oblique volumes
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Clicking the Graphic Rx icon in the Additional Parameters area
opens the Graphic Rx screen.

Graphic Rx Additional Parameter Screen

NOTE: For additional information on prescribing scan locations
with Graphic Rx, refer to the chapter Scanning With a
Protocol, Volume 1.
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The following table gives a description and acceptable values
for each selection on the Graphic Rx screen.[

Selection Description

[Erase Group] Erases a deposited group of slices.

[Erase All] Erases all deposited slices.

[Reset Center] Allows you to change the center of the voxel prescription to the
desired image location.

# of Slices The number of slices prescribed for a radial graphic prescription.
The maximum allowable is 16.

Radial Dir. Clockwise and counter clockwise directions for radial
prescription. System defaults to clockwise.

Instructions for
Add Group

Adds a group of slices in a different location.

[Tracker] Defines the tracker slice location and thickness in a SmartPrep
acquisition.

[Fallback] Moves the slice centers from off center prescribed position to
isocenter in the slice select direction of localizer image.

SAT icon Opens the SAT screen. The currently prescribed slices are
automatically accepted.

[Copy Rx] Copies a previous Rx with the same FOV, slice thickness, and
spacing. A single click on the desired series to copy followed by
[Accept] displays the same slice locations on the currently
displayed image. A double-click displays image used to
prescribe slices for the copied series and the slice locations.

[Accept] Registers slice prescription and exits Graphic Rx.

[Display Normal] Returns the displayed image to its default size.

Zoom Adjusts magnification factor for displayed images using the
slider bar.

Text Box Enters series and image number for the images to be displayed.

[Select Series] Lists valid series from which a localizer image can be selected.

[Select Image] Lists the images for the selected series.

[-] [+] (prior/next) Displays the previous or next image in the series from the
currently displayed image.

Image View Port Displays the middle slice of the most recent series which could
be used as a localizer.

Auto W/L Selects the window level mode to auto.
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Vascular Screen
The Vascular Screen is available in the Additional Parameters
area when prescribing a TOF, PC, Cine PC, or 3D FGRE pulse
sequence.

The available options for reconstructions for vascular imaging
are accessed in the Vascular Screen. There are four different
types of image reconstructions: magnitude, weighted-phase,
collapsed, and projection images.

• Magnitude images for Time of Flight sequences
demonstrate the vessels clearly, while suppressing the
static tissues.

• Magnitude images for Phase Contrast sequences
demonstrate both vessels and static tissues. These images
provide an anatomical frame of reference with an
appearance similar to that of GRE.

• Weighted-phase images provide static tissue suppression
to vividly reveal vascular anatomy.

• Collapsed images provide quick visualization of the vascular
data set in the plane of acquisition, without interference
from stationary tissue.

• Projection images create multiple views of a particular data
set and permit visualization of the anatomy at various
angles.
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The following table shows the vascular pulse sequences that
are compatible with various vascular reconstruction techniques.

NOTE: For additional information on the Vascular Screen
Additional Parameter selections available for specific
vascular pulse sequences, refer to Volume 2.

User Control Variables (User CVs) Screen
User CVs Screen is used to define control variables which must
be specified to initiate an acquisition for certain pulse
sequences. Certain timing parameter combinations require
access to User CVs for data entry. Depending on the pulse
sequence chosen, the User Control Variables screen may vary.

If a pulse sequence requires a User CV, the User CVs Screen in
the Additional Parameters area will be available.

NOTE: For the User CV parameter selections specific to each
pulse sequence, refer to Volume 2.

Pulse
Sequences

Magnitude Weighted
Phase

Collapsed 0, 19, 0r 37
Projections

2DTOF X2 X X

3DTOF X2 X X

FGRE 3D X2 X X

2D PC X X2 X

3D PC X X2 X X

Cine PC X X

1. Optional.

2. Used as input for the creation of collapsed and /or projection
images because they suppress static tissue.
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Gating/Triggering Screen
The Gating/Triggering Screen is a combined Cardiac
Gating/Triggering and Respiratory Gating/Triggering screen. It
is used to enter gating/triggering parameters and allows for
compatibility between features for selected pulse sequences.

The Gating/Triggering Screen is available in the Additional
Parameters area when Cardiac Gating/Triggering or
Respiratory Gating/Triggering is selected from the Imaging
Options window.

The combined Cardiac and Respiratory Gating/Triggering
Screen is displayed when the Gating/Triggering icon is
selected.

Combined Cardiac and Respiratory Gating/Triggering Screen

NOTE: The selections available on this screen depend on the
Pulse Sequence and Imaging Options selected. The
selections in gray are unselectable if they do not require
a value.
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NOTE: For detailed information on the Gating/Triggering Screen
Additional Parameter, refer to the chapter Gating and
Triggering, Volume 3.

Cine Screen
Cine is an optional GRE acquisition that acquires data
continuously throughout the cardiac cycle. Cine scans employ
retrospective sorting and reconstruction that allows the creation
of images throughout all phases of the cardiac cycle. Cine GRE
generates images that can be displayed in a movie loop
temporal mode for dynamic views of the heart or vasculature.

NOTE: Cine is an optional software package to continuously
sample data. It is compatible with GRE, SPGR, Fast
SPGR, and Phase Contrast. Cine is not synchronized
with the cardiac cycle.

The CIne Screen is available in the Additional Parameters area
when a Cine pulse sequence is selected.

NOTE: For additional information on Cine, refer to Volume 2.

NOTE: For additional information on Cine Screen parameters,
refer to the chapter, Gating and Triggering, Volume 3.

Multi Phase Screen
The Multi Phase Screen allows the defining of parameters for
imaging of the same slice at different times to provide temporal
resolution. Images acquired with Multi Phase are annotated MP.

Multi Phase Screen is available in the Additional Parameters
area when the Multi Phase Imaging Option is selected with a
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Fast SPGR, Fast TOF GRE, Fast TOF SPGR, EPI, or Smart
Prep sequence.

Clicking the Multi Phase icon gives access to the Multi Phase
options.

Phases Per Location

Phases Per Location indicates the number of phases to be
acquired at one location.

Phase Acquisition Order

Phase Acquisition Order indicates whether the image data is
collected in either sequential or interleaved mode.

• In Sequential mode, the system acquires all images at the
first slice location (pass 1) before moving to the second
(pass 2) location.

• In Interleaved mode, the system acquires the first phase at
each location (pass 1), then goes back and acquires the
second phase at each location (pass 2), and so on.
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Delay After Acquisition

Delay After Acquisition indicates the length of delay after every
acquisition. The system resumes scanning automatically after
the prescribed delay.

Applications for Multi Phase:

• Interleaved: dynamic contrast studies for liver, breast, and
metastatic lesions.

• Sequential: kinematic range of motion studies of the joints
or C-spine.

Something to Think About...

• The (phases÷location)x(number of slices) cannot
exceed 512.

• Delay after acquisition times available are 20 ms to 20
seconds. Locations Before Pause may be selected from
the Acquisition Timing area instead of programming the
delay after acquisition from the Multi Phase screen. If
so, select the minimum delay after acquisition from the
Multi Phase screen.

• Images acquired at a single location with multiple
phases (SSMP) may appear shifted upon display. This
is most noticeable when these images load into a
paging-loop mode.

DWI Screen
Diffusion Weighted Imaging (DWI) Screen in the Additional
Parameters area is available with the optional DW-EPI
package. Diffusion-Weighted Echo Planar Imaging (DW-EPI) is
a single shot EPI pulse sequence designed to create images
that differentiate tissues with restricted diffusion from tissues
with normal diffusion.
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The DWI Screen is available when a DW-EPI pulse sequence is
selected from the pulse sequence window.

NOTE: For additional information on the DW-EPI optional
software package, refer to Volume 2.

Scanning Range
The Scanning Range area is used to select the Field of View
(FOV) covering the anatomy of interest, the slice thickness and
spacing, location of the slices and FOV center, and the number
of slices in the acquisition. The entries can be made explicit or
graphically for the scan locations, FOV center, and slice
number.

Field of View
FOV is the area of the anatomy selected for imaging.

Prescribe FOVs as large as the scanning range.

• For the body coil, choose FOVs from 1 cm to 48 cm, in 1 cm
increments in all planes. The minimum and maximum
alternatives vary, depending upon scan parameters and
system configuration.

• For the head coil, choose FOVs from 1 cm to 28 cm, in 1 cm
increments in all planes. The minimum and maximum
alternatives vary, depending upon scan parameters and
system configuration.
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° EPI sequences in the head coil have a FOV range from 4
cm to 28 cm.

The FOV should be larger than the total number of slices times
the slice thickness for the best spatial resolution. To calculate
the pixel size (spatial resolution) for an acquisition, divide the
FOV in millimeters by the phase or frequency of the acquisition
matrix.

For example, for an 8 cm (or 80 mm) FOV and an
acquisition matrix of 256x384:

80 ÷ 256 = 0.31 mm, 80 ÷ 384 = 0.21 mm

The pixel size is 0.31 x 0.21 mm.

As pixel size decreases, the SNR is reduced because fewer
signal-producing protons are present per pixel. Other
parameters assumed to be equal, SNR is proportional to the
square of the FOV.

For example, halving the FOV from 24 to 12 results in a
signal-to-noise (SNR) reduction of 75%. A 12 cm FOV
image of the orbit is better resolved than a 24 cm FOV
image. However, there is a substantial reduction in SNR
under this scenario.

To compensate for loss of SNR, increase the number of
excitations (NEX), adjust the TR, or slice thickness.
Alternatively, decrease the matrix size or TE to generate more
signal and improve image quality.

Something to Think About...

• When using a 3D acquisition as a localizer, make sure
the FOV of the prescription intersects the localizer. To
avoid FOV restrictions, use a center slice.

• To change FOV size for a graphic prescription, Graphic
Rx must be open.

• The frequency gradient slope determines FOV. As the
FOV decreases, gradient heating and minimum TE
increases. This can lead to a reduction of slices.

Slice Thickness
The Slice Thickness text box is for selecting the thickness of
the slices being prescribed. In general, the thinner the slice, the
better the resolution, and the lower the signal to noise.

• Slice thickness range in millimeters:
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° 2D- 0.9 mm to 20 mm in 0.1 mm increments
(1.5T range is 0.6 to 20 mm)

° 3D- 0.1 mm to 5.0 mm in 0.1 mm increments
° 2D PC slabs- 3 to 99 mm

• Use thin slices of 3 to 4 mm for small structures such as the
pituitary, inner ear, spine, and vessels.

• Use thicker slices for studies of the abdomen, pelvis, and
heart.

Something to Think About...

• The thicker the slice, the more partial voluming and
certain structures may be hidden by overlying tissue.

• SNR is improved with a larger slice thickness.

• To avoid excess low-signal graininess when using thin
slices, increase FOV, NEX, or TE.

• To change slice thickness for a graphically prescribed
series, Graphic Rx must be open.

Spacing
The Spacing text box allows selection of the space between
the slices for everything except 2D and 3D vascular
prescriptions.

The # of Scan Locs text box allows for the number of scan
locations and overlap locations for 3D aquisitions.

• Slice Spacing in millimeters:
° 2D- variable interslice spacing in increments as small as

0.1 mm. The interleave option is available for multi-slice
imaging.

° 3D- 12 cm to 124 cm contiguous slice volume imaging in
increments of 2.

• Overlap Location allows you to select up to 4 overlaps for
3D acquisitions (each overlap = 1 mm).
° Prescribing an overlap allows you to acquire a

continuous series of slices—with no gaps. Remember,
any 3D acquisition has aliased image data on both ends
2292261-100 Rev. 0 (03/01) 3-53



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
of the slab, which is discarded. If this aliased (and
discarded) image data is in the overlap area, the scan
prescription should result in a continuous, no gap, set of
slices.

Choosing spacing allows you to increase the scan range or
image coverage with larger interscan spacing to ensure
complete coverage. Insert small gaps (spacing) between slices,
to reduce cross-talk, typically 20% of the actual slice thickness.
Cross-talk or overlap is caused by partial excitation of adjacent
slices during RF excitation and refocusing by a 180° pulse. This
causes a reduction in image contrast and SNR, as the expected
TR and the effective TR may differ.

The following figure shows the effect slice spacing has on the
excitation time. Note, for example, that excitation of slice #5 at
time t = 0.2 TR also results in partial excitation of slices #4 and
#6, which are excited at time t = 0.6 and t = 0.7 TR.

This difference in TR alters the contrast-to-noise ratio (CNR)
and signal-to-noise ratio (SNR). The effects on short TR/TE
sequences may be lower SNR and possibly, greater T1
contrast, similar to decreasing TR. The overall effect may be
decreased CNR. Decreased SNR tends to offset the increase in
contrast. This usually means that the scan’s CNR has been
decreased, although the cross-talk effect may not be the same
for all slices.

If Interleave is selected or you have two or more acquisitions,
the system acquires data from every other slice during the first
pass, then goes back and acquires data from the rest. For
example, slices 1, 3, 5, 7 first, then slices 2, 4, 6, and 8.
Cross-talk is eliminated with Interleaved acquisitions.

Something to Think About...

• To reduce the effects of interslice cross-talk use:

° Interleave (doubles the scan time)

° Larger interscan spacing
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° 3D technique

° Sequential

• To change spacing for a graphically prescribed series,
Graphic Rx must be open.

Start and End Location

The Start and End location text boxes specify the scanning
range in relation to the landmark in the A-P, L-R, or S-I
directions. Together, start and end determine the area covered
in the scan and can be prescribed explicitly or graphically.

The system acquires the data in the order of the slices
prescribed and automatically calculates the actual end location
and the number of locations. This is based on scan thickness
and the interscan spacing selected. The actual end location is
displayed at the bottom of the Scanning Range area.

Something to Think About...

• Multiple slice thicknesses cannot be prescribed.

• To modify the end location or to add or subtract slices,
enter a different value for the number of locations. The
system automatically updates the actual end location.

• In 3-Plane Localizer acquisitions, start and end locations
are not entered in the text box. Entries here reflect the
FOV center for the axial images.

• Enter the scanning range from L to R, or I to S, or P to A:
“LIP to SAR”- Left, Inferior, Posterior or Superior,
Anterior, Right so that 2D and 3D acquisitions have
images collected in the same direction within the exam.

FOV Center

The FOV Center defines the center of an image. Ideally, this is
located at the magnet’s isocenter. An off-center FOV is a FOV
not centered at isocenter. This is accomplished by typing in
appropriate numbers at the FOV center prompt in the Explicit
Scanning Range area or using Graphic Rx.
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The FOV Center defaults to zero unless otherwise specified.
FOV center offsets can be done in the phase and frequency
directions.

The following table demonstrates the slice select axis and offset
for a defined orthogonal plane.

• S/I offsets bring the anatomy to isocenter by moving the
table. You are prompted to move the table before
prescanning.

• A/P and L/R offsets cannot be larger than 240 mm for body
and surface coil imaging, or 120 mm for head coil imaging.

• In 3-Plane Localizer acquisitions, the FOV Center
determines the center of the FOV for the middle slice of
each plane. For example, if you prescribe three slices per
plane are selected, the second slice of each plane is located
at the FOV Center.

Something to Think About...

• In axials, sagittals, and coronals, two offsets are
allowed. The system accommodates for any offset in the
S/I direction by means of a table movement.

• Multiple groups and offsets in two directions can be
prescribed in orthogonal acquisitions. In oblique
acquisitions, only multiple groups can be prescribed.

• Axial images with a two direction offset prescribed
explicitly results in a tilted image on the screen. Note
that the annotation is correct.

Number of Slices/Slabs

The # of Slices or Slabs text box specifies how many slices
(slabs) are prescribed per acquisition. This text box only
becomes available after the Graphic Rx icon is selected in the
Additional Parameters area. The start and end locations
determine the number of slices (slabs). A value is automatically
entered in this text box if slice thickness, slice spacing, and
start/end locations are specified.

Plane Slice Select Axis Offset

Axial S/I R/L and/or A/P

Coronal A/P R/L and/or S/I

Sagittal R/L A/P and/or S/I
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The number of slices defines a 2D prescription.

The number of slabs defines a 3D prescription.

Up to 64 slabs are permitted and the # of Slabs text box is
visible with the following sequences:

• 3D FSE

• 3D PC

• 3D GRE/SPGR

• 3D Fast GRE/SPGR

• 3D TOF GRE/SPGR

• 3D Fast TOF GRE/SPGR

Something to Think About...

• A limited number of slices can be acquired in a given
scan time. If too many slices are prescribed, the system
automatically increases the number of acquisitions.
Scan time increases accordingly.

Your options are to:

° Accept the longer scan time.

° Increase the TR, shorten the TE, or reduce the SAT
pulses. However, these choices may prevent the
desired tissue contrast.

° Switch from an oblique to an orthogonal plane.

° Enter a smaller scanning range to reduce the
number of slices.

° Increase the FOV.

° Increase the slice thickness or spacing to get the
same coverage with fewer slices.

• In a 3-Plane Localizer acquisition, the number of slices
entry determines how many slices are acquired for each
plane.

° This entry must be an odd number.
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Acquisition Timing

The Acquisition Timing area allows selection of timing
parameters that define scan time, resolution, prescan settings,
and indication for contrast material.

Acquisition Matrix

An Acquisition Matrix is the number of data points collected in
the frequency and phase encoding directions. More data points
result in higher resolution. The matrix selections are frequency
and phase.

• Frequency controls resolution.

° Frequency encoding options are 256 or 512.

• Phase controls scan time and may control resolution.

° Phase encoding options from 128 to 512 in steps of 32.

A matrix can be square or asymmetrical.

• A square matrix means that both phase and frequency
values are equal.

• An asymmetrical matrix means that the phase axis is
smaller than the frequency axis.

Matrix values, FOV, the Square Pixel imaging option, and the
Phase FOV entry determine the size and shape of the pixel,
which in turn determines image resolution.
3-58 2292261-100 Rev. 0 (03/01)



Scan Rx Desktop
This results in the following equation:

For example, a 250 mm FOV and a 192 Phase x 256
Frequency Matrix results in a 1.28 pixel size.

therefore, 1.3 = 0.98 = 1.28 mm pixel.

• When the Square Pixel imaging option is selected, the pixel
shape is always square and its size is determined by the
frequency axis only. An asymmetrical matrix results in a
rectangular FOV shape.

• When the Phase FOV is less than one and a symmetrical
matrix is selected, the pixel shape is square and the FOV
shape is rectangular.

• When Phase FOV is less than one and asymmetrical matrix
values are selected, both the pixel shape and the FOV
shape are rectangular.

FOV
MatrixValue
----------------------------------- PixelValue=

250mm
192Pmatrix
-------------------------------- 1.3= 250mm

256Fmatrix
-------------------------------- 0.98=
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• When Phase FOV is one and an asymmetrical matrix is
selected, the pixel is rectangular and the FOV is square.

Match the size and shape of the matrix, FOV, and Square Pixel,
or Phase FOV options to resolve the anatomy being imaged.

• Select a frequency encoding matrix from the pre-defined list
or enter a value in the text box.

• Select a phase encoding matrix from the pre-defined list or
enter a value between 128 and 512 in increments of 32, in
the text box. The system automatically selects the closest
valid value for each entry.

NOTE: The frequency encoding matrix value cannot be smaller
than the phase encoding matrix, except for EPI
sequences.

Something to Think About...

• A small matrix has a shorter acquisition time but less
resolution. A 256 matrix produces standard resolution.

• A large matrix has more resolution but takes longer to
acquire. A 512 matrix produces high resolution.

• Acquisition matrix selection does not affect the size of
the displayed image. Normally, all images are displayed
in an “auto expand” mode on a 512x512 matrix.

NEX
The Number of Excitations (NEX) is the number of times the
phase encoding steps are repeated in a given acquisition. You
can prescribe up to 150 NEX.

The SNR increases by the square root of the ratio of NEX.

For example, increasing the NEX from 2 to 4 results in a 40%
increase in SNR and a doubling of the scan time.

4
2
--- 1.41=
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NEX is a factor in calculating scan time. Note the following
equation: (TR) x (Phase Steps) x (NEX) = basic 2D scan time

Adjust NEX to change SNR and/or scan time.

Something to Think About...

• Typically, as resolution increases, the NEX value needs
to be increased. An exception to this is 3D imaging.

• Select the NEX value that produces adequate SNR to
make the diagnosis. Too much SNR wastes time, too
little SNR produces undiagnostic images.

Phase FOV

The Phase FOV shortens scan time by scaling down FOV size
in the phase direction. The pulse sequences you prescribe
determines the range and increments you can choose from.
The pre-defined list displays the allowable values and the new
FOV.

Phase FOV can be combined with a symmetrical or
asymmetrical matrix.

• When Phase FOV is 0.5 or 0.75 and a symmetrical matrix is
selected, the pixel shape is square and the FOV shape is
rectangular.

• When Phase FOV is 0.5 or 0.75 and asymmetrical matrix
values are selected, the pixel shape and the FOV shape are
both rectangular.
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The number of phase steps acquired is equal to: (Number of
phase steps programmed) x (Phase FOV), which reduces the
scan time in comparison to a full phase FOV.

For example, a 256 Frequency matrix, a 192 Phase matrix
and a selection of 0.75 Phase FOV, results in the reduced
scan time of: (TR) x (192P) (0.75) x (NEX) = new scan time.

Useful applications for a small Phase FOV:

• Scans with anatomy smaller than the FOV in the phase
direction, such as extremities, spines, axial, and coronal
heads.

• High resolution images in a short scan time when combined
with a symmetrical matrix.

Something to Think About...

• Phase FOV requires more precise placement of
anatomy in the center of the FOV. This is easily
accomplished with FOV center offsets and swing table
positions.

• Phase wraparound occurs if anatomy exists outside the
new, reduced FOV. SAT pulses placed in the phase
direction can reduce the aliasing artifact.

• Phase FOV is not compatible with No Phase Wrap,
POMP, Square Pixel, or NEX greater than one with
Respiratory Compensation.

• SNR is reduced by approximately:

° 14% for 0.75 Phase FOV.

° 30% for 0.5 Phase FOV.

• Decrease the Phase FOV in EPI acquisitions to
decrease geometric distortion and increase spatial
resolution.

• Typically a Phase FOV less than one is not selected on
a sagittal or coronal if phase and frequency are
swapped.
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The following diagram shows how your image is effected when
phase and frequency are swapped.

Number of Acquisitions/Locations Before Pause

Scan pause techniques can be used to pause a scan at
predetermined points for scans with more than two prescribed
slices. This text box name automatically changes depending on
the pulse sequence selected to:

• # of Locs Before Pause

• # of Acqs Before Pause

• # of Reps Before Pause

The # of Locs Before Pause text box indicates the number of
locations to be acquired before pausing the scan.

The # of Acqs Before Pause text box indicates the number of
acquisitions to be acquired before pausing the scan.

The # of Reps Before Pause text box indicates the number of
TRs to be acquired before pausing the scan in FSE sequences.

A. Phase and Frequency swapped with a Phase FOV of 1.
B. Phase and Frequency swapped with a Phase FOV of 0.75.
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This feature is useful for pausing scanning at predetermined
points for breath-hold, joint motion, or contrast perfusion
studies. The “scan time remaining” clock counts down time
before the pause. The [Scan] button must be selected to
resume scanning after each pause.

NOTE: The number of slices must be determined before the
number of locations before pause is available.

Frequency Direction
The Frequency Direction is the scanning direction associated
with the frequency encoding gradient.

The phase and frequency axis determine the vertical and
horizontal axis of the displayed image.

In general, frequency is the long axis of the imaging plane.
Default frequency (F) and phase (P) directions are displayed in
the following figures.

The default frequency direction is automatically entered in the
Freq DIR text box. Swap frequency and phase directions by
changing the entry from the predefined list.
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The following table summarizes the default directions for phase,
frequency, and slice-select based on the coil selection.

For oblique prescriptions, the frequency direction selections in
the Freq DIR text box are Unswap or Swap. Unswap is the
frequency direction displayed prior to prescribing oblique slices.

NOTE: When acquiring a 3-Plane Localizer acquisition, the Freq
DIR text box is not a selectable parameter and does not
follow the default conventions for determining the
frequency direction.

Something to Think About...

• Flow, motion, and other phase artifacts, such as aliasing
or wraparound, are mapped onto the image in the phase
direction. A wise choice of frequency direction can
reroute these artifacts away from the region of interest.
For example, sagittal spines have the frequency
direction in the S/I direction and phase A/P, which routes
motion artifacts through the vetebral bodies and spinal
canal. One solution is to make phase run S/I so that the
flow artifact from the aorta and vena cava runs parallel
to the cord, rather than through it.

Auto Center Frequency

Auto Center Frequency (CF) fine-tunes the system’s RF
transmit/receive frequency to the precessional frequency of the
protons under study.

Coil Plane Frequency Phase Slice Select

Body, Extremity,
Neurovascular,

and Receive Only
Surface Coils

Axial R/L A/P S/I

Sagittal S/I A/P R/L

Coronal S/I R/L A/P

Head Coil Axial A/P or
EPI-R/L

R/L or
EPI-A/P

S/I

Sagittal S/I A/P R/L

Coronal S/I or
EPI-R/L

R/L or
EPI-S/I

A/P
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Four CF options are available:

• Current

° Skips center frequency tuning in prescan and uses the
last center CF values.

° Is used if a scan is stopped and the scan is re-initiated.

° Is not used if scan parameters have changed since last
series.

• Water

° Is the default.

° Centers on water peak as long as a valid fat/water pair is
present.

° Uses maximum peak if it cannot determine a valid
fat/water pair.

° Is the mandatory choice for fat suppression.

• Fat

° Centers on fat protons, assuming a valid fat/water pair is
present.

° Uses maximum peak if it cannot determine a valid
fat/water pair.

° Is the mandatory choice for water suppression.

• Peak
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° Centers on the maximum peak.

Flow Comp Direction

The flow compensation direction allows you to prescribe a
direction to reduce flow artifacts by putting the flowing protons
into phase with the stationary protons. This feature is only
available with FSE acquisitions.

• One direction must be chosen to apply the flow comp
gradient: slice selection or frequency encoding.

° The system suggests a direction based on the scan
plane.

° With sagittal or coronal scan planes, frequency is
the default.

° With an axial scan plane, slice is the default.

° With oblique scan planes, no default is highlighted.

• The flow compensation direction should match the direction
of the flowing protons.

For example, a sagittal spine should have the same
frequency axis as the flow compensation direction, which is
head to foot, the direction of CSF and blood flow.

• Only one direction can be selected.

NOTE: A pre-defined flow compensation direction selection from
a protocol, previous series, or scan takes precedence
over these defaults.

Something to Think About...

• The flow compensation gradient is applied in the
frequency or slice direction only. If phase and frequency
have been swapped, the flow motion runs in the phase
direction of the image and flow comp is then ineffective.
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Autoshim
Autoshim improves image quality by optimizing the X, Y, Z
gradient shim settings, particularly with Chem SAT, Fast, and
chemical-shift imaging.

There are two Autoshim Modes:

• Automatic, which is selected in the Acquisition Timing area.

• Manual, which is selected from the Manual Prescan window
as Grad Shimming.

Autoshim is the system’s default and is included in Prescan.
Autoshim uses the scan prescription parameters to calculate
the optimal shim region. For the ROI, the system scans the
intersection of three orthogonal planes in the following order:
axial, sagittal, and coronal. ROI size depends on coil type and
the FOV.

• The axial plane is always acquired at isocenter.

• The sagittal and coronal planes are acquired from the scan
coordinates of the first and last slices scanned.

• Autoshim generates up to 12 images, two magnitude and
two phase, from each scan plane.

• Nine images are displayed in Manual Mode, three
magnitude, three phase, and three phase-difference
images.

• Shim results can be saved in one of the ten Gradient Shim
files.

• Autoshim sets up the PSD to acquire data from the sagittal
and coronal plane. For display, the analysis program
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calculates both the linear and quadratic coefficients for shim
correction.

Select Autoshim for the following applications:

• First series for each new exam or area of anatomy.

• Chem SAT acquisition.

• Fat/Water suppression prescriptions.

• When using the imaging option Classic.

Something to Think About...

• No Current CF option appears, unless Autoshim is
deselected.

• If Autoshim fails, prescan continues. You can still
proceed with the scan. An error message is posted to
the Advisory Panel.

Phase Correct
Phase Correct is an option for FSE, FMPIR, and EPI pulse
sequences. It obtains additional data prior to image acquisition
and is used to correct for phase shifts.

Phase Correct compensates for undesired phase shifts due to
eddy currents and RF misalignment. This is more noticeable on
FSE scans because FSE combines data from many echoes
acquired at different times to form a single image. Phase errors
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between acquired echoes lead to ghosting and/or signal loss.
Phase Correct compensates for these phase errors by means
of RF phase shifts and gradient amplitude calibration.

• In EPI, Phase Correct performs a reference scan following a
successful prescan.

• Phase Correct is not annotated on the images.

• Select Phase Correct for the following applications:

° Off-Center FOV with FSEs that exhibit blurring.

° Peripheral signal artifacts on sagittal FSE spines when
using phased array coils.

° Echo Planar Imaging.

Something to Think About...

• When using Phase Correct, scanning starts
approximately four seconds after selecting the [Scan]
button due to the additional data acquisition and
calculations of correction values.

• Phase Correct cannot be used with the number of
locations before pause in the Acquisition Timing area.

Contrast

The Contrast selection provides a place to enter a contrast
agent and amount for the current and all subsequent series.

If Autoscan is On and Contrast is selected, the first series in the
Rx Manager containing contrast is not started until the contrast
injection message box appears and you select the [OK] button.
Autoscan must be reselected to restart auto scanning mode.

The contrast injection message does not appear again on this
exam for subsequent +C series. An exception to this occurs
when there is a series prescribed with contrast followed by a
series prescribed without contrast, then another series with
contrast. The contrast injection message appears again
following the no contrast series.
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Rx Manager
The Rx Manager is used to create, view or edit, and prepare a
series to be scanned. A series list is created in the Rx Manager
upon selection of a protocol. Additionally, gating controls for the
waveform display are accessed from Gating Control window
and Auto Archive and Auto Transfer features from Scan Modes.

The Rx Manager is located on the left side of the screen on the
Scan Rx Desktop.
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The following table describes the functions of the Rx Manager
control buttons.

Applications of the Rx Manger:

• Reduce scan prescription time by using predefined patient
protocols.

• Use the time-saving benefits of multiple prescribe ahead
series concurrent with scanning.

• Adjust the gating controls for displayed waveforms on the
PC monitor.

Scan Modes
Scan Modes sets Auto Archive and Auto Transfer functions, as
well as, the system operation mode (Clinical or Research).

Selection Description

[Scan Modes] Sets Auto Archive, Auto Transfer, and system
operation mode.

[Gating
Control]

Controls the waveform display.

[New Series] Adds a blank series to Rx manager.

[End Exam] Ends the current exam and returns the desktop to
the Patient Register.

[View Edit] Allows modification of parameters.

[Prepare to
Scan]

Activates Scan Operations area with parameters of
highlighted series.

[Save Rx as
Protocol]

Saves a Rx to the Site Protocol list with a
user-defined name.

[AutoScan] All series in RXD state in the Rx Manager are
automatically scanned.

[AutoStep] Automatically scans data acquisitions containing
different stations with MultiStep option.
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The Scan Modes window appears when clicking the [Scan
Modes] button in the Rx Manager.

Mode

Mode selects the operation mode of the system; Clinical or
Research.

• Clinical mode is the normal operation mode for most
systems.

° Clinical mode is the only selection available unless there
is an agreement between the site and GE Medical
Systems to enable the Research mode.

• To use Research mode, a special agreement with GE
Medical Systems is required. Research mode allows the
user to monitor SAR levels and to log CV (control variable)
errors during pulse sequence operation.

Auto Archive

Auto Archive automatically saves exams to the Magnetic
Optical Disk (MOD) as they are completed; that is, when the
[End Exam] button has been selected.

Auto Archive is functional only when the selected archive
device is a local device. The Auto Archive feature state is
maintained after a system reboot.
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Auto Transfer by Exam

Auto Transfer by Exam automatically sends the entire exam
from the operator’s console to a single remote host upon
completion of an exam for review, image manipulation, or
storage.

A remote host is any workstation (other than the one you are
working on), that is in the network.

Auto Transfer by Exam can be used simultaneously with Auto
Transfer by Series. You must turn Auto Transfer by Exam on
and specify a remote host through the Auto Transfer Node List
window.

This feature must be activated and a host must be defined
before you select the [End Exam] button. The exam is not sent
unless you select the [End Exam] button first.

Auto Transfer by Series

Auto Transfer by Series automatically sends images from the
operator’s console to as many as three remote hosts for review,
image manipulation, or storage.

Auto Transfer by Series can be used simultaneously with Auto
Transfer by Exam. The feature can be enabled or disabled as
needed. A remote host, or hosts, must be specified through the
Auto Transfer by Series Node List window. The entire series is
transferred upon successful completion of the scan. If another
scan is completed without selecting New Series, the additional
images within the series transfer automatically when scanning
is complete.
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Up to three remote hosts can be specified for transfer by series.
These hosts can be prioritized to specify in which order the
hosts receive the images. Priority is specified by entering any
number from 1 (highest) to 3 (lowest) in the Priority text box on
the Auto Transfer Node List. A blank text box is considered the
lowest priority. Equal priority can be given to remote hosts. The
order in which the images are sent is at the discretion of the
system. Once a priority number has been entered for a host, the
text box holds that number until it has been deleted or changed.

Something to Think About...

• For image transfer to take place, Auto Transfer by
Series must be fully enabled before the scan process
has completed.

• Auto Transfer functions cannot be saved as part of a
pre-defined protocol.

• Remote hosts are configured through Network and
hosts cannot be added or deleted from the Auto
Transfer Node List pop-up in Scan Modes.

• Auto Transfer by Series remains on until it is turned off
or until a reboot is performed.

Gating Control

The Gating Control window is used to set the cardiac and respi-
ratory waveform display and functions.

There are two components to viewing a waveform:

• The Gating Control window which is used to set the
waveform options. The Waveform Display is for display
2292261-100 Rev. 0 (03/01) 3-75



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
purposes only and does not affect a scan in progress if it is
turned ON or OFF.

• The PC Monitor that is used to display the waveforms.

WARNING:Do not use Gating Waveforms for physiological
monitoring. The patient’s condition may not be
reflected, resulting in improper emergency treatment.

The Gating Control window appears when the [Gating Control]
button is selected in the Rx Manager.
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The following table describes the functions of the Gating
Control selections.

NOTE: For detailed information on the Gating Control window,
refer to the chapter Gating and Triggering, Volume 3.

New Series
New Series adds additional series to a patient’s exam. It is
tracked in the Rx Manager list and begins at the Patient
Position area. Select this button to add an additional series to
the Rx Manager.

Selecting a New Series in the Rx Manager is only available with
GE or Site protocols. New Series is not available after selecting
Picture This protocols.

This following diagram is an overview of the scan process for
New Patient or New Series. Several windows are found in the
Patient Position and Imaging Parameters areas. The selections

Selection Description

Waveform Display Selects the display state for the cardiac waveform,
respiratory waveform, or histogram on PC Monitor.

ECG Noise Filter Moves the ECG gradient noise filter cut-off
frequency down for improved cardiac filtering.

Cardiac Sweep
Rate

Selects a sweep rate, at the speed at which the
cardiac waveform displays.

[Gating Reset] A reinitialize command is issued to the PAC to
resets the gating control information.

Lead Display Selects the ECG lead or PG for trigger. If Auto lead
is selected, the PAC indicates the actual lead used.

Cardiac Trigger
Level

Adjusts the level or threshold the system uses to
“look” for triggers.

Cardiac Trigger
Level Annotation

Controls the horizontal annotation marks on the
waveform display.

[Update] R-Peak
Amp

Updates the measured amplitude in millivolts (mV)
of the displayed cardiac lead in peak signal.

Audio Trigger
Volume

Adjusts the audio level of the trigger. Moving to the
right increases volume.
2292261-100 Rev. 0 (03/01) 3-77



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
made at the Pulse Sequence and Imaging Options windows
subsequently affect which windows and choices are available
for Scan Timing and Additional Parameter areas.

Something to Think About...

• A series cannot be scanned unless the [Save Series]
button is used. Saving the series changes its status from
INRX (in prescription) and places it in the prescribed or
RXD state in the Rx Manager.

• The system automatically downloads the first series
and, therefore, selecting the [Prepare to Scan] button is
not required.

End Exam

End Exam completes the current exam. It separates patient
exams or anatomical regions for one patient.

Completing an exam with this key:

• Changes the status of the exam from current to completed.
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• Closes the scan screens and displays the Patient Register
window.

• Makes New Patient selection available for the next patient
or anatomy to be scanned.

• Makes the exam number available for archiving

• Removes the current images from the Autoview Window
memory buffer.

Something to Think About...

• Once you select the [End Exam] button, no more
images can be added to the exam number.

• You must select the [End Exam] button before Auto
Store can save the exam’s images to the MOD.

Rx Manager List

The Rx Manager List shows the prescribed series state and
series description. All scan information can be recalled by
selecting and copying a series. This allows you to repeat a
series exactly, without entering any information.

Each series in the Rx Manager list contains three pieces of
information:

• The current state.

° SCND indicates the series has been scanned and is
complete.

° ACT indicates the series is active and in the process of
being scanned or ready to scan.
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° RXD indicates the series is prescribed, once a
successful download has occurred, and it is waiting to be
scanned.

° INRX indicates the series is currently in prescription and
is being processed, or it is being viewed in the
prescription area.

° NEW indicates nothing has been done to the series or is
only partially prescribed.

• The series number. A series number is not assigned until
the scan is initiated.

• The series description.

For example, a typical series of entries in the Rx Manager List
might include:

SCND 1. Sagittal T1 Loc

This indicates the series has been scanned, was the first
series, can be used as a localizer, and remains in the list for
easy access to the scan values.

ACT 2. Axial T2

This indicates that this scan was the second series and is
currently being scanned or it is ready to scan.

RXD 3. Axial T1 Pre

This indicates that this scan is the third series and is ready
for downloading.

INRX 4. Coronal T1 Pre

This indicates that the scan is the fourth series and has not
been saved, it is being view/edited.

NEW 5. Sagittal T1 Pre

This indicates that the scan is the fifth series and has not
been saved, nor is it being view/edited.

Something to Think About...

• Select the entries in the Rx Manager list in any order.

• The series highlighted in the Rx Manager is not
necessarily the series being viewed on the desktop. The
series in the INRX state is the series on the desktop.

• If a series on the desktop in the INRX state is not saved
and the [Scan] button is selected, the system does not
scan this series (the one on the desktop) but repeats the
series previously scanned or the one in the ACT state.

• Series from different protocols can be added to the list.
For example, if the current patient exam is a thoracic
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and lumbar spine study, the list can be arranged to have
both exams ready to scan. Keep the landmark and
orientation the same for each scan.

• The Rx Manager list is created when a protocol is
selected. Select any series in the list and prescribe slice
locations, change the stored protocol values, and save
the protocol to the Rx Manager. The process can be
repeated for as many series as needed.

View Edit

View Edit allows you to review or edit a series in the Rx
Manager. It can also be used to adjust a scan range after
viewing the most recent acquisition.

The View Edit selection in the Rx Manager provides access to
the scan parameters.

Scan Rx Desktop
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The series can then be modified and saved again. A new series
in the Rx Manager list changes to INRX if a view edit is
performed.

Something to Think About...

• If you view or edit another series before a save series is
initiated for the current series (INRX), changes for the
current series (INRX) are saved and the INRX series is
relisted in the Rx Manager as NEW.

• You can view but not edit a series that has a status of
ACT (active) or SCND (scanned), even though the
status of the series changes to INRX.

Prepare to Scan
Prepare to Scan changes the status of a series from prescribed
(RXD) to active (ACT) or ready to be scanned.

The system automatically moves the first series in the Rx
Manager list to active status.

Something to Think About...

• Prepare to Scan is not needed if the [AutoScan] button
is selected.

• Prepare to Scan is not needed for the first series of an
exam.

• Prepare to Scan is required to download series on an
individual basis.

• The series highlighted in the Rx Manager is the series
prepared. Note that the series represented on the Scan
Rx Desktop is not necessarily the series highlighted in
the Rx Manager.

Save Rx as Protocol
Save Rx as Protocol is used to save the current prescription as
a site protocol. You must define the protocol name. This allows
you to build predefined site protocols to reduce prescription
set-up time and increase productivity.
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When the [Save Rx as Protocol] button is selected, the entire
series list in the Rx Manager is saved as a protocol in the site
protocol list.

Auto Scan

Auto Scan automatically downloads, prescans, and scans all
RXD series in the Rx Manager. This feature extends the
multi-tasking capabilities by allowing you to prescribe multiple
scans in advance.

The next RXD series in the list begins automatically when the
[Auto Scan] button is selected. All RXD series in the Rx
Manager list are scanned sequentially.

Something to Think About...

• Auto Scan turns OFF if:

° A table move is required (Move to Scan).

° Move to scan is not activated after two audio alarms
and scan times out.

° A contrast series is in the queue following a
non-contrast series.

° A new landmark is selected.

° New Patient or a patient from Patient Register list is
selected.

• The following describes the behavior of
contrast-enhanced series when Auto Scan is active:

° AutoScan is on and there are no series in the Rx
Manager in the RXD state.

° When the first series containing contrast On is ready
to scan, the contrast injection message appears.
You must select the [OK] button to proceed.

° The contrast message does not appear again in this
exam for subsequent contrast-enhanced series. An
exception to this occurs when there is a series
prescribed with contrast followed by a series
prescribed without contrast, then another series with
contrast selected on. The contrast injection
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message appears again following the no contrast
series.

• If Auto Scan is turned on and there is no series in the Rx
Manager in the RXD state but a series in a SCND or
ACT state has been copied, the system
AUTOMATICALLY changes its status to RXD. The
system scans this series before there is a chance to edit
the copied series.

AutoStep

AutoStep provides automatic table movement and scan
initialization for data acquisitions containing more than one
station, until all stations are acquired. It is available with the
MultiStep imaging option in the SmartStep software purchase
option.

AutoStep is available with a SmartStep meta-series. All
prescribed stations in the meta-series must be saved and
prescanned before selecting AutoStep to initiate the acquisition.

NOTE: For additional information on the SmartStep meta-series
using AutoStep, refer to the chapter Bolus Chasing with
SmartStep, Volume 3.

NOTE: SmartStep is a purchase option on Signa MR systems
running 8.3 or above software.

Series Control and Advisory Panel

Series Control area allows prescribed acquisitions to be saved,
parameters to be reset to their original values, and the relative
SNR% to be monitored. This area also contains an Advisory
Panel to provide information about scan time, the number of
acquisitions, the maximum number of slices per acquisition,
estimated and peak SAR, real time imaging frame rate
notification, and posts messages during the prescription
process.
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Save Series

The Save Series selection accepts the parameters and places
the series in the RXD State in the Rx Manager.

A landmark must be established and all parameters must be
completed for Save Series to be valid. The first series is
automatically downloaded to scan when the [Save Series]
button is selected.

Something to Think About...

• Once Save Series is initiated for the first series, patient
information can no longer be updated.

Reset Values

The Reset Values selection resets parameters to their original
values before any modifications were made.

Relative SNR%

The Relative SNR% meter reflects changes to parameters
within a protocol that impact signal to noise.

The parameters used to calculate changes in SNR are:

• Fractional or full TE

• Receiver bandwidth

• FOV

• Slice thickness

• Frequency matrix

• Phase matrix

• NEX

• Phase FOV

• Square pixel

• 3D number of locations per slab
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The relative SNR% is not an absolute value but a relative value
based on the current set of parameters being equal to 100%.
Changes made to parameters that affect SNR are calculated
and relative SNR% is updated to indicate their impact on SNR.
The relative SNR% for a protocol can be reset to 100% using
the Reset SNR selection.

Something to Think About...

• Changes for SNR are not calculated for changes in TR
or TE. Significant changes in TR and TE can change the
SNR for an acquisition.

• The calculation does not include changes for TR, PSD,
or coil selected.

• For a variable SE sequence, a relative SNR% is given
for TE and TE2.

SAR Level

Specific Absorbtion Rate (SAR) refers to the RF power
absorbed per unit of mass of an object (Watts/kg).

• The SAR limits are not exceeded when the patient’s correct
weight is entered on the Patient Information area.

• If the head coil is in use, the estimated average head SAR
shall be displayed along with the estimated average and
peak SAR values.

• SAR levels for the patients are based on current scientific
literature related to safety. The level of exposure shall be a
medical judgment as to the patient’s potential risk versus
benefit.

Frames per Second Notification

Frames per Second (FPS) notifications are displayed during
Real Time Imaging acquisitions. FPS is dependent on the
system hardware configuration. The FPS rate for the prescribed
series appears prior to the beginning of the scan.

NOTE: For Real Time Interactive Imaging frame rates refer to the
chapter Imaging Real-time with iDrive, Volume 3.
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Scan Operations
Scan Operations area displays the dB/dt level, provides
prescan options to improve image quality, and allows you to
start the scan prescription.

STL% or dB/dt Level
The STL% or dB/dt level displays the value your site’s
governing board (Investigational Review Board) has approved
for scanning limits.

• DB/dt refers to the rate of change in magnetic field to time
which is expressed in Tesla/seconds.

• STL is an abbreviation for Stimulated Threshold Limit and
the dB/dt is expressed in T/s. Your service representative
sets the units in T/s or STL%.

• The Signa system is capable of operating under several
modes: normal, first level controlled operating mode
(research mode), and second level controlled operating
mode (proprietary license agreement with GE).

• The screen appearance changes based on the operating
mode (clinical vs research), the governing regulator (IEC vs
FDA), and the pulse sequence (non-EPI or EPI).

NOTE: STL% values appear on systems outside the US.
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The following table shows messages that appear during certain
scanning situations with non-EPI and EPI pulse sequences.

Prescan
The Prescan procedure optimizes performance and improves
image quality.

Prescan accomplishes this by:

• Providing shim consistency through the Autoshim Program.

• Fine-tuning the system for optimal sampling of the individual
patient’s anatomy through the Center Frequency Program.

Mode/Governing
Board

Scan
Type

Imaging Parameter Area Message

Non-Research
IEC Hi Speed
Echo Speed

Non-
EPI

Accept>20 T/s [On]/[Off]
Selecting [On] means you might exceed 20 T/s
and it produces the following message,
“Attention, possible patient peripheral nerve
stimulation”. You must select [OK] to proceed.
[Off] allows you to use the default value set by
site’s governing board.

Research IEC or
FDA HiSpeed
Echo Speed

EPI 1. The STL% or T/s can be changed by
entering a value between the default and a
maximum value allowed. If the value exceeds
the default value the following message
appears, “Do you accept responsibility for
operation up to [STL]% of peripheral nerve
stimulation threshold limit?” If your site does
not have an STL% display but rather a T/s
display, the message is, “Do you accept
responsibility for operation up to [ ] T/s?”
Select [Accept] to proceed with protocol
prescription, or select the [Reject] key and
enter a value less than or equal to the default
value your governing board has approved. Note
that the system never allows a protocol to
exceed the maximum level set by your
governing board.

2. If you enter a value that exceeds your
governing board’s maximum value, the
following message appears, “Valid range is 1
to xx STL%” or “Valid range is 1 to xx T/s
[OK]”. The xx STL% or xx T/s is the maximum
value allowed by your governing board. You
must select the [OK] button to proceed.
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• Adjusting the RF transmit gain to ensure precise flip angles.

• Adjusting the RF receive gain to optimize the use of the
receiver’s dynamic range.

There are two Prescan Programs: Auto and Manual.

• Auto Prescan automatically adjusts and sets Center
Frequency, Transmit and Receive Gain.

• Manual Prescan requires that you set the Center
Frequency, Transmit, and Receive Gains.

NOTE: For detailed information on prescanning, refer to the
chapter Optimizing Image Quality with Prescanning,
Volume 1.

Prep Scan

Prep Scan can be used to eliminate the lapse in time between
the moment you select the [Scan] button and the moment the
system begins scanning. It is useful for breath-hold
examinations. Prep Scan can be selected after Auto or Manual
Prescan and before Scan.

Scan

Scan initiates the acquisition and begins to scan the prescribed
series.

When selected first, scan automatically adjusts and sets Center
Frequency, Transmit and Receive gain then begins scan. Scan
can also be selected after a successful Auto or Manual
prescan.
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Reference Scan
Reference Scan initiates collection of “phase correction” data
for EPI acquisitions. Needed when performing a Manual
Prescan.

Reference Scan is included automatically when the [Auto
Prescan] or the [Scan] button is selected.

NOTE: Reference Scan only appears with EPI acquisitions.

NOTE: Scan Operation keys (Scan, Manual Prescan, Auto
Prescan, Prep Scan, Reset Values, and Save Series) can
be activated by placing the cursor over the key and
pressing the space bar.
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Where Am I?
Volume 1

Chapter 4

Gradient, Shim,
and Imaging Coils

Introduction
This chapter gives you a brief overview of the function of the
gradient and shim coils. This chapter also explains the function and
use of RF and imaging coils. The guidelines in this chapter help you
to select the appropriate coil for common exams. This chapter
contains the step-by-step instructions to help you learn how to:

• Position in the Head Coil

• Position in the Body Coil

• Position a Surface Phased Array Coil
4-1
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In addition, this chapter answers the following questions:

1. What is the purpose of RF, surface and phased array coils?

2. How do surface and phased array coils affect FOV and
depth penetration?

3. How do I select the appropriate coil?

4. What is the function of the gradient coils?

5. What is the function of the shim coils?

6. How do I position a patient in the head coil?

7. How do I position a patient in the body coil?

8. How do I position a patient using a surface or phased array
coil?

9. What is a phased array coil?

10. How do I perform the head coil quality assurance test?
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About... Gradient, Shim,
and Imaging Coils
This section presents the concepts necessary to successfully
complete the coil selection and patient positioning process.
Specifically, you need to understand:

• Gradient and Shim Coil Function
° Gradient Coils
° Shim Coils

• Imaging Coil Function and Classification
° Head Coil
° Body Coil
° Surface and Phased Array Coils

• Coil Sensitivity Range
° Adaptive Phased Array

• Performing Coil QA
° Performing Head Coil QA
° Performing QA for Other Coils

Gradient and Shim Coil Function

Gradient Coils
The gradient coils are three sets of wire coils wrapped around a
fiberglass cylinder located within the magnet housing. Electric
current flows through these gradient coils and is turned on and
off very rapidly, thereby producing expansion and contraction of
the gradient coils. This expansion and contraction creates the
tapping sound when scanning.

The electric current flowing through these coils produces
another magnetic field. Because the current is turned on and off
in a specified manner, this magnetic field varies and is called a
time-varying magnetic field. The MR image is the
representation of a slice of anatomy that has been divided into
cubes or voxels. These time-varying magnetic fields create
controlled and graded variations in the static magnetic field;
thus affecting nuclear precessional frequency in any given voxel
of anatomy and allowing for spatial detection of signal within a
slice. Knowing how much the magnetic field has been graded or
altered at any given point in a slice, the system can determine
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where each voxel is located by reading the precessional
frequency of the signal within that voxel.

An MRI system uses three gradient coils. Each coil affects a
different plane, the XY, YZ, or XZ plane, as it is turned on and
off at different points in a pulse sequence. The scan plane and
pulse sequence selected determines which gradient functions
as the slice selective, phase encoding and frequency encoding
gradient. The system calculates this automatically.

Consider the Z axis gradient, which is created by enclosing two
coils, one on the top of the bore, the other on the bottom of the
bore. If current is passed through the coil at the top of the bore,
then magnetic field lines are created along the +Z axis. Then,
by passing current in the opposite direction through the wire at
the bottom of the bore, a similar but opposite field is created
along the -Z axis. The net effect is offset at the middle of the two
coils (isocenter), resulting in zero change to the static magnetic
field at isocenter. The X and Y gradients are also located on the
top and the bottom of the bore and use a similar method to
localize signal in these planes.

The gradients are resistive magnets and are water cooled by
the gradient chiller located in the computer room.

• 1 - Body Coil

• 2 - Gradient Coil

11 2 2
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Shim Coils
Shim coils are used to compensate for inhomogeneities and
imperfections in the main magnetic field caused by
environmental factors that cannot be controlled or eliminated.
Your MR system shim coils are made of niobium-titanium
(NbTi). These coils can be either superconducting or resistive
coils. Current runs through the shim coils creating magnetic
fields that alter the main magnetic field, and thereby
compensates for inhomgeneities.

The presence of magnetic field inhomogeneities decreases
system performance. This is particularly noticeable when
imaging with Fat Saturation. When scanning with Fat Sat, be
sure to select Autoshim on; this allows the system to
automatically calculate the optimal shim values during Prescan.
The initial shim values are adjusted during scanner installation
and are checked and re-adjusted as necessary as part of
preventive maintenance.

NOTE: For additional information regarding Autoshim, refer to
the chapter Scan Rx Desktop.

Imaging Coil Function and Classification
The head coil, body coil, surface, and phased array coils are RF
coils that consist of loops of copper wire that transmit and/or
receive the RF signal. The coils are used to transmit matching
radio frequencies to resonate with nuclei in the anatomy of
interest. The RF coil then acts as a receiver of the signal
emitted by the nuclei upon cessation of the RF transmission.
The received signal is the raw data used to create an image.
Generally, the head and body coils give a uniform depth of
signal. Surface coils are specialized coils used in imaging
limited areas and with limited depth penetration. Phased array
coils are two or more, closely coupled surface coils that receive
signal over an area.

Imaging coils are tuned to match the precessional frequency of
nuclei under evaluation.

Magnet Field Strength Hydrogen Proton
Precessional Frequency

1.0T 42.6MHz

1.5T 63.9MHz
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Head Coil
The head coil is a one piece bird cage design device that
transmits and receives RF signals. It provides higher Signal to
Noise Ratio (SNR) than the body coil because it is smaller. The
head coil is primarily used to image the head, although it can be
used for imaging any body part that fits into the coil. The head
coil is an example of a volume (uniform depth of signal) coil. A
mirror gives the patient a greater sense of openness.

WARNING:Do not let the patient’s skin touch the head coil. Place
sponges or cloth between the head coil and the
patient.

The head coil is plugged into the top outlet of the trolley (1).

1

2
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Body Coil
The body coil (arrow in picture) is located within the magnet
enclosure and is invisible to you and the patient. The body coil
is a transmit and receive coil which excites nuclei and collects
signals from them as they relax. It transmits the RF pulses that
excite and rephase the protons, and receives the signals
created by these protons. The body coil can also act as a
transmit only coil when used with receive only coils. The body
coil is a volume coil and is used for large FOV (Field of View)
imaging and for uniform depth penetration.

Surface and Phased Array Coils
Surface and phased array coils are used to increase SNR when
imaging a limited area of the body. Flat surface and phased
array coils do not have uniform depth penetration. Phased array
coils are a number of coils combined together to increase SNR,
and depending on the coil design, may increase available FOV
(either length or depth) without decreasing SNR. An example of
a surface coil would be a 3 inch coil; an example of a phased
array coil would be the Torso array coil. The maximum number
of coils of a phased array that can be turned on at one time is
four. For those who have the phased array option, the phased
array coils are plugged into the bottom outlet of the doghouse.

1

2
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• 1 - The plug-in port for head or surface coils.

• 2 - The plug-in port for phased array coils.

WARNING:Some coils are transmit and receive coils. Be sure
that the proper coil is selected (at the operator’s
console) before scanning the patient. DO NOT SCAN
TRANSMIT AND RECEIVE COILS WITH THE
BODY COIL. Making a coil selection that does not
match the actual coil used may result in severe
damage to the coil and possible patient warming. See
the individual coil manuals for specific cautions and
warnings.

Coil Sensitivity Range
Generally, the length of a coil is equal to the FOV the coil
covers; the depth of penetration is half the width of the coil.
When selecting a coil, keep in mind the FOV you need, how
deep you need to image, and the size of the patient. Phased
array and surface coils give you better SNR, but this is only
over a localized area. Also, phased array and surface coils
need to be placed close to the area of the body you are
imaging. It is best to choose the smallest coil possible to get the
optimum SNR.

The following are some examples of different types of coils:

• Volume Coils
° Head Coil
° Body Coil

• Surface and Phased Array Coils
° Wrist Coil
° Shoulder coil
° General Purpose (GP) Flex Coil
° 3 Inch Round Coil

Adaptive Phased Array
Sometimes one or more elements of a multicoil array extend
physically beyond the selected FOV. These outlying coil
elements are often better at receiving unwanted tissue signals
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from outside than desired signals from inside the selected FOV.
Signals from outside the FOV are often poorly controlled in the
imaging process which can lead to ghosting in the phase
encode direction. These ghosts, which can run across the entire
phase encoding dimension of the offending receiver’s image,
often lie on the anatomy of interest.

The original version of Adaptive Phased Array (APA), known as
N-coil, reconstruction solved this problem by identifying the
ghosting receivers beforehand and hardcoding these receivers
in the coil configuration file. Since the ghosting depends on
FOV and receiver position, N-Coil reconstruction failed to
identify the ghosting receivers in the run time.

By calculating the mean for each intermediate image, the new
version of APA identifies the right receiver’s images that contain
ghosting and rejects them from the final combined image. APA
achieves this by selecting the maximum mean of the signal
from each coil and calculates the threshold of each image. Only
the intermediate images that are above the threshold are
combined to form the final image.

You can enable the APA feature by selecting the User Control
Variable (CV) Auto N-Coil from the User CV screen in the
Additional Parameters area of the Scan Rx Desktop.

This feature is only available with Fast Spin Echo (FSE) pulse
sequences.
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The following table summarizes the User CVs available for
Auto-N coil.

Performing Coil QA

Performing Head Coil QA
You should perform a head coil Quality Assurance test (QA)
every day. When the head coil is working normally, a QA scan
produces a normal image showing no holes, distortions or other
artifacts. If there are artifacts in the visual image, contact the
service engineer and do not use the head coil for patient
studies.

When performing the head coil QA test use the protocol in the
table below:

User Control Variables

Auto N-Coil Off = 0 Select 0 if you do not want
to use the Adaptive
Phased Array option.

Auto = 1 The system uses the
selected FOV to identify
which receivers to use
during reconstruction.

2 Receivers = 2 The system chooses two
receivers with the highest
signal intensity to use dur-
ing reconstruction.

3 Receivers = 3 The system chooses three
receivers with the highest
signal to use during recon-
struction.

4 Receivers = 4 The system reconstructs
the images using all four
receivers.

Patient Entry Position Landmark Coil Scan Plane Mode

Head First Supine Other Head Axial 2D
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NOTE: For additional information on performing the daily QA,
refer to the chapter Getting Started.

Performing QA for Other Coils
Refer to the individual coil manuals for more detailed
information and the QA for that coil.

PSD Imaging Options TE TR FOV Slice Thickness

SE None 25 300 24 3

Spacing Start End Acq. Matrix NEX Auto CF

1.5 0 0 256x256 2 Peak
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How to Select Coils and
Position the Patient
This section provides the step-by-step instructions for selecting
coils and positioning patients. Specifically, it describes how to:

• Position the Patient
° Head Coil
° Body Coil
° Surface and Phased Array Coils
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Choosing a Coil and Positioning Your

Patient

Position the Patient

Head Coil
The head coil is a bird cage design transmit and receive,
volume coil. Use the head coil whenever imaging the head. The
head coil can be used for any body part that fits into the head
coil, but remember to place sponges so that the patient’s skin
does not touch the coil.

1. Unplug and remove all other coils from the magnet bore.

WARNING:Be sure that the proper coil is selected (on the
operator’s console) before scanning with the head
coil. Do not scan using the head coil when the body
coil selected on the operator’s console. This could
result in damage to the coil and possible patient
warming.

2. Place the cage portion of the head coil on the trolley.

3. Place the base of the head coil assembly on the cradle and
align with the table notches.

4. Lock the base.

• Turn the knob clockwise until tightened.

5. Place a sponge in the coil base and cover with a sanitary
liner.

6. Instruct the patient that during the scan it be quite noisy, and
give the patient ear plugs.

• If available, headphones may be substituted for ear
plugs.

7. Give the patient the Patient Alert bulb and instruct the
patient how to use it.

8. Have the patient lie supine with head in the cradle.

• Shoulders should rest against the head cradle.

9. Use sponges to make the patient comfortable.

° Usually, placing an angled sponge under the
patient’s knees helps to take pressure off his/her
back.

In Brief: Head Coil

1. Unplug and remove all
coils from the magnet.

2. Place the cage of the
head coil on the trolley.

3. Place base of coil on
table and align notches.

4. Lock the base.

5. Place a sponge in the coil
base and cover with a
sanitary liner.

6. Give the patient ear
plugs.

7. Give the patient the
Patient Alert bulb.

8. Have patient lie supine
with head in the cradle.

9. Use sponges to make the
patient comfortable.

10. Use straps to immobilize
the patient’s head.

11. Instruct the patient close
eyes.

12. Press [Align Light].

13. Press [In Slow].

14. Align cross of the align
light with the glabella.

15. Press [Landmark].

16. Slide cage part of coil
over patient’s head.

17. Plug in the head coil.

18. Press [Move to Scan].
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10. Use straps to immobilize the patient’s head.

• Security straps across the arms, abdomen, or legs
provide patient safety and help control patient motion.

11. Instruct the patient close his/her eyes.

WARNING:Instruct the patient to close eyes before turning on
the alignment light. The eyes must be protected from
laser radiation. The patient needs to be instructed to
close his/her eyes when landmarking and the laser
light is turned on. Exposing eyes to the laser
alignment lights may result in eye injury.

12. Press [Align Light].

13. Press [In Slow].

• Moves table in slowly.

14. Align cross of the align light with the glabella.

15. Press [Landmark].

• Communicates the region of interest center to the
system.

• Automatically turns off the alignment light.

CAUTION:Do not leave the laser light on after you position the
patient.

16. Slide the cage portion of the head coil over patient’s head.

• Slide it as far as possible, covering the entire head.

17. Plug in the head coil.

• Make sure the cables are NOT twisted or looped.

• The coil must be for this particular system.

° Coils from other MR systems (including coils from
other GE MR systems) must NOT be used.
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WARNING:To prevent patient burns, use only coils with this label
near the connector:

CAUTION:If there is any visible damage to the coil or cables DO
NOT USE. Notify the service engineer.

18. Press [Move to scan].

• Moves the patient to isocenter (center of magnet).

The following figure shows a patient positioned in the head coil.
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Position the Patient

Body Coil
The body coil is a volume coil. Use the body coil whenever you
need to use a large FOV and/or need uniform depth
penetration. Examples are abdomen imaging and cardiac or
chest imaging. Unplug and remove all other coils from the
magnet bore.

1. Unplug and remove all other coils from the magnet bore.

• The body coil is built inside the magnet housing, so no
coils need to be placed on the cradle.

2. Instruct the patient to lie supine on the table either head first
or feet first.

• Feet first is preferred, due to fewer problems with
claustrophobia.

• If possible, try to position the patient’s arms away from
the area of interest. When imaging the abdomen or
chest you may want to bring the patient’s arms above
his/her head (if the patient can tolerate it).

3. Place sponges to make the patient comfortable.

• Usually, placing an angled sponge under the patient’s
knees helps to take pressure off his/her back.

• Place thermal pads where the patient touches the bore
to help prevent warming.

4. Use straps to immobilize the patient.

• Security straps across the arms, abdomen, or legs
provide patient safety and help control patient motion.

5. Instruct the patient that during the scan it is quite noisy, and
give the patient earplugs.

• You may want to substitute ear plugs with headphones,
if available.

In Brief: Body Coil

1. Unplug and remove all
other coils from the
magnet bore.

2. Instruct the patient to lie
supine on the table either
head first or feet first.

3. Place sponges to make
the patient comfortable.

4. Use straps to immobilize
the patient.

5. Give the patient ear
plugs.

6. Give the patient the
Patient Alert bulb.

7. Instruct the patient close
eyes.

8. Press [Align Light].

9. Press [In Slow].

10. Align cross of alignment
light over the center of the
area of interest.

11. Press [Landmark].

12. Press [Move to Scan].
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6. Give the patient the Patient Alert bulb and instruct the
patient how to use it.

7. Instruct the patient to close his/her eyes.

WARNING:Instruct the patient to close his/her eyes before
pressing [Align Light]. The eyes must be protected
from laser radiation. The patient needs to be
instructed to close his/her eyes when landmarking
and the laser light is turned on. Exposing eyes to the
laser alignment lights may result in eye injury.

8. Press [Align Light].

9. Press [In Slow].

• Moves table in slowly.

10. Align cross of the alignment light with the center of the area
of interest.

11. Press [Landmark].

• Communicates the region of interest center to the
system.

• Automatically turns off the alignment light.

CAUTION:Do not leave the laser light on after you position the
patient.

12. Press [Move to Scan].

• Moves the patient to isocenter (center of magnet).
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Phased Array Coils Position the Patient

Surface and Phased Array Coils
When imaging a small region of interest, remember that the
smaller the coil the better the SNR. Use surface coils and
phased array coils when imaging an area of the body where you
are able to place the coil close to the region of interest. Surface
Phased array coils have a limited depth of penetration, typically
about half the width of the coil. They are NOT volume coils.

WARNING:Some surface coils are transmit and receive coils. Be
sure that the proper coil is selected (at the operator’s
console) before scanning the patient. DO NOT SCAN
TRANSMIT AND RECEIVE COILS WITH THE
BODY COIL SELCECTED. Making a coil selection
that does not match the actual coil used may result in
severe damage to the coil and possible patient
warming. See the individual coil manuals for specific
cautions and warnings.

1. Unplug and remove all other coils from the magnet bore.
Observe all warnings that are listed below:

WARNING:When using surface coils and phased array coils:

• Remove all unplugged and unused accessory items
from the bore, a patient burn could result.

• GATING: DO NOT USE BLUE WIRE TYPE ECG
LEADS.There is a potential for patient heating with
these leads. ONLY USE HIGH IMPEDENCE ECG
LEADS when doing surface coil or phased array coil
ECG gated scans.

• Only use coils and accessories that are in good
condition. Inspect coils and accessories for
damage. If damage is apparent DO NOT USE and
notify the service engineer. DO NOT USE coils with
damaged insulation. If the coils are exposed, patient
burns can result, DO NOT USE these coils.

In Brief: Surface and
Phased Array Coils

1. Unplug and remove all
other coils from the
magnet bore.

2. Position patient on table
and position coil on
patient.

3. Place sponges to make
the patient comfortable.

4. Use straps to immobilize
the patient.

5. Provide patient with ear
plugs.

6. Give Patient Alert bulb
and instruct patient on its
use.

7. Instruct the patient close
eyes.

8. Press [Align Light].

9. Press [In Slow].

10. Align cross of align light to
the center of the coil.

11. Press [Landmark].

12. Plug in the coil.

13. Press [Move to Scan].
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• Route cables out of the magnet through the center
of the magnet bore. Position the patient to minimize
the distance the cables extend into the bore.

WARNING:DO NOT LOOP OR CROSS CABLES: Arcing and
patient burns can result.

• Do not allow the cable to touch the patient because
burns could result. Use a thermal resistant material
or pad to keep cable from touching the patient.

• The patient should not touch the magnet bore. Place
pads between patient and bore to avoid touching.
For large patients, use wide patient safety straps
across the arms (or any other part of the body that
is touching the bore).

• Use only compatible coils, make sure the plug has a
compatibility tag as shown below. The coil must be
for this particular system. Coils from other MR
systems (including coils from other GE MR
systems) must NOT be used.

2. Position the patient on the table and position the coil on the
patient.

3. Use sponges to make the patient comfortable.

• Use appropriate sponges where necessary for coil
positioning.

• Usually, placing an angled sponge under the patient’s
knees helps take pressure off the back and makes the
patient more comfortable.

• Place thermal pads at points where patient touches
bore.

4. Use straps to immobilize the patient.

• Security straps across the arms, abdomen, or legs
provide patient safety and help control patient motion.
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5. Instruct the patient that during the scan it is quite noisy, and
provide the patient with ear plugs.

• If available, you may want to substitute headphones for
ear plugs.

6. Give the patient the Patient Alert bulb and instruct the
patient how to use it.

7. Instruct the patient to close his/her eyes.

WARNING:Instruct the patient to close his/her eyes before
turning on the Align Light. The eyes must be
protected from laser radiation. The patient needs to
be instructed to close his/her eyes when landmarking
and the laser light is turned on. Exposing eyes to the
laser alignment lights may result in eye injury.

8. Press [Align Light].

9. Press [In Slow].

• Moves table in slowly.

10. Align cross of the alignment light with the center of the coil.

11. Press [Landmark].

• Communicates the region of interest center to the
system.

• Automatically turns off the alignment light.

CAUTION:Do not leave the laser light on after you position the
patient.

12. Plug in the coil.

• The coil must be for this particular system.

° Coils from other MR systems (including coils from
other GE MR systems) must NOT be used.

• The cables should not be twisted or looped.

13. Press [Move to Scan].

• Moves the patient to isocenter (center of magnet).
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The figures below are some examples of surface and phased
array coils. Please refer to the individual coil manuals for more
detailed information on your site’s coils:

• The CTL Array coil allows imaging of the C,T, and L spine
without repositioning the patient. A volume neck coil is also
built into this coil.

• The Torso Array coil for imaging and MR Angiography of the
abdomen or pelvis. The pictured coil is a four element
phased array coil.
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• The Shoulder coil allows for imaging of a patient’s shoulder,
two sizes allow for optimal imaging.

• The Extremity coil can be used to image the knee, ankle or
foot.

• The four element Phased Array Wrist coil is designed for
wrist and hand imaging.
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• The Phased Array Breast coil allows for bilateral or
unilateral breast imaging and has an open design for biopsy
capability.

• The Neurovascular coil for imaging and MR Angiography of
the head and neck without repositioning of the patient.
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• The Cardiac Array coil, is a 4 element phased array coil for
1.5T systems; dedicated for cardiac imaging.

• The Peripheral Vascular coil allows for imaging and MR
angiography of the lower extremities with moving the
patient.

• The Torso Pelvis Array coil allows for imaging or MR
angiography of the abdomen and/or pelvis without moving
the patient. This is a four element coil with two sections, a
torso section and a pelvis section.
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• The General Purpose Flex (GPFlex) coil is a receive only
coil, and can be used for imaging of the knee, ankle,
brachial plexus, hip, or any body part the coil fits.
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Chapter 5

Building and
Saving Protocols

Introduction

This chapter explains the protocol building and saving process. It
provides highlights of key concepts and brief guidelines for building
protocols and saving protocols for future use. This chapter also
contains the step-by-step instructions to help you learn how to
perform these processes:

• Building a Protocol

• Copying to a Site Protocol

• Editing a Protocol

• Saving a Protocol While Scanning

• Deleting a Site Protocol

• Copying a Series in a Protocol

• Printing Site Protocols

• Saving Site Protocols to MOD

• Restoring Site Protocols from MOD

• Deleting Site Protocols from MOD
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In addition, this chapter answers the following questions:

1. What is a protocol?

2. How do I build a protocol?

3. How do I save a protocol?

4. Can I edit a saved protocol?

5. Can I save protocols for my site?

6. How can I remove a saved protocol?

7. Can I print the site protocols for my site?
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About... Building and
Saving Protocols
This section presents the concepts necessary to successfully
complete the building and saving protocol process. Specifically,
you need to understand:

• Building Protocols with the Protocol Manager

• Selecting and Saving from the Protocol Libraries

• Managing Site Protocols
2292261-100 Rev. 0 (03/01) 5-3



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
Building Protocols with the Protocol
Manager
A protocol is a series of scan parameters that are used for
imaging a particular part of the body. You can build and save
protocols from the Protocol Manager Desktop.

The Protocol Manager Desktop icon is located on the control
panel.

Desktop Control Panel

Selecting and Saving from Protocol
Libraries
Protocol libraries are sets of scan parameters that are
pre-programmed into your system. Your system comes with
protocols in the GE and Picture This libraries. The Site library is
empty until you create and save your own protocols. Using
pre-programmed protocols optimize the scanning process and
help maintain consistent imaging. Protocols from the GE and
Site libraries can be edited, copied, pasted and saved to suit
your particular needs. The Picture This protocols CANNOT be
modified, this is insures that you obtain images similar to those
“pictured”.

• Your MR system has 3 libraries of protocols:

° Picture This
° Site
° GE
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The protocol list is available in the Patient Protocols area.

• Each library contains eight protocol categories:

° Head

° Neck/Cervical

° Chest/Thoracic

° Upper Extremities

° Abdomen/Lumbar

° Pelvis

° Lower Extremities

° Other

Protocol categories can contain up to 100 protocols, with up
to 100 series each.

GE Library

The GE library contains pre-programmed protocols that
includes all of the protocols from the Picture This library, as well
as additional protocols.

The GE library does not contain sample images but does allow
scan parameter changes; you can edit the protocols from the
GE library and save them to the Site library.
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Site Library

You create and save your own protocols into the Site library; the
protocols from the GE library can be used (and edited) as a
starting point.

The Site library is empty until you add your Site’s protocols.

Picture This Library

The Picture This library contains pre-programmed protocols
with an image gallery. The image gallery shows examples of the
image to expect when using these protocols.

Only start and end locations can be changed in this library.

Most series contain three sub-series choices, standard, faster,
and higher resolution, and sample images to assist in selection.

The Picture This window reflects the scan time of the series as
it is built into the Picture This library. Each Picture This series
has a value entered for the number of slice locations (or number
of slabs for 3D series). The scan time in the Picture This
window reflects that value. If you change the number of
locations (in either the Graphic Rx or on the Scanning Range
area), and that change results in an increase or decrease in the
number of acquisitions, the actual scan time is reflected in the
Picture This window.

NOTE: The [New Series], in the Rx Manager, is not available
after selecting a Picture This protocol. The [New Series]
is only available with GE or Site protocols.

• If you wish to exit a Picture This series that is currently
in the process of prescription, click on the Humanoid
icon and select a GE protocol or a Site protocol. At this
point, the selected protocol can be edited, or the New
Series button can be selected if you wish to build a
protocol from scratch.

NOTE: Picture This protocol advisory panel may be incorrect.
The maximum # of slices in the advisory panel may be
less than the actual maximum number of allowed slices
since the number is based on a single gradient
configuration.

• Protocol for 1.5T HighSpeed, EchoSpeed, N1 Cervical
spine, T1 FLAIR, series 9, maximum slices states 16,
actual number is 19.
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• Protocol for 1.5T HighSpeed, EchoSpeed, A4 Lumbar
spine, T1 FLAIR series 12, maximum slices states 16,
actual number is 19.

• Protocol for 1.5T HighSpeed, EchoSpeed, Routine
Brain, T1 FLAIR oblique coronal, maximum slices states
22, actual number is 24.

Managing Site Protocols

You can choose a protocol from any of the protocol libraries and
save to the Site library. Protocols from the GE and Site library
can be edited, although edited GE protocols can only be
SAVED to the Site library. Remember, Picture This protocols
CANNOT be edited. To streamline scanning you want to have
commonly performed exam protocols stored in your Site library.
You may want to have protocols saved with different
parameters or coils to maintain efficiency (example: Liver
protocol saved with patient positioned head first and patient
positioned feet first). The Site library can be updated by editing
or adding new series to the protocol. This library can also be
stored on an MOD and printed to paper. This is especially
important when software is upgraded and new features are
added to your system.

NOTE: The Print Protocol feature requires a postscript printer.
Many printers are “postscript ready” and an upgrade may
not guarantee the printer’s compatibility with the Print
Protocol feature. It is recommended, at this time, NOT to
use this feature. DICOM print will be made available at a
time that is yet to be determined.

NOTE: When a scan value within a protocol results in an
incompatibility, the system sets the Protocol TR to the
PSD’s default TR.

• For example, if a T2, sagittal, protocol of the spine is
prescribed using a FOV of 36 cm or larger with Phase
and Frequency swapped and Flow Comp turned on,
when the protocol is downloaded, the TR is changed
from the T2 value to the PSD’s default TR.

• The solution to this problem is to rebuild the protocol
and not have Flow Compensation and
Phase/Frequency swapped with a FOV larger than
36 cm.
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How to Build and Save
Protocols
This section provides the step-by-step instructions for building
and saving protocols. Specifically, it describes how to:

• Build a Protocol

• Copy a Protocol to Site the Library

• Edit and Save a Protocol

• Save a Protocol While Scanning

• Delete a Site Protocol

• Copy a Series in a Protocol

• Print Site Protocols

• Save Site Protocols to MOD

• Restore or Delete Site Protocols from MOD
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uilding a ProtocolBuild a Protocol

Protocol building is a valuable tool for you to use to maintain
consistent imaging while optimizing your patient flow. Having
pre-programmed protocols saves you from entering the scan
parameters each time you scan a patient. You can build
protocols a number of ways, which is covered later in the
chapter. In this section we concentrate on building a protocol
from the beginning (not editing a pre-programmed protocol).

1. Click the Protocol Manager desktop from the control panel.

2. Click [Protocol Rx] from the Protocol Prescription area.

• [Schedule Rx] ONLY appears if you have purchased
the ConnectPro Plus option.

3. Click [New Protocol] from the Protocol Rx area.

In Brief: Build a
Protocol

1. Click Protocol Manager
desktop.

2. Click [Protocol Rx].

3. Click [New Protocol].

4. Enter information in the
Patient Information area.

5. Enter information in the
Patient Position area.

6. Enter information in the
Imaging Parameters
area.

7. Enter information in the
Scan Timing area.

8. Select Additional
Parameters and complete
information.

9. Enter information in the
Acquisition Timing area.

10. Enter information in the
Scanning Range area.

11. Click [Save Series]. If
done go to step 13.

12. Click [New Series].
Repeat steps 3-11 to add
more series.

13. Click [Save Rx as
Protocol].

14. Select Protocol Category.
Type name in Protocol
Name text box.

15. Click [Accept].
2292261-100 Rev. 0 (03/01) 5-9



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
NOTE: Click [Cancel] to exit from Protocol Rx.

NOTE: For more detailed information regarding the areas and
windows in steps 4-10 see the chapter titled Scan Rx
Desktop.

4. Enter the information in the Patient Information area.

• When building protocols, not every text box needs to be
filled in. This allows you to create protocols even is you
do not know the exact parameters for every text box,
window, or area. When you use the protocol, you can
“fill in the blanks” to meet the requirements for the
current patient. If an entry is required, you are prompted
to enter data in that text box before continuing.

• Click the arrow below Landmark to view the menu, and
then click the appropriate selection from the menu.
5-10 2292261-100 Rev. 0 (03/01)



Building and Saving Protocols
5. Enter the information in the Patient Position area.

NOTE: See the Scan Rx Desktop chapter of this Volume for more
detailed information regarding entering the information
for steps five through 10.

6. Enter the information required on the Imaging Parameters
area. The arrows and the ellipse buttons, to the right of the
text boxes, display menus and windows providing
selections for these text boxes. The PSD name text box is
used for type in PSDs only. Mode and pulse sequence text
boxes must be filled to view the remaining areas and
windows.

7. Enter the information required in the Scan Timing area.
2292261-100 Rev. 0 (03/01) 5-11



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
8. Select the buttons as needed for the Additional Parameters
area. Complete the required information.

9. Enter the information required in the Acquisition Timing
area.

10. Enter the information required in the Scanning Range area.

NOTE: If this is the first series of a protocol enter a scan range
(example: scan plane sagittal, Type L40 in the Start text
box and type R40 in the End text box). If this is not the
first series of the protocol, and you plan to use Graphic
Rx, no entries are needed for the Start/End locations.

11. Click [Save Series]. The series status in the Protocol
Manager from INRX to RXD.
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a) If no more series are needed go to step 13.

12. Click [New Series] from the Protocol Manager to add
another series to the protocol and repeat steps 3-11.

13. Once all the series are created click [Save Rx as Protocol]
on the Protocol Manager.

The Save Protocol Rx window appears.

14. Click the button to the right of Protocol Category, and then
click a category from the menu. Type a unique name in the
Protocol Name text box, example, Claustrophobic
Brain.

15. Click [Accept] to save the protocol and return to the
Protocol Prescription area.

• The protocol is saved in the Site library.

• To begin the protocol building process again, click
[Protocol Rx].

• Clicking [Cancel] exits without saving the protocol.
2292261-100 Rev. 0 (03/01) 5-13



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
Copy a Protocol Copy a Protocol to the Site Library
You may find that you want to copy an entire protocol into
another protocol. Instead of creating a new protocol, is much
faster and easier to copy an existing protocol. Protocols can
only be copied into the Site library.

This section gives you step-by-step instructions to copy a
protocol.

1. Click the Protocol Manager desktop from the control panel.

2. Click [Protocol Rx] from the Protocol Prescription area.

• [Schedule Rx] ONLY appears if you have purchased
the ConnectPro Plus option.

3. Click the button to the right of Patient Protocols, and then
click to select the library from which to copy the protocol.

The protocol library menu appears.

In Brief: Copy a
Protocol to the Site
Library

1. Click the Protocol
Manager desktop.

2. Click [Protocol Rx].

3. Select the library.

4. Click an area of the
Humanoid to select
protocol category.

5. Select desired protocol.

6. Select the desired series.

7. Click [Accept].

8. Click [Save Rx as
Protocol].

9. Select the Protocol
Category and type
protocol name (must be a
different name) in
Protocol Name text box.

10. Click [Accept].
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4. Click the region of the humanoid, from the Patient Protocols
area, to select the protocol category.

5. Select the desired protocol, from the menu.

6. Select the desired series.

• You can skip this step if you want to copy every series in
the protocol.

7. Click [Accept] to continue.

8. Click [Save Rx as Protocol], from the Protocol Manager.

9. Click the button to the right of Protocol Category. Select a
category from the menu. Type a unique name in the
Protocol Name text box.

10. Click [Accept] to save the protocol in the Site library under
this name.

• Click [Cancel] to exit without saving.

• The protocol is now saved and can be found under the
Site library.
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Editing a Protocol Edit and Save a Protocol
Once a protocol is saved you may wish to adjust the
parameters. Editing a protocol allows you to do this without
re-building the entire protocol. This section gives you
step-by-step instructions to edit a protocol.

Protocols from the GE and Site libraries can be edited. Edited
protocols can ONLY be saved to the Site library.

1. Click the Protocol Manager Desktop icon from the control
panel.

2. Click [Protocol Rx] from the Protocol Prescription area.

• [Schedule Rx] ONLY appears if you have purchased
the ConnectPro Plus option.

3. Click the button to the right of Patient Protocols, and then
click to select the library from which you would like to edit
the protocol.

In Brief: Edit and
Save a Protocol

1. Click the Protocol
Manager Desktop icon.

2. Click [Protocol Rx]

3. Select Site library from
Patient Protocol area.

4. Click on area of the
Humanoid to select
protocol category.

5. Select desired protocol.

6. Click [Accept].

7. Select series in Rx
Manager to edit.

8. Click [View Edit].

9. Make necessary changes
and click [Save Series]. If
done go to step 10.

• Repeat steps 7-9 for
any additional series
to edit.

10. Click [Save Rx as
Protocol].

11. Click [Accept] or Protocol
Category and type in new
protocol name.
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4. Click a region of the Humanoid, in the Patient Protocols
area, to select a protocol category.

5. Select the desired protocol from the menu.

6. Click [Accept] to continue.

• Click [Backup] to return you to the Humanoid to select
a different protocol category.

7. Select the series you want to edit from the Rx Manager.

8. Click [View Edit].

9. Make any changes to the series and click [Save Series]
below the Scan Timing area.

• If no other series need editing go to step 11.

• To make changes to other series in the protocol repeat
steps 7-9.

• Once all changes have been completed go to step 10.
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10. Click [Save Rx as Protocol] from the Rx Manager.

11. From the Save Protocol Rx window, do one of the following:

• Click [Accept] to update the existing protocol.

• Click Protocol Category (1), then click the desired
category, and then type in a unique name (2) to create a
new protocol.

NOTE: The protocol is now listed in the Site library.

1

2
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Saving a Protocol While ScanningSave Protocol While Scanning

After you have entered in the parameters for a scan you may
want to save them as a protocol. Saving a protocol is similar to
Building a Protocol. For more details on entering the scan
parameters refer to the section on Building a Protocol steps
three through 11.

1. Enter all the scan parameters from the Scan Rx Desktop.

2. Click [Save Rx as Protocol] from the Rx Manager.

• This saves all series that are in the Rx Manager.

3. Click Protocol Category (1), and then click the desired
category where to store the protocol.

4. Type in a protocol name such as L-spine at the Protocol
Name (2) text box.

• When in the Scan Rx Desktop you are creating a new
protocol. You must type a new name in the Protocol
Name text box.

NOTE: You can only update an existing protocol when in the
Protocol Manager Desktop.

5. Click [Accept] in the Save Protocol Rx window to save the
protocol.

• The protocol is now saved in the Site library.

• Clicking [Cancel], exits without saving the protocol.

In Brief: Save a
Protocol While
Scanning

1. Enter parameters from
Scan Rx Desktop.

2. Click [Save Rx as
Protocol].

3. Click Protocol Category.

4. Type in name at Protocol
Name text box.

5. Click [Accept].

1

2
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Delete a Site Protocol
If a protocol is no longer be needed, you may want to delete it
from your Site library.

1. Click the Protocol Manager Desktop icon from the control
panel.

2. Click [Protocol Rx] from the Protocol Prescription area.

• [Schedule Rx] ONLY appears if you have purchased
the ConnectPro Plus option.

3. Click the button to the right of Patient Protocol and select
Site library. Only protocols from the site library can be
deleted.

4. Click the region of the humanoid, from the Patient Protocols
area, to select the protocol category.

5. From the menu select the protocol you want to delete.

In Brief: Delete a Site
Protocol

1. Click the Protocol
Manager Desktop icon.

2. Click [Protocol Rx].

3. Select the Site library.

4. Click an area on the
Humanoid to select
protocol category.

5. Select protocol to delete.

6. Click and hold right
mouse and select Cut.

7. Click [Confirm] to delete.

8. Click [Backup].

9. Click [Cancel].
5-20 2292261-100 Rev. 0 (03/01)



Building and Saving Protocols
6. Right click on the selected protocol and select Protocol Cut
from the menu.

A confirmation box appears.

7. Click [Confirm] to remove the protocol from the Site library.

• The protocol is now deleted from the Site library.

NOTE: Clicking [No] exits without deleting the protocol.

8. Click [Backup].

9. Click [Cancel] to exit.
2292261-100 Rev. 0 (03/01) 5-21



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
Copying a Series in a Protocol Copy a Series in a Protocol
You may want to repeat a series either while scanning or when
saving a protocol, For example, Pre- and Post-contrast
injection. The same process is used for copying while scanning
and while saving protocols.

1. Follow steps 1-6 from the prior section Copying a Protocol
and continue with these steps.

2. Highlight the desired series from the Rx Manager.

3. Right click to display the menu, and then click Copy Series.

NOTE: You can delete a series, in the Rx Manager, by selecting
(highlighting) that series and right click and then click Cut.

4. Select (highlight) another or the same series.

• The copied series is placed immediately below the
selected (highlighted) series.

5. Right click to display the menu, and then click Paste Series.

• The copied series is placed just below the highlighted
series. For example, if you copy series #2 and you want
to paste after series #4, highlight series #4 after you
click copy and before you click paste.

6. Click [Save Rx as Protocol] to save the updated protocol in
the Site library.

7. Click the button to the right of Protocol Category (1). Select
a category from the menu. Type a unique name in the
Protocol Name text box (2).

In Brief: Copy a
Series in a Protocol

1. Follow steps 1-6 from
Copying a Protocol.

2. Highlight series to copy.

3. Right click and click
Copy Series.

4. Select another or same
series.

5. Right click and click
Paste Series.

6. Click [Save Rx as
Protocol].

7. Select the Protocol
Category and type
protocol name (must be a
different name) in
Protocol Name text box.

8. Click [Accept].

1

2
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8. Click [Accept] to save the protocol in the Site library under
this name.

• Click [Cancel] to exit without saving.

• The protocol is now saved and can be found under the
Site library.
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Printing Site Protocols Print Site Protocols
If you have a printer connected to your system you can print
your site library. This section gives you step-by-step instructions
to print your protocols.

NOTE: The Print Protocol feature requires a postscript printer.
Many printers are “postscript ready” and an upgrade may
not guarantee the printer’s compatibility with the Print
Protocol feature. It is recommended, at this time, NOT to
use this feature. DICOM print will be made available at a
time that is yet to be determined.

1. Make sure printer is connected.

• Contact the service engineer for initial printer
connection, specific printers (must be a post script
printer), and special cabling that may be necessary.

2. Click the Service Desktop icon from the control panel.

The Service Desktop Manager appears.

3. Click [Utilities] (1) from the Service Desktop Manager.

4. Click and drag the slider (2) to scroll down the utilities list
and select the Save/Restore/Print Protocol (3).

5. Click [Start] (4) from the Service Desktop manager.

In Brief: Print Site
Protocols

1. Make sure printer is
connected.

2. Click the Service
Desktop icon.

3. Click [Utilities].

4. Select
Save/Restore/Print
Protocol.

5. Click [Start].

6. Select the anatomical
category (select the
protocol and/or series)
you want to print.

7. Click [Configure].

8. Select the correct printer
and parameters.

9. Click [Accept].

10. Click [Print].

11. Click [OK].

• To print more protocols
repeat steps 6-11. If
finished go the step
12.

12. When done printing, click
[Exit].

1

2

3

4
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The protUtilShell window appears.

• The Protocol Selection menu defaults to the Site library.

6. From the left column, select the protocol category that you
want to print.

NOTE: For more detailed steps on selecting anatomical category,
protocols or series refer to the section Saving Protocols
to an MOD step 6. Select the protocol and/or series to
print.

7. Click [Configure] to ensure proper printer selection and
parameters.

A menu appears.

8. Select the correct printer and choose parameters according
to your printer set-up.

9. Click [Accept].

10. Click [Print].

A confirmation message appears.

11. Click [OK] to print.

NOTE: Clicking [Cancel] exits without printing.

• The protocols print, if you are finished printing protocols
go to step 12.
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• To print more protocols repeat steps 6-11, when
complete go step 12.

12. Click [Exit] to exit the protUtilShel window.

NOTE: Do Not click the second icon to the right, this action closes
the protUtilShel window, placing the icon behind the
Control Panel where it is inaccessible until the system is
rebooted.

The print protocol process is completed. Select another desktop
from the control panel to continue to another system function.
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Saving Site Protocols to an MODSave Site Protocols to MOD

Saving your protocols onto an MOD (Modifiable Optical Disk)
eliminates the need to re-create them if they are deleted from
from your hard disk. For example, if your hard disk gets
reformatted, your Site library is deleted. If you have the
protocols saved on an MOD, you can easily and quickly restore
your protocols to the system. You can save by anatomical area,
by protocol, or by series.

It is the individual site’s responsibility to save their own site
protocols on an MOD as a backup. This section gives you
step-by-step instructions on saving site protocols to an MOD.

1. Insert a new MOD into the disk drive.

NOTE: It is very important to choose a new MOD to avoid
accidental removal of already archived data. If the MOD
has patient images on it, this patient information is lost
when you save the protocols on the same MOD.

2. Click the Service Desktop icon from the control panel.

The Service Desktop Manager appears.

3. Click [Utilities] (1) from the Service Desktop Manager.

In Brief: Save Site
Protocols to MOD

1. Insert a new MOD.

2. Click the Service
Desktop icon.

3. Click [Utilities].

4. Select
Save/Restore/Print
Protocols.

5. Click [Start].

6. Select the anatomical
category (select the
protocol and/or series)
you want to save from the
protUtilShell window.

7. Click [Save].

8. Click [Continue]. If done
saving go to step 9.

• Repeat steps 6-8 to
save additional
protocols/series.

9. Select Media to check if
protocols were saved.

10. Click [Exit].

11. Click [OK] to exit and
eject MOD.

1

2

3

4
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4. Click and drag the slider (2) to scroll down the utilities list
and then select Save/Restore/Print Protocols (3).

5. Click [Start] (4) from the Service Desktop Manager.

The protUtilShell window appears.

• The Protocol Selection menu defaults to the Site library
on the protUtilShell window.

• The Site library protocol categories appear in the 1st left
column.

6. Select the protocol category desired.

• Once the protocol category is highlighted, the Site’s
protocols for that category are shown in the middle
column.

• If more than one category is selected, the two remaining
columns appear empty.

NOTE: To select more than one protocol category or series, click
and drag.

a) Select the specific protocol from the middle column.

° Once the protocol is highlighted, the series’ of the
protocol are shown in the far right column.

b) Select the series to be saved from the right column.

° Click and drag to select more than one series.

7. Click [Save].

A new MOD warning message appears.

• This message states that the MOD will be reformatted,
and all existing data on the MOD will be erased.
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8. Click [Continue] to format MOD and save selected series
to MOD. If done saving, go to step 9.

NOTE: Clicking [Cancel] does not format MOD and does not
save protocols to the MOD.

• Repeat steps 6-8 if you would like to save more
protocols or series to the MOD.

NOTE: To add an additional protocol to already saved protocols,
it is best to re-save all protocols. This ensures that all
protocols and changes are saved.

9. Click Media from the Protocol Selection menu, to check that
protocols are saved to the MOD.

a) Select the protocol category.

• The protocols appear in middle column

b) To check individual series, select the protocol to display the
series in the right column.

10. Click [Exit] to exit the protUtilShel window.

NOTE: Do Not click the second icon to the right, this action closes
the protUtilShel window, BUT places this icon behind the
Control Panel icons where it cannot be accessed, until
the system is rebooted.
2292261-100 Rev. 0 (03/01) 5-29



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
A confirmation message appears.

11. Click [OK] to exit and eject the MOD.

NOTE: Clicking [Cancel] keeps you in the protUtilShell window
and does NOT eject the MOD.
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Restoring Site Protocols from an MODRestore or Delete Site Protocols from
MOD

The restore option is designed to easily restore the site’s
protocols in the event of accidental deletion. The delete option
gives you the opportunity to delete old or outdated protocols off
the MOD. This section gives you detailed step-by-step
instructions on restoring or deleting protocols from an MOD.

1. Insert the MOD that contains the Site protocols into the disk
drive.

2. Click the Service Desktop icon from the control panel.

The Service Desktop Manager appears.

3. Click [Utilities] (1) from the Service Desktop Manager.

4. Click and drag the slider (2) to scroll down to the bottom of
the Utilities list, and then select Save/Restore/Print
Protocol (3).

In Brief: Restore or
Delete Site Protocols
from MOD

1. Insert MOD into disk
drive.

2. Click the Service
Desktop icon.

3. Click [Utilities].

4. Select
Save/Restore/Print
Protocols.

5. Click [Start].

6. Click Media.

7. Select protocol
category/protocol/series
to be restored or deleted.

8. Select [Restore] or
[Delete].

9. Click [OK].

10. Check the process by
selecting Site Protocols
if restoring, or Media if
deleting, select protocol
category.

11. Click [Exit].

12. Click [OK] or [Cancel].

1

2

3

4
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5. Click [Start] (4) from the Service Desktop Manager.

The protUtilShell window appears.

6. Click Media from the Protocol Selection menu.

7. Select the protocol category, from the left column, that you
want restored or deleted.

• If necessary, select the individual series to be restored
or deleted.

NOTE: For more details on selecting protocol categories,
protocols, or series see step 6 of the Saving Protocols to
an MOD section.

8. From the protUtilShell window, do one of the following:

• Click [Restore] to restore the protocols.

• Click [Delete] to delete the protocols.

A confirmation message appears.

9. Click [OK] to start the process.

• Clicking [Cancel] exits without restoring or deleting the
protocols.

10. To check the process, do one of the following:

• If you were restoring, set the Protocol Selection option
menu to Site Protocols (1) and select the protocol
category. The protocols are listed in the middle column
and the series are be listed in the right column.

• If you were deleting, set the Protocol Selection option
menu to Media (2) and select the protocol category, the
protocol should NOT appear.

° However, if you deleted individual series, the deleted
series of the protocol should NOT appear in the right
column.

1

2
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11. Click [Exit] from the protUtilShell window.

A confirmation message appears.

12. Click [OK] to exit and eject the MOD.

• Clicking [Cancel] keeps you in the proUtilShell window
and does not eject the MOD.
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Where Am I?
Volume 1

Chapter 6

Pre-Registering
Patients and
ConnectPro

Introduction
This chapter explains how to pre-register a patient, enter patient
demographic information before their arrival in the MR department,
and use the ConnectPro feature thereby increasing throughput by
reducing patient set-up time. It contains the step-by-step instructions
to help you learn how to:

• Enter Patient Information

• Link a Patient to a Protocol

• Sort the Patient Register

• Select a Registered Patient

• Delete a Registered Patient

• Enter Patient Information with ConnectPro Plus*

• Use Guided Install-Mapping Protocols to Action Items*

• Assign

• Image Storage*

NOTE: *Items with an asterisk are purchasable options.

In addition, this chapter answers the following questions:
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1. Why do you pre-register a patient?

2. How do you enter the patient information?

3. How do you link a patient to a protocol at pre-registration?

4. How do you delete a patient from the register?

5. How do you sort once a patient is registered?

6. How do you use ConnectPro?*

NOTE: *Items with an asterisk are purchasable options.
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About... Pre-Registering
Patients and ConnectPro
This section presents the concepts necessary to successfully
complete the pre-registration process and using the
ConnectPro and ConnectPro Plus features. Specifically you
need to understand the concepts regarding:

• Pre-Registering Patients

• Deleting a Registered Patient

• Using ConnectPro
° Navigating the Schedule Window
° Ending Exams with ConnectPro

• Using Perform Procedure Step (ConnectPro Plus)

• Using the Guided Install for HIS/RIS DICOM

• Using the Guided Install for Mapping Protocols to Action
Items
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Pre-Registering Patients
You can pre-register patients before their arrival in the MR
Department, thereby helping to facilitate increased throughput.
Once the patient arrives, you can bring up his/her information
and move forward with scanning. To begin a scan, you must, at
a minimum, enter the patient’s ID and weight. The patient’s
weight determines the SAR (Specific Absorbtion Rate.)

NOTE: Refer to the Working Safely chapter for more detailed
information regarding SAR.

WARNING:Entering a weight less than the actual patient weight
could potentially harm the patient by exposing to high
RF values and warming the patient.

Something to Think About...

Patient Information requires detailed information about the
patient. Refer to the Scan Rx Desktop chapter for more
information.

• Accession Number:

° This is generally related to a number assigned by
the hospital, clinic, or site, and is tied to the patient’s
records. Enter the number manually or by using the
optional bar-code reader, (if applicable).

• Entering Patient ID:

° Enter any combination of numbers, letters, and
dashes.

° If the system finds the same ID in its memory, it
displays all the pertinent data so long as the entry is
identical, including the use of upper-case and
lower-case letters.

° Enter MR and the system re-displays the last (most
recent) patient’s data.

• Patient Name:

° Type the name of patient here.
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• Birthdate:

° Enter month using numbers (1-12), day using
numbers (1-31), and year (19xx or 20xx) as
mm/dd/yyyy or mm-dd-yyyy. The year entry must
contain four digits.

° The birthdate entry is optional when pre-registering
patients.

° Note that the system can be configured for
dd/mm/yyyy by the service engineer.

• Patient Age:

° If the birthday is entered, the age is automatically
calculated.

° Enter only whole numbers, (i.e., no decimals) and
age, in years, ranges from 1-123 years.

° Days (1-90), weeks (1-52), or months (1-23) can
also be entered. For example, 28D, 4W or 1M.

• Patient Sex:

° Enter M for male.

° Enter F for female.

• Patient Weight:

° Enter either pounds or kilograms.

° The system automatically calculates and displays
the other weight measure.

° Limits are 2 to 350 lb. ( 1 to 158 kg.)

° Enter accurate weight information. Otherwise, the
system could abort the scan or deliver the wrong
amount of RF power to the patient.

• Radiologist:

° Type the name of the radiologist.

• Referred By:

° Type the name of the referring doctor.

• Operator:

° Type the 3 initials of the operator.
2292261-100 Rev. 0 (03/01) 6-5



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
• Select a [Status] from the menu.

• Exam Description:

° Enter the exam description. If this area is not
completed, no information appears on the Browser
except the patient name.

• Patient History:

° Include relevant background information regarding
the patient’s symptoms or other relevant information.

• Landmark:

° Click this button. A new window appears that leads
to the landmark text box for the Patient Information
area.

• Schedule:

° Access the ConnectPro Option by clicking
[Schedule].

Deleting a Registered Patient
A patient’s name is automatically removed from the Patient
Register after clicking the [End Exam] button on the Rx
Manager window.

If a patient cancels his/her exam or does not show up for an
appointment, you can delete him/her from the patient register. It
is also possible to copy, paste, and cut patient information
within the register. Highlight the patient name with a left mouse
click and use a right mouse click to perform the desired
copy/paste/cut function.
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Using ConnectPro Plus
ConnectPro Plus is a purchasable option available for systems
equipped with 8.2 software and above. This feature allows
information from the Hospital Information System and/or the
Radiology Information System (HIS/RIS) to cross over to the
MR system. There are some new features and windows added
to this option.

• The Worklist Search, also called the Schedule window, has
been expanded to look for as few as two matching
characters.

• The Schedule window has been expanded with multiple
choices across the bottom of the window. From the choices
on this window, you can change the procedure code
associated with the patient. Also, you are able to view
patient information, and the A.I. (Action Item) Mapping of
protocols (attaching protocols to HIS/RIS codes).

Some background information may be needed to understand
the purpose of the ConnectPro Plus feature. For example,
Hospital and Radiology Information Systems (HIS/RIS) use
procedure codes when ordering and charging for an exam or
procedure. These codes vary by institution, but an example
would be the use of CPT codes (codes for various procedures
established by the AMA and used by federal Medicare/Medicaid
programs). The codes used by the HIS/RIS may be unique to a
hospital or clinic, but these codes can be configured on the
system and linked to protocols in the system protocol library.
When patient information from the HIS/RIS is called to the
system through ConnectPro, the procedure code is part of the
information. If the code is linked to a system protocol, that
protocol is loaded to the Scan Rx Desktop along with the
patient information. Series one of the protocol loads into the
series prescription. The remaining series in the protocol is seen
in the Rx Manager window.

At the New Patient window in the Scan Rx Desktop, two or
more numbers entered at the Accession Number or Patient ID
text box prompts a search through the ConnectPro Worklist for
a match. The search looks for the sequence of digits within the
Accession Number or the Patient ID, depending which text box
was used to enter the data. If the sequence was found, the
patient information for that patient is entered into the Patient
Information window. If two or more matches are found, the
Worklist opens showing a list of all the matches. The Schedule
Worklist can also be accessed by clicking either the [Schedule]
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button from the Patient Information area in the Scan Rx
Desktop, or by clicking the [Schedule] button from the Patient
Information window in the Protocol Manager Desktop.

Navigating the Schedule Window
The Schedule window appears showing a list of all patients that
have been entered through the HIS/RIS system. Selecting
(highlighting) the desired patient, and clicking the [OK] button at
the bottom of the window, enters the information in the Patient
Information area.

The buttons across the bottom of the Schedule window allow
you to access more patient information. The following list gives
brief information about each button.

• [OK] - (1) Accepts the selected patient and enters the
patient information into the Patient Information area of the
Scan Rx Desktop.

• [Update] - (2) Updates the list of scheduled patients.

1 2 3 4 5 6 7
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• [More Info] - (3) Lists more information about the patient,
such as Allergies, Alerts, Weight, etc. This information is for
viewing purposes only and cannot be edited. The
information on this window can be viewed by clicking and
dragging on the slider on the right side of the window.
° The most valuable information, to the technologist, is

accessed by clicking the [Scheduled Procedure A.I.
(Action Item)] button. This button is found at the bottom
of the More Information window. The meaning column
shows the procedure for which this patient is scheduled;
this information comes across from HIS/RIS.

• [Sort] - (4) Sorts patients by either ID, Name, or Time
(scheduled). Click the diamond to the left of the desired sort
method.

• [Preferences] - (5) Provides customization of the Schedule
Worklist. This window allows you to decide: when the
Worklist is updated; the modalities to be included in the list;
and the range of exam dates for the list. The list can also
include a specific Accession Number, Patient Name, or
Patient ID by entering the data on the Query Preferences
window.

° Update - (a) The diamond to the left of the option
determines when the Schedule (Worklist) window
updates. The first choice automatically updates when the
Schedule window is opened. The second choice updates
when the Update on the Schedule window is selected.

° Get Patient List For - (b) Allows you to select lists for
the scanner, the modality, or all scanners.

a

b

c
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° With a Date Range - (c) Allows you to select the patient
list by a date or a range of dates. The entries with a text
box to the right, require a number entered into this ftext
box.

° The remaining type-in fields allow you to perform a
search on a specific patient. The search can be
performed by typing the patient’s name, ID number,
Accession number, or by typing the Requested
Procedure ID that lists all the patients scheduled for that
procedure.

• [A.I.] - Action Items - (6) Shows the A.I. Mappings
Browser, which lists all the protocol choices. If the protocol
that came over from HIS/RIS is incorrect, selecting
(highlighting) a protocol from this list and then clicking
[Accept] maps (attaches) the correct protocol to the patient.

• [Close] - (7) Exits from the Worklist window and the exits
the ConnectPro feature.

Ending Exams with ConnectPro
If you have used the ConnectPro feature, when you click
[End Exam], another window appears. It asks if you would like
to Complete, Defer, Discontinue, or Cancel. The following list
gives a description of each of these choices.

• [Complete] - Ends the exam and PPS (Performed
Procedure Step). You can add a series, such as a screen
save, but CANNOT edit the patient information, such as the
patient name, ID number, etc. Also, you can still annotate on
the images. On the Browser page, the PPS column of this
patient shows the status of COMP (completed).

• [Defer] - Does not end PPS. You can still post-process and
edit the patient information, such as the patient name, ID
number, etc. On the Browser page, the PPS column of this
patient shows the status of Inprog (in progress). Click PPS
from the menu bar displays a window, and allows you to
Complete or Discontinue the PPS on this patient.
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• [Discontinue] - Notifies the HIS/RIS that you are aborting
the PPS. This should be used only if the images you
acquired were unacceptable. You would then need to
re-scan the patient.

• [Cancel] - Exits from this window without ending or
changing anything.

NOTE: When scanning with the Imaging Option SCIC (Surface
Coil Intensity Correction) and PPS, you cannot complete
the exam when finished scanning. The [Complete]
button is not available on the Scan Rx Desktop if SCIC
was selected. First click the [End Exam] button, then click
the [Defer] button. Complete the exam from the Browser
by clicking PPS from the Browser menu bar, and then
click the [Complete] button.

NOTE: If you plan to apply ClariView filters to the images, and
you have used PPS, do not complete the exam when
finished scanning. Post-processing functions must be
done before the exam is completed in PPS. First click the
[End Exam] button, then click the [Defer] button. Apply
the ClariView filters. Then complete the exam by clicking
PPS from the Browser menu bar, and click the
[Complete] button.

CAUTION:Although it is NOT recommended to edit patient
information gathered from the HIS/RIS, the
ConnectPro feature does NOT “lock” an exam from
being edited. If patient information that has originated
from the HIS/RIS Worklist Browser is edited, this
information at the operator’s console DOES NOT
match the patient information in HIS/RIS.
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Using Performed Procedure Step
(ConnectPro Plus)
The following is an overview of ConnectPro Plus, which
includes Performed Procedure Step (PPS).

The PPS is a closed loop of information transfer. The loop starts
with the HIS/RIS, when the patient information is transferred to
the system after you select the patient from the Schedule
window. The PPS is completed when the images are archived
and transferred to a PACS. The HIS/RIS is notified that the
exam is complete and of the location of images (e.g., at the
PACS).

The diagram below shows the complete circle of events that
ensue when ConnectPro with PPS is used.

The dashed lines represent the PPS connectivity additions:
from pushing images to end destinations to a fully integrated
image and text workflow. PPS provides a feedback loop to the
HIS/RIS system that the patient “session” is completed (or not)
and therefore the MR worklist (schedule) is updated to reflect
the patient’s session status.

ConnectPro Plus maintains connectivity between HIS/RIS, the
MR system, and networked stations through following
procedures:

• Detailed retrieval and display of patient information and
procedures.

• Capability of prescribing protocols in advance on the
Protocol Desktop with Worklist entries.
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• Auto-load of protocols for Scan Rx and Protocol Rx from
Worklist entry selection.

• Reports the worklist entries being performed.

• Reports real-time scan status to HIS/RIS, including
actual protocols performed.

• Enables auto verify with PACs system with the list of
completed images acquired and stored for the study.

• W/L transferred to PACs when ss is typed in the
Accelerator Line at the operator’s console. The ss entry
must occur prior to network activity.

• Auto Archive on/off selection is retained after a reboot.

Guided Install for HIS/RIS DICOM
The HIS/RIS DICOM mode requires no password to access.
Configuration is restricted to HIS/RIS tab, which allows
configuration of server and port setups, and to the SCP (charge
codes used by the scanning facility when billing insurance) tab.
The Verification tab is available to verify any changes made to
HIS/RIS are legal. The Log File can also be viewed from this
mode.

Mobile sites can also use the same steps as fixed sites for the
HIS/RIS DICOM install. One reminder for mobile users, be sure
to check that the IP address and the port number are correct on
the HIS/RIS tab.

Guided Install for Mapping Protocols to
Action Items
The Guided Install allows you to save, change, or delete
protocols that are mapped (connected) with an Action Item
Code in HIS/RIS and mapped with the Action Item Code in the
system.
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Mobile Sites can follow the same steps as fixed sites to map
protocols to charge codes; be sure to check that the IP address
and the port number are correct on the HIS/RIS tab.
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How to Pre-Register
Patients and Use
ConnectPro
This section provides the step-by-step instructions for
pre-registering and entering patient information into the system.
Specifically, it describes how to:

• Enter Patient Information

• Link a Patient to Protocol at Pre-Registration

• Select a Registered Patient

• Sort the Patient Register

• Delete a Registered Patient

• Enter Patient Information Using ConnectPro Plus (PPS)*

• Use Guided Install-Mapping Protocols to Action Items*

• Assign Image Storage*

NOTE: *Items with an asterisk are purchasable options.
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Anchor Pre-Register a Patient
You can pre-register your patient or patients prior to their arrival
in the MR Department, thereby helping to facilitate increased
throughput.

1. Click the Protocol Manager icon.

2. Click [Patient Rx] from Protocol Prescription area.

3. Click [New Pt] from the Patient Register area.

4. At a minimum, enter the patient ID and name and then click
[Accept]. The time and date are not required fields.

5. From the Patient Information area, you can enter additional
patient information. Type information within each text box

In Brief: Pre-Register
a Patient

1. Click the Protocol
Manager icon.

2. Click [Patient Rx].

3. Click [New Pt].

4. At a minimum, enter the
patient ID and name, then
click [Accept].

5. Type information within
each text box and press
Enter on the keyboard.

6. Once all the information is
entered on the patient,
click [Save RX as
Protocol].
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and press Enter on the keyboard. The Status text box and
[Landmark] display additional, selectable information.

6. Once all the information is entered for the patient, click
[Save RX as Protocol] from the Protocol Manager window.
You can enter additional information at scan time. This
completes the registration process.

Protocol Manager
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Link a Protocol to a Patient at
Pre-Registration
Pre-registering a patient can also include assigning a protocol.
All patients for the day can be pre-registered with a protocol.
This increases your site’s productivity by having everything
done ahead of the patient’s arrival into your department.

1. Complete steps 1-5 from pre-registering a patient.

2. Click [Landmark].

• The following window appears after clicking on
Landmark. Landmark provides options for the alignment
light position.

• Select a Landmark, either from the menu, or click in the
text box and enter any appropriate name.

In Brief: Link a
Protocol to a Patient
at Pre-Registration

1. Complete steps 1-5 from
Entering Patient
Information.

2. Click [Landmark].

3. Click [Site], [GE], or
[Picture This] from the
Patient Protocol menu.
Then click on the
Humanoid, the area that
corresponds to the body
part of the patient you are
scanning. Example: Head

4. Select the desired
protocol and click
[Accept] to download the
entire protocol.

5. Click
[Save Rx as Protocol]
from Protocol Manager,
and then click [Accept].
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3. Click the button next to the Patient Protocols title. Click
[Site], [GE], or [Picture This] from the Patient Protocol
menu. Click on the part of the Humanoid body that
corresponds to the part of the patient body that you need to
scan. (Example: Head)

4. Select the desired protocol and click [Accept] to download
the entire protocol.

5. After the category and protocol are selected, click
[Save Rx as Protocol] from Protocol Manager, and then
click [Accept] on the Save Protocol Rx window.

Protocol Manager
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Select a Registered Patient
Once a patient is ready to be scanned, this function gives you
the ability to select him/her from the patient register. The
following steps help you to select a pre-registered patient.

1. Click the Scan Rx Desktop icon.

2. Click [Patient Rx].

3. Select an entry from the Patient Register area.

4. Click [Select] to choose a patient.

5. Click [Accept] from the Patient Information window to view
the information already entered for the patient.

NOTE: Click and drag the slider to view all data in the Patient
Register area. The patient name and ID fields are 64
characters in length to accommodate long patient names
and other useful data such as session numbers, left or
right extremity, etc.

In Brief: Select a
Registered Patient

1. Click the Scan Rx
Desktop icon.

2. Click [Patient Rx].

3. Select an entry from the
Patient Register area.

4. Click [Select].

5. Click [Accept].
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Sort the Patient Register
You can sort patients within the register by three fields.

1. Click [Sort] on the Patient Register, from the Scan Rx
Desktop, giving you the ability to sort the list by:

• Patient ID number

• Patient Name

• Date / Time

Patient Register

NOTE: Only the patient ID or name is displayed if you sort by ID
or Name. To see all three sort methods, click Time in the
Sort text box.

In Brief: Sort the
Patient Register

1. Click [Sort] key to list by
ID number, Name or
Date.
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Date / Time Delete a Registered Patient
When a patient cancels an exam or does not show up for an
appointment, he/she can be deleted from the Patient Register
located within the Scan Rx Desktop.

1. From the Scan Rx Desktop, select an entry in the Patient
Register area.

2. Right click and click [cut] removing that patient from the
register.

3. Click [Confirm].

In Brief: Delete a
Registered Patient

1. From the Scan Rx
Desktop, select an entry
in the Patient Register
area.

2. Right click and click [cut],
removing that patient
from the register.

3. Click [Confirm].
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Entering Patient Information Using

Connect Pro (PPS)

Enter Patient Information Using
ConnectPro Plus (PPS)
If your facility has purchased the ConnectPro Plus (and
PPS-Performed Procedure Step) option, you can enter the
patient HIS/RIS more quickly and with more accuracy than
entering this information manually.

1. Click [New Pt], from the Scan Rx Desktop.

• Or, ConnectPro Plus can be accessed from the Protocol
Manager Desktop by clicking [Schedule Rx] in the
Protocol Prescription area. This pre-registers the patient
and attach a protocol. (You CANNOT scan from the
Protocol Manager Desktop; you can only pre-register
the patient and attach a protocol.)

2. Click [Schedule] from the bottom of the Patient Information
area.

Schedule/Patient Information

• You can type in the patient’s name in the appropriate
text box, or type in as few as two digits of the Accession
number or Patient ID number to initiate the search.

In Brief: Enter Patient
Information Using
ConnectPro Plus
(PPS)

1. Click [New Pt].

2. Click [Schedule].

3. Highlight patient and click
[OK]. Or if needed, click
the buttons across the
bottom of window to
obtain patient information
or other functions.

4. Scan patient.

5. When scanning is
complete, click [End
Exam].

6. Click [Complete], or
other appropriate button.

7. After post-processing,
click PPS, and then click
[Complete].
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3. Highlight the desired patient from the Worklist window and
click [OK] to enter the patient information and the attached
protocol into the system.

Schedule/Worklist window

• The buttons across the bottom of the Worklist (Schedule
window) allow for additional information on the patient.
See the About... section in this chapter for more detailed
information about these buttons.

• [Close] (arrow) - This button closes the Schedule
(Worklist) window.

4. Scan the patient using your facility’s normal procedures.

CAUTION:Patient data text boxes in the Patient Information area
can be edited after the data is imported from the
worklist. However, editing patient information from the
Scan Rx Desktop results in the HIS/RIS data differing
from the local patient data.
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5. Click [End Exam], after scanning is finished.

• The End PPS window appears.

6. Click the appropriate choice.

• The selection made at this window annotates this exam
in the Browser in the PPS column as follows:

° Complete - Annotates as COMP.

° Defer - Annotates as INPR (for In-Progress, exam is
still active).

° Discontinue - Annotates as DISC (for Discontinued,
exam is aborted). The Discontinued message is sent
to the HIS/RIS and therefore the exam is left on the
Worklist.

° Cancel - Annotates as INPR (for In-Progress, the
exam is still active).

Browser

NOTE: When scanning with the Imaging Option SCIC (Surface
Coil Intensity Correction) and PPS, you cannot complete
the exam when finished scanning. [Complete] is not
available on the Scan Rx Desktop if SCIC was selected.
First click [End Exam], then click [Defer]. Complete the
exam from the Browser by clicking PPS from the Browser
menu bar, and then click [Complete].
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NOTE: If you plan to apply ClariView filters to the images, and
you have used PPS, do not complete the exam when
finished scanning. Post-processing functions must be
done before the exam is completed in PPS. First click
[End Exam], then click [Defer]. Apply the ClariView
filters. Then complete the exam by clicking PPS from the
Browser menu bar, and click [Complete].

7. Once the post-processing is finished, exams with the status
of INPR need to be changed to COMP. Click PPS from the
Browser menu bar and click Complete.

Browser Menu Bar

• Once an exam is complete, a message is sent to the
radiologists’ console, the PACS, and the HIS/RIS stating
that the exam is complete and that images may be
retrieved and archived.
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Guided Install for HIS/RIS DISOMGuided Install-HIS/RIS DICOM Mode
Selecting HIS/RIS DICOM mode requires no password to
access. The following steps are used to check that the HIS/RIS
system has been configured with the MR System. The actual
configuration must be done by a service engineer with the
assistance of the facility’s Information Technology department.

Configuration of the HIS/RIS tab allows configuration of server
and port setups. and to the SCP (charge codes used by the
scanning facility when billing insurance) tab.

Mobile sites can also use the same steps as fixed sites for the
HIS/RIS DICOM install.

NOTE: Mobile users, be sure to check that the IP address and
the port number are correct on the HIS/RIS tab.

1. Click the Service Desktop icon from the control panel.

2. Click [Guided Install].

3. Select GI: HIS/RIS DICOM.

In Brief: Guided
Install-HIS/RIS DICOM
Mode

1. Click the Service
Desktop icon.

2. Click [Guided Install].

3. Select GI: HIS/RIS
DICOM.

4. Click [Start].

5. Select the HIS/HIS tab.

6. Select File > Exit.
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4. Click [Start].

• If the HIS/RIS configuration has NOT been done, you
need the assistance of your facility’s Information
Technology department and service engineer to help set
up the server and the port configurations. Continue with
step 5 when the configurations have been completed.

• The Guided Install window appears.
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5. Select the HIS/RIS tab from the top of the Guided Install
window.

• The HIS/RIS tab allows you check that the MR system
has been configured with the HIS/RIS.

• If the systems have not been configured, notify the
service engineer and facility’s Information Technology
department to complete this task.

6. Select File (arrow) in the upper left corner of the window,
and then select Exit from the menu, to exit the Guided
Install window.

NOTE: Clicking the icon, in the upper left corner of the Guided
Install window, places the icon behind the desktop icons
where it cannot be accessed.
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Guided Install-Mapping Protocols to

Action Items

Guided Install-Mapping Protocols to
Action Items
This function allows you to create the maps of protocols to
Action Items. An Action Item is the procedure that gets attached
to the patient once the patient is entered into the system from
HIS/RIS. Also, from the SCP (charge codes used by the
scanning facility when billing insurance) tab you can attach
billing codes to procedures.

This section gives step-by-step instructions to map protocols
with the Action Items.

1. Click the Service Desktop icon from the control panel.

2. Click [Guided Install].

3. Select GI: HIS/RIS DICOM.

4. Click [Start].

• If HIS/RIS configuration has been done, continue with
step 5.

• If the HIS/RIS configuration has NOT been done, you
need the assistance of your facility’s Information
Technology department and service engineer to help set
up the server and the port configurations. Continue with
step 5 when the configurations have been completed.

In Brief: Guided
Install-Mapping
Protocols to Action
Items

1. Click the Service
Desktop icon.

2. Click [Guided Install].

3. Select GI: HIS/RIS
DICOM.

4. Click [Start].

5. Select the SCP tab.

6. Click A.I. Code from
HIS/RIS area. Type in
desired code.

7. Select A.I. Code from the
system area and type in
same code as step 6.

8. Select the desired
Protocol library.

9. Select the protocol to
map with, from the
system protocol libraries.

10. Select the desired
Protocol Category.

11. Select the desired
protocol.

12. Click [Save].

13. Select File > Exit.
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• The Guided Install window appears.

Guided Install window

5. Select the SCP tab from the top of the Guided Install
window.
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• The SCP Display window appears.

Guided Install window

• The top display box (1) shows the HIS/RIS Action Item
Codes and the protocols linked to them. The lower two
display boxes show the Action Item Codes for the
system (2) and the system protocol (3) libraries.

6. To map protocols, select the procedure number from
HIS/RIS Action Item Code (area 1), and type in desired
code, such as CPT code.

7. Select the procedure number from system Action Item Code
(area 2), and type in the same number (code) used in the
HIS/RIS Action Item Code.

8. Select the desired Protocol Library.

9. Select the protocol to map with from the system Protocol
libraries (area 3).

10. Select the desired Protocol Category.

11. Select the desired protocol.

1

2
3
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12. Click [Save] to save the mapping of the Action Item Code
with the selected protocol.

• Click [Delete] to remove the mapping of this protocol to
the Action Item Code.

• Click [Cancel] to cancel the mapping the process.

NOTE: Click [Help] to display step-by-step instructions for the
mapping procedure. Refer to [Help] when you have
questions about the Guided Install.

13. Select File (arrow) in the upper left corner of the window,
and then select Exit, to exit the Guided Install window.

NOTE: Clicking the icon, in the upper left corner of the Guided
Install window, places the icon behind the desktop icons
where it cannot be accessed.

Guided Install - HIS/RIS DICOM Mode
To connect the HIS/RIS and the MR system to activate Connect
Pro, you need the assistance of your facility’s Information
Technology department and service engineer to help set up the
server and the port configurations.
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Image Storage Assign Image Storage
You can decide the meaning of the “Y” or “N” label in the
archive column displayed on the Browser’s exam list. If you
have a PACS (Picture Archival Computerized System), you can
set the archive column of the Browser, such that “Y” means the
images have been successfully transferred to the PACS. The
archive column can also be set to mean that the images have
successfully transferred to the MOD.

1. Click Network from the Display or Image Management
Browser menu bar.

2. Select Selected remote host from the Network menu.

• The Remote host selection window appears.

3. Select one entry (1) from the Remote host list.

4. Click [Update] (2) from the Remote host selection window.

In Brief: Assign
Image Storage

1. Click Network.

2. Click Remote Host.

3. Select an entry.

4. Click [Update].

5. Click Yes, No, or Auto.

6. Click [Save].

7. Click Archive.

8. Click Select Archive
Device.

9. Click Remote or Local.

10. Click [Scan Modes] and
click Auto Archive on.

1

2
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5. In the Archive Node area of the remote Host Parameters
window, do one of the following:

• Click Yes to have the archive “Y” label represent the
successful transfer of images to the PACs system.

• Click No to have the archive “Y” label represent the
successful transfer of images to the MOD.

• Only click Auto to test if the auto archive function is
operational.

6. Click [Save] to close the window and save your changes.

7. Click Archive (1) from the Browser menu bar.

8. Select Selected archive device (2) to display the Archive
Device Selection window.

9. Click Remote as the archive destination if you want the
archive label “Y” to represent that an exam has successfully
transferred to the PACs system.

• Click Local as the archive destination if you want the
archive label “Y” to represent that an exam has
successfully transferred to a MOD.

10. Click [Scan Modes] from the Rx Manager window, and turn
on Auto Archive.

Something to Think About...

• Currently, there is no mechanism for labeling both the
successful transfer of images to MOD and PACs
system.

• The archive destination selection (Local or Remote)
must synchronize with the archive label (Yes or No)
selected from the Remote Host Selection window.

• If Remote is selected as the archive destination device,
verify that the PACs system is not on the Auto Transfer
by Exam or Series list of nodes. The PACs system
should not be an end destination for both Auto Archive
and Auto Transfer.

1

2
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Where Am I?
Volume 1

Chapter 7

Scanning with a
Protocol

Introduction

This chapter focuses on prescribing and performing scans using a
protocol. It highlights key concepts and provides brief guidelines for
registering a patient, selecting a protocol, editing a series,
prescribing scan locations and saturation bands, and scanning a
series. It also contains instructions to help you learn how to:

• Prepare the Patient for the Exam

• Start a Scan Prescription

• Transfer the Patient to the System Table

• Position the Patient

• Align and Landmark

• Select a Protocol

• Edit Protocol Parameters

• Define the Scanning Range

• Define Saturation Bands

• Scan
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In addition, this chapter answers the following questions:

1. What types of protocols are available?

2. What functions are controlled in the Rx Manager?

3. How does graphic prescription define an area?

4. What is the general purpose of pulse sequences?

5. What is the general purpose of imaging options?

6. What factors affect contrast?

7. What factors affect spatial resolution?

8. What factors affect scan time?

9. What factors affect SNR?

10. What types of saturation techniques are available?
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About... Scanning
This section presents the concepts necessary to successfully
complete a scan prescription process and begin scanning.
Specifically, you need to understand:

• Protocol Libraries
° Picture This Library
° Site Library
° GE Library

• Rx Manager
° Series List
° Scan Modes
° Gating Control

• Pulse Sequences

• Imaging Options

• Parameter Trade-offs
° Factors that Affect Contrast
° Factors that Affect Spatial Resolution
° Factors that Affect Scan Time
° Factors that Affect SNR

• Defining a Scanning Range
° Explicitly
° Graphically
° Radial Graphically

• Defining Saturation Bands
° Spatial Saturation
° Chemical Saturation
° Graphic SAT Prescription
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Protocol Libraries
The Signa® system is designed to optimize productivity, and
preprogrammed protocols are a significant factor in simplifying
exam set-up.

Your MR system has 3 libraries of protocols:

• Picture This

• Site

• GE

The protocol list is available in the Patient Protocols area.

Each library contains eight protocol categories:

• Head

• Neck/Cervical

• Chest/Thoracic

• Upper Extremities

• Abdomen/Lumbar

• Pelvis

• Lower Extremities

• Other

Protocol categories can contain up to 100 protocols, with up
to 100 series each.
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Picture This Protocol Library
The Picture This library contains pre-programmed protocols
and an image gallery.

• Each sub-series includes three category choices: standard,
faster, and higher resolution. Each contains sample images
to assist selection.

• The Picture This protocols do not allow scan parameter
changes other than the entry of start and end locations and
prescription of saturation bands.

• The Picture This window reflects the scan time of the series
as it is built into the Picture This program. Each Picture This
series has a value entered for the number of slice locations
(or number of slabs for 3D) and the scan time in the Picture
This window that reflects that value. If the number of scan
locations is changed (at either the Graphic Rx or Scanning
Range area), and that change results in an increase or
decrease in the number of acquisitions, the actual scan time
reflects the number of acquisitions.

Site Protocol Library
The Site library does not contain any pre-programmed
protocols initially. You create and save your own protocols into
the Site library; the GE protocols can be used as a starting
point.

GE Protocol Library
The GE library contains pre-programmed protocols that include
the protocols from the Picture This library, as well as, additional
protocols. The GE library does not contain sample images but
does allow scan parameter changes. You can edit protocols
from the GE library and save them to the Site library.
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Rx Manager
The Rx Manager is used to create, view, edit, and prepare
series for scanning. A series list is created in the Rx Manager
upon selection of a protocol. The Rx Manager reduces scan
prescription time by using predefined patient protocols and has
time-saving benefits of multiple prescribe ahead series
concurrent with scanning. It also provides access to the scan
mode selection and gating control.

The Rx Manager is located on the left side of the Scan Rx
Desktop appears after the selection of a protocol.

The Rx Manager has several
controls for starting and ending
an exam or pre-programmed
protocol. The status of a series
is listed in the window with the
series description.
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The following table describes the function of the controls in the
Rx Manager.

NOTE: For additional information on the Rx Manager Scan
Modes and Gating Control functions refer the chapter
Scan Rx Desktop.

Rx Manager List
The Rx Manager List shows the prescribed series state and
series description. All scan information can be recalled by
selecting and copying a series. This allows you to repeat a

Selection Description

[Scan Modes] Sets Auto Archive, Auto Transfer, and system
operation mode.

[Gating
Control]

Controls the waveform display.

[New Series] Adds a blank series to Rx manager.

[End Exam] Ends the current exam and returns the desktop to
the Patient Register.

[View Edit] Allows modification of parameters.

[Prepare to
Scan]

Activates Scan Operations area with parameters of
highlighted series.

[Save Rx as
Protocol]

Saves a Rx to the Site Protocol list with a
user-defined name.

[AutoScan] All series in RXD state in the Rx Manager are
automatically scanned.

[AutoStep] Automatically scans data acquisitions containing
different stations with MultiStep option.
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series exactly, without entering any information. Series are
loaded from the protocol library into the Rx Manager.

Each series in the Rx Manager list contains three pieces of
information:

• The current state.

° NEW- series is not yet prescribed or saved and cannot
be scanned.

° INRX- (in prescription) series is opened, not yet saved,
and cannot be scanned.

° RXD- (prescribed) series is saved and can be scanned.
° ACT- (active) series is ready for scan and can no longer

be edited.

° SCND- (scanned) series has been scanned and can no
longer be edited but can be re-scanned.

° PSCD- (prescanned) series is pre-scanned and ready for
scan (can no longer be edited).

• The series number. A series number is not assigned until
the scan is initiated.

• The series description.

For example, a typical series of entries in the Rx Manager
List might include:

SCND 1. Sagittal T1 Loc

This indicates the series has been scanned, was the first
series, can be used as a localizer, and remains in the list
for easy access to the scan values.
ACT 2. Axial T2
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This indicates that this scan was the second series and
is currently being scanned or it is ready to scan.
RXD 3. Axial T1 Pre
This indicates that this scan is the third series and is
ready for downloading.
INRX 4. Coronal T1 Pre
This indicates that the scan is the fourth series and has
not been saved, it is being view/edited.
NEW 5. Sagittal T1 Pre
This indicates that the scan is the fifth series and has not
been saved, nor is it being view/edited.

Something to Think About...

• Select the entries in the Rx Manager list in any order.

• The series highlighted in the Rx Manager is not
necessarily the series being viewed on the desktop. The
series in the INRX state is the series on the desktop.

• If a series on the desktop in the INRX state is saved and
the [Scan] button is selected, the system does not scan
this series (the one on the desktop) but repeats the scan
on the series previously scanned or in the ACT state.

• Series from different protocols can be added to the list.
For example, if the current patient exam is a thoracic
and lumbar spine study, the list can be arranged to have
both exams ready to scan. Keep the landmark and
orientation the same for each scan.

• The Rx Manager list is created as soon as a protocol is
selected. Select any series in the list and prescribe slice
and SAT locations, change the stored protocol values,
and save the protocol to the Rx Manager. The process
can be repeated for as many series as needed.

New Series
New Series adds additional series to a patient’s exam. It is
tracked in the Rx Manager list and begins at the Patient
Position. Select this button to add an additional series to the Rx
Manager.

Selecting a New Series in the Rx Manager is only available with
GE or Site protocols. New Series is not available after selecting
Picture This protocols.
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Something to Think About...

• A series cannot be scanned unless a series is saved.
Saving the series changes its status from INRX (in
prescription) and places it in the prescribed or RXD
state in the Rx Manager.

• The system automatically downloads the first series
and, therefore, selecting the [Prepare to Scan] button is
not required.

End Exam

End Exam completes the current exam. It separates patient
exams or anatomical regions for one patient.

Completing an exam with this key:

• Changes the status of the exam from current to completed.

• Closes the scan s and displays the Patient Register.

• Makes New Patient selection available for the next patient
or anatomy to be scanned.

• Makes the exam number available for archiving

• Removes the current images from the Autoview Window
memory buffer.

Something to Think About...

• Once you select the [End Exam] button, no more
images can be added to the exam number.

• You must select the [End Exam] button before Auto
Store can save the exam’s images to the MOD.

View Edit

View Edit allows you to review or edit a series in the Rx
Manager. It can also be used to adjust a scan range after
viewing the most recent acquisition.
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With View Edit, a series can be modified and saved again. A
new series in the Rx Manager list changes to INRX if a View
Edit is performed.

Something to Think About...

• If you view or edit another series before a Save Series is
initiated for the current series (INRX), changes for the
current series (INRX) are saved and the INRX series is
relisted in the Rx Manager as NEW.

• You can view but not edit a series that has a status of
ACT or SCND, even though the status of the series
changes to INRX.

Prepare to Scan

Prepare to Scan changes the status of a series from prescribed
(RXD) to active (ACT) or ready to be scanned.

The system automatically moves the first series in the Rx
Manager list to active status.

Something to Think About...

• Prepare to Scan is not needed if AutoScan is selected.

• Prepare to Scan is not needed for the first series of an
exam.

• Prepare to Scan is required to download series on an
individual basis.

• The series highlighted in the Rx Manager is the series
prepared. Note that the series represented on the Scan
Rx Desktop is not necessarily the series highlighted in
the Rx Manager.

Save Rx as Protocol

Save Rx as Protocol is used to save the current prescription as
a site protocol. You must define the protocol name. This allows
you to build predefined site protocols to reduce prescription
set-up time and increase productivity.
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The entire series list in the Rx Manager is saved as a protocol in
the site protocol list.

Auto Scan

Auto Scan automatically downloads, prescans, and scans all
RXD series in the Rx Manager. This feature extends the
multi-tasking capabilities by allowing you to prescribe multiple
scans in advance.

The next RXD series in the list begins automatically when
AutoScan is selected. All RXD series in the Rx Manager list are
scanned sequentially.

Something to Think About...

• Auto Scan turns OFF if:

° A table move is required (Move to Scan).

° Move to scan is not activated after two audio alarms
and scan times out.

° A contrast series is in the queue following a
non-contrast series.

° A new landmark is selected.

° New Patient or a patient from Patient Register list is
selected.

• The following describes the behavior of
contrast-enhanced series when Auto Scan is active:

° AutoScan is on and there are no series in the Rx
Manager in the RXD state.

° When the first series containing contrast On is ready
to scan, the contrast injection message box
appears. You must select the [OK] button to
proceed.

° The contrast message does not appear again in this
exam for subsequent contrast-enhanced series. An
exception to this occurs when there is a series
prescribed with contrast followed by a series
prescribed without contrast, then another series with
contrast selected on. The contrast injection
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message appears again following the no contrast
series.

• If Auto Scan is turned on and there is no series in the Rx
Manager in the RXD state but a series in a SCND or
ACT state has been copied, the system
AUTOMATICALLY changes its status to RXD. The
system scans this series before there is a chance to edit
the copied series.

AutoStep

AutoStep provides automatic table movement and scan
initialization for data acquisitions containing more than one
station, until all stations are acquired. It is available with the
MultiStep imaging option in the SmartStep software purchase
option.

AutoStep becomes available with a SmartStep meta-series. All
prescribed stations in the meta-series must be saved and
prescanned before selecting AutoStep to initiate the acquisition.

NOTE: For additional information on the AutoStep options refer
to the chapter Bolus Chasing with SmartStep, Volume 4.

Pulse Sequences

Pulse sequences determine the type of RF and gradient pulses
used to excite and rephase the nuclei.

Pulse sequences are used to create and control contrast and
can be divided into six categories based on how they
regenerate the echo signal and fill k-space:

• Standard Spin Echo Sequences

• Fast Spin Echo Sequences

• Gradient Echo Sequences

• Vascular Sequences

• Echo Planar Sequences

• Spectroscopy Sequences
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NOTE: For a better understanding of how pulse sequences
collect data and create contrast, refer to Volume 2.

Imaging Options

Imaging options are used to control artifacts, enhance
resolution and contrast, minimize motion, and improve SNR.
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NOTE: For a better understanding of how imaging options
improve image quality refer to the chapter Optimizing
Images with Imaging Options, Volume 3.

Parameter Trade-offs
During protocol prescription, you use your knowledge of MR
physics. Certain situations warrant trading scan time for
contrast, resolution or coverage. Others require careful
consideration of SNR. In the following section, these parameter
trade-offs are discussed, as well as, their effect on image
quality.

Factors that Affect Contrast

Contrast resolution is an image function providing the ability to
differentiate the signal intensities of one anatomical region with
respect to surrounding anatomical regions. This helps to
distinguish pathology from normal tissue. Contrast is directly
affected by scan timing parameters such as TR, TE, TI, and flip
angle. The SNR can enhance or obscure contrast but cannot
change the image weighting from one type of contrast to
another.

• Proton Density, T1, and T2 components affect all images to
some degree; however, the goal is to use pulse sequences
and scan timing parameters so that one component affects
contrast more than the others:

° In a T1-weighted image, variation in T1 relaxation has
the most significant impact on contrast.

° In a T2-weighted image, variation in T2 relaxation has
the most significant impact on contrast.

° In a PD-weighted image, variation in proton density has
the most significant impact on contrast.

• Scan timing parameters have minimum or maximum limits,
depending on the type of pulse sequence. You can use
parameters within these limits to produce the desired type of
contrast in your images.

• Certain imaging options also affect image contrast:

° Chemical Saturation
° Magnetization Transfer
° SPECIAL
° Classic
° IR and DE Prepped
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° Surface Coil Intensity Correction
° Full Echo Train
° Tailored RF

Factors that Affect Spatial Resolution

Spatial resolution is the ability to distinguish two points as
separate and distinct. Spatial resolution is measured in line
pairs. The size of the line and space between determines the
resolution.

Spatial resolution is affected by voxel size. Voxels are three
dimensional elements that make up the image. Voxel size is
controlled by:

• Slice thickness

• Matrix

• FOV

Slice thickness
controls the
depth of the
voxel.

Matrix and FOV
control the in
plane height and
width of the voxel.
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A single intensity value is assigned to each voxel.

Spatial Resolution Formulas:

• Phase FOV ÷ Phase Matrix* = Phase Dimension (Pixel
Width)

• Frequency FOV ÷ Frequency Matrix* = Frequency
Dimension (Pixel Height)

• Phase Dimension x Frequency Dimension = Pixel Area

• Pixel Area x Slice Thickness = Voxel Volume

NOTE: *Matrix refers to the actual gradient encoding parameter
and not the reconstruction parameter.

Imaging Options that enhance spatial resolution:

• Square Pixel

• Matrix ZIP

• Slice ZIP

Factors that Affect Scan Time
The factors that affect scan time per acquisition depend on the
pulse sequence and scan mode.

To calculate the scan time for certain pulse sequences and
scan modes:

• 2D Spin Echo or a 2D Multi-planar Gradient Echo Sequence

TR x Phase Matrix x NEX x Number of Acquisitions

• 2D Fast Spin Echo Sequence

x Number of Acquisitions

• 3D Fast Spin Echo Sequence

x Number of Slices per Slab

Structures smaller
than the voxel create
a partial volume.

TRxPhaseMatrix xNEX( )
ETL

----------------------------------------------------------------------

TRxPhaseMatrix xNEX( )
ETL

----------------------------------------------------------------------
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• 2D Sequential Gradient Echo Sequence

TR x Phase Matrix x NEX x Number of Slices

• 3D Gradient Echo Sequence

TR x Phase Matrix x NEX x Number of Slices x Number of
Slabs

• Echo Planar Sequence

TR x NEX x Number of Shots

Factors that Affect SNR

SNR is the ratio of the amplitude of the signal received by the
coil to the amplitude of noise or undesired signal.

Noise is undesirable signal that is generated from the patient,
the environment, and the system electronics. The bigger the
parcel of information, the more signal contributes to it.

Everything affects SNR in some way; some parameters have a
minor impact and some have a major impact.

• Patient and System

• Pulse Sequences and Contrast Parameters

• Spatial Resolution Parameters

• Receive Bandwidth

• NEX

• Flip Angle

Noise is random, but constant.

High SNR Low SNR
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Spatial Resolution Parameters and SNR

SNR decreases as spatial resolution increases due to the
smaller voxel size.

Select the slice thickness and FOV to balance resolution and
SNR needs.

• Increasing slice thickness decreases the resolution but
increases the signal-to-noise ratio.

• Select the FOV to balance resolution and SNR needs.
° Increasing the field of view decreases the resolution and

increases the signal-to-noise ratio.

Matrix size affects SNR.

• More phase encoding samples increase SNR, but decrease
the size of each individual pixel and therefore, decrease
signal and signal-to-noise.

Larger voxels contain
more nuclei that
produce more signal

As voxel size increases, SNR increases.
As voxel size decreases, SNR decreases.

SNR SliceThicknessNew
SliceThicknessOld
---------------------------------------------------------=

SNR FOVnew
FOVold
-------------------------

 
 

2
=

SNR PhaseEncodesNew
PhaseEncodesOld
---------------------------------------------------------=

SNR FrequencyEncodesNew
FrequencyEncodesOld
----------------------------------------------------------------------=
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Receiver Bandwidth and SNR

The receiver bandwidth (RBw) is measured as the range of
frequencies in kHz. It is the rate at which the echo is sampled
by the readout gradient.

By changing the value of the bandwidth, you can control how
many frequencies are going to be read in each echo. This
determines how much signal-to-noise is in each image.

SNR decreases by increasing the RBw. Refer to the following
figure. As the window narrows, less noise is detected. As the
window widens, more noise is detected.

Sampling rate controls the receive bandwidth. The narrower the
bandwidth, the slower the sampling rate.

Sampling rate also affects readout time. This is shown in the
following figures.

A receiver band with a plus or minus 16 kHz means that we are
sampling 16 kHz or 16,000 Hz each side of center frequency,
for a total of 32,000 kHz.

Narrow
Window

Wide Window
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Slower sampling requires a longer readout time.

Faster sampling allows for a shorter readout time.

Decreasing the RBw has many trade-offs. The following are a
few of the trade-offs that occur.

• Decreasing RBw increases chemical shift. Chemical shift is
typically matched in the frequency direction of an image,
and it occurs because fat and water precess at different
frequencies.

• Decreasing RBw also increases the minimum TE available
for a given TR. As you increase the minimum TE, you
increase the amount of motion that you could potentially get
in your resultant scan. Remember, motion appears in our
echo because of the time that lapses between when our
phase-encoding gradient is applied and our echo is read.

• Since the RBw controls the length of time that the receive
window is open, it can have a major impact on the
appearance of motion in our MR image.

NEX and SNR

The number of signal averages or NEX can also impact SNR.
NEX is the number of times that you repeat the entire scan
process.

Select the NEX to balance scan time and SNR needs.

• As the number of samples increase, the SNR increases.

• This relationship is not linear.

For example, if you double the NEX from 2 to 4, the signal
increase equals the square root of 4 divided by 2, which
equals the square root of 2, which equals 1.41. Doubling the
NEX doubles the scan acquisition time but produces a 41%
increase in signal-to-noise.

SNR NEXnew
NEXold
-------------------------=

4
2
--- 2 1.41==
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Something to Think About...

• Resolution and SNR work in complete opposition to
each other. Each time you make a field of view, matrix,
or slice thickness choice, make sure that it is a careful
blend of achieving a resolution good enough to make a
diagnosis, without resulting in a signal-starved image.

• As a rule of thumb, SNR decreases as TR decreases or
TE increases.

• Decrease bandwidth to balance minimum TE, minimum
echo space, and SNR needs.

NOTE: Do not forget to refer to the Relative SNR meter and
compensate for SNR changes.

Defining a Scanning Range

The Scanning Range is where you define the Field of View
(FOV), the slice thickness and spacing, location of the slices
and FOV center, and the number of slices in the acquisition.
The entries can be made explicitly or graphically for the scan
locations, FOV center, and slice number.

Explicit Prescription

Explicit prescription allows start and end locations and the
number of locations to be entered explicitly in the Scanning
Range without entering the Graphic Rx.

Explicit prescription can be used to prescribe a single group of:

• 3 Plane Localizer pulse sequence

• 2D orthogonal slice locations

• 2D oblique slice locations

• 3D orthogonal volumes

• 3D oblique volumes

Explicitly prescribe a series of scan locations by entering
coordinates in the Scanning Range that represent the desired
coverage of the anatomical locations. The actual end and total
number of slices or slabs are calculated by the system and are
displayed in the Scanning Range area.
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Graphic Prescription
Graphic Prescription (Rx) is used to graphically define the scan
locations using a cursor on a localizer image. To graphically
prescribe orthogonal scan locations, the localizer image must
have the same landmark and must not be in the same plane as
the series being prescribed. Oblique slices can be prescribed
from an orthogonal or an obliqued scan prescription.

Graphic Rx can prescribe single or multiple groups of:

• 2D orthogonal slice locations from an orthogonal localizer

• 2D oblique slice locations

• 2D oblique slice locations with multiple angles

• 2D radial slice locations

• 3D orthogonal volumes from an orthogonal localizer

• 3D oblique volumes

When a localizer image is acquired, the Graphic Rx icon is
available in the Additional Parameters area.

The Graphic Rx screen appears when the icon is selected.
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The following table gives a description and acceptable values
for each selection on the Graphic Rx screen.

Selection Description

[Erase Group] Erases a deposited group of slices.

[Erase All] Erases all deposited slices.

[Reset Center] Allows you to page through a data set and reselect a new
center image for prescription.

# of Slices The number of slices prescribed for a radial graphic
prescription. The maximum allowable is 16.

Radial Dir. Clockwise and counter clockwise directions for radial
prescription. System defaults to clockwise.

Instructions
for Add Group

Adds a group of slices in a different location.

[Tracker] Defines the tracker slice location and thickness in a
SmartPrep acquisition.

[Fallback to
R0]

Moves the slice centers from off center prescribed position to
isocenter in the slice select direction of localizer image.

SAT icon Opens the SAT screen. The currently prescribed slices are
automatically accepted.

[Copy Rx] Copies a previous Rx with the same FOV, slice thickness, and
spacing. A single click on the desired series to copy followed
by [Accept] displays the same slice locations on the currently
displayed image. A double-click displays image used to
prescribe slices for the copied series and the slice locations.

[Accept] Registers slice prescription and exits Graphic Rx.

[Display
Normal]

Returns the displayed image to its default size.

Zoom Adjusts magnification factor for displayed images using the
slider.

Text Box Enters series and image number for the images to be
displayed.

[Select Series] Lists valid series from which a localizer image can be
selected.

[Select Image] Lists the images for the selected series.

[-] [+]
(prior/next)

Displays the previous or next image in the series from the
currently displayed image.

Image View
Port

Displays the middle slice of the most recent series which
could be used as a localizer.

Auto W/L Selects the window level mode to auto.
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Graphic Rx is available only if a valid localizer exists; the plane
of the localizer cannot be the same as the plane of the
prescription INRX. The exception is an oblique image which can
be used to prescribe oblique locations.

The system automatically displays the center image of the most
recent valid series that can be used to select a localizer image.
Use [Select Series] and [Select Image] to select a different
image to be used as a localizer.

To edit FOV, slice thickness and spacing for a prescribed series,
Graphic Rx must be open.

Once slices have been plotted, numeric values for the start/end
locations, FOV center, and the number of slices prescribed
appear in the Scan Location text boxes in the Scanning Range
area.

The line cursor in graphic prescription has several meanings:

• The tic line on the line cursor represents the FOV center.

• The length of the cursor represents the FOV coverage.

• The cursor handles for oblique slices are used to define tilt.

Click and grab on one
of the circular handles
to tilt the line cursors.
(Oblique plane only.)

Click, grab, and drag
the diamond tic mark
to add or remove slic-
es from the prescrip-
tion.

Click, grab, and drag
the square to + or - slic-
es from the prescrip-
tion, and tilt the line
cursor. (Oblique Plane
only.)

Click anywhere on the line cursor other
than the handles, and drag the mouse
to adjust the position of the cursors.
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In 3D prescription, the box displayed represents the size of the
imaging volume based on FOV, slice thickness, and number of
scan locations selected in the scanning range. Oblique 3D has
the same operation on the graphic slabs as in the 2D oblique
mode. The tilt angle handle, slice prescription handle, and tilt
angle-slice prescription handle are available. Multi slab and
single slab prescriptions are also available.

The localizer image can be magnified or minified.

If the number of slices is defined prior to opening Graphic Rx,
that number of slices automatically appear when you click on
the image.

Copy Rx

Use Copy Rx to copy the slice locations of a previous prescrip-
tion in the same exam for use in a new series.

To use Copy Rx the following requirements must be met:

• The plane of the current prescription must be the same as
the plane of the series to be copied. For example, to copy
the slice locations of an axial series, the selected scan
plane (at the Imaging Parameters) for the current
prescription must be axial.

• FOV and slice thickness of the current prescription must be
selected before entering Graphic Rx and must be set at the
same values as the copied series.

• When copying an oblique series that was prescribed from
an oblique localizer, one of the following must be true:

° The localizer used for the current prescription must be
from the same series used for the copied series, or

° The localizer used for the current prescription must be an
oblique image of the same plane and have the same tilt
angle as the localizer used for the copied series.

The Graphic Rx series list, which opens when the [Copy Rx]
button is selected, lists only those series in the exam which
meet the necessary requirements. If there are no series
meeting those requirements, the series list window does not
appear and a message is posted in the Advisory Panel after
selecting the [Copy Rx] button.
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Reset Center

The Reset Center option allows you to graphically prescribe
your locations on one slice location and redefine a new center
image at another slice location.

A message appears on the left side of the Graphic Rx screen
displaying the number of the localized image.

Redefining the center image can be useful when prescribing
axial orbits or shoulder images. For example, use a sagittal
image where you see the optic nerves to prescribe the slice
locations, then move to the center of the image and select the
[Reset Center] button.

Fallback

Fallback moves the slice centers from their graphically
prescribed position to isocenter, along the localizer slice-select
direction. This can be in either the phase or frequency direction
for the prescribed slices.

Changes to the Graphic Rx are not readily noticed, but the
resulting images fall back to isocenter in the slice select
direction for sagittals and coronals. The fallback occurs only in
the slice-select direction of the localizer and the imaging plane
determines the phase and frequency direction.

Something to Think About...

• The numbering of the slices within a graphic prescription
group are numbered per group and not by the total
number of slices. If you have prescribed three groups of
three slices, each group has 1, 2, 3 slice numbers. For
example:

° Numbering prior to 8.3 software:1-3, 4-6, 7-9

° Numbering now:1-3, 1-3, 1-3

• If Fallback is used, make sure the FOV is large enough
to include the anatomy of interest when the FOV falls
back. Of course, as FOV increases, resolution
decreases. The system does not prevent you from
scanning any FOV with an offset.
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Multi-Plane Graphic Rx

It is possible to prescribe multiple groups of slices within one
acquisition. This is useful when an entire range of slice
locations is not desired or needed for a given anatomical body
part (e.g., axial spine and sagittal TMJ examinations).

If using a FSE-XL pulse sequence, a user CV becomes
available with this prescription.

You must define the acquisition order by selecting an
Interleaved Acquisition or a Sequential Group. Selecting
Sequential Group (1) results in a Multi-Slice Multi-Angle
(MSMA) acquisition and selecting Interleaved (0) results in a
Multi-Slice Multi-Group (MSMG) acquisition.

MSMA means that all prescribed slices are acquired within a
single acquisition and MSMG means that only the slices within
an angled group are acquired within a single acquisition. Three
angled groups of slices therefore results in three separate
acquisitions.

MSMA is compatible with FSE-XL, GRE, and SE pulse
sequences. Note that, artifacts ranging from dark banding to
low SNR to tissue contrast changes are likely to occur when
MSMA angles intersect. To avoid these cross-talk artifacts, do
not intersect the slices within the anatomy of interest. There is
no cross-talk artifacts in MSMG.

Radial Graphic Rx

Radial Graphic Rx allows multiple slices to be acquired around
a central axis in the same series. Radial and partial radial
graphic prescription is available with FSE-XL, FastCard, and
SSFSE pulse sequences. This type of prescription can be
useful for imaging, but not limited to, knees, MRCPs,
myelograms, and hearts.
7-28 2292261-100 Rev. 0 (03/01)



Scanning with a Protocol
The Graphic Rx screen contains the radial and partial
prescription parameters.

You must define the number of slices and the radial direction
while prescribing the acquisition.

• The system defaults to one slice and clockwise rotation.
These settings can be changed.

• The maximum number of acquisitions in one prescription is
16. If this limit is exceeded, an error message appears and
you are not be able to accept the prescription.

• The radial direction can be clockwise or counterclockwise.

• The # of Slices and Spacing text boxes control the angle
between the slices of the radial prescription.

For example, if you select 5 slices in the radial parameters
and leave the Partial Radial Spacing text box empty, your
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graphic prescription looks like a wagon wheel with a 36°
angle between each slice.

If you select 5 slices in the radial parameters and 5° in the
partial radial spacing parameter, your graphic prescription
looks more like cat whiskers and there are 5° between each
slice location.

Something to Think About...

• When prescribing a second group, you must first enter
the number of slices and the radial spacing before
placing the cursor on the image and clicking. Once the
Rx is prescribed on the image, you cannot change it.
You must select the [Erase Group] or [Erase All]
button, enter in the new values, and click the image to
view the new prescription.

• Set the number of locations before pause to zero if all
slices are the same angle. This allows you to scan all
slices in one breath hold. For multiple shorter breath
holds, type in any number to break up the group.

• Set the number of locations before pause to zero or one
for a radial prescription. If you select one, the system
pauses after each slice and you need to click the [Scan]
button for each slice. Although zero is compatible, it
causes cross-talk where the slices intersect.
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• Set the locations before pause to the number of slices of
the largest group when using MSMA. This enables you
to scan one group or one angle at a time.

NOTE: After entering your graphic prescription, enter the number
of locations before pause. The number of locations before
pause can be of a confusing nature. If you select zero,
you do not have to push the scan button for every slice
(angle), but you may have cross talk problems. If you
select one, you control the scan, so you could let the
tissue relax by waiting a few seconds before pressing the
scan button.

Since each slice is an angle and each angle is a group,
the maximum number of locations before pause is
always one unless you prescribe an oblique group on the
same series.
For example, if you prescribe a radial scan with 4 slices
and an oblique group with 8 slices, you could enter 8 in
the # of Locs Before Pause text box. You would start
the scan, the system would acquire those 8 slices, then
you would hit scan four more times (one for each slice) to
acquire the radial. The oblique slices in the group (single
angle) would let you select 4 (or whatever number of
locations before pause). See example below:

NOTE: Graphically prescribed locations override an explicit
prescription.

NOTE: For additional information on the Additional Parameter
Graphic Rx, refer to the chapter Scan Rx Desktop.
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Defining Saturation Bands
The additional parameter SAT option allows explicit or graphic
prescription of presaturation (SAT) pulses on a localizer image
from a valid series. A valid series is any prospective orthogonal
series in the current exam with the same landmark. Oblique and
collapsed vascular images cannot be used.

A combination of RF and gradient pulses decrease SNR in
specific locations where spatial SAT has been supplied. SAT
pulses can be applied spatially to saturate an entire area of
tissue or chemically to saturate (suppress) specific chemical
components.

Spatial Saturation
Spatial saturation pulses are 90° RF pulses applied before the
slice-selective excitation pulse. They deliver the RF pulses to
anatomy outside or inside the imaging volume to saturate
nuclei, so that the signal from this area does not contribute to
the image.

The following basic pulse sequence diagram shows the
location of the SAT pulse.

Shortly after the 90° SAT pulse, the 90° slice excitation
pulse is applied. The tissues affected by the SAT pulses do
not have time to adequately recover, thus, there is little or
no longitudinal magnetization to excite from these tissues
and little or no signal is produced. Immediately following the
SAT pulse, a dephasing gradient is applied to dephase the
spins in the region of the SAT pulse. A combination of RF
and gradient pulses decrease SNR in the locations spatial
SAT has been applied.

There are three types of Spatial SAT:

• Conventional SAT (SAT outside of the FOV)

• Concatenated SAT

• SAT in the FOV

Conventional SAT (SAT outside the FOV)

A conventional SAT pulse applies extra RF pulses outside the
FOV to minimize the signal from protons flowing into the FOV. If
7-32 2292261-100 Rev. 0 (03/01)



Scanning with a Protocol
blood is flowing along the slice-select axis, blood from outside
the imaging volume flows into the entry and exit slices. This
blood has not experienced RF excitation.

Spatial presaturation can reduce the signal from moving spins
by saturating them before the spins move into the area being
imaged. SAT pulses are generally applied in the slice-select
direction to saturate blood that may flow into the slice and
cause either flow-related enhancement (bright blood) or
phase-blurred artifact.

Conventional Spatial SATs outside the FOV are useful to
suppress the signal from protons that move within the imaging
FOV, such as:

• Cardiac imaging

• Cervical, thoracic, and lumbar spines

• Body

• Joints

• Axial heads

Something to Think About...

• Without conventional SATs:

° Bright signals can mask certain pathological states
such as thrombus.

° If the blood signal is bright, phase artifacts may
appear bright across the image in the phase
direction.

• SAT increases RF exposure to the patient and increases
the SAR, especially for SAT pulses in more than one
plane. This reduces the number of slices permitted.

• In general, if TR divided by the number of slices is
greater than 150 ms, SAT may not be effective.
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Concatenated SAT

Concatenated SAT makes spatial SAT “move along” with
slice-select acquisitions for even more effective suppression of
motion in the slice-select direction of concatenated acquisitions.

If the prescription is compatible with concatenated SAT, the
[Concat SAT] button can be selected and the SAT pulses are
automatically concatenated if:

• A SAT band is prescribed in the slice-select direction,
without explicit instructions.

• More slices than a single TR can accommodate are
prescribed resulting in a concatenated scan.

• The thicknesses of each slice of a pair, in the slice-select
direction, are equal.

With a concatenated SAT activated, SAT overall performance is
improved, especially when the scanning range is large enough
to give presaturated protons time to recover before they reach
the middle slices, when there is blood flow in the slice-select
directions, and when the SAT pulses are outside the scanning
range.

• When a Concatenated SAT is selected, the scanning range
is divided into groups composed of contiguously ordered
slices. For each acquisition, it moves the slice-select SAT
pulses to presaturate regions outside of the acquisition
range.

For example, in a ten-slice, two-acquisition prescription, the
SAT pulses would be applied first around slices 1 to 5, and
then around slices 6 to 10. Slice spacing plays an important
role with this subgrouping, since the acquisitions are
grouped in contiguous order.

• After the system breaks the scanning range down into as
many acquisitions as necessary, slices are distributed within
each acquisition.

For instance, in the ten-slice example, first-acquisition 1 to 5
would be acquired in this order: 1, 3, 5, 2, 4. Then, after a
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three-second delay, slices 6 to 10 would be acquired in this
order: 6, 8, 10, 7, 9.

• Spatial Concatenated SATs improve SAT performance
during scans, by:

° Maintaining the effectiveness of slice-select SAT pulses
over large scanning ranges.

° Minimizing flow related artifacts, which can mimic
pathology.

° Moving SAT pulses in the slice-select direction along with
the acquisitions, saturating tissue before acquiring each
slice.

Something to Think About...

• The possibility of getting fewer slices per TR exists
because of the time required to apply SAT pulses,
increased SAR, and increased application of gradients.

• For a concatenated SAT pulse, at least one default band
in the slice select direction must exist.

• A concatenated acquisition does not concatenate the
SAT pulses unless the [Concat SAT] button is selected
and there are SAT pulses selected in the slice direction.
Concatenated acquisition and concatenated SAT are
entirely independent functions.

SAT in the FOV

SAT pulses are applied in the FOV to effectively saturate
specific tissues, which may otherwise give rise to flow or motion
artifacts.

For 2D Gradient Echo-Sequential and 2D SPGR studies, the
system "walks" the slice-select SAT pulses along with each
slice as they are imaged, applying a SAT pulse superior to the
first slice and inferior to the second slice.
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The inside edge of each SAT pulse is placed explicitly or
graphically. The following figure shows the locations of spacial
SATs in reference to a sagittal spine image.

You can select the thickness of the slice, so that only the
appropriate amount of tissue is saturated. Note the leading
edge of the SAT pulse is moved close to the anatomy imaged.

The thickness of the pulse may greatly affect the effectiveness
of the saturation. Generally, the thinner the pulse, the better the
saturation, because the RF power is focused over a small area.
If there is only 40 mm of tissue to saturate, make the SAT pulse
40 mm wide. However, if the tissue area is larger, the area of
suppression is smaller and all unwanted tissue may not be
suppressed.

Spatial SATs moved inside the FOV are useful to suppress
tissue motion that moves within the imaging FOV, such as:

• Anterior abdominal wall

• Descending aorta when imaging the lumbar and thoracic
spine

• Swallowing motion for the cervical spine

• Signal from tissue at the edge of the FOV, reducing
wraparound
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Something to Think About...

• When using SAT in the FOV over or near air-tissue
interface, a loss of saturation due to susceptibility may
be noticed.

• When using these SAT pulses in very large FOV (48 cm)
scans, the SAT bands may appear to bend outward at
the bottom and the top of the image. This is due to the
magnetic field remapping process (GradWARP –
Conformal Remapping) that occurs. This technique is
used to correct for non-linearity inherent in any gradient
magnetic field. This bend of the SAT pulse can be used
as an advantage by moving the pulse closer to the
anatomy in the middle.

• Directional pairs of SAT pulses (S, I or R, L or A, P) with
the same thickness and tilt (Hadamard pairs) can be
applied in 8 ms. If the pair have different thicknesses or
tilts, they are applied individually causing a further
reduction in the number of slices which can be acquired
per TR.

Chemical Saturation
Chemical saturation suppresses the signal from either fat or
water. Chemical saturation delivers RF pulses within the FOV at
a specific frequency to saturate and eliminate unwanted signal
from selected nuclei. Chemical saturation takes advantage of
the fact that fat and water precess at different frequencies.

Chemical saturation affects only the nuclei precessing at the
same frequency as the RF pulse. During auto prescan, the
system selects the appropriate center frequency based on your
choice. If Fat SAT is chosen, for example, water is the required
center frequency for auto prescan. The system then determines
two peaks, fat and water, and centers on water. It then centers
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the narrow SAT pulse at the appropriate frequency on the
spectrum.

The success of these spectral saturation techniques depend on
the uniformity of the anatomical area being imaged, in addition
to the pulse sequence and coil being used. While the system is
shimmed to a system specification to provide you with optimal
homogeneity, once a patient is placed in the magnet bore, the
homogeneity can be affected. For example, an abdomen may
be more uniform than a shoulder.

Fat or water suppression reduces chemical shift artifacts
because these artifacts are caused by relative shifts of fat from
water. When one component is suppressed, there is nothing for
the other component to shift away from.

Chemical Saturation techniques are useful to suppress fat or
water in your images, such as:

• Suppressing fat in abdominal studies to reduce anterior
abdominal wall breathing artifacts.

• Identifying fatty infiltrate in the liver.

• Demonstrating musculoskeletal or optic nerve tumors when
used with contrast agents.

• Dramatically reducing chemical shift artifacts.

• Identifying fat by its dark appearance in fat-suppressed
images.

Something to Think About...

• Chemical Suppression:

° Decreases slice locations per TR because of extra
time required to apply the pulse.

° Contributes to SAR.

• Effectiveness of chemical suppression is reduced if the
anatomy of interest is more than 20 cm from isocenter.

• Site or patient specific inhomogeneities may be
unavoidable even at isocenter. The result can be
uneven suppression.

• Fat and water cannot be selected at the same time.

• Fat/Water Suppression selections turn off when the
pulse sequence (PSD) is changed.
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Classic and Improved Fat Saturation

In the classic version of Fat SAT, the saturation flip angle is set
at a fixed value. This fixed flip angle is not always optimal when
considering multiple fat components, number of slices acquired,
and other parameters such as the pulse sequence, TE, and TR.

Improved Fat SAT is the default for Spin Echo and Fast Spin
Echo pulse sequences. This includes the following selections
as they are made from the Pulse Sequence: Spin Echo, FSE,
FSE-XL, and SSFSE.

The multiple component nature of fat tissue and the use of
multiple slice acquisition techniques have been determined to
have a major impact on the effectiveness of Fat SAT. The
Improved Fat SAT alters the flip angle based on all of the
prescription parameters to improve and give a more uniform
tissue saturation.

Overall uniformity of the fat suppression may or may not
improve with the Improved Fat SAT algorithm. However,
non-uniformity may appear greater on Improved Fat SAT
images. This is because there is better fat suppression with this
technique. The improved suppression contrasts greatly with
areas of uneven suppression, giving the appearance that there
is a problem with the Fat SAT itself. Factors affecting overall Fat
SAT effectiveness remain the same:

• Anatomy offset from isocenter is likely to experience more
non-uniformity than anatomy at isocenter.

• The shape and composition of the anatomy affects Fat SAT
uniformity.

• Overall magnet homogeneity affects Fat SAT uniformity.

There are no changes to the user interface with the Improved
Fat SAT for SE and FSE sequences. However, it may not be
necessary to use Manual Prescan to adjust the CSA and CSF,
although this procedure can be used if desired.

NOTE: Refer to Volume 1, Chapter 8, For information on
chemical saturation prescan techniques, refer to the
chapter Optimizing Image Quality with Prescanning.
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NOTE: Fat suppression for SE and FSE sequences can also be
obtained with the classic version of Fat SAT. The table
below gives the type-in PSDs for accessing the classic
method of Fat SAT.

Something to Think About...

• For FSE T2 fat suppressed accusations with Improved
Fat SAT, non-fatty tissue (muscle in particular) may
appear darker than desired.

° Use FSE-XL whenever possible to take advantage
of the shorter echo spaces. The variation of echoes
used to create images is less than a standard FSE
sequence.

° Use the TE values of 70 to 80 ms to obtain better
tissue contrast. The T2 of muscle is such that it
loses signal at longer TEs.

° Use ETLs of 8 to 12. Long ETLs average in signal
from very late echoes, resulting in decreased signal
from non-fatty tissue.

• The overall SNR of improved Fat SAT images may
slightly decrease. Consider adjusting parameters which
affect SNR, e.g., increase NEX, increase the FOV,
decrease matrix size, decrease the RBw.

• The Fat SAT improvements decrease the possibility of
poor or uneven saturation, however, tissue saturation
may be reduced when the FOV is greater than 20 cm.

• Uneven saturation can still occur as a result of local
inhomogeneities, e.g., at air/tissue interfaces or when
the anatomy of interest is non-uniform.

Sequence
Desired

Selection at the Pulse
Sequence

Type-in Required for
the Classic Fat SAT

Spin Echo SE mempc

Spin Echo with
Flow Comp

SE, Flow Comp is selected
at Imaging Options.

fcmempc

Fast Spin Echo FSE fsec

FSE-XL FSE-XL fse-xlc

3D FSE FSE, 3D is selected for
Image Mode.

3dfsec

Single Shot
Fast Spin Echo

SSFSE ssfsec
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Graphic SAT Prescription
You can graphically prescribe SAT pulses on a localizer image
from a valid series within the current exam. A valid series is any
prospective orthogonal series with the same landmark. Oblique
images and collapsed vascular images cannot be used.

The SAT pulses are displayed as rectangular dotted areas
representing thickness and location. The SAT localizer image
can be changed to allow prescription of SAT pulses on various
planes. Define, adjust, and erase graphic actions are supported
as well as the placement and thickness explicit definition for the
SAT slab.

The SAT icon is located in the Additional Parameters area.

The SAT screen appears when the icon is selected.

SAT Additional Parameter Screen
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The following table gives a description for each selection on the
SAT screen.

Selection Description

S, I, A, P, L, R Defines a SAT pulse in the selected plane.

Location Defines the location of the leading edge of the SAT pulse.
Leave this text box blank for default positioning of SAT
outside FOV. A positive or negative numerical value is
entered here to explicitly prescribe the SAT location.

Thickness Defines the thickness/width of the SAT band. The default
thickness is defined by the PSD and in most cases is 80 mm.
Enter a value from 10 to 200 in steps of 1.

Concat SAT Enables "walking SAT" for slice-select direction SAT pulses in
concatenated acquisitions.

Fat/Water To suppress either FAT or Water using spectral or chemical
saturation pulses. Center Frequency must be set to FAT when
Water is selected and vice-versa.

[ALL OFF] Turns all selected SAT directions OFF.

Graphic Rx icon Toggles to Graphic Rx screen and accepts current SAT
entries.

[Copy Rx] Copies SAT prescriptions for a previously prescribed series to
current series. All SAT selections must be deselected to use
copy Rx. Click on the desired series followed by [Accept].
The SAT bands appear on the currently displayed image. A
double click on a series from the series list displays the image
on which SAT bands were prescribed in the copied series,
and the SAT bands for that series are posted.

[Accept] Enters the prescribed values for the series and exits SAT.

[Display Normal] Returns the localizer image to the original state.

Zoom Adjusts magnification factor for displayed images using the
slider bar.

Text Box Enters series and image number for the image displayed in
the SAT viewport.

[Select Series] Lists all valid series from which a localizer image can be
selected.

[Select Image] Lists the images for the selected series.

[-] [+] (prior/next) Displays the previous or next image in the series of the
currently displayed image.

Image View Port Displays the middle slice of the most recent series which
could be used as a localizer for Graphic SAT prescription.

Auto W/L Selects the Auto W/L option.
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The SAT pulse default location and thickness change based on
the PSD selected. Generally, the thickness for Spatial SAT
pulses defaults to 80 mm in all directions. Default location for
Spatial SAT pulses are 30 mm away from the FOV in slice
direction, abutting the FOV in phase and frequency directions.

• Available SAT band thickness values are 10 mm to 200 mm
in 1 mm increments.

• SAT bands may be prescribed inside or outside the
scanning volume.

• SAT locations entered state the leading edge of the SAT
pulse.

The SAT icon, located in the Additional Parameters area,
indicates the SAT pulses applied within the current prescription.

• Spatial SAT pulses applied at the default location and
thickness are shown in upper case letters beneath the SAT
icon, e.g., S, I.

• Spatial SAT pulses applied with a change to their thickness
or location are shown in lower case letters, e.g., a. i.

• If Fat or Water suppression has been selected, the selection
is indicated as FAT or WATER.

• If no SAT selections are made, the icon label reads, "SAT".

• The icon only indicates if SAT has been turned on at its
default value or if the SAT pulse location/thickness has been
altered. It does not indicate the actual thickness or location.
To view the thickness and location of SAT pulses, enter the
SAT screen.
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Something to Think About...

• SAT increases RF exposure to the patient and increases
the SAR, especially for SAT pulses in more than one
plane or if SAT pulses are obliqued. This reduces the
total number of slices permitted per TR.

• In general, if TR divided by the number of slices is
greater than 150 ms, SAT may not be effective.

• If you change the coil or image plane in the protocol,
previously selected SAT directions are turned off.

• All SAT selections, including Fat and Water
Suppression, are deleted if you change the Pulse
Sequence.

NOTE: For additional information on the SAT Additional
Parameter, refer to the chapter Scan Rx Desktop.

NOTE: For additional information on Spatial or Chemical
Saturation, refer to the chapter Optimizing Images with
Imaging Options, Volume 3.
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How to Scan with a Protocol
This section provides the step-by-step instructions for scanning
with a protocol. Specifically, it describes how to:

• Prepare the Patient

• Start a Scan Prescription

• Transfer the Patient to the System Table

• Align and Landmark

• Select a Protocol

• Review the Protocol Parameters

• Define a Scanning Range
° Explicitly
° Graphically
° Radial Graphically

• Define Saturation Bands

• Scan
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Anchor Prepare the Patient for the Exam
Use this procedure to prepare your patient for an MRI exam.
Some patients may experience feelings of fear and
claustrophobia. The following techniques may help reduce or
eliminate these feelings. Even if your patient does not exhibit
signs of fear or claustrophobia, use these techniques for all
patients.

Larger patients can feel anxious due to a confined feeling in the
magnet. Degradation of image quality can also occur. Verify that
the patient’s weight does not exceed 350 pounds, which is the
weight limit of the patient table.

1. Thoroughly screen the patient to make sure they are MR
safe.

• Screen for pertinent medical history and conditions that
contraindicate scanning.

• If proper screening cannot be performed, postpone MRI
exams until screening can be done.

NOTE: Thoroughly read the Patient Screening section in Volume
1, Chapter 1.

2. Give the patient the information booklet to read.

3. Discuss the procedure with the patient:

• The length of the exam.

• What the patient sees.

• What the patient hears.

• What the patient feels during the exam.

4. Explain the features of the bore:

• Soft lighting.

• Good ventilation.

• A microphone and speaker to enable the patient to hear
and be heard at all times.

5. Determine scan protocol in advance.

6. Explain the exam/acquisition time length.

7. Enter the patient information at the console before
positioning the patient.

• Refer to steps on Start a Scan Prescription for detailed
information.

In Brief: Prepare the
Patient for the Exam

1. Thoroughly screen the
patient to make sure they
are MR safe.

2. Give the patient the
information booklet to
read.

3. Discuss the procedure
with patient.

4. Explain the features of
the bore.

5. Determine scan protocol.

6. Explain the
exam/acquisition time
length.

7. Enter the patient
information at the console
before positioning the
patient.

8. Have patient use
restroom prior to exam.

9. Describe the Patient Alert
System.

10. Provide the patient with
hearing protection.

11. Explain use of straps.

12. Ensure the patient
comfortable.

13. Stay in constant oral and
visual communication
with patient.

14. Stress the need for the
patient’s cooperation.
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8. Have the patient use the restroom prior to the exam.

9. Describe the use and function of the Patient Alert System.

• A patient activated system that allows the patient to
signal for assistance during a scan.

10. Provide the patient with hearing protection.

• Use earplugs or music through an MRI-compatible
stereo system.

11. Explain the use of straps.

• Straps are to stabilize, not restrain the patient.

12. Ensure the patient is comfortable.

• Use sponges and wedges to relieve pressure points and
support the body in the correct position.

• Ask if a blanket is needed.

13. Stay in constant oral and visual communication with the
patient throughout the exam.

• Some patients may require the physical presence of an
operator or nurse in the scan room.

14. Stress the need for the patient’s cooperation to attain a
diagnostic study.
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Start a Scan Prescription
Use this procedure to start a scan prescription. Scanning is the
act of collecting data from a subject to produce MRI images.
This procedure guides you through beginning a scan with a
predefined protocol.

1. Click Scan Rx Desktop.

• Located in the desktop control panel.

• Allows you to start a new patient prescription.

• Once the system is ready, the Patient Register, Rx
Manager, and AutoView areas appear on the desktop.

2. Click [New Pt].

• Located in the Patient Register area.

In Brief: Start a Scan
Prescription

1. Click Scan Rx Desktop.

2. Click [New Pt].

3. Complete the patient
information text boxes.

4. Confirm that all
information is correct
before proceeding.
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• The Patient Information area appears.

3. Complete the Patient Information text boxes.

• Position the cursor in the text box, type the appropriate
information in to the text box and press Enter.

• At a minimum, you must enter the patient’s identification
number and correct weight.

4. Confirm that all information is correct before proceeding.
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Anchor Transfer the Patient to the System
Table

The table itself is detachable and can support up to 350
pounds. The patient table is designed to accommodate the
transfer of ambulatory, wheelchair and gurney patients. It is also
very important to remember that conventional life-support
equipment cannot be brought into the magnet room because it
might contain metal parts and may malfunction. Although each
procedure requires a few deviations, the general procedure is
very similar. Follow these steps when transferring a patient and
refer to the specific steps for each patient type (ambulatory,
wheelchair, or gurney).

1. Ensure that the patient is "magnet ready."

• The patient has completed the screening sheet and has
removed all metal items.

2. Bring the patient to the table.

• If using a wheelchair or a gurney, be sure it is
non-ferrous.

3. If using a coil, place it on the table.

4. Adjust the table height.

• Use the up and down foot pedals at the side or the
magnet end of the table.

• If the patient is in a wheelchair, lock the wheels.

• If the patient is on a gurney, place it next to the table and
lock the wheels. The table and gurney height should be
the same.

5. Transfer the patient onto the table.

6. Help the patient with any medical accessories they may
have.

7. Secure the patient with padding and straps.

8. Raise the table to scanning height.

9. Remove any wheelchairs or gurneys from the scan room.

In Brief: Transfer the
Patient to the System
Table

1. Ensure that the patient is
"magnet ready."

2. Bring the patient to the
table.

3. If using a coil, place it on
the table.

4. Adjust the table height.

5. Transfer the patient onto
the table.

6. Help the patient with any
medical accessories they
may have.

7. Secure the patient with
padding and straps.

8. Raise the table to
scanning height.

9. Remove any wheelchairs
or gurneys from the scan
room.
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Position the Patient
Use this procedure as a guide to position the patient for an
exam. Patient positioning depends on a range of factors
including the type of study, the RF coil being used, and the
patient’s condition.

Regardless of patient position and orientation, patient comfort
and safety are of primary importance.

• Whatever the study, two decisions must be made up front in
terms of the patient’s orientation within the magnet:

° Patient entry
° Patient position

• Localized heating may increase significantly near contact
points where patients complete closed loops with their
bodies (see figure below). A closed loop occurs when the
patient’s hands touch other parts of the body.

° Radio frequency current flows through such loops
through the cross sectional contact area. The heating
mechanism depends on loop formation and depends
inversely on contact area, i.e., the smaller the contact
area, the greater the chance of heating.

° To eliminate a closed loop, place a pad between contact
points. Local heating decreases with the thickness of the
pad used to break the loop. It is best to use 0.25 inch,
nonconductive pads to minimize any contact heating.

WARNING:To help prevent a patient burn from closed loops
formed by clasped hands, by hands touching the
body, or from thighs or knees contacting over a small
area, insert non-conducting pads at least 0.25 inches
thick between the touching parts.

In Brief: Position the
Patient

1. Position the patient in the
coil.

2. Provide the patient with
earplugs or music.

3. Provide the patient with
comfort cushions.

4. Ensure the patient is
comfortable and ready to
begin the exam.
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1. Position the patient in the coil.

a) Decide whether to have the patient lie head-first or feet-first.

° For head and neck exams, generally use the
head-first position.

° For body exams, the decision might be made to
position the patient feet-first, although head-first
remains more common.

° When using the coils or prescribing a gated study,
position the patient to minimize the distance that the
cables extend into the aperture of the magnet.

b) Decide whether to have the patient lie supine, prone, left
decubitus, or right decubitus.

° Coil requirements and patient comfort
considerations can affect these choices.

NOTE: Always compare the patient entry and patient position
with the information entered at the operator’s console.
Incorrect entries can result in incorrect left/right, anterior
posterior, or inferior/superior image annotation.

2. Provide the patient earplugs or headphones for music.

3. Provide the patient cushions for comfort and to minimize
any contact heating.

• Use sponges and wedges to relieve pressure points and
support the body in the correct position.

• Use accessories, such as knee bolster.

Supine

Prone

Left Decubitus

Right Decubitus
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• Insert non-conducting pads at least 0.25 inches thick
between touching parts.

4. Ensure that the patient is comfortable and ready to begin
the exam.

• Ask if a blanket is needed.
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Align and Landmark
Use this procedure to align and landmark a patient during the
scanning procedure. Alignment and landmarking are steps
taken to ensure the Region of Interest (ROI) center is as close
as possible to isocenter. That is, the location in the bore where
the magnetic field is most homogenous. The purpose of
selecting a landmark is to establish an anatomical point from
which all images in a series are referenced. This procedure
guides you through the alignment and landmarking processes.

• Alignment means properly centering the patient from the
sagittal standpoint; that is, so the patient is not leaning from
the right or left.

• Landmarking helps bring the region of interest to isocenter
from the second perspective, longitudinally. For this step,
the axial alignment light is used.

1. Position the patient at the magnet enclosure inside the scan
room.

• Refer to steps on Positioning the Patient for detailed
information.

2. Press [Alignment Light].

• Located on the button control panel.

CAUTION: Exposing eyes to the laser alignment lights may result
in eye injury.

° Do not stare directly into the laser beam.
° Instruct patients to close their eyes during landmarking to

avoid eye exposure to the alignment light while the laser
light is "on."

° Closely monitor all patients and prevent them from
accidently staring into the beam.

° Do not leave the laser beam on after you position the
patient.

In Brief: Align and
Landmark

1. Position the patient at the
magnet enclosure.

2. Press [Alignment Light].

3. Press [In Slow] or [In
Fast] to advance cradle
to landmark position.

4. Press [Landmark].

5. Press [Move to Scan].

6. If cradle position display
fails to count down to "0",
press [Move to Scan] a
second time.

7. Stay in the scan room
until the cradle stops and
check to make sure that
the patient is comfortable.

8. Return to scan console.

9. Click [Landmark] on the
Patient Information
window.

10. Select an appropriate
landmark or type in the
desired landmark.
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3. Press [In Slow] or [In Fast] to advance the cradle until the
axial alignment light rests at the desired landmark.

• Confirm centering with the sagittal and axial alignment
lights.

NOTE: Homogeneity decreases as distance from isocenter
increases. Although it is not always possible to place the
anatomy being scanned at isocenter, bring the anatomy
as close to isocenter as possible, keeping the patient as
comfortable as possible.

4. Press [Landmark].

• Informs the system the position of the landmark.

• The cradle location display reads "0" when the landmark
has been established.

NOTE: A scan cannot be started until a landmark is defined in
the magnet room.

5. Press [Move to Scan].

• The table moves the patient to isocenter.

• The laser alignment lights turn off automatically.

• Make sure all health lines are long enough to
accommodate cradle travel.

Landmark

Move to
Scan
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• The cradle location display now counts down to "0"
again as the cradle moves the landmark into isocenter.

• You can confirm the patient landmark by viewing a red
dot when the alignment light is active. The red dot
represents landmark.

6. If the cradle location display fails to count down to "0," press
[Move to Scan] a second time.

• If that does not work, move the table in or out with the
in/out buttons and press [Move to Scan] one more time.

7. Stay in the scan room until the cradle stops and check to
make sure that the patient is comfortable.

8. Return to the scan console.

9. Click [Landmark] on the Patient Information area.

• An abbreviated Patient Information area appears.

The Landmark
chosen should de-
scribe the align-
ment light position
on the patient.
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10. Select an appropriate landmark or type in the desired
landmark.

• Select from the predefined selections, or

by positioning the cursor in the Landmark text box and
typing in the appropriate landmark.

NOTE: Selecting a landmark is not required but if a landmark is
not entered, the images have no anatomical reference
annotation.

NOTE: Landmark annotation can be found on the exam text
page.
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Anchor Select a Protocol

Use this procedure to select a predefined protocol from the
protocol library. This procedure guides you through beginning a
scan with a protocol.

1. To select the protocol library, click the Patient Protocol
button and select [Site], [GE], or [Picture This].

2. Select the desired protocol category.

• Select Head, Neck/Cervical, Chest/Thoracic, Upper
Extremities, Abdomen/Lumbar, Pelvis, Lower
Extremities, or Other.

• A Protocol and Series Description window appear.

In Brief: Select a
Protocol

1. Click the Patient Protocol
button and select [Site],
[GE], or [Picture This].

2. Select the desired
protocol category.

3. Click desired protocol.

4. Select the desired series
on the right window.

5. Click [Accept].

When using the protocol
option, select the cate-
gory by clicking on the
desired body part of the
humanoid.

Also, you may enter the
protocol name in the text
box.
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3. Select the desired protocol category.

• The protocol category is on the left side of the window;
the associated series is listed on the right side.

4. Select the desired series on the right window.

5. Click [Accept].

• The selected series loads into the Rx Manager.

6. If using the Picture This library, click [Accept] to access the
image gallery:

• Select the weighting and plane, then the pulse
sequence.

• Highlight the series and click Standard, Faster, or
Higher Resolution to view the associated image, scan
times and number of available slices.

• Click [View Selection] to list all of the series.

• Select the desired series and click [OK].
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Anchor Review the Protocol Parameters
Use this procedure to review the selected protocol parameters
prior to beginning your scan. It is important re-examine the
protocol parameters to ensure your desired choices are
selected. This procedure guides you through the reviewing
process.

1. Select the desired series in the Rx Manager.

2. Click [View Edit].

• The series opens on the Scan Rx Desktop and displays
the pre-defined parameters.

• Allows the revision or editing of a series in the Rx
Manager. The series can then be modified and saved
again.

• A new series changes to INRX in the Rx Manager if a
View Edit is performed.

• Use View Edit to adjust the scan range after viewing the
most recent acquisition.

3. Review the pre-defined scan parameters and confirm that:

• Patient Position and Patient Entry parameters are
correct for the current patient’s orientation in the
magnet.

° Incorrect patient entry parameters result in incorrect
image annotation.

• Coil Selection is correct.

° The coil selected in the protocol must match the coil
connected to the system.

° Incorrect coil selection can result in prescan failure,
coil damage, or degraded image quality.

NOTE: If the coil connected does not match the coil selected in
the current protocol, the system posts a message warning
of the mismatch.

• Scan Plane is correct.

• Scan Mode is appropriate for the pulse sequence.

In Brief: Review the
Protocol Parameters

1. Select the desired series
in the Rx Manager.

2. Click [View Edit].

3. Review the pre-defined
scan parameters.

4. Check the Relative SNR
meter.
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• Pulse Sequence is appropriate for the clinical
circumstances.

• Imaging Options are appropriate for the clinical
circumstances.

• Scan Timing parameters produce the desired contrast.

• Scanning Range parameters allow proper coverage of
anatomy being imaged.

• Acquisition Timing parameters produce the desired
spatial resolution, scan time, and signal-to-noise ratio.

4. If you make any parameter changes consult the Relative
SNR meter as well as the scan time.

• Located in the Scan Operations area.
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Anchor Define a Scanning Range

Explicitly
Use this procedure when prescribing a series of scan locations
by typing in the coordinates representing the anatomical
locations. Explicit prescription allows single groups of slices or
volumes to be prescribed. This procedure guides you through
the process of explicitly defining the scanning range.

1. Enter the FOV in centimeters to cover the area of anatomy
selected for imaging.

• Choose one of the system pre-defined values or enter
your own value in the text box. Use the scroll arrows to
increase or decrease the selected value in steps of 2
cms.

• Anatomy outside the FOV in the phase direction results
in aliasing.

• Small FOVs produce:

° increased resolution

° decreased SNR

° increased minimum TE value.

2. Enter the slice thickness in millimeters.

• Choose one of the system pre-defined values or enter
your own value in the text box. Use the scroll arrows to
increase or decrease the selected value in steps of 1
mm.

• Thin slices produce:

In Brief: Explicit Rx

1. Enter the FOV in
centimeters.

2. Enter the slice thickness
in millimeters.

3. Enter the slice spacing or
number of scan locations
in millimeters.

4. Enter the start and end
locations.

5. Enter the FOV center.
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° increased resolution

° decreased SNR

3. Enter the slice spacing or number of scan locations in
millimeters.

• Assigns a space between the prescribed slices.

• Select a spacing that reduces cross-talk. This spacing is
typically 20% of the slice thickness.

° Cross-talk or overlap is caused by partial excitation
of adjacent slices during RF excitation and
refocusing by a 180-degree pulse. This causes a
reduction in image contrast and SNR.

• To reduce the effects of cross-talk, use one of the
following:

° Interleave (doubles scan time)

° Use sequential imaging option

° Larger interscan spacing

° 3D technique

• Choose one of the system pre-defined values or enter
your own value in the text box. Use the scroll arrows to
increase or decrease the selected value in steps of 1
mm.

• Define the slice spacing for 2D acquisitions.

• Define the overlap locations and number of scan
locations per slab for 3D aquisitions.

° Each 3D group is able to overlap on another group
for a multi group prescription. Enter the number of
slices that you want to overlap between slabs within
the same group.
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4. Enter the start and end locations.

• Start and End determine the area covered in the scan.

a) Axial Scan Plane-enter the S/I value for the most inferior
location and the S/I value for the most superior location.

b) Coronal Scan Plane- enter the A/P value for the most
posterior location and the A/P value for the most anterior
location.

c) Sagittal Scan Plane- enter the R/L value for the most left
location and the R/L value for the most right location.

d) Oblique Scan Plane- place the crosshair at the desired start
location and enter its coordinates displayed on the image.
Place the crosshair at the end location and enter its
coordinates.

NOTE: The system automatically calculates the end location and
the number of locations for 2D or the number of slabs for
3D based on scan thickness and the interscan spacing
selected. The Actual End location is shown in brackets to
the right of the End location explicitly entered.

5. Enter the FOV Center to define the center of the image.

a) Axial Scan Plane-enter the appropriate values for A/P and R/L
Center. Enter 0 for no offset.

b) Coronal Scan Plane- enter appropriate values for S/I and R/L
Center. Enter 0 for no offset.

c) Sagittal Scan Plane- enter appropriate values for S/I and A/P
Center. Enter 0 for no offset.

d) Oblique Scan Plane- place crosshair at desired FOV center
on the image and enter the coordinates.
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Define the Scanning Range

Graphically
Use Graphic Rx to graphically define the scan locations on a
localizer image using the same landmark and coil. Either
orthogonal or oblique imaging can be used. This procedure
guides you through the process of graphically defining the
scanning range.

1. Enter the FOV in centimeters to cover the area of anatomy
selected for imaging.

• Choose one of the system pre-defined values or enter
your own value in the text box. Use the scroll arrows to
increase or decrease the selected value in steps of 2
cms.

• Anatomy outside the FOV in the phase direction results
in aliasing.

• Small FOVs produce:

° increased resolution

° decreased SNR

° increased the minimum TE value

2. Enter the slice thickness in millimeters.

• Choose one of the system pre-defined values or enter
your own value in the text box. Use the scroll arrows to
increase or decrease the selected value in steps of 1
mm.

• Thin slices produce:

° increased resolution

In Brief: Graphic Rx

1. Enter the FOV in
centimeters.

2. Enter the slice thickness in
millimeters.

3. Enter the slice spacing or
number of scan locations
in millimeters.

4. Click [Graphic Rx].

5. If necessary, click [Select
Series] to choose a
different series.

6. Use [-][+] to review the
images and select the
desired image.

7. Magnify the image if
necessary.

8. Position the cursor on the
image at the desired start
location and click and hold
left.

9. Drag the pointer to the
desired end location and
release.

10. Adjust the start and end
locations, number of slices
or slabs, and FOV center.

11. Note the start and end
locations, number of slices
or slabs, and FOV center.

12. Click [Accept].
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° decreased SNR

3. Enter the slice spacing or number of scan locations in
millimeters.

• Assigns the space between the prescribed slices.

• Select a spacing that reduces cross-talk. This is typically
20% of the slice thickness.

° Cross-talk or overlap is caused by partial excitation
of adjacent slices during RF excitation and
refocusing by a 180° pulse. This causes a reduction
in image contrast and SNR.

• To reduce the effects of cross-talk use one of the
following:

° Interleave (doubles scan time)

° Sequential Imaging Option

° Larger interscan spacing

° 3D technique

• Choose one of the system pre-defined values or enter
your own value in the text box. Use the scroll arrows to
increase or decrease the selected value in steps of 1
mm.

• Define the slice spacing for 2D acquisitions.

• Define the overlap locations and number of scan
locations per slab for 3D aquisitions.

° Each 3D group is able to overlap on another group
for a multi group prescription. Enter the number of
slices that you want to overlap between slabs within
the same group.
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4. Select [Graphic Rx].

• The Graphic Rx screen opens in the upper right corner.

• The system automatically displays the center image of
the most recent valid series that can be used to select a
localizer image.

5. If necessary, click [Select Series] to choose a different
series to be used as a localizer.

6. Use [-][+] to review the previous or next image in the series
and select the desired image.

• The series and/or image can also be selected by typing
the desired series and/or image number in the text box.
Example: series 2, image 5.

7. Magnify the image using the slider, if necessary.

8. Define the start location by positioning the cursor on the
desired start location and click and hold left mouse button.

9. Drag the cursor to the desired end location and release.
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10. Adjust the start and end locations, number of slices or slabs,
and FOV.

• To adjust the number of slices or locations, click the
appropriate slice prescription handle and adjust the end
location to add or remove slices.

• To adjust the angle for an oblique series, click the tilt
handles and adjust the tilt angle. Oblique must be
selected for the scan plane.

• To prescribe a second group of slices, move the cursor
to a new location, press Shift on the keyboard. Click
and drag the left mouse button to deposit a new set of
slices.

• To copy a prescription from a previous series that was
scanned in the same plane, same FOV, and with the
same slice thickness:

° Click [Copy Series] and select the series from the
list.

° Click [Accept] in the copy window.

• To graphically prescribe your locations on one slice
location and redefine a new center image at another
slice location:

° Select an image where you want to prescribe the
slice locations, then move to the center of the image
and click [Reset Center].
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• To eliminate an undesired offset FOV (when using a
non-zero localizer), click [Fallback].

° The fall back is in the slice direction.

° The fallback button does not appear if prescribing an
oblique prescription off of an oblique localizer.

11. Note the start and end locations, number of slices or slabs,
and FOV.

• Once slices have been plotted and accepted, numeric
values for the start/end locations, FOV center, and the
number of slices or slabs prescribed, appear in the Scan
Location text boxes in the Scanning Range area.

• For 2D techniques, the locations appear as follows.

• For 3D techniques, the locations appear as follows.

12. Click [Accept].
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Define the Scanning Range

Radial Graphically
Use radial graphic prescription to acquire multiple slices around
a central axis in the same series. A radial or partial radial
prescription can be useful for imaging, but not limited to, knees,
MRCPs, myelograms, and hearts. This procedure guides you
through the process of graphically prescribing a radial
sequence.

NOTE: The prescription must be an oblique 2D FSE-XL,
FastCard, or SSFSE pulse sequence.

1. Follow steps 1-7 on how to define the scanning range
graphically.

• The Graphic Rx screen should be open.

2. Select the radial direction.

• The radial direction can be clockwise or
counterclockwise.

• The system defaults to clockwise rotation.

3. Enter the number of slices and degree of spacing desired in
the text boxes.

• The # of Slices and Spacing text boxes control the
angle between the slices of the radial prescription.

° For a radial graphic prescription that looks like a
wagon wheel, enter the number of slices and leave
the spacing text box empty.

° For a partial radial prescription that looks like cat
whiskers, enter the number of slices in the radial

In Brief: Radial
Graphic Rx

1. Follow steps 1-7 on how to
defining the scanning
range graphically.

2. Select the radial direction.

3. Enter the number of slices
and degree of spacing
desired in the text boxes.

4. Click on the image in the
Graphic Rx.

5. Place the cursor in the
center of the graphic
prescription and move the
entire prescription to
desired location on image.

6. Click the rotating handle
and rotate prescription the
the desired starting slice
number.

7. Hold the Shift key and
click image to add another
group to the prescription.
Repeat as necessary.

8. Click [Accept].
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parameters and a value for the degree of the angle
between the slices in the partial radial spacing
parameter.

• The maximum number of slices in one prescription is 16.
If this limit is exceeded, an error message appears and
you are not able to accept the prescription.

4. Click on the image in the Graphic Rx.

• Radial graphics appear on the image.

• If you "draw" the slices using the cursor, you are not
able to get the angles.

5. Place the cursor in the center of the graphic prescription
and move entire prescription to the desired location on
image.

6. Click the rotating handle and rotate prescription the desired
starting slice number.

7. Hold the Shift key and click image to add another group to
the prescription. Repeat as necessary.

• If another group is desired with a different number of
slices than the prior prescription, first change the
number of slices to the desired amount, then hold the
Shift key and click image.

• Once the Rx is prescribed on the image, you cannot
change it. You must select [Erase Group] or [Erase
All], enter in the new values, and click the image to view
the new prescription.

8. Click [Accept].

• Saves the prescribed prescription.

NOTE: Refer to Radial Graphic Rx in the About... section of this
guide for detailed information on setting the number of
locations before pause during scanning.
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Define Saturation Bands
Use the following procedure to define saturation bands on your
images. Use the SAT option to explicitly or graphically prescribe
SAT pulses on an image from a series within the current exam.
This option is also used for prescribing a concatenated SAT or
prescribing a chemical saturation technique. This procedure
guides you through the process of defining saturation bands
during scanning.

1. Click SAT.

• Located in the Additional Parameters area.

• The SAT screen opens in the upper right corner.

2. Click [Select Series] and choose the desired series to
prescribe the saturation pulses.

3. Use [-][+] to review the previous or next image in the series
and select the desired image.

4. Magnify the image if necessary.

5. Prescribe the desired spatial, concatenated, or chemical
saturation pulses.

a) To explicitly prescribe spatial saturation:

• Click the desired spatial saturation band: S, I, A, P, R,
and/or L.

In Brief: Define
Saturation Bands

1. Click SAT.

2. Click [Select Series] and
choose desired series.

3. Use [-][+] to review the
images and select the
desired image.

4. Magnify the image if
necessary.

5. Prescribe the desired
spatial, concatenated, or
chemical saturation
pulses.

6. Click [Accept].
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• Accept the default thickness and location or enter a
value for thickness and location.

b) To graphically prescribe spatial saturation:

• Click the desired spatial saturation band: S, I, A, P, R,
and/or L.

• Accept the default thickness and location or enter a
value for thickness and location.

• Position the cursor on the image at the desired location
for the inside edge of the saturation band and click left.

• Use the handles on the SAT band to change the size
and location of the SAT band.

c) To prescribe concatenated spatial saturation:

• Click saturation bands in the slice direction.

• Select Concat SAT.

° Two concatenated saturation pulses can be placed
parallel to the acquisition slice when used with a

If you do not enter any value in
the location text box, the SAT
band is placed outside the
FOV.
To set a SAT band inside the
FOV, enter the location corre-
sponding to the leading edge.
The default SAT thickness is 80
mm for most sequences.

Click, grab, and drag the center
handle to move the SAT band.

Click and grab these
handles to tilt the SAT
band.

Click and grab this han-
dle to size the SAT band.
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sequential series, or with an orthogonal series with
two acquisitions.

° Concat SAT makes SAT pulses in the slice-select
direction more effective in concatenated acquisitions
and "moves along" with the slice-select acquisition
for more effective suppression of motion in the
slice-select direction.

d) To prescribe chemical saturation:

• Select Fat or Water.

• Click [Accept].

e) To copy a saturation prescription from a previous series:

• Turn off all saturation bands.

• Click [Copy Rx] and select the series from the list.

• Click [Accept] on copy window.

NOTE: For information on optimizing chemical saturation with
manual prescan, refer to the chapter Optimizing Image
Quality with Prescanning.
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Scan

Use the scanning procedure to follow through with the scan
after all scan prescription is complete. This procedure guides
you through the scanning process.

1. When a series prescription is complete, click [Save Series].

• The series state changes from INRX to RXD.

• The completed series is saved in the Rx Manager.

NOTE: The system automatically downloads the first series and,
therefore, selecting [Prepare to Scan] is not required.

2. Select the desired saved (RXD) series in the Rx Manager.

3. Click [Prepare to Scan].

• The parameters are automatically downloaded for
scanning.

4. Click [Scan].

• The system prescans and immediately proceeds to
scan.

• Or, click [Auto Prescan], allow it to complete, then click
[Manual Prescan] to manually prescan. When manual
prescan adjustments are complete, click [Scan].

NOTE: For additional information on Manual Prescan, refer to the
chapter Optimizing Image Quality with Prescanning.

In Brief: Scan

1. Click [Save Series].

2. Select the desired series
in the Rx Manager.

3. Click [Prepare to Scan].

4. Click [Scan].

5. Click [New Series] to add
additional scans.

6. Click [End Exam].
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• To automatically prescan and scan all saved series,
click [Autoscan] in the Rx Manager.

5. Click [New Series] to prescribe or add a new series to the
Rx Manager.

6. Click [End Exam] when finished.
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Where Am I?
Volume 1

Chapter 8

Optimizing Image
Quality with

Prescanning

Introduction

This chapter focuses on manual prescan and chemical saturation
tuning. These are important tools to help you improve your image
quality. The chapter highlights key concepts and provides guidelines
for manual prescan and chemical saturation tuning. It also contains
the step-by-step instructions to help you learn how to:

• Auto Prescan

• Match the Coarse Center Frequency to the Patient

• Adjust the Transmit Gain to Achieve Optimum Flip Angle

• Match Fine Center Frequency to the Patient

• Adjust the Receiver Gain

• Optimize Chemical Saturation
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In addition, this chapter answers the following questions:

1. What are the purposes and benefits of MPS and CSTUN?

2. What are reasons for APS failures?

3. What values are set?

4. Why does transmit frequency need to match precessional
frequency?

5. How does transmit gain affect the flip angle?

6. Why does the receiver need to be adjusted?
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About...Prescanning
This section presents the concepts necessary to successfully
complete the prescanning process. Specifically, you need to
understand:

• Purpose and Benefits

• The Two Prescan Programs
° Auto Prescan
° Manual Prescan

• Reasons for Auto Prescan Failures

• Precessional and Transmit Frequency

• Transmit Power and Flip Angle

• Receiver Sensitivity

• Prescan for Chemical Saturation
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Purpose and Benefits
Prescan optimizes the system transmit and receive values for
each patient and area of interest. Every patient is a unique
collection of protons that requires a unique combination of RF
frequency and power to image. There are many reasons to
prescan. The primary reasons are as follows:

• Prescan optimizes auto-shim values (when selected) to
improve the homogeneity of the magnetic field with the
patient in the bore.

• Prescan allows the manual optimization of chemical
saturation.

• Prescan sets:

° Center Frequency Coarse
° Transmit Gain
° Center Frequency Fine
° Receive Gain

The Two Prescan Programs
• Auto Prescan

• Manual Prescan

Auto Prescan

Auto Prescan (APS) automatically adjusts the center frequency
and the transmit and receive gains. These values appear in the
message area upon completion of a successful APS.

Use APS for the most efficient, accurate, and consistent
prescan.

Manual Prescan

Manual Prescan (MPS) requires you to set center frequency,
transmit gain, and scan TR.

Use MPS:

• If APS fails.
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• When a particularly strong or weak signal exceeds the
system’s ability to self-adjust.

• When values have been manually set for chemical
saturation techniques.

Four transceiver hardware settings are used in MPS.

• Center Frequency Coarse (CFL)

• Transmit Gain (TG)

• Center Frequency Fine (CFH)

• Scan TR (R1/R2)

NOTE: Remember that you are delivering RF to the patient
during prescan.

Something to Think About...

• MPS takes longer than APS.

• MPS relies on your accuracy.

Reasons for Auto Prescan Failures
During an APS, the system may fail to automatically calibrate
the RF power transmitted and received in a slice. The message
"Prescan Failed" appears in the scan operations area, followed
by a reason, if an error is detected.

• If APS fails and the system can determine the cause, the
"Prescan Failed" message contains additional information.
Two common messages and problems are:

° "Auto Prescan Failed. Table not at scan plane." In this
case, press the [Move to Scan] button to move the table
to scan plane. Then click the [Auto Prescan] button.

° "Auto Prescan Failed. RF amplifier not ready." To correct
this problem, wait for the "RF amplifier ready" message
to appear in the message area.

• In certain Center Frequency prescriptions, fat and water
peaks may not be readily discernible. In such cases, the
systems displays "Auto Prescan Incomplete" and "Set AX
manually." At this point, the MRI system requires a MPS to
find the desired peak.

• An improperly connected coil may result in a failed prescan
with a message, "TR Driver Fault." Check coil connections
before proceeding with prescan.
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Precessional and Transmit Frequency

The center frequency matches the transmitting frequency of the
system to the precessional frequency of the nuclei in the patient
and region of interest. The closer these frequencies match, the
more efficient the transfer of energy and the shift to resonance.

Each patient magnetizes differently and this results in a unique
precessional frequency. The Larmor Equation calculates this
frequency as shown in the graphic below.

Various adjustments are made in order to move the location of
the bandwidth and center frequency.

• Center Frequency Coarse adjustments are made on a scale
of ±2000 Hz. The coarse adjustment allows you to view the
spectrum (regardless of its location) compared to the
current bandwidth location. Fat and water may appear as
one peak.

• Center Frequency Fine adjustments use a scale of ±500 Hz.
At this point the spectrum often has a fat and a water peak.
You can center the spectrum’s midpoint on the desired
location.

Transmit Power and Flip Angle

Transmit gain adjusts the transmitting power (amount of RF) the
system uses in order to obtain the correct flip angles.

A correct transmit gain means that a 90° RF pulse flips the net
magnetization vector exactly 90°.
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Receiver Sensitivity
Receive gain adjusts the analog and digital receivers for the
level of signal returning from the patient. The receiver must be
able to convert or translate the MR signal coming from the
patient into a useful electronic signal. Signal exceeding the
translation range of the receiver cannot be converted and
becomes noise; like a radio playing too loudly.

To access receive gain, the scan TR (R1 and R2) are used.

• R1- Analog Gain

• R2- Digital Gain

NOTE: Improper adjustment to R1 and R2 settings results in
distortion and can result in image quality degradation. If
R1 and R2 are set too high, contrast reversal effects can
occur. If R1 and R2 are set too low, a low SNR can occur.

Prescan for Chemical Saturation
ChemSAT Tune (CSTUN) is a prescan function for the chemical
saturation pulse. You must match the transmit frequency with
the precessional frequency, and adjust the amplitude of the
imaging pulse for the suppression pulse.

CSTUN:

• Allows the optimization of fat or water peak suppression.

• Adjusts the frequency of the SAT pulse using CSF.

• Adjusts the amplitude of the SAT pulse using CSA.
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How to Prescan
This section provides the step-by-step instructions for
performing an APS or MPS. Specifically, it describes how to:

• Automatically Prescan

• Manually Prescan
° Match the Coarse Center Frequency to the Patient
° Adjust the Transmit Gain to Achieve Optimum Flip Angle
° Match Fine Center Frequency to the Patient
° Adjust the Receiver Gain

• Optimize Chemical Saturation
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AnchorAutomatically Prescan
Use this procedure to automatically prescan with routine scan
prescriptions. APS automatically adjusts and sets the center
frequency, transmit and receive gains. This procedure guides
you through the automatic prescan process.

Proceed with routine scanning prescription to begin this
procedure.

1. Click [Auto Prescan].

• Located in the Scan Operation area.

2. Verify the completion of a successful APS.

• The prescan values display in the Scan Operations
area.

3. Click [Scan].

• Located in the Scan Operation area.

• The acquisition begins scanning.

In Brief: APS

1. Click [Auto Prescan].

2. Verify the completion of a
successful APS.

3. Click [Scan].
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Manually Prescan

Match Coarse Center Frequency to
the Patient
Use this procedure during MPS to manually adjust and set the
coarse center frequency to the patient. This allows you to tune
the system for optimal sampling of the individual patient and
anatomy. This procedure guides you through the process to
match center frequency to your patient.

1. Click [Manual Prescan].

• Located in the Scan Operation area.

• Allows you to begin the prescan program.

• The MPS window appears.

2. Click [Center Freq Coarse (CFL)].

• Located in the Transceiver Hardware Settings area.

• The center frequency course setting displays a window
of ±2000 Hz.

• Fat and water usually appear as one peak.

In Brief: Match
Coarse Center
Frequency

1. Click [Manual Prescan].

2. Click [Center Freq
Coarse (CFL)].

3. Enter or adjust center
frequency value then click
[Apply].

4. Repeat step 3 until the
peak aligns with the
center line.

5. Continue to the steps on
adjusting the TG.

+2000 -2000
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3. Enter the actual frequency value or adjust the midpoint by
moving the Delta Freq slider and click [Apply].

• Your goal is to get the water peak centered to the
frequency line.

• Each time a frequency number is applied, the value is
cumulative.

• A negative number moves the peak to the left. If the
transmit frequency is too high, subtract frequency.

• A positive number moves the peak to the right. If
transmit frequency is too low, add frequency.

NOTE: Make changes in small increments to avoid moving the
peak out of the window.

NOTE: If you lose the peak, exit MPS and restart.

4. Repeat step 3 until the peak aligns with the center line.

NOTE: To return the Actual Frequency (Ax) to its original value,
click [Reset] in the Gradient Shimming area of the
window.

5. To continue the MPS process and achieve an optimum flip
angle, continue steps on next page, Adjusting the Transmit
Gain. Otherwise, click [Done] to close the Prescan window.

The transmitting fre-
quency of the system is
higher than

the precessional fre-
quency of the patient.

The transmitting fre-
quency of the system is
lower than

the precessional fre-
quency of the patient.
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Manually Prescan

Adjust the Transmit Gain to Achieve
Optimum Flip Angle

Use this procedure during MPS to manually adjust and set the
RF Transmit Gain (TG) to ensure precise flip angles. This
allows the appropriate RF energy to achieve maximum signal.
This procedure guides you through the process to adjust the TG
to achieve optimum flip angles.

Complete the steps on the course CF adjustment prior to
setting the TG.

1. Click [Transmit Gain].

• Located in the Transceiver Hardware Settings area.

• The correct TG produces the highest peak.

° Too much or too little produces a smaller peak.

2. Select Markers > Horizontal Hairline.

• Located on the MPS menu bar.

• A horizontal white line marker appears on the spectrum.

In Brief: Adjust the
Transmit Gain

1. Click [Transmit Gain].

2. Select Markers >
Horizontal hairline.

3. Click the horizontal
marker and position at
peak.

4. Adjust Transmit Gain
slider.

5. Continue to move
horizontal marker with
profile peak until a
optimum setting is
reached.

6. Select Markers >
Horizontal Hairline to
turn off.

7. Continue to the steps on
Matching the Fine Center
Frequency.
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3. Click the horizontal marker and move marker to the peak of
the image profile.

• The goal of TG is to get the image profile at the highest
peak. The highest peak indicates the protons have been
flipped 90 degrees or into the transverse plane.

4. Adjust the Transmit Gain slider.

• Increase the TG until the peak no longer increases.

° Change the gain in increments of 10 to 20 initially
and then 5 to 10 as you get closer to the peak value.

5. Continue to move the horizontal marker up as the image
profile increases.

• Increase the TG as long as the peak increases.

° If the peak increases, the magnetization is moving
closer to the transverse plane.

• If the peak decreases, the magnetization is moving
away from the transverse plane.

° Once the peak of the profile falls below the marker,
you have surpassed the optimum TG setting.

° Decrease the gain until you find a setting that places
the profile at the highest peak.
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6. Select Markers > Horizontal Hairline.

• The white line horizontal marker turns off.

7. To continue the MPS process, continue steps on next page,
Matching the Fine Center Frequency. Otherwise, click
[Done] to close the Prescan window.
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Manually Prescan

Match Fine Center Frequency to the
Patient
Use this procedure during MPS to manually adjust and set the
fine center frequency to the patient. This allows you to fine tune
the system for optimal sampling of the individual patient and
anatomy. This procedure guides you through the process to
match center frequency to your patient.

Complete the steps on the course CF and TG adjustments prior
to matching the fine center frequency to your patient.

1. Click [Center Freq Fine (CFH)].

• Located in the Transceiver Hardware Settings area.

• A fat peak is displays along side of the water peak.

• The center frequency fine setting displays a window of
±500 Hz.

• Fat and Water appear as two peaks at mid and high
field.

° The water peak is on the left.

° The fat peak is on the right.

In Brief: Match Fine
Center Frequency

1. Click [Center Freq Fine
(CFH)].

2. Enter or adjust center
frequency value and
select [Apply].

3. Repeat step 2 until the
peak aligns with the
center line.

4. Continue to the steps on
Adjusting the Receiver
Gain.

+500 -500
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2. Enter the actual frequency value or adjust the midpoint by
moving the Delta Frequency slider and click [Apply].

• The goal is to fine tune the desired peak on the center
frequency line.

• A negative number moves the peak to the left. If the
transmit frequency is too high, subtract frequency.

• A positive number moves the peak to the right. If
transmit frequency is too low, add frequency.

NOTE: Make changes in small increments to avoid moving the
peak out of the window.

3. Repeat step 2 until the peak aligns with the center line.

NOTE: To return the Actual Frequency (AX) to its original value,
click [Reset].

4. To continue the MPS process, continue steps on next page,
Adjusting the Receiver Gain. Otherwise, click [Done] to
close the Prescan window.

Transmit frequency opti-
mized for water.

Transmit frequency opti-
mized for fat.
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Manually Prescan

Adjust the Receiver Gain to Achieve
Optimum Signal

Use this procedure during MPS to manually adjust and set the
RF receive gain to optimize the use of the receiver’s dynamic
range. This procedure guides you through the process to adjust
the receive gain to achieve the best signal-to-noise ratio (SNR).

Complete the steps on the course center frequency, TG, and
fine center frequency adjustments prior to adjusting the receiver
gain.

1. Click [Scan TR (R1/R2)].

• Located in the Transceiver Hardware Settings area.

• The goal of Scan TR is to assure both R1 and R2 values
fall below 50%.

2. Set the Analog Gain R1 value.

• Check the analog gain (R1) value in the upper right
corner of the spectrum display to verify the signal is less
than 50%. If so, no change is necessary.

• If R1 value exceeds 50%, use the Analog Gain (R1)
slider to decrease the gain.

° Decrease in increments of one, until the R1 value is
as high as possible without exceeding 50%.

• Analog receive gain range is 1 to 15. In most cases, the
default setting is 11 and provides the best SNR.

3. Set the Digital Gain R2 value.

• Check the digital gain (R2) value in the upper right
corner of the spectrum display to verify the signal is less
than 50%. If so, no change is necessary.

In Brief: Adjust the
Receive Gain

1. Click [Scan TR].

2. Set the Analog Gain R1
value.

3. Set the Digital Gain R2
value.

4. Click [Done].

5. Click [Scan].
2292261-100 Rev. 0 (03/01) 8-17



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
• If R2 value exceeds 50%, use the Digital Gain slider to
decrease the gain.

° Decrease in increments of one, until the R2 value is
less than 50%.

• Digital receive gain range is 1 to 15 (1 to 30 with EDR).

NOTE: R1 and R2 gains should not exceed 50%.

4. Click [Done].

• Located in the lower left corner of the window.

• The MPS window closes.

5. Click [Scan].

• Located in the Scan Operations area.

• The acquisition begins scanning.

R1=45%
R2=43%
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Optimize Chemical Saturation

Use this procedure for best manual prescanning results when
using chemical saturation techniques. The overall success of
ChemSAT depends somewhat on the uniformity of the anatomy
to be imaged, in addition to the pulse sequence and coil being
used. This procedure guides you through the process to
optimize the chemical saturation techniques.

NOTE: It may not be necessary to use MPS to adjust the CSA
and CSF for SE and FSE sequences using the default
improved Fat SAT, however, this procedure can be used
if desired.

1. Click [Auto Prescan].

• Located in the Scan Operation area.

• At completion, note the results, especially any
accompanying messages referring to CF peak selection.

° When performing FAT SAT, make sure CF is set to
water.

° When performing WATER SAT, make sure CF is set
to fat.

2. Click [Manual Prescan].

• Located in the Scan Operation area.

• The MPS window appears.

3. Select [Center Freq Fine (CFH)].

• Located in the Transceiver Hardware Settings area.

4. Check the offset between fat and water.

• At 1.0T the shift is about 147 Hz.

In Brief: Optimize
Chemical Saturation

1. Click [Auto Prescan].

2. Click [Manual Prescan].

3. Click [Center Frequency
Fine (CFH)].

4. Check the offset between fat
and water.

5. Evaluate for correct
positioning of CF on the
appropriate peak.

6. Select Options > Modify
RSP.

7. Scroll through the list of
names in the RSP Names
window and double-click
csf.

8. Enter the actual offset value
for the chemical saturation
pulse found in step 5 in the
Current Value text box.

9. Scroll through the names in
the RSP Name window and
double-click cstun.

10. Enter 1 in the Current Value
text box.

11. Check peak suppression.

12. Scroll through the list of
names in the RSP Names
window and double-click
csa.

13. Enter new value in the CSA
text box.

14. Recheck the peak
suppression.
2292261-100 Rev. 0 (03/01) 8-19



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
At 1.5T the shift is about 220 Hz.

5. Evaluate for correct positioning of CF on the appropriate
peak.

a) Set CF to water when using fat saturation.

• At 1.0T, subtract 147 Hertz.

• At 1.5T, subtract 220 Hertz.

° The CF shifts to the fat peak.

° If not, adjust the frequency to determine the actual
offset, and return center frequency to water

b) Set CF to fat when using water saturation.

• At 1.0T, add 147 Hertz.

• At 1.5T, add 220 Hertz.

° The CF shifts to the water peak.

° If not, adjust the frequency to determine the actual
offset and return center frequency to fat.

6. Select Options > Modify RSP.

• Located on the MPS menu bar.

• The Modify RSP (Real-time Sequence Parameters)
window appears.

In Brief: Optimize
Chemical Saturation
cont.

15. Click [Accept].

16. Click [Done].

17. Click [Scan].

CF set to water after APS

CF should shift to the fat
peak after 220Hz is sub-
tracted at 1.5T.
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7. Scroll through the list of names in the RSP Names window
and double-click csf. Alternatively, you can enter csf in
RSP Name text box to adjust the offset value.

• CSF allows changes in the frequency shift value
expected between fat and water peaks.

8. Enter the actual offset value for the chemical saturation
pulse found in step 5. This should be a negative number for
Fat SAT and a positive number for Water SAT.

9. Scroll through the names in the RSP Name window and
double-click cstun. Alternatively, you can enter cstun in the
RSP Name text box to turn on the saturation pulse.

• CSTUN allows entrance into the program to tune the
ChemSAT pulse.

10. Enter 1 in the Current Value text box.

• Valid values are 0 and 1.

° One turns on the presaturation pulse to suppress
either fat or water.
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° The spectrum changes to show the result of the
applied suppression pulse.

11. Check the peak suppression.

• If the peak is not sufficiently suppressed, continue to
Step 12.

12. Scroll through the list of names in the RSP Names window
and double-click on csa. Alternatively, you can enter csa in
the RSP Name text box.

• CSA allows changes in the amplitude of the ChemSAT
pulse.

• CSA defaults to a particular value unique to the MRI
magnet strength and pulse sequence chosen.

• Increasing CSA may provide a chemical SAT pulse
which produces better saturation.

• CSA represents a percentage of the original flip angle
used to saturate the selected tissue.

13. Enter a new value in the Current Value text box.

• Increase this value until the desired peak is optimally
suppressed.

Fat Peak not sufficiently
suppressed.
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° Carefully evaluate both the fat and water peak.

° Your goal is to decrease the desired peak without
affecting the peak centered over the line.

14. Recheck the peak suppression.

NOTE: You cannot always make the fat/water peak disappear.

15. Click [Accept].

• Accepts the changes and closes the Modify RSP
window.

16. Click [Done].

• The MPS window closes.

17. Click [Scan].

• Located in the Scan Operations area.

• The acquisition begins scanning.

Fat Peak sufficiently
suppressed.
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Where Am I?
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Chapter 9

Displaying
Images

Introduction
This chapter explains the image display process. It provides
highlights of key concepts and brief guidelines for displaying and
manipulating images. This chapter also contains the step-by-step
instructions to help you learn how to:

• Sort Exams, Series, or Images

• View Patient List

• Refresh List

• Display Images in a Viewer

• Set a Primary Viewport

• Set a Secondary Viewport

• Cine Page

• Compare

• Analyze Images

• Manipulate Images

• Annotate Images

• Remove Annotation
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• Apply Mattes to Images

• Measure

• Enhance Images

• Cross-Reference a Series

• Screen Save

• Set Up User Preferences

• Use Accelerator Commands

• Save State

• Reverse the Video (Inverse Video)
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In addition, this chapter answers the following questions:

1. What is the Display Browser?

2. How do I display an image?

3. How do I display slice locations?

4. How can I magnify (enlarge) an image?

5. Can I annotate on an image?

6. How can I measure distance on an image?

7. Can I compare images from different series?

8. What are Accelerator Commands and how do I use them?
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About... Displaying
Images
This section presents the concepts necessary to successfully
complete the image display and manipulation process.
Specifically you need to understand:

• Sorting Images

• Viewport Control

• Viewer Organization

• Window/Level Control

• Display Features
° Cine Paging
° Reference Image
° Measuring

• Image Annotation

• User Preferences

• Accelerator Commands
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Sorting Images
Exams and images can be sorted in a variety of ways using the
menu bar across the top of the Browser. Sorting allows you to
change how exams, series, and images are listed in the
Browser and the order in which they are displayed on the
Viewer or the Mini Viewer.

Viewport Control
The viewport is the section of the viewing screen that contains
an image. For example, if there are four images on the viewing
screen, there are also four viewports. Viewports can either be
active or inactive and primary or secondary. The default is for
the upper left viewport to be primary and active, while the
remaining viewports are secondary and active. Active viewports
are affected by display functions, while inactive viewports are
not. The primary viewport is the one first affected by the display
function. Secondary and active viewports are connected with
the primary viewport and can be affected by display functions.
For example, if you window and level on the primary viewport,
the same window and level appear on the secondary and active
viewports.

A single click on a viewport makes that viewport primary and
active and the other viewports are now secondary and active. A
double-click on the viewport to make that the primary and all
others become secondary and inactive. Triple clicking in a
viewport makes that the primary viewport and the others
become secondary and active viewports.

The border around the image for primary and active viewports
turns teal, or bright white if you have a black and white monitor.
Secondary and active viewports borders are yellow, or bright if
you have a black and white monitor. Inactive viewports have no
borders or black borders.
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Viewer Organization
The Viewer is organized such that the Viewer window allows
you to do a number of manipulations, such as cross-referencing
a series (displaying slice locations on a localizer image),
measuring a distance, magnification and multiple ways to view
(display) images. The left hand column contains multiple
buttons to perform the manipulations. Some of the buttons are
simple on/off buttons, and others have menus or windows that
allow for choices in the manipulation process. This chapter
gives detailed instructions on how to perform these functions.

Window/Level Control
The window and level values are adjusted to control which pixel
values are visible in images, and the degree of contrast. The
window level is an image adjustment, which is marginally
similar to the brightness adjuster on a television. The window
width is defined as twice the number of intensities above and
below the currently set level.

Window/Level changes are controlled by the middle mouse
button. If all viewports are connected, the W/L change to an
image in one viewport is applied to all images within the series.
There is one exception to this rule. If the series is a dual echo
acquisition, changing the W/L of a first echo image only
changes all first echo images and not all images within the
series. Changing the W/L of a second echo image only changes
the second echo images and not all the images within the
series. This W/L method allows for independent image
adjustment for first and second echo images when displayed
side-by-side.

Display Features
When you click the Display Desktop icon, the (Display)
Browser appears. The Browser is the area that allows you to
choose the patient, series and images to display. The Browser
has the applications buttons located on the right side of the
screen. These applications buttons take you to windows that
allow you to view or manipulate the images. This chapter
concentrates on Viewer or Mini Viewer application buttons. The
other application buttons are discussed in other
chapters/volumes of this document. After you have selected
(highlighted) the patient, series, images you want to display,
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clicking Viewer or MiniViewer takes you to the Viewer (display)
window.

Cine Paging
Access the Cine Paging function clicking the [Paging] button
from either the Viewer or the Mini Viewer. This function allows
you to page through images in a manner that gives the
appearance of a moving picture. Paging can load up 256
images in the series with a speed up to 60 images (frames) per
second. Paging has the control to set up the “movie” and control
the speed (frames per second) of the “movie.” The default rate
is 10 frames per second for each viewport. Image annotation is
available but effects the frame rate’s performance.

The only valid formats for paging are 1-on-1, 2-on-1, and 4-on-1
with the Viewer and 1-on-1 with the Mini Viewer. Each viewport
has the control of the frame rate, temporal versus spatial
looping, as well as parameters specific to an individual
viewport.

Whether the looping mode is temporal or spatial, the same
mode is applied to all paging viewports simultaneously.

Temporal mode is the default mode and allows you to see how
the images taken at the same location change over time. This
gives you the effect of motion. In this mode, the system
advances continually from first to last image, without pausing.
or an example, an image set consisting of four images appears

in the following order: 1, 2, 3, 4, 1, 2, 3, 4, etc. Suggested
application would be to review a cardiac motion study or a bolus
contrast injection.

Spatial mode allows you to view images taken at different
locations throughout the body. This method enables you to
trace through the anatomy of interest. In this mode, the system
advances sequentially through the images, then moves
backwards through the sequence to the first image. Spatial
demonstrates the motion of a joint or structure in two directions.
For example, an image set consisting of four images appears in
the following order: 1, 2, 3, 4, 3, 2, 1, etc. A suggested
application would be kinematic studies of the TMJ or knee.
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Reference Image
The Reference Image function allows you to insert an image
into a small viewport on the Viewer or Mini Viewer. This inserted
(reference) image identifies the slice location of the main image.
The reference image must be in another plane from the main
image. The two images (the main image and the reference
image) must be from the same exam, have the same horizontal
landmark, same patient position, and same patient entry. When
using Reference Image in the Viewer, the valid screen formats
are 1-on-1, 2-on-1, 4-on-1, 6-on1, and 9-on-1. The Reference
Image cannot be used on viewing formats larger than 9-on-1,
but can be filmed with any film format. If using Reference Image
in the Mini Viewer 1-on-1 is the only valid screen format.

Something to Think About...

• When no series or image is selected for the Reference
Image, the system determines the reference image by
scan and graphic prescription guidelines: the system
uses the series and image used to prescribe the scan of
the non-reference image, and starts with the lowest
numbered series and image.

• The viewport image and the Reference Image cannot be
a Screen Save, a 3D Rendered Image, or Combined
Images.

• Inverse Video affects both the main image and the
Reference Image.

• Series Binding is not be applied to the Reference Image.

A new series for the Reference Image is selected using the
Accelerator Line. The Series [+/-] button on the Viewer Window
are NOT available for new series selection of the Reference
Image.

When filming, the main image and the Reference Image are
filmed as displayed. The Reference Image does not appear on
images filmed when using the F4 key (print series). The
Reference Image and its cutlines appear only if:

• The series displayed includes images scanned in an
intersecting plane.

• The Image Scroll has not scrolled the intersection out of
the Reference Image port.

• The Reference Image’s cutline is not magged out of the
Reference Image port.
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Measuring
You can use the Measure feature a number of ways to obtain
information, distances, and areas of anatomy or pathology. The
[Measure] button is found on either the Viewer or the Mini
Viewer windows. The Measure feature:

• Reports the cursor to record a point on the image.

• Calculates the linear distance between two points on an
image.

• Measures any anatomy or pathology on an image.

• Measures an angle and lists the angle of a line between
two points.

• Measures a rectangular area, a curved area, an elliptical
area, a curved area, and a free draw area.

Click the desired method of measuring from the menu.

• 1 - Measure with a cursor. Click and drag the cursor
over the area of interest to display the cursor
coordinates (A/P, I/S, and L/R locations).

• 2 - Measure with a straight line. Click and drag the
endpoint to resize the line. (The opposite endpoint stays
fixed). Click anywhere on the line except on the
endpoints and drag to the desired area to measure
angle and distance.

• 3 - Measure an angle. Click and drag on the endpoints
to change the angle or click on the line to reposition. The
angle measurement is reported.

• 4 - Measure a rectangle. Click and drag on the small
boxes in the corner to change the size and shape of the
rectangle, or on the tick marks to rotate the rectangle.
Click and drag anywhere on the rectangle, except on the

1

2

3

4

5

6

7
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small (corner) box or the tick marks, to move the
rectangle over the area of interest. Standard deviation,
m, and mmz measurements are reported.

• 5 - Measure with a smooth curve. Click and drag the
small box to the start point. To add the next point to the
curve, move the cursor pointer to the desired location,
hold down the Shift key, and click. Continue adding
points by holding down the Shift key and clicking to
outline the area of interest. Click and drag on a point to
resize (all other points stay stationary). To close the
endpoints of the curve, add the last point near (but not
on top of) the first point. Now click the last point and
drag it on top of the first point. To move the curve over
the area of interest, click and drag anywhere on the
curve (except on the points/boxes). To delete a point,
while holding down the Shift key, click on the point to be
deleted. Click anywhere on the image to hide the points.
(Click on the curve to show points). Standard deviation,
m, and mmz measurements are reported.

• 6 - Measure with ellipse. Click and drag on the small box
to change the size and shape of the ellipse. Click and
drag on the tick marks to rotate the ellipse. Click and
drag anywhere on the ellipse, except on the small boxes
or tick marks to move the ellipse over the area of
interest. Standard deviation, m, and mmz
measurements are reported.

• 7 - Measure with free hand trace. Click and drag on the
small box to move it to the desired staring point. To start
drawing, hold down Shift, and click and drag on the
small box. (Or to define a series of segments, hold down
Shift, and click on each desired endpoint location. To
remove the most recently created segment, press
Backspace.) To move the free drawn area click and
drag anywhere on it. This trace cannot be resized.
Standard deviation, m, and mmz measurements are
reported.

Image Annotation
Image annotation is the text that appears on the image.
Annotation is either system supplied text or text/graphics that
have been added by you. System supplied text is the data
identifying the patient, hospital, physician, and image
parameters. System supplied text is hidden from the screen
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only, the film only or both. The next section about User
Preferences discusses this in more depth.

This illustrates the location of system supplied annotation and is
a composite of all possible parameters. Actual image
annotation varies depending on the acquisition parameters and
the customized screen annotations that were chosen.
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The displayed annotation information uses abbreviations; the
following tables list some annotation abbreviations.

System Supplied

Image Annotation

Abbreviation Description

Th Thickness of slice

TB Top/Bottom flip

LR Left/Right Flip

RO Rotated Image

W Window (pixel value range)

L Level (mid gray pixel value)

MF Magnification Factor

FI Flip

GSE Gray scale enhancement

SP Spacing between slices

DT Trigger delay with MultiPhase imaging
option (gated scan only)

TD Trigger delay without MultiPhase
imaging option (gated scans only)

Ph Number of phases (gated scans only)

FV Flow Velocity (phase contrast only)

v^ Frequency direction

CS Contiguous slice

C A "C" following the slice thickness and
spacing indicates contiguous slice
(0 mm slice spacing)

I A "I" following the slice thickness and
spacing indicates Interleaved slices
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Imaging Option Annotation

Abbreviation Description

UNORIGINAL
IMAGE

Indicates the image is a combination of
multiple images

8/04:18/0: 01 Number of scan/Total Scan Time/Pause
Time

Ramped Pulse Direction (annotation
may vary due to direction)

/F Fast Receiver was used for this scan

AS Autoshim (series text page only)

CL Classic

ED Extended Dynamic Range

EG ECG Gated

ES Echo Spacing (EPI only) (Text page
only)

ET Echo Train

FC Flow Compensation

FCf Flow Compensation in the frequency
direction (FSE scans only)

FCs Flow Compensation in the slice
direction (FSE scans only)

M3D Multi-Slab 3D

MP Multi Phase

MT Magnetization Transfer

NP No Phase Wrap

Ov Number of slice locations on each end
of slab that overlap with the neighboring
slab

PC Phase Correction (series text page
only)

PG Peripheral Gating

PM POMP

PscOpts Prescan Options (series text page only)

RC Respiratory Compensation
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RT Rectangular FOV

RTr Respiratory Triggered

SH Number of Shots (EPI only)

Sl Number of 3D slabs x slice locations
per slab

SPF Swap Phase and Frequency

SQ Sequential

SqP Square Pixels

St Saturation Parameters

TRF Tailored RF

trig Respiratory trigger point as a percent of
maximum (respiratory triggered scans
only)

VB Variable Bandwidth

VS Views per Segment

Abbreviation Description
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Pulse Sequence Annotation

Abbreviation Description

IR Inversion Recovery

SE Spin Echo

SE/V Variable Echo, Spin Echo

SE/EPI Spin Echo, Echo Planar Imaging

GR¹ Gradient Echo, both sequential and
non-sequential

GRE/EPI Gradient Echo, Echo Planar Imaging

3D/GR¹ 3D Gradient Echo

3D/FGR¹ 3D Fast Gradient Echo

2D/FSE 2D Fast Spin Echo

2D/FSEIR 2D Fast Spin Echo, Inversion Recovery

3D/FSE 3D Fast Spin Echo

3D/FSEIR 3D Fast Spin Echo, Inversion Recovery

SPGR¹ 2D Spoiled Grass

SPRG/EPI Spoiled Grass, Echo Planar Imaging

3D/SPGR¹ 3D Spoiled Grass

3D/FSPGR¹ 3D fast Spoiled Grass

TOF/GR¹ 2D Time -of -Flight

3D/TOF/GR¹ 3D Time-of -Flight

3D/TOF/FGR¹ 3D Time-of-Flight Fast Grass

PC/GR¹ 2D Phase Contrast

3D/PC/GR¹ 3D Phase Contrast

Cine/PC/GR¹ Phase Contrast Cine

Cine/SPGR¹ Spoiled Grass Cine

SPGR/EPI Spoiled Grass, Echo Planar Imaging

Cine/GR¹ Gradient Echo Cine

TOF/SPGR 2D Time-of-Flight Spoiled Grass

TOFX 2D Time-of-Flight with SAT Gap

3D/TOF/SPGR 3D Time-of-Flight Spoiled Grass

3D/TOF/FSPGR¹ 3D TIme-of-Flight Fast Spoiled Grass
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¹ Includes Flip Angle Annotation.

User Preferences
This button opens a window which is used to custom set the
following functions:

Annotation - As it appears on the screen and/or the film.

• Full, partial, or custom annotation selects the amount of
annotation that appears on the film or the screen. Custom
opens a window that allows you to pick and choose multiple
options for annotation on the screen or film.

• When Full annotation is selected, all annotation appears.

• When Partial Annotation is selected, only the following
annotation appears:
° Exam, series, and image number
° Scan plane and location
° Echo train
° Flip angle
° Pulse sequence
° Timing parameters (TR, TE, TI)
° Bandwidth
° Number of echoes
° Patient name
° Date of exam
° Magnification factor
° Flip or rotation of image
° Frequency direction
° Window and level values

3D/TOF/MT 3D Time-of-Flight with Magnetization
Transfer

FSE Fast Spin Echo

FSE/V Fast Spin Echo Variable Echo

FMPIR Fast Spin Echo, Inversion Recovery

FMPSPGR¹ 2D Fast Multi Planar Spoiled Grass,
both sequential and non-sequential

FMPGR¹ 2D Fast Multi Planar Gradient Echo,
both sequential and non-sequential

Abbreviation Description
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• When Custom Annotation is selected, only the selected
annotation appears on the film or screen.

• Left, right, top, or bottom removes or shows the FOV
location. For example, an axial image annotated with A200,
P198, R200, and L198, selecting to remove left, removes
the L198 annotation from the film or screen.

Something to Think About...

• When filming with the F3 key be careful of the
annotation on the film. If the film annotation is set to
FULL and filmed with the F3 key, the films have only
PARTIAL annotation. This is to prevent annotation from
overlaying annotation. If you want anything other than
the default annotation to appear (when filming with F3)
you need to click the [Customize] button in the film
section of Annotation Level on the User Preferences
window, then select the annotation that you want to
appear on the film.

Tick Marks - Whether hidden or shown. Tick marks are a scale
shown either on the right side of the image, at the bottom of the
image, or in both places used for measuring.

Grid Preferences - Customize allows for a number a ways to
display a grid on an image.

• Matrix lines - Are either on or off, the matrix lines form the
grid pattern around the central vertical and horizontal line.

• Line style - Lines are selected as dotted or solid.

• Grid Spacing - This is the spacing between the grid lines in
mm.

• Tick spacing - The space between the tick marks in mm.

• Tick Length - The length of the tick marks in mm.

Right mouse button - Controls the primary function of the right
mouse to either scroll or magnify the image.

Series binding - Used when viewing images. With Series
Binding On, when you reach the last image of a series, the next
image displayed is the first image of the next series. With Series
Binding Off when you reach the last image in a series the next
image displayed is the first image of that same series.

Square viewports - Whether on or off, when the selected
viewer format is larger than 4-on-1. For example, viewing with a
12-on-1 screen format, the viewports are rectangular when
Square Viewports Off is selected. The images do not fill the
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entire viewport. With Square Viewports On, the images are
displayed as they appear on the film, each image fills the
viewport and the entire format display is rectangular. Square
Viewports On is recommended to help you select the correct
magnification factor without overlapping annotation when
filming magnified images.

Presets - Allows to create several predetermined values for
window widths and window levels in the Viewer or the Mini
Viewer.

Accelerator Commands
The Accelerator Commands are a shortcut option for frequently
used display and filming functions. A variety of functions can be
performed by entering commands in the Accelerator Line. The
Accelerator Commands are listed later in this chapter.
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How to Display Images
This section provides the step-by-step instructions for
displaying and manipulating images. Specifically, it describes
how to:

• Sort Exams, Series, or Images

• View Patient List

• Refresh List

• Display Images in a Viewer

• Set a Primary Viewport

• Set a Secondary Viewport

• Cine Page

• Compare Images

• Analyze Images

• Manipulate Images
° Magnify Images (Zoom)
° Apply the Magnifying Glass
° Scroll
° Grid
° Erase All
° Hide and Show
° Display Normal
° Reference Image
° Flip/Rotate

• Annotate Images

• Remove Annotation

• Apply Mattes to Images

• Measure

• Enhance Images

• Cross-Reference a Series

• Screen Save

• Set Up User Preferences
° Customize System Supplied Annotation
° Tick Marks
° Customize Grid Preferences
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° Control the Right Mouse Button
° Control Series Binding
° Apply Square Viewports
° Customize the Window/Level Presets

• Use Accelerator Commands

• Save State

• Reverse the Video (Inverse Video)
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Sorting ImagesSort Exams, Series, or Images
Use this procedure when you want to change the way the
exams are listed on the system. You can sort the exams by the
examination number, patient name, date (of scan), modality,
and archive status.

Once an image sorting mode is selected, and the Viewer or Mini
Viewer is opened, the images are displayed in the order of the
selected mode. When the Viewer or Mini Viewer is opened, it is
locked into the currently selected sort mode. To change the
image Sort mode you must return to the Sort menu and select
another Sort mode.

1. Click Sort, from the Browser.

• This is located on the menu bar at the top of the
Browser.

2. Click on the sort method you prefer, from the Sort list.

Something to Think About...

• Only MR images that were acquired using cardiac
gating can be sorted by trigger (trigger delay).

• If your facility has purchased the Connect/Pro PPS
option, you can sort examinations by PPS status.

• The sort by name option responds alphabetically in the
English language, but not other European languages or
Asian languages.

In Brief: Sort Exams,
Series, or Images

1. Click Sort, from the
Browser.

2. Click the sort method you
prefer.
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Build ing a Protocol View Patient List
When you click the Display Desktop icon the current patient
list appears; this is called the (Display) Browser. The Browser
allows you to view (browse) through the contents of the disk
and to select images for display or manipulation functions.
Using the Browser is the best way to view the list of exams and
select them for utility functions, such as archiving or removing.
The Browser also provides access to advanced
post-processing features such as 3-D Model, Reformat, and IVI
(Interactive Vascular Imaging).

1. Click the Display Desktop icon from the Control Panel.

• The patient list appears on the Display Browser.

Display Desktop/Browser

2. You can view the contents of the first section titled
Examinations by clicking and dragging up or down on the
vertical slider (1), found on the right side of this section.
Click (highlight) on the desired exam.

3. The series belonging to the exam are displayed in a window
to the left of the exam window. The images belonging to the
selected series are displayed under the exam window.To
view the contents of these sections, click and drag the slider
up or down. Click (highlight) on the desired series and/or
images.

• The series list shows the series number, the type of
series, total number of images, a series description,
modality and manufacturer.

In Brief: View Patient
List

1. Click the Display
Desktop icon.

2. Place cursor on the slider
of the Examinations
Section. Drag the slider to
view the list.

3. With the cursor on slider
of the Series or Images
section, drag the slider to
view contents.

1
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• The image list shows the location, flip angle, echo, TE,
TI, TR, trigger delay, thickness, spacing, FOV, matrix,
NEX, and archive status.
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Refresh List Refresh List
The patient list updates automatically once the images are
reconstructed. If this does NOT happen automatically, you can
refresh the list manually.

1. Click Application from the Browser menu bar.

2. Click [Refresh lists].

In Brief: Refresh List

1. Click Application.

2. Click [Refresh lists].
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Displaying Images in a ViewerDisplay Images in Viewer
There are a lot of different ways that you can move from one
exam, series, or images to another. This section describes the
way to change this information using the buttons on the Viewer
or Mini Viewer window. You can also use the Accelerator Line
which is discussed later in this chapter.

1. After selecting the exam, series or images to view (follow
the instructions in View Patient List), click [Viewer] or
[Mini Viewer] to display the selected images.

• Viewer window appears.

Browser/Viewer

In Brief: Display
Images in a Viewer

1. Follow instructions in
View Patient List. Select
the exam (series or
image) and click [Viewer]
or [Mini Viewer].

2. Click [Format] and click
the display format.

3. Move to a prior or next
exam, series or image
using [+] or [-], typing in
the number, or using the
Image slider.

4. Change the window width
and level settings, click
and drag with the middle
mouse.
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NOTE: Mini Viewer has all the functions of the Viewer except:

° No Compare Mode

° No Save Screen

° No User Prefs

2. Click [Format], from the lower left of the window, and then
click on the desired display format. You can format to
display 1 or more images on the screen.

3. You can move from one exam, series, or image by clicking
[-] (minus) or [+] (plus) located next to the Exam, Series, or
Image entry. The order in which the images are displayed is
dependent on how the exams/images are sorted in the
Browser.

• This moves you up or down the patient list, displaying
each exam. Clicking [+] moves you to the prior patient
series, or image on the list, and clicking [-] moves you to
the next patient, series, or image on the list.

Something to Think About...

• A limited number of exams can be accessed in the
Viewer when using the plus or minus exam key.
Therefore, highlight an exam in the Browser as the start
or reference point and use the exam plus and minus
keys to navigate around that reference exam.

NOTE: Additional ways to change the image:

• Highlight the number in the Image text box (1) and type
in the new image number in the text box, for example
32.

• Or, clicking and dragging the Image slider (2), manually
pages through the images.

1

2
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4. Change window width and level settings to the desired
contrast using one of the following methods:

a) With the mouse cursor in the viewport, click and drag using
the middle mouse button, in a diagonal direction and release
once you achieve the desired window/level setting. Moving
the mouse L/R changes the window width and moving the
mouse Up/Down changes the window level.

b) Using the arrow keys on the keyboard, pressing the right or
left arrow key increases or decreases (respectively) the
width by 2, pressing the down or up arrow key increases or
decreases (respectively) the level by 2. Holding the arrow
key down continuously provides accelerated
increase/decrease until the key is released. The change is
applied to the primary view first, then to the other views once
you have stopped pressing the arrow key for a few moments.

c) Using the Accelerator Line, located at the bottom of the
Viewer window (shown in picture below), type ww and the
value to change the width, and type wl and the value to
change the level. For example, type wl 800 and wl 250 to
set specific values for window width and level.

d) Using the Predefined values from [Presets]. Click [Presets],
a window appears. Click the desired selection. These
predetermined values are applied to the displayed images.
See the steps for [User Preferences] later in this chapter for
instructions on changing the preset values.

e) Using the F (Function) keys located on the keyboard. See the
chart below for keys and descriptions.

Key Description

F5 Resets the window level to the previous
level.

F6 Uses the Predefined 1 window and
level settings.

F7 Uses the Predefined 2 window and
level settings.
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F8 Uses the Predefined 3 window and
level settings.

F9 Uses the Predefined 4 window and
level settings.

F10 Uses the Predefined 5 window and
level settings.

F11 Uses the Predefined 6 window and
level settings.

Shift + F6 Changes the Predef 1 window/level
settings to those of the active viewport.

Shift + F7 Changes the Predef 2 window/level
settings to those of the active viewport.

Shift + F8 Changes the Predef 3 window/level
settings to those of the active viewport.

Shift + F9 Changes the Predef 4 window/level
settings to those of the active viewport.

Shift + F10 Changes the Predef 5 window/level
settings to those of the active viewport.

Shift + F11 Changes the Predef 6 window/level
settings to those of the active viewport.

Key Description
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Setting a Primary ViewportSet a Primary Viewport
If you have more than one image displayed, you can set any
viewport to be your primary viewport. A viewport becomes
active or receives primary focus by clicking once on it. The
other viewports are secondary and active (affected by display
functions). Double clicking on a viewport makes it a primary
viewport, and the other viewports are secondary and inactive.
The frame around the primary viewport turns teal. If you have
black and white monitor, the primary viewport has a white
frame. Once a window has become the primary viewport and
the others inactive, you can magnify and perform other image
manipulation functions without effecting other images currently
displayed on the screen.

1. Display two or more images in a multi-format setting.

• For the steps, see the section on Displaying Images in a
Viewer.

2. Place your cursor in the viewport you want to make primary,
and double-click. Other viewports are secondary and
inactive.

In Brief: Set a Primary
Viewport

1. Display two or more
images.

2. With cursor in viewport
that is to be primary,
double click.
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Setting a Secondary Viewport Set a Secondary Viewport
Secondary viewports have a yellow or bright white (on black
and white monitors) frame around it. Secondary and primary
viewports are linked together. A change in one of the viewports
is reflected in the other viewport. For example, changing the
window width and window level in the primary image also
changes the window width and window level secondary focused
image.

1. Display two or more images in a multi-format setting.

• For the steps, see the section on Displaying Images in a
Viewer.

2. Double-click on the image that you want to isolate from the
other viewports.

• This is done by placing the cursor over the image that
you want in primary focus and clicking twice quickly. The
image has a frame around it and all the other images on
the screen do not have any frames around them.

3. Single-click on the image that you want to link to.

• This is done by placing the cursor over the image that
you want in secondary focus and click once. This image
now has a teal frame and the previous selected image
has a yellow frame around it.

NOTE: You have to click on the image that you want to be in
primary focus again. Remember that the teal (or white)
frame is the primary focus and the yellow (or black) frame
is the secondary focus.

4. Triple-click on a view activates all viewports and allows you
to change the W/L, Scrolling, and Zoom (magnification)
functions for all the viewports in unison.

In Brief: Set a
Secondary Viewport

1. Follow the steps in
Displaying Images in a
Viewer.

2. Double-click on the image
to be isolated from the
other viewports.

3. Single-click on the image
to link.

4. Triple-click in a viewport
makes that viewport
primary and all others
active.
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Cine PagingUse Cine Page
The Cine Paging function allows you to page through images in
a manner that gives the appearance of a moving picture.
Paging can load up 256 images in the series with a speed up to
60 images (frames) per second. [Paging] has the controls for
the “movie” to get the “movie” set up and the speed (frames per
second). Image Annotation is available but effects the frame
rate’s performance. Cine Paging is accessible from either the
Viewer or the Mini Viewer.

Suggested applications for Cine Paging include kinematic
studies of the TMJ, or knee, heart motion studies and CSF flow
studies.

The default frame rate is 10 frames per second for each
viewport. Maximum frames per second (fps) for 512 x 512 pixel
images with no annotation are as follows:

Image Annotation is available but effects the frame rate’s
performance. Cine Paging is accessible from either the Viewer
or the Mini Viewer.

The following are step by step instructions to use the Cine
Paging function.

1. Select the desired series or images for cine paging.

2. Click [Paging], from the Viewer or the Mini Viewer.

In Brief: Cine Page

1. Select series/images.

2. Click [Paging].

3. Select the first image in
Start area.

4. Select the last image in
the End area.

5. Set FPS.

6. Click Temporal or
Spatial mode. If you do
not wish to page images
in another viewport go to
step 11.

a) Single click on desired
viewport.

b) Click on [Select Series].

c) Select exam and series.

d) Click [Viewer].

7. Click [Go] or [Stop].

8. To change images/series
have viewport in primary
focus Repeat steps 3-7.

9. Click [Cancel] to exit
from the Paging Mode.

Number of
Viewports

Maximum Frames Per Second (fps)

1 60 fps

2 30 fps

4 15 fps
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3. In the Paging window, do one of the following to set the first
image in the movie loop:

• Click and drag on the Start slider to obtain the desired
first image in the movie loop.

• Use the scroll arrow to increment the start image of the
movie loop.

• Type in the image number in the Start text box, and
press Enter.

4. In the Paging window set the last image using on the
following:

• Click and drag on the End slider the obtain the desired
last image in the movie loop.

• Use the scroll arrow to increment the end image of the
movie loop.

• Type in the image number in the End text box, and
press Enter.

5. Set the FPS (Frames Per Second) using one of the
following:

• Click and drag the FPS slider to the desired rate.

• Use the scroll arrow to set the FPS.

• Type a value in the FPS text box, and press Enter.

6. Click on the Temporal or Spatial arrow to set the mode for
looping. Go to step seven if you do not wish to page images
in another viewport.

a) To load images into another viewport for paging, single-click
on the desired viewport.

b) Click [Select Series] to return to the Browser.

c) Select the exam and series desired for paging.

d) Click [Viewer].
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7. Click [GO] (on the movie projector) to start the movie loop.

• [GO] becomes [Stop] while the movie loop is running.
Click [Stop] to stop the movie loop.

NOTE: There is a slight pause before the movie loop starts
running for the images to load.

8. To change the images in a viewport or change the FPS,
make that viewport the primary focus repeat steps 3-7.

9. Click [Cancel] to exit from the Paging Mode.
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Comparing Compare Images
The Compare function allows you to compare images to one
another. The images you compare can be from the same
series, or a different series from the current exam, or you can
even compare another exam or patient to the current one
displayed. This feature is only available using the Viewer.

The following display functions are active in the Compare
Mode: Magnify, Scroll, Annotate, Rect Matte, Grid, Display
Normal, Cursors, and Measuring.

Cross Reference is not available while in Compare mode.

Something to Think About...

• You cannot film images using MID (F3 key) in Compare
mode, as they are two separate images.

1. Select the first exam, series and image that you want to
compare.

2. Click [Viewer] to load the images.

3. Click [Format] and drag to the format you want to use.

• Choose the format for viewing, only the 2-on-1 or 4-on-1
formats are valid for comparing.

4. Click [Compare] from the Viewer.

5. From the Browser, select the second exam/series/image
that you want to compare with the first set of images.

6. Click [Viewer] and the Viewer returns with the Compare
mode activated.

• The monitor is divided into two separate Viewers. If you
want to make changes to the first exam, click on that
side to make that image the primary viewport. Make
your changes, then click on the other side to make it the
primary viewport and make the changes to that side.

In Brief: Compare
Images

1. Select exam/series/
image.

2. Click [Viewer].

3. Click [Format] and
choose 2-on-1 or 4-on-1.

4. Click [Compare].

5. From the Browser choose
the second
exam/series/image for
comparing.

6. Click [Viewer].

7. Click the Left Series or
Right Series Up/Down
arrows to move through
the image set.

8. Click [Cancel].
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7. Click the Left Series or Right Series Up and Down arrows
to move through the image set that is displayed on either
the left side of the Viewer or the right side of the Viewer.

• If you want to move both Series at the same time, use
the Page Up or Page Down keys on the keyboard.

8. When you are finished comparing the images, click
[Cancel Compare].
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Analyzing Images Analyze Images
Image Analysis consists of some the more advanced function
available on your system. Each of these functions are described
in greater detail in Volume 4 of The Signa Learning and
Reference Guide.

1. Display the desired images.

2. From the Viewer window, click [Image Analysis].

• A menu appears listing Image Analysis selections.

3. Click the desired selection to access the function.

• Menu selections vary due to the functions your site has
purchased.

In Brief: Analyze
Images

1. Have desired images
displayed.

2. Click [Image Analysis].

3. Click desired function.
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Magnifying Images (Zoom)Manipulate Images

Magnify Images (Zoom)
You can enlarge or reduce the size of the images using the
Zoom control. You can use zoom to better visualize an area of
interest. Zoom is found on both the Viewer and the Mini Viewer.
The initial zoom factor of the image varies depending the
display format (1-on-1, 4-on-1, etc.) and the image matrix size.
The zoom factor can range from 0.5 (reduction) to 8.0
(enlargement) in increments of 0.1. The following table shows
examples of the zoom factors.

The Zoom factor is displayed in the text box to the right of Zoom
and in the upper right corner of the image.

Use the following steps to perform the Zoom function.

1. Display the desired images.

2. Do one of the following:

• From the Viewer or the Mini Viewer, enter in the Zoom
factor in the text box. Double click in the text box, type in
the desired Zoom factor. Press the Enter key on the
keyboard.

• Click on the right or left arrows to increase or decrease
the zoom factor by 0.1.

• Click and drag the slider (found just below the word
Zoom) left or right. This performs a continuous Zoom on
the selected image.

° 1 - the text box

° 2 - the arrows

° 3 - the slider

In Brief: Magnify Images
(Zoom)

1. Display the desired
images.

2. Select the method to
zoom the images.

3. Click [Display Normal] to
return to original size.

Display Format Zoom Factor for a 256 x 256 Image

1 x 1 4.0

2 x 1 2.0

4 x 1 2.0

3 x 4 1.0

1

2

3
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3. Click [Display Normal] to return to the original image size.

Something to Think About...

• If necessary, the operator’s console automatically
reduces the quantity of annotation when reducing the
image size. This is to avoid overflowing the display area.
If all annotation is not visible when viewing an image,
magnifying the image displays more annotation.

• When an image is magnified you can activate the Scroll
function to move the image around within its frame,
centering over the area of interest.

• Zoom is applied to all images in the series if you have
your view selection as primary, followed by secondary. It
applies only to the primary if you de-select the other
views.
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Magnifying GlassManipulate Images

Apply the Magnifying Glass
The Magnifying Glass allows you to magnify a square region of
view with 2X magnification. The Magnifying Glass is moved
about the image by moving the mouse. This function is applied
with an image in the Viewer or Mini Viewer.

1. Click the Magnifying Glass icon.

2. Place the cursor in the image of interest.

3. Click on the right mouse and hold to activate the Magnifying
Glass.

4. While holding the right mouse, move the mouse so the
Magnifying Glass is over the area of interest.

5. Releasing the right mouse deactivates the Magnifying
Glass.

Something to Think About...

• You can set the right mouse button to default as the
Magnifying Glass, see the section on User Preferences
in this chapter. This allows you to use the right mouse
button as a magnifying glass without first clicking the
Magnifying Glass icon.

In Brief: Apply the
Magnifying Glass

1. Click the
Magnifying Glass icon.

2. Place cursor in image.

3. Right click and drag
mouse to move the
Magnifying Glass around
the image.

4. Releasing the right
mouse deactivates the
Magnifying Glass.
2292261-100 Rev. 0 (03/01) 9-39



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
Scroll Manipulate Images

Scroll
Scrolling allows you to move the image within the viewport and
to move the area of interest to the center of the viewport. Image
Scrolling can be accessed from either the Viewer or the Mini
Viewer and can be applied to any image.

1. Click the Scroll icon.

2. Move the cursor to the desired image.

3. Click the right mouse button and hold to activate the scroll
feature.

4. While holding the right mouse button, move the cursor
around the image. The image follows the cursor.

5. Click [Display Normal] to return the image to its original
state.

Something to Think About...

• If you have the right mouse button programmed to scroll
(see section on User Preferences) you to use the right
mouse button as a scrolling feature without first clicking
the Scroll icon.

• If you have used a matte, the Scroll function scrolls your
matted image within the viewport. It does not “pan”
outside the matte.

In Brief: Scroll

1. Click the Scroll icon.

2. Place cursor in image.

3. Click and hold the right
mouse button.

4. Move the cursor around
the image.

5. Click [Display Normal] to
return to original state.
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GridManipulate Images

Grid
Grid allows you to place a grid (matrix) over the primary image.
See the section in this chapter on User Preferences to
customize how the grid is displayed.

1. Put the image of interest into primary viewport.

2. Click the Grid icon.

3. Click the Grid icon again to turn off.

In Brief: Grid

1. Put the image of interest
in primary viewport.

2. Click the Grid icon.

3. Click the Grid icon again
to turn off.
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Erase All Manipulate Images

Erase All
The Erase All button is used to erase user added Annotation,
Rect. Matte and graphics (such as a grid) operations. This
feature works similar to the Display Normal feature described
later in this chapter.

1. Put the image of interest in primary viewport.

2. Click [Erase All].

In Brief: Erase All

1. Put the image of interest
in primary viewport.

2. Click [Erase All].
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Hide and ShowManipulate Images

Hide and Show
You can temporarily remove user added annotation using the
Hide feature.

You can redisplay this annotation using the Show feature.

1. Have the image of interest in primary focus.

2. Click [Hide].

3. Click [Show] to have the text reappear.

In Brief: Hide and Show

1. Put the image of interest
in primary viewport.

2. Click [Hide].

3. Click [Show].
2292261-100 Rev. 0 (03/01) 9-43



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
Display Normal Manipulate Images

Display Normal
You can reset the image display to its original size and
orientation using the Display Normal feature.This feature
removes all filters, magnification factors (Zoom), flip/rotate,
scroll, and image enhancements from the selected images.

1. Put the image of interest in primary viewport.

2. Click [Display Normal]

Something to Think About...

• Using [Display Normal] has NO effect on Rect. Matte,
Annotation, or Graphics Operations. Use [Erase All] to
remove these elements from the image.

In Brief: Display Normal

1. Put the image of interest
in primary viewport.

2. Click [Display Normal].
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Reference ImageManipulate Images

Reference Image
The Reference Image function allows you to insert an image
into a small viewport on the Viewer or Mini Viewer. The inserted
image identifies the slice location of the main image. This
inserted (Reference) image must be in another plane from the
main image. The two images (the main image and the
Reference Image) must be from the same exam, have the
same horizontal landmark, same patient position, and same
patient entry.

1. Click [Reference Image].

2. Click one of the Reference Image options from the menu by
clicking the desired choice.

• All On places the reference image on all the viewports.

• All Off takes the reference image off all the viewports.

• Selected On places the reference image on only the
selected viewports.

• Selected Off places the reference image off only the
selected viewports.

3. The system automatically chooses a reference image for
you. If you would like to use a different image for the
reference do one of the following:

• To change the reference image on a specific viewport,
select (as you would to set primary viewport) the
reference image viewport and type in ri 3 7, in the
Accelerator Line. The example ri 3 7 represents
series 3 image 7 as the reference image (ri).

• To change the reference image on all viewports, select
all reference image viewports (as you would to set
secondary viewport) and type ria 3 7 in the
Accelerator Line. The example ria 3 7 represents
series 3 image 7 reference image all (ria).

In Brief: Reference Image

1. Click [Reference Image].

2. Click the desired option
from the menu.

3. Use the system reference
image or change the
reference image.
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Something to Think About...

• The Reference Image only displays in the lower right
corner of each viewport, the Reference Image CANNOT
be moved.
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Flip RotateManipulate Images

Flip / Rotate
You can flip or rotate the images you have displayed. Once you
flip or rotate the images, they are annotated with the flip
direction and the rotation. This annotation is on the top right of
the image. If the images are not flipped or rotated there is no
annotation flowing the FL: or ROT: annotation.

1. Put the image of interest in primary viewport.

2. Click [Flip Rotate].

• A menu appears.

Flip Rotate

3. Click on the desired manipulation.

• 1 - Flips Left to Right, film annotation FL: L/R

• 2 - Flips Top to Bottom, film annotation FL: T/B

• 3 - Rotates Counterclockwise, film annotation ROT: 270

• 4 - Rotates Clockwise, film annotation ROT: 90

In Brief: Flip / Rotate

1. Put the image of interest
in primary viewport.

2. Click [Flip Rotate].

3. Click the Flip or Rotation
desired.

1

2

3

4
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Annotating Images Annotate Images
You can add annotation to the image, for example, to make
comments or observations, to draw attention to a specific area
of interest, or for labeling purposes. Multiple areas of annotation
can be added to an image and then later deleted. Annotation
includes an on-screen arrow for pointing out specific structures
as well as text entry. The annotation function can be done using
either the Viewer or the Mini Viewer. This procedure guides you
through annotating images.

1. Place the image to receive the annotation in primary
viewport.

2. Click the A (annotate) icon.

• A text box and arrow are positioned in the middle of the
image.

3. Move the cursor to the image and begin typing. The
message is automatically placed inside of the displayed
box. Press enter key to create a new line of text.

4. Drag the box and arrow to the desired location.

5. Click on the arrowhead and drag the cursor (now a pencil)
to change the direction and length of the line.

• Clicking and dragging the arrowhead into the text box
hides the arrow, or type arrow off in the Accelerator
Line. Typing arrow turns it back on.

• Click the cursor outside the text box (or Ctrl X) to erase
the text box lines.

• Click the cursor on the text to make the text box lines
reappear.

6. Type prop all in the Accelerator Line to propagate the
text to all the images of the series.

In Brief: Annotate Images

1. Have image of interest in
primary viewport.

2. Click the A icon.

3. Move cursor to image and
type text.

4. Drag box and arrow to
desired location.

5. Click on arrowhead to
change size/length of the
line.

6. Type prop all for text
to go on all images of
series.

7. Click the Erase Annotate
icon to erase a single
area of annotation.
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7. Highlight the active text box and arrow, click the Erase
Annotate icon to erase that single area of annotation.

NOTE: Clicking [Erase All] removes all areas of annotation.
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Removing Annotation Remove Annotation
You can easily remove some or all of the user entered
annotation.

1. Use one of the following methods:

• To remove all the user entered annotation, click
[Erase All].

• To remove specific user entered annotation, select
(highlight) the text and click Erase Annotate icon.

• To temporarily hide the annotation, click [Hide]. Click
[Show] to redisplay the annotation.

In Brief: Remove
Annotation

1. Click [Erase All],
[Erase Annotate], or
[Hide].
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Applying Mattes to ImagesApply Mattes to Images
The Matte function eliminates unwanted information or artifacts
on or around an image before displaying or filming images.
There are two types of matte: rectangular and elliptical. The
size of the matte can easily be adjusted to fit the size of the
area of interest.

1. While in the Viewer or Mini-Viewer, put the image of interest
in primary viewport.

2. Click [Rect. Matte].

• A rectangular matte appears on your image.

NOTE: Using the Accelerator Line, you may type the command
ematte to use an elliptical matte instead of rectangular.

Modifying a Displayed Matte
Once a matte is displayed you can modify its size and shape,
add it to all images, copy it to a single image or remove it
completely. The steps for doing these modifications are
discussed below.

3. Click and drag on the plus sign (+) in the upper left corner of
the matte to resize it.

4. Click and drag on any side of the matte to re-position it.

5. Type prop all in the Accelerator Line to propagate the
matte to all the images in the series.

6. Click [Erase All] to remove the matte.

In Brief: Apply Mattes to
Images

1. Put image in primary
viewport.

2. Click [Rect. Matte].

Modifying a Displayed
Matte

3. Click and drag the plus
sign to size the matte.

4. Click and drag on side of
matte to re-position.

5. If desired type prop all
in the Accelerator Line.

6. If desired click [Erase All]
the remove matte.
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Something to Think About...

• Use the scroll function to scroll the matted image within
the Viewport. It does not “pan” the image area outside
the matte.

• To copy the matte, press Ctrl C, on the keyboard. Click
on the new image and press Ctrl V, on the keyboard, to
paste.
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Measuring DistanceMeasure
You can use the Measure feature a number of ways to obtain
information, distances, and areas of anatomy or pathology.
[Measure] is found on either the Viewer or the Mini Viewer
windows. It can report the cursor to record a point on an image,
calculate the linear distance between two points, measure the
area of anatomy or pathology, and list the angle of the line
between the two points.

1. Put the image of interest in primary viewport.

2. Click [Measure].

• A menu appears.

Measure

3. From the window click on the desired method to measure.

• The cursor starting point is placed in the center of the
image.

4. Click and drag on the small box to draw or resize. Move
them to the desired start and end location.

• Once the start and end points are set, a real time
readout of the distance and angle appears in the lower
right corner of the image.

• Up to three statistics are displayed on the screen at one
time. If the measurement you want to see is not
displayed, just click anywhere on the line and the
measurement is displayed.

NOTE: Click [Erase] to erase the active (blue) Measure Distance
line. If more than one measure is on the image, continue
clicking [Erase].

In Brief: Measure

1. Put the image of interest
in primary viewport.

2. Click [Measure].

3. Select the desired option
from the menu.

4. Click and drag where
necessary.
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Editing a Protocol Enhance Images
Image Enhance provides a menu of filters and gray scale
changes. The filters are used for edge or lung enhancement or
to smooth and image. The ClariView feature uses different
filtering algorithms than the Image Enhance feature. The gray
scale enhancement adjusts the gray scale to one of three
different levels. The gray scale enhancement increases the
image contrast so that the image has a more black/white
appearance. Image Enhance is accessed through either the
Viewer or the Mini Viewer.

1. Place desired image in the Viewer.

2. Click [Image Enhance].

• A menu appears, listing your choices for Image
Enhancement.

3. Click on a gray scale or filter.

• Gray scale enhancement: g1 results in the smallest
contrast change while g3 has the most contrast change.
Gray Scale Enhancement is generally used more for CT
images than MR images.

• Filters: those labeled s are smoothing filters (various
levels), those labeled e are edge enhancing filters
(various levels.) The filter labeled lu is for lung
enhancement and is primarily used for CT lung images.

NOTE: Images are annotated on the middle right side of the
image as, FLT: s2 or FLT: e1(examples.) Image Enhance
filters can apply only one filter, at any time to an image.

In Brief: Enhance
Images

1. Place image in Viewer.

2. Click [Image Enhance].

3. Click on desired filter.

4. Click [Display Normal] to
remove filter.
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4. Click [Display Normal] to display the image without the
filter.

Something to Think About...

• Image Enhance filters are not additive. Only one filter
may be applied to an image at any time. Applying a new
filter negates the previously applied values.

• The Image Enhance gray scales and filters are applied
to image data only. They are not applied to graphics,
image annotation, or user added annotation.
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Cross-Referencing Cross Reference a Series
The Cross Reference feature displays lines on a view that
represent where one series intersects another plane.
Cross Reference is used for filming or viewing to provide an
anatomical reference to the images acquired on an intersecting
plane. You can cross reference an entire series, the first and
last image of a series, a single image, or range of images within
a series by typing in a single command in the Accelerator Line.
Cross referencing can be done either in the Viewer or the Mini
Viewer.

Something to Think About...

• The cross reference lines may overlap annotations.
Take this into consideration when filming.

• You cannot cross reference more than one
non-consecutive image with a single command.

1. Select the view on which to display the cross reference and
put this image of interest in primary focus.

2. Type in the Accelerator Line one of the following
commands:

NOTE: Be sure to follow the example, including the spaces.

• xr 3 to display the slices for series 3.

• xr 3/5-% to display the slices for series 3 starting with
image 5 through (/) the last slice number of the series
(%).

• xr 3/10-60:5 to display the slices for series 3 starting
with image number 10 to image number 60, with an
interval (:) of 5 slices.

• noxr to deactivate the cross reference mode (removes
the Cross reference lines).

• xra to append an image to the cross reference display.
For example: xra 2 11 where 2 represents the series
and 11 represents the image (displays the
cross reference of a single slice).

• xr #(series number) extrema to display only the first
and last slices of a series. For example: xr 3 extrema
displays the first and last slice of series 3.

In Brief: Cross
Reference a Series

1. Put image of interest in
primary viewport.

2. Type in the Accelerator
Line one of the
commands.
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NOTE: A 3D data set with projection (PJN) images does not post
the first and last slice with the cross reference type in
command xr # extrema. You must use the cross
reference type in command for images with a gap. For
example: a 3D data set (series 3) with 1 collapsed image,
19 projection images, and 60 total slices, type in the
following: xr 3/21-60:39 to display the cross
reference without the PJN images.

• Non-consecutive images require several commands.
For example, to cross reference slices 2, 5, 6, 8 and 12
of series 3, the commands required are:

a) xr3 2

b) xr 3 5-6

c) xra 3 8

d) xra 3 12

• The resultant cutline would appear like this:
3/2-------------
3/5-------------
3/6-------------
3/8-------------
3/12-----------
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Screen Save Screen Save
The Screen Save feature allows you to save any image,
including manipulated images, to a new series in the same
exam. Screen Save is available from the Viewer (but not from
Mini Viewer).

1. Have image of interest in the primary viewport.

2. Click [Save Screen].

• The new series is available on the Browser. It is labeled
as SSAVE with a series number of 99. If additional
images are saved they are added to this series and the
Imgs column increases by one for each image.

• Window level is still adjustable and magnify is still
available.

Something to Think About...

• Any annotation that is on the image cannot be removed
once the screen has been saved; it is a “snapshot” of
the screen and cannot be altered.

In Brief: Screen Save

1. Put image in primary
viewport.

2. Click [Save Screen].
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Set Up User PreferencesSet Up User Preferences
You can modify a number of system defined defaults to
customize the display based on your site’s preferences. These
functions can only be set from the Viewer, not the Mini Viewer
(although the effect can be seen on the Mini Viewer). This
section gives you step-by-step instructions to set up and/or
change any of these functions.

Customize System Supplied
Annotation
This gives you the ability to change and customize the system
annotation as it appears on the screen (viewer) and on the film.

1. Display an image in the Viewer.

2. Click [User Preferences].

• The User Preferences window appears.

In Brief: Customize
System Supplied
Annotation

1. Display images in the
Viewer.

2. Click
[User Preferences].

3. Select No, Full, Partial,
or Custom Annotation
Select for screen or film.

4. To change custom
annotation options go to
step 5. Go to Step 7, if not
changing custom
annotation options.

5. To Customize annotation,
click [Customize] and
select the desired
choices.

6. Click [Ok].

7. Click one of the following:
[Apply], or [Save as
Defaults], or [Cancel].
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3. Choose whether you want to change the annotation on the
screen (viewer) or the film; the process is the same for both.

a) Click the button next to the annotation option No annotation,
Partial annotation, Full annotation, or Custom annotation
to turn on that option. Custom annotation displays whatever
options are selected in the custom annotation window. Go to
Step 9 if you do not want to select Custom annotation.

4. Click [Customize] and a window appears.

User Prefs / Customize

• The buttons that are “in” show that annotation on the
screen/film.

Something to Think About...

• When filming with the F3 key be careful of the
annotation on the film. If the film annotation is set to
FULL and filmed with the F3 key, the films have only
PARTIAL annotation (Site name, patient name, system
ID, and Lower Left corner - technique are missing). This
is to prevent annotation from overlaying annotation. If
you want anything other than the default annotation to
appear (when filming with F3) click [Customize] in the
film section of Annotation Level on the User Preferences
window, then select the annotation (typically all) that you
want to appear on the film.

5. Turn on or off any of the options, by clicking the button in
front of the desired option to set the amount of annotation
on the screen (or film).

6. Click [Ok] to accept the changes to the annotation and to
close the window.
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7. Do one of the following:

• Click [Apply] from the User Preferences window to
apply the selected options to the screen (or film). This is
a temporary application and applies only to the currently
displayed images.

• Click [Save as Defaults] to permanently save the
selections.

• Click [Cancel] to exit without applying or saving the
selections.
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Tick Marks Set Up User Preferences

Tick Marks
This function allows you to turn the Ticks Marks on or off the
Viewer, or Mini Viewer and the film. This function cannot be
customized for film or screen, it is applied to both.

1. Click [User Preferences].

2. Select Shown or Hidden in the Tick Marks area.

In Brief: Tick Marks

1. Click
[User Preferences].

2. Select Shown or Hidden.
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Grid PreferencesSet Up User Preferences

Customize Grid Preferences
The Grid Preferences allow you to control the Grid spacing and
Grid appearance.

1. Click [User Preferences].

2. Click [Customize] from the Grid Prefs area.

• A grid Preferences window appears.

User Preferences/Customize gridPrefs

3. Click on the desired selections for:

• Matrix Lines which turns on or off the lines that form a
grid pattern about the central vertical and horizontal
lines.

• Line Style which changes to the grid lines to solid or
dotted.

Double click in the text box to the right of the following and type
in the desired number:

• Grid Spacing which changes the space between the
grid lines in mm.

• Tick Spacing which changes the space between the
tick marks in mm.

• Tick Length- which changes the length of the tick
marks in mm.

4. Press the Enter key after typing in the text box.

5. Click [Ok] to save the changes.

In Brief: Customize Grid
Preferences

1. Click
[User Preferences].

2. Click [Customize] from
Grid Prefs.

3. Click on the desired
selections. Grid Spacing,
Tick Spacing and Tick
Length are text boxes.

4. Press Enter.

5. Click [Ok] or [Cancel].

6. Click one of the following:
[Apply], or [Save as
Defaults], or [Cancel].
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• Click [Cancel] to exit without saving the Grid
Preferences.

6. Do one of the following:

• Click [Apply] from the User Preferences window to
apply the selected options. This is a temporary
application and applies only to the currently displayed
images.

• Click [Save as Defaults] to permanently save the
selections.

• Click [Cancel] to exit without applying or saving the
selections.
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Right Mouse ButtonSet Up User Preferences

Control the Right Mouse Button
This allows you control the default setting for the right mouse
button on views.

1. Click [User Preferences].

2. In the Right mouse button area select the desired function
for the right mouse, when viewing.

• Scrolling is the standard right mouse function.

• Magnify glass is the alternate option.

3. Do one of the following:

• Click [Apply] from the User Preferences window to
apply the selected options. This is a temporary
application and applies only to the currently displayed
images.

• Click [Save as Defaults] to permanently save the
selections.

• Click [Cancel] to exit without applying or saving the
selections.

In Brief: Control the Right
Mouse Button

1. Click
[User Preferences].

2. In the Right mouse
button area, click
Scrolling or
Magnifying glass.

3. Click one of the following:
[Apply], or
[Save as Defaults], or
[Cancel].
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Series Binding Set Up User Preferences

Control Series Binding
Series Binding is a function used when viewing images. If
Series Binding is on and you reach the last image in a series,
the next image displayed is the first image of the next series. If
Series Binding is off, and you are viewing the last image in a
series, the next image to view is the first image of that same
series. To turn Series Binding on or off complete the follow
steps.

1. Click [User Preferences].

2. In the Series binding area click the button to the left of the
desired choice:

• Series binding ON (To turn ON).

• Series binding OFF (to turn OFF).

3. Do one of the following:

• Click [Apply] from the User Preferences window to
apply the selected options. This is a temporary
application and applies only to the currently displayed
images.

• Click [Save as Defaults] to permanently save the
selections.

• Click [Cancel] to exit without applying or saving the
selections.

In Brief: Control
Series Binding

1. Click
[User Preferences].

2. Click the button for Series
Binding ON or OFF.

3. Click one of the following:
[Apply], or [Save as
Defaults], or [Cancel].
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Square ViewportsSet Up User Preferences

Apply Square Viewports
Square Viewports affects the shape of the image viewports and
the selected Format in the Viewer. If Square Viewports are on,
the system displays the images in the Viewer exactly as they
are seen on the film. The default is Square Viewports Off. The
following instructions explain how to turn Square Viewports On
or Off. To achieve the correct magnification factor be sure
Square Viewports are on.

1. Click [User Preferences].

2. In the Square viewports area select the desired choice:

• Square viewports On (to turn on).

• Square viewports OFF (to turn OFF).

3. Do one of the following:

• Click [Apply] from the User Preferences window to
apply the selected options. This is a temporary
application and applies only to the currently displayed
images.

• Click [Save as Defaults] to permanently save the
selections.

• Click [Cancel] to exit without applying or saving the
selections.

In Brief: Apply Square
Viewports

1. Click
[User Preferences].

2. Click the button for
Square viewports ON or
OFF.

3. Click one of the following:
[Apply], or
[Save as Defaults], or
[Cancel].
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Presets Set Up User Preferences

Customize the Window/Level Presets
The Preset selection allows you to preset six different filming
Window Widths and Window Levels. Using these presets, you
can quickly adjust the brightness and contrast of the image. If
the operator’s console is networked with a CT system, you have
a separate set of six preset values for CT images. The following
are step by step instructions to customize the preset values.

The Presets (1-6) values correspond to the Function (F) keys
F6-F11. Pressing one of these F keys changes the window
width and level to the Preset value.

NOTE: The F5 key sets the window and level to the most recent
settings.

1. Click [User Preferences].

2. Click [MR/CT] and select the appropriate modality.

3. In the Presets area, do one of the following:

• Select the text you want to change and type in the new
title, w/width, or w/level. Press the Delete key (on the
keyboard) to clear the text box.

• Width and level need to be entered as numbers.

• Click [Set Current]. To set the width/level on the image
selected (and overwrites any type-in).

In Brief: Customize
the Window / Level
Presets

1. Click
[User Preferences].

2. Click [Modality] and
select the modality.

3. Do one of the following:
Type in new values/text,
or click [Set Current].

4. Click one of the following:
[Apply], or
[Save as Defaults], or
[Cancel].
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4. Do one of the following:

• Click [Apply] from the User Preferences window to
apply the selected options. This is a temporary
application and applies only to the currently displayed
images.

• Click [Save as Defaults] to permanently save the
selections.

• Click [Cancel] to exit without applying or saving the
selections.
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Using Accelerator Commands Use Accelerator Commands
The Accelerator Commands are type in commands that allow
you to use as shortcuts to perform some functions. You can use
these commands by entering text in a text box, called the
Accelerator Line. The Accelerator Commands are listed after
these instructions.

1. Place your cursor inside the Accelerator Line text box (the
cursor must remain inside this text box).

• 1 - the Accelerator Line.

2. Type text for desired command, using lowercase letters
only.

• To access the list of Accelerator Commands type ? in
the Accelerator Line. A window appears listing all the
Accelerator Commands. Scroll the slider on the right to
view entire list.

Something to Think About...

• Some Accelerator Commands can be accessed directly
from the list by clicking on the command.

• Click [Cancel] to exit from the Accelerator Command
list.

3. Press the Enter key (on the keyboard).

• The following is a list of the available Accelerator
Commands.

In Brief: Use
Accelerator
Commands

1. Place the cursor in the
Accelerator Line.

2. Type in the Accelerator
Command.

3. Press Enter.
1
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Accelerator Command List

Command Type in
Abbr.

Description

? ? Opens a list of these
commands with
abbreviations and
descriptions.

Paging

paging interval pi Sets the interval between
movie loop frames. For
example: pi 2.

paging interval all pia Sets the interval between all
movie loop frames. For
example: pia 2.

paging mode pm Toggles between spatial and
temporal mode. For
example: pm spatial.

cine paging pa Runs a movie loop with
given range and frame rate.
For example:
pa 1 20 10, where 1 and
20 define the slices in the
movie loop and 10
represents the FMS.

Series Selection

exam
series
image

e

s

i

To select a particular
Exam/Series/Image. When
no e/s/i letters are specified,
priority goes to image
number, then series, and
then exam. For example,
12/13 means
series12/image13. For
example: e50 51.

next exam ne Goes to the next exam in the
Browser.

next series ns Goes to the next series in
the Browser.
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previous exam pe Goes to the previous exam
in the Browser.

previous series ps Goes to the previous series
in the Browser.

series binding sb Sets the series binding to be
on or off. For example:
sb on.

Annotation Level/Groups

annotation none an Displays no annotations
levels on the screen.

annotation partial ap Displays partial annotations
levels on the screen.

annotation full af Displays all annotations
levels on the screen.

annotation custom ac Turns on your
predetermined advanced
annotation on the viewer.

annotation groups agp Turns on/off annotation
groups on the screen.

film annotation none fan Films no annotations.

film annotation partial fap Films partial annotations.

film annotation full faf Films all annotations.

film annotation custom fac Turns on your advanced
annotation on the film
composer.

film annotation groups fagp Turns on/off annotation
groups in the film.

Image Manipulation

autofit Returns to autofit zoom
factor. For example:
autofit.

flip horizontal fh Flips image horizontally (top
to bottom).

flip vertical fv Flips image vertically (left to
right).
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rotate left rl Rotates image left by 90
degrees.

rotate right rr Rotates image right by 90
degrees.

normal no Returns to normal
orientation and autofit zoom
factor.

format Sets display format to a
maximum of 5 rows and 5
columns. For example:
format 3 5.

reset Resets the initial display
parameters. For example:
reset.

window level wl Sets the window level value.
For example: wl 250.

window width ww Sets the window width value.
For example: ww 800.

set initial windowing siw Sets windowing values to
the initial values.

zoom zoom Sets the zoom factor. For
example: zoom 2.

invert Inverts the video. For
example: invert.

filter fi Turns on filters. For
example: fi edge1.

gray scale enhance gse Changes the gray scale. For
example: gse g1.

Graphics

reference image ri Turns on Reference Image
for one image. For example:
ri 2 1, where 2
represents the series, and 1
represents the image.

reference image all ria Turns on Reference Image
for all images. For example:
ria.
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reference image off nori Turns off Reference Image
for the selected image. For
example: nori.

reference image all off noria Turns off all Reference
Images. For example:
noria.

cross ref xr Displays the cross reference
lines representing images
im1 - im2 from the series
s(xr s#), or from imx-%
(the last image in the series:
xr s# # %), or from the
first and last images only
within the series
xr s# extrema.

cross ref off noxr Turns off cross reference on
the selected image.

cross ref append xra Appends an image to the
cross reference display. For
example: xra s2 11,
where 2 represents the
series and 11 represents the
image.

report cursor Creates a report cursor
graphic. For example: click
on report cursor from the
help menu, and then press
[Enter] when the cursor is
positioned in the
Accelerator Line.

report pixel Displays a 4 x 4 mm cursor
that can be dragged to a new
location. When the cursor is
deposited, the mean, sd
(standard deviation), and
area are displayed. For
example: click on report
pixels from the help menu
and then press [Enter] when
the cursor is positioned in
the Accelerator Line.

tick marks tm Turns tick marks on or off.
For example: tm on.
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tick mark vertical tmv Turns vertical tick marks on
or off. For example:
tmv on.

tick mark horizontal tmh Turns horizontal tick marks
on or off. For example:
tmh off.

grid Turns Grid on or off. For
example: grid on.

erase graphics eg Erases selected graphics.

erase all graphics eag Erases all graphics.

hide graphics hg Hides all graphics.

show graphics sg Shows all graphics.

Filming

print page pp Captures a page for filming.

print series prs Prints the current series.

text page exam te Opens the text page with
exam information.

text page series ts Opens the text page with
series information.

text page roi tpr Opens the text page with
ROI information.

Miscellaneous

mouse mode mm Sets mouse right button
mode to either image scroll
or magnifying glass. For
example: mm scroll.

user prefs up Displays the user preference
panel.

user text page utp Automatically displays an
annotation box so the
selected viewport can be
used as a user text page.

quit Quits Viewer or Mini Viewer.
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save state ss Stores save state
parameters (W/L) for images
between the first image and
last image inclusive (entire
series if first image and last
image are not specified). For
example: ss 1-10.
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Save StateSave State
Use the Save State feature to save parameters which are
recalled every time the current series or images are viewed on
the same operator’s console. The following parameters are
saved:

• Image Orientation

• W/L Values

• Graphics (including the user added annotation)

1. Enter the following command in the Accelerator Line
save_state or ss followed by the image numbers to be
saved, such as ss 1-10.

NOTE: The Save State parameters are stored LOCALLY on the
operator’s console only. The Save State parameters are
not archived or transferred with networked images.

• Images with the Save State applied are archived in their
original form.

In Brief: Save State

1. Type save_state or
ss_image numbers in
the Accelerator Line.
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Reversing the Video Reverse the Video (Inverse Video)
Reversing the video (inverse video) changes the blacks to
white, creating a negative image.

This is applied to all images in Viewer.

1. Put the image of interest in primary viewport.

2. In the Accelerator Line type invert.

3. To return image to “normal,” type invert again.

In Brief: Reverse the Video
(Inverse Video)

1. Put image in primary
viewport.

2. Type invert in the
Accelerator Line.

3. Type invert again to
return to normal.
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Chapter 10

Filming Images

Introduction

This chapter explains how to film images from the operator’s
console. You can send images that have been displayed, analyzed
and manipulated to a laser camera for film output or to a printer for
paper output. Clicking the Display Desktop icon takes you to the
Browser, where you can film images using the Viewer or the Mini
Viewer. This chapter contains the concepts and the step-by-step
instructions to:

• Set Up the Film Composer

• Load with Drag and Drop

• Load with the Function (F) Keys

• Load Text Pages

• Erase an Image from the Film

• Print Images

• Select a Remote Printer

• Check the Print Queue

• Set Window and Level Presets
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In addition, this chapter answers the following questions:

1. How do I set the format?

2. How do I preset window widths and levels?

3. What are the different ways to film images?

4. How do I check the Print Queue?
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About...Filming Images
This section presents the concepts necessary to successfully
film images. Some of the concepts you need to understand are:

• The Film Composer
° Setting Up the Filming Parameters
° Print Options
° Loading the Images
° Printing

• The F (Function) Keys

• The Print Queue

• The Remote Printer
2292261-100 Rev. 0 (03/01) 10-3



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
The Film Composer
The Film Composer window allows you to choose a print format
and send images to a laser camera for a film output or to a
printer for paper output. The system must be linked to the
appropriate output device. You can place images from multiple
viewing applications, and therefore multiple studies, on the
same film. The Film Composer can be accessed from the
Viewer or the Mini Viewer.

Something to Think About...

• If the film composer disappears when Viewer functions
are performed, click the [Film Composer] button from
the Viewer window to redisplay the film composer.

There are three primary steps to the filming process:

• Setting up the filming parameters

• Loading the images

• Printing
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Setting Up the Filming Parameters
Setting the film parameters means to select the parameters you
will use to film images at the operator’s console:

• How many images to print on the film (typically up to 20).
This is the Film Format.

Film Composer/Formats

° The available film formats may vary depending on the
laser camera or printer being used.

° Use a 2 x 2 display format (4-on-1 screen) on the Viewer
for filming, otherwise the magnification factor is different
between the Viewer and filming.

Something to Think About...

• If configuring formats in the camera selected and film
composer format list, does not automatically take the
selected changes, then restart the film composer
operation. Or, click immediately on Printer Label located
at the top of the Film Composer application after
configuring the printer.
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Print Options

A number of print options are available on the Film Composer
and can be customized for your filming protocols. When you
select these options they are set in your system, but may
adjusted at any time.

Film Composer/ Print Options

• Slide Format - Images produced in slide format can be
helpful for presentations or teaching files. If your camera
is set up for slides, you can select On to print slides or
Off to print regular films.

NOTE: If the selected output device does not support the slide
format, this function is not available and the
[Slide Format] button appears grey.

• Greyscale - Clicking this button turns the Greyscale on
or off. If your system does NOT support Greyscale, this
button is grey and you are not able to select it. The
Greyscale is a vertical bar that displays varying shades
of grey from white to black. If Greyscale is selected, it
appears on the left side of the image.

• Auto Printing - Clicking this button turns auto filming on
or off. If you select On, the system automatically sends
the film to the printer when all the frames of the film are
filled. If you select Off, the film does not go to the printer
and you have to click the [Print] button on the Film
Composer window to manually send the film to the
printer and click the [Clear] button to clear the frames of
the Film Composer.
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• Auto Clear Page - Clicking this button turns the auto
clear function on or off. If you select On, the frames of
the film (in the Film Composer) are automatically
cleared once the film goes to the printer. If you select
Off, you have to clear the film manually by clicking the
[Clear] button on the Film Composer window.

• Icon labels - Clicking this button changes the way
images are displayed in the frames of the Film
Composer (not on the actual printed film). This is a way
to keep track of what has been placed on the film in the
Film Composer. Clicking the [E/S/I] button shows the
Exam number/Series number/Image number in the
frame and clicking the [Image] button shows a small
picture of the image being printed in that frame.

• Expose Order - Clicking this button allows you to
change the order in which the images are loaded when
using the Function keys. Click and hold the
[Expose Order] button and drag to
Left/Right/Top/Bottom for the films to be exposed from
the Left to the Right and from the Top to the Bottom of
the film. Drag to Right/Left/Bottom/Top to have films
exposed from the Right to the Left and from the Bottom
to the Top.

• No. of Copies - This feature allows you to customize
the number of copies you create. Click on the up or
down arrows just below No. of Copies to increase or
decrease the number by one. Alternatively, highlight the
text box and enter the number from the keyboard and
press Enter.

• The Status Area - This message area keeps you
informed of various conditions in the filming process
(print queue empty, printing, film supply low, output
device not connected, etc.). The Status area is found at
the bottom of the Film Composer window. This area
cannot be edited or changed. If an arrow appears in the
lower-right corner of this area, click on it to see
additional information regarding the filming status.

Film Composer/Status Area
2292261-100 Rev. 0 (03/01) 10-7



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
Loading the Images
Loading the images simply means displaying images within one
or more viewing applications, and where each image is to be
placed on the film. Loading with Drag and Drop allows you to
place only one image into a frame on the film. Viewing and film
formats do not need to be the same. The F1 through F4 keys
along the top of the computer keyboard are accelerator keys for
filming. Selecting the appropriate key places the images on the
film with one keystroke.

Printing
Printing is the act of transferring the images onto a sheet of film
once you have set up the film parameters and loaded the
images. The Print Series function, (available from the Viewer,
the Mini Viewer and the Accelerator Line), allows you to set up
and print the series currently being viewed.

Using the F (Function) Keys
The top row of the computer keyboard is composed of keys
labeled F1 through F12. These keys are often called
accelerator or function keys. These keys have preset filming
and window/level functions associated with them.

The F1 through F4 keys are used exclusively for filming. The
exact function of each key is detailed in the Loading with the F
(Function) Keys section.

Keys F5 through F11 are used for adjusting the window/level of
an image. The F5 key corresponds to the most recently set
window/level values. Keys F6 through F11 correspond to the 6
preset values that are customized from the User Preferences
window.

Keyboard

• F1 - Use F1 to place a single image in the first available
frame on the Film Composer. The cursor must be on the
desired image to film.
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• F2 - Use F2 to load an entire page (all of the displayed
images in the viewing application) of images into the
Film Composer. If the viewing application and the Film
Composer format are different, the Film Composer
format automatically changes to match the viewing
application’s format. The cursor can be in any image on
the Viewer or Mini Viewer. The Film Composer must be
empty to use the F2 key. If it is not empty, click the
[Clear] button in the Film Composer window.

• F3 - Use F3 to film a multiple image display (MID) into
one frame on the film. The images must be viewed in
the manner you want them on the film (e.g., the screen
divided vertically one image occupying each side).
Since all the images are placed into a single frame, the
resolution of a MID film is not as good as that of a film
obtained when the same set of images is filmed using
page filming. Also, the images must be magnified by a
factor of 2 for them to fill the frame on the film. Scroll
images if necessary. Place the cursor in any image on
the screen, then press the F3 key. You cannot skip
frames using the F3 key. Single image frames and MID
(Multiple image) frames can be mixed on the same film.

Something to Think About...

• Filming using the F3 key may result in Partial Annotation
(Site name, patient ID, system ID, and Lower Left corner
annotation - technique are missing) on the film. To
prevent this, select Custom Film Annotation (see
Displaying Images chapter, section User Preferences)
and select the Annotation (typically select all choices)
you want to appear. Click the [OK] button, and then click
the [Apply] button for a temporary save, or click the
[Save as Defaults] button or a permanent change to
the film display state. Then film using the F3 key.

• If a custom message annotated on the viewport spans
the left-to-right borders of the viewport and the F3 key is
used for filming, the front portion (about 50%) of the
message is cut off. To avoid this, use the Enter key and
shorten the width of the message and lengthen in the
vertical direction.

• F4 - Use F4 to film all the images in a single series with
just one keystroke. The F4 key can only be used with
the Viewer. The cursor must be in any image on the
screen. All of the images are filmed with the same
window and level values when using the F4 key. Typing
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print series in the Accelerator Line also prints the entire
series.

° The Print Series window appears after pressing the
F4 key, allowing you to customize the print series
options.

1 - Format allows you to select to film the series using
the film format or the Viewer format.

2 - Interval allows you select to print all the images in the
series, or selecting 1/2 prints every other image in the
series, or selecting 1/3 prints every third image in the
series.

3 - Print last sheet, prints only the last sheet of images in
the series.

4 - Clicking the [Print Series] button prints the series
using the selected options.

5 - Clicking the [Close] button exits the Print Series
window.

6 - Clicking the [Cancel All] button stops the printing of
all the print series jobs.

7 - Clicking and dragging on either, or both, ends of the
Image Selection slider allows you to select a specific
group of images to print.

1

2

3

54

6

7
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The Print Queue
The Print Queue displays the jobs that are waiting to be printed.
The queues for the laser camera (printer) and any remote
(network) cameras can be accessed from the Print Queue. The
Print Queue allows you to stop a job from printing. For example,
to stop a duplicate film from printing.

The Remote Printer
The Remote Printer is a printer, (usually in another area), that is
networked to your system. This allows you to continue printing if
your laser camera (or paper printer) is not functioning. For
example, your camera or processor is shut down for
maintenance or cleaning.
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How to Film Images
This section provide the step-by-step instructions for Filming
Images. Specifically, it describes how to:

• Set Up the Film Composer

• Load with Drag and Drop

• Load with the Function (F) Keys

• Load Text Pages

• Erase an Image from the Film

• Print Images

• Select a Remote Printer

• Check the Print Queue

• Set Window and Level Presets
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Setting Up the Film ComposerSet Up the Film Composer
Use the Film Composer to print images on film (or paper).
There are a number of options you can use when filming, such
as film format, number of copies, auto print, and auto clear.

1. Click [Film Composer] from the Viewer, Mini Viewer, or
Browser.

• The Film Composer window appears.

Film Composer

2. In the Formats area, click on the type of film format you
would like to use.

In Brief: Set Up the
Film Composer

1. Click [Film Composer].

2. Select the film format.

3. Click [Options].

4. Decide on Options. Click
and hold the left mouse
and move the cursor to
the desired selection and
release.

5. Click [Done] to close
window and enable
settings.
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Something to Think About...

• If configuring formats in the camera selected and film
composer format list, do not automatically take the
selected changes, then restart the film composer
operation.

3. Click [Options].

• The Print Options window appears.

Film Composer/Print Options

4. Decide the options you want. Click and hold the left mouse
on the option, move to the desired choice to make the
selection.

• The number of copies option allows you to type in the
desired number of copies. You can also click the
up/down arrows to get the desired number.

5. Click [Done].

• Closes the Print Options window and enables all
settings.

Something to Think About...

• If the film composer disappears when Viewer functions
are performed, click [Film Composer] from the Viewer
window to redisplay the film composer.
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Loading With Drag and DropLoad with Drag and Drop
Loading the film with drag and drop allows you to choose the
exact location on the film to place your image (allowing you to
skip frames if desired). Loading with drag and drop allows you
to place only one image into a frame on the film. Viewing and
film formats do not need to be the same.

1. Have the images of interest in view.

2. Click [Film Composer] from the Viewer or the Mini Viewer.

Film Composer

3. Select the desired film format.

4. Place the cursor on the desired image.

5. Click and hold on the image, drag to the desired frame in
the Film Composer.

6. Release to deposit (drop) the image.

• If you clicked [Image] for your icon label, a reproduction
of the image appears in the frame.

• If you clicked [E,S,I] for your icon label, the exam,
series, and image appear in the frame.

7. Mover cursor to the next image and repeat the click and use
the drag and drop process as needed.

NOTE: It is not necessary to place images in consecutive frames,
or fill all the frames on the film.

• If all the frames on the film are not filled, or if
[Auto Printing] is Off, you must click [Print]. Also, you
need to click [Clear] if [Auto Clear] is Off.

In Brief: Load with
Drag and Drop

1. Have images of interest in
view.

2. Click [Film Composer].

3. Select the film format.

4. Have the cursor in the
desired image.

5. Click and hold on image,
drag to frame in the Film
Composer.

6. Release to deposit image.

7. Move cursor and repeat
step 4-6 as needed.
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LOLoading with the Function Keys Load with the Function (F) Keys
The Function (F1 through F4) keys along the top of the
computer keyboard are accelerator keys for filming. Pressing
the appropriate key places the images on the film with one
keystroke.

1. Display the images on the Viewer or Mini Viewer.

• See the Displaying Images chapter for more information
on how to display an image.

2. Click [Film Composer].

3. Select a film format.

4. Move the cursor onto an image in the Viewer or Mini Viewer
and hit the appropriate Function key. The images are loaded
into the frames of the Film Composer in the order they were
selected.

Keyboard

° A, B, C, and D are pointing to Function keys F1, F2,
F3, and F4 respectively.

• F1 - Use F1 to place a single image in the first available
frame on the Film Composer. The cursor must be on the
desired image to film.

• F2 - Use F2 to load an entire page (all of the displayed
images in the viewing application) of images into the
Film Composer.

• F3 - Use F3 to film multiple image display (MID) into one
frame on the film. Place the cursor in any image on the
screen, then press the F3 key.

Something to Think About...

• Filming using the F3 key may result in Partial Annotation
(Site name, System ID and Lower Left corner annotation
missing) on the film. To prevent this, select Custom Film
Annotation (see Displaying Images chapter, section
about User Preferences) and select the Annotation

In Brief: Load with the
Function (F) Keys

1. Have images of interest in
the Viewer or Mini Viewer.

2. Click [Film Composer].

3. Select film format.

4. Press the appropriate
Function key.

A B CD
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(typically select all choices) you want to appear. Then
film using the F3 key.

• F4 - Use F4 to film all the images in a single series with
just one keystroke. The F4 key can only be used with
the Viewer. Typing print series in the Accelerator
Line also prints the entire series.

° The Print Series window appears after pressing the
F4 key. Choose the options to customize the print
series.
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Text pages Load Text Pages
Text pages contain patient information. You may decide to have
a frame on the film that lists this information. Text pages can list
the exam or series information. The exam text page lists all the
information entered on the Patient Information area and all the
series (with scan parameter information) completed on this
patient.

The series text page lists all the patient information entered on
the Patient Information area and lists the images (image
numbers, locations, plane and other parameters). The series
text pages also list the prescan values for that series. Text
pages can be accessed from the Viewer or the Mini Viewer.

1. Have images of interest in view.

2. Click [Text Page].

The Text Page menu appears.

3. Click on the desired choice.

• [Exam] to show the Exam Text Page or [Series] to
show the Series Text Page.

• The Accelerator command for Exam Text Page is te
and for Series Text Page is ts.

4. Load the text page on the Film Composer by pressing the
F1 key. The cursor must be inside the Exam or Series Text
Page. You can also click [Film] from the bottom of the Text
page.

• Both methods of filming place the text page it in the next
available frame on the Film Composer.

In Brief: Load Text
Pages

1. Have images of interest in
Viewer or Mini Viewer.

2. Click [Film Composer].

3. Click [Text Page], and
then click either [Exam],
or [Series].

4. Use the F1 key or click
[Film] on the text page to
load text page on the film.
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Erasing Images From the FilmErase an Image from the Film
While filming, you may decide to remove an image from a frame
on the Film Composer.

1. Have the Film Composer open with at least one image in a
frame on the film.

Film Composer

2. In the Film Composer, click on the image you wish to erase.

3. A message appears asking if you really want to discard this
image. Click [Yes] to discard the image, or [No] to exit
without erasing the image from the film.

NOTE: If you want to erase all the images on the film, click [Quit].

In Brief: Erase an
Image from the Film

1. Have images on a film in
the Film Composer.

2. Click an image to erase.

3. Click [Yes] to discard or
[No] to exit.
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PPrinting Print Images
Printing is the process of sending the images to the Print Queue
and from there to the laser camera (or paper printer) to get
printed on the film (or paper). As mentioned in the section on
Film Composer, if you have Auto Printing on, the film prints
automatically when the frames are full. Turn auto printing off if
you want to check your film before it leaves the Film Composer.
For example, to check that you have filmed images in the
proper order. This procedure assumes auto print is off.

1. Have all the images needed in the frames of the film in the
Film Composer.

2. Click [Print].

• Prints the contents of the Film Composer.

• The Status area at the bottom of the Film Composer
changes to display Printing..., and the image data are
sent to the print queue. The output device prints the data
when it reaches the top of the print queue.

• If Auto Clear Page is On, the film in the Film Composer
clears automatically.

° If Auto Clear Page is Off, you need to click [Clear].
At the confirmation message click [OK] to clear the
film from the Film Composer. Clicking [Cancel] exits
without clearing the film.

3. When you are finished filming, close out of the Film
Composer by clicking [Quit].

NOTE: Clicking [Quit] clears any images left in the frames.

• To close the Film Composer without losing any images
in the frames, click on the Film Composer iconify button
in the upper right hand corner of the Film Composer
window.

Film Composer

In Brief: Printing

1. Have images in frames of
film in Film Composer.

2. Click [Print].

3. Click [Quit] or click on the
iconify button to close the
Film Composer.
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Selecting a Remote PrinterSelect a Remote Printer
A remote printer is a printer (either a laser camera or paper
printer) located outside of your immediate area. This printer can
be networked to your system and used as an additional or
backup printer. Only one printer can be used for a print job.

Something to Think About...

• The initial set up of a Remote Printer requires the
assistance of a service engineer and your facility’s
Information Systems department.

1. Click [Film Composer].

2. Click [Configure].

Browser/Film Composer

A window appears with buttons to [Add], [Update], or
[Delete] printers.

3. Click [Add].

• At this point you will need the assistance of your
institution’s Information Technology department for
printer names, IP addresses, etc.

In Brief: Select A
Remote Printer

1. Click [Film Composer].

2. Click [Configure].

3. Click [Add].

• Enlist the help of IT
dept. and service
engineer to configure.

4. Click [Done].

5. Click [Configure].

6. Select the printer just
configured.

7. Click [Update].
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4. Once the data for the remote printer has been entered,
click [Done] on the Remote Configure window, to exit this
window.

NOTE: DO NOT click [Update] at this point. You must first click
[Done].

5. Click [Configure].

6. Select the printer just configured.

7. Click [Update].

Something to Think About...

• If configuring formats in the camera selected and film
composer format list, do not automatically take the
selected changes, then click immediately on Printer
Label located at the top of the Film Composer
application after configuring the printer.
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Checking the Print QueueCheck the Print Queue
The Print Queue is the holding area for films that are waiting to
go the laser camera or networked printers. In the Print Queue,
you can view how many films are waiting to be printed or stop
jobs from being printed.

1. Click [Queue], from the menu bar on the Browser.

Browser/Queue

2. Click Filming.

• The Filming Queue window appears. Two queues show,
the top half of the window shows the Laser Camera
Queue, and the bottom half of the window shows the
Network Film Queue.

• The job at the top of the list is the job currently being
printed.

NOTE: If there are no jobs in the Print Queue, a message
appears telling you the film composer queue is empty.
Click [OK].

Queue/Confirm

3. Do one of the following:

° Click [Pause All] to temporarily pause all jobs in the
Queue. The word (Paused) appears after each job.

In Brief: Check the
Print Queue

1. From the Browser, click
[Queue].

2. Click Filming.

3. Select the desired
function.

4. Click [Refresh] to update
or [Quit] to exit.
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° Click [Resume All] to restart all jobs in the Queue.
The word (Active) or (Pending) appears after each
job. Active jobs are in the process of printing or
networking (depending on the queue the job is in)
and pending jobs are those waiting to print or
network (again, depending on the queue).

° Click on a specific job to pause only that specific job.
The word (Pause) appears after the job name.

° Click on a specific job to resume only that specific
job. The word (Active) or (Pending) appears after the
job name.

° Click on one or more jobs and click [Clear] to
remove them from the Queue.

4. Do one of the following:

• Click [Refresh] to update the window to show the
current status of the jobs.

• Click [Quit] to exit from the queue.

• These buttons affect both queues.
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Setting Window and Level PresetsSet Window and Level Presets
Using preset window widths and window levels allows you to
quickly adjust the brightness and contrast of a displayed image.
You can program up to six different settings for your system. If
the operator’s console is networked with a CT system, you can
have a separate set of six preset values for CT images. The
following are step-by-step instructions to customize the preset
values. Pressing one of these “F” keys changes the window
width and level to the preset value.

NOTE: The F5 key sets the window and level to the most recent
settings.

1. Display images in the Viewer. Window Width and Window
Level presets cannot be set from the Mini Viewer.

2. Click [User Preferences].

• Located on the bottom left of the Viewer.

3. Click and hold [Modality] and select the appropriate
modality.

4. In the Presets area, double-click on the text you want to
change and press the Delete key (on the keyboard).

5. Do one of the following:

• In the title, w/width, or w/level text boxes, type in the
new text.

• W/width and w/level need to be entered as numbers.

User Preferences/Presets

• Click [Set Current] to set the Window Width and Level
to that of the displayed image.

In Brief: Set Window
and Level Presets

1. Have images displayed in
the Viewer.

2. Click
[User Preferences].

3. Click and hold, release on
the appropriate Modality.

4. In Presets area highlight
the text box and type text
and/or values.

5. Type in the text desired
for title, w/width or
w/level. Or, click
[Set Current].

6. Click [Apply],
[Save as Defaults], or
[Cancel].
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6. Do one of the following:

• Click [Save As Defaults], to replace the current setting
with the new setting and save for future use.

• Click [Apply], to apply the new settings on the displayed
image. The settings are not saved.

• Click [Cancel], to exit without saving the changes.
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Chapter 11

Managing Images

Introduction
This chapter explains the process of managing images. It highlights
key concepts and provides brief guidelines for creating an
anonymous patient, as well as, saving, restoring, deleting, and
networking images. This chapter also contains the step-by-step
instructions to help you learn how to:

• Create an Anonymous Patient

• Select an Archive Device

• Label your Storage Media

• Save Images to a Storage Media or Remote Archive Device

• Restore Images to the System Disk

• View and Alter Queues

• Detach the Storage Media from your System

• Remove Images from the System Disk

• Network Images to and from Connected Stations
11-1



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 1
In addition, this chapter answers the following questions:

1. What is the feature status area?

2. What is an anonymous patient?

3. What is archive media?

4. What archive media are compatible with the system?

5. How do you label a MOD?

6. What messages warn about disk space limits?

7. What is a network?

8. What components can be networked?
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About... Managing Images
This section presents the concepts necessary to successfully
complete the process of managing image data. Specifically you
need to understand:

• Feature Status Area

• Anonymous Patient

• Archive Media
° Selecting an Archive Device
° Composition of the Archive Option
° Labeling the Storage Media
° Saving Images
° Restoring Images from Local Archive Media
° Archive Queues

• Managing Disk Space
° System Disk Space
° Removing Images from the System Disk

• Networks
° Networking Terms
° Network Queues
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Feature Status Area
The Feature Status area displays a status message to the right
of the four image management icons. From left to right, the
icons are for image reconstruction, filming, archive and network
functions.

A continuously updated status message appears to the right of
the image reconstruction, filming, archive and network icons.

• Scan Reconstruction Status

° Text to the right of this icon indicates exam, series, and
image numbers being reconstructed.

• Filming Status

° Text to the right of this icon indicates filming status of the
images being filmed.

• Archive Status

° Text to the right of this icon indicates the archive status of
the images being archived.

• Network Status

° Text to the right of this icon indicates the status of the
system’s networking functions.

Anonymous Patient
There may be times when you want the name of a patient to be
kept confidential. You can do this using the anonymous patient
feature.

Some situations for using this feature include:

• Your radiologist wants to take the films to a conference.

• You have scanned a test patient or volunteer and do not
want the name displayed.

• You want to use the films in a display or at a show.

An anonymous patient can be created by exam, series, or even
a single image.
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Archive Media
This section explains the set-up and use of an off-line filing
system for images. The archive media feature allows you to
save, remove, and restore images to and from a media storage
device or remote host.

The archive system uses a Magnetic Optical Disk (MOD) for
storage. Images stored on MOD are "off-line," meaning that in
order to display the images, you must first restore them to the
system disk. The MOD is considered a local archive device.
Communication from your system to the MOD is in a DICOM
format, so the MOD is listed in the archive window as a
DICOM_MOD.

The archive function can read from and write to MaxOptix
archive media. Archive can also be used to import data from
Pioneer MODs or legacy digital audio tapes (DATs). Archive
offers "read only" capabilities with these archive media.

In addition to the MaxOptics MOD, images can be archived to
DICOM networked remote archive devices. The DICOM
networked devices archived to your system are listed in the
archive windows as remote devices.

Selecting an Archive Device

Before saving or restoring image data the archive device must
be selected. The archive function can be accessed from the
Image Management or the Display Desktop.

• The archive devices on your system depend on your site’s
unique configuration.

• To save images the archive device can be the local
MaxOptics MOD, or a DICOM networked remote device
(Remote Archive Host).

• To restore images the selected archive device must be a
local device, the MaxOptics MOD, the Pioneer 5-1/4, MOD
or Legacy DAT.

• The following compatibility issues exist for archiving to
MOD:

° 8.2.5 and 8.3 images cannot be saved to MaxOptics
MODs labeled on a system with software that is Signa
8.2 or earlier.

° Images stored on MaxOptics from Signa 8.2 or earlier,
CAN be restored to a system with 8.2.5 or 8.3 software.
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° 8.2.5 and 8.3 images cannot be saved to MaxOptics
MODs labeled on Signa Advantage systems with 5.8
software and equipped with the MaxOptics MOD drive.

° Signa Advantage 5.8 MaxOptics saved images CAN be
restored to Signa 8.1.5 and 8.3

° MaxOptics MODs labeled and saved to Signa 8.2.5 and
8.3 cannot be read and images cannot be restored to a
Signa Advantage 5.8 system equipped with the
MaxOptics MOD drive.

° The archive Browser of a DICOM MOD (note that the
archive feature on Signa 8.2, 8.2.5, and 8.3 use the
DICOM format) does not provide all image information in
the same format as the Signa image Browser. Some of
the discrepancies seen include slice spacing and number
of echoes, as well as others. Note that Rectangular FOV
and NEX (when No Phase Wrap is used) can be
misleading. Therefore, it is recommended that the
Archive not be used to obtain scan parameter
information. Restore an image(s) to obtain the scan
parameters.

NOTE: Remote archive devices must be configured through the
Network. In addition, the network to that device must be
active to save images to the desired remote archive host.
See selecting a Remote Host in the Network section of
this chapter to configure a remote archive device and
select a remote archive host for saving images.

Composition of Archiving Option

Your MR system equipped with the archiving option has a 5 ¼"
MOD archive device. The archiving software is installed in the
workspace cabinet. The archiving software is indicated by the
presence of the Archive selection on the Browser menu bar.
This can be accessed from the Image Management or the
Display Desktop.

Labeling the Storage Media

Brand new MODs must be labeled before they can be used on
the system. MODs that contain data that is not needed anymore
can also be relabeled. When an MOD is relabeled, all existing
data on it are permanently erased.

Once the labeling process is complete, the Media ID, format
type, number of images on the media and percent of media
used are displayed at the bottom of the Browser.
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Something to Think About...

• Archive media on remote archive devices cannot be
labeled from your MR system.

Saving Images
Archive images from the system disk on a regular basis.
Archive as soon as an exam is complete to provide a back up in
case of a disk crash. The time to store an image using
MaxOptix MOD media is approximately 2 seconds per 512x512
image. Before attempting to save images on a MOD, be sure to
be in compliance with the restrictions listed below.

Restrictions for Saving Images

The ability to save images depends on the archive device type
and the initial source of images.

• The following archive devices can be used to save image
data:
° The local MaxOptics MOD labeled on Signa.
° DICOM Networked remote archive devices.

• Images from the following sources, once on your MR
system, can be saved to local and remote devices:
° Signa 4X.
° Genesis (e.g. Signa 5X, CT Highlight Advantage or

CT/MR Independent Console).
° ODINA with Genesis shadow group.
° ODINA with 9800 shadow group.
° GE-YMS CT scanners with Advantage Net.
° Advantage Windows 1.2 (except client data as indicated

by CL in the mod column of the series list on the main
Browser).

° GE-YMS MR scanners.

NOTE: Only local archive devices can be selected for the Auto
Archive function. Refer to "Networking from the Scan Rx
Desktop" in the tasks section of this chapter and the
ScanRx Desktop chapter for information regarding Auto
Archive.

Something to Think About...

• The Archive window appears as Archive (active) if other
items are already in the process of being saved or
restored, but the window is still available. Requests are
saved in a queue and executed as soon as the other
requests ahead are completed.
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• Items being saved cannot be deleted from the
workstation system disk until the save process is
complete. This is indicated by the gray Remove
selection title on the Browser whenever items being
saved are selected.

• Saving third party images is not allowed. Attempting to
save these images results in an archive pause status for
the selected images.

Restoring Images from Local Archive Media
Image data residing on Pioneer MODs and Legacy DATs can be
restored to your MR system. When restoring or reading from
archive media, the system makes a copy of the image data and
does not remove the image data from the archive media.
Images must be restored to be viewed, you cannot view images
directly from archive media. The time it takes to retrieve an
image using MaxOptics MOD media are approximately 2
seconds per 512x512 image. Before attempting to restore
images to the workstation, be sure to be in compliance with the
restrictions listed below.

Restrictions for Restoring Images from Archive Media

The ability to restore images to your MR system depends on the
media type and image format.

• Media types available to restore image data to workstation:
° MaxOptics or Pioneer MOD labeled on Signa.
° MOD labeled on any Genesis OC/IC.
° MOD labeled on a GE-YMS system equipped with a

Pioneer brand MOD drive.
° MOD labeled on Advantage Windows.
° Legacy DAT labeled on any Genesis OC/IC.

• Image types that can be restored to your MR system:
° All Genesis images.
° GE-YMS.
° Advantage Windows.

Something to Think About...

• Image data cannot be restored from remote archive
devices.

• When viewing the Browser of the MaxOptics MOD, the
displayed slice spacing may not be the same value as
the spacing indicated on the workstation image Browser.
This is because the DICOM definition of spacing is
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generally the slice thickness plus the spacing. If these
images are restored to your MR system, the correct
spacing is reflected.

• The annotation for a DICOM image is incomplete for
fields supported by Genesis or GE-YMS systems and
not by DICOM. Be aware that DICOM images may not
contain all the information that is provided by a Genesis
or GE-YMS image.

Archive Queue

An archive queue is a list of images transferring to or from an
archive medium. The archive queue has both save and restore
queues, therefore, it is not necessary to wait for one save or
restore request to be carried out before setting up the next one.
When a save request is set up, it is sent to the save queue.
When a restore request is set up, it is sent to the restore queue.

If there are save and/or restore processes taking place, the
Local Archive or Remote Archive windows open. The window
depends on which device (local or remote), has a process
taking place.

• The Local Archive window displays both the Archive Save
Queue and the Archive Restore Queue.

• The Remote Archive window displays only the Remote
Archive Save Queue. (Restore can not be done through
remote devices.)

Each line in a queue represents a job to be executed as shown
in the table below.

All jobs are followed by the archive device name in
parentheses. After the display of the archive device a status
message follows.

• (Active) indicates the job is currently being executed.

• (Pending) indicates the job is waiting to be executed.

• (Paused) indicates the job is temporarily paused.

Job Representation

Entire Exam Exam number

Entire Series Exam number/series number

Single Image Exam number/series number/image number
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Something to Think About...

• Jobs in the restore queue have priority over jobs in the
save queue. Save jobs are started once the restore
queue is empty.

• If an entire exam or series is being saved or restored,
only one job is executed for the entire exam or series,
respectively. But, if only a certain series in an exam, or a
certain image in a series is being saved or restored, a
separate job is executed for each series or image,
respectively.

• The restore queue is deleted on system shutdown or by
selecting Detach from the Archive window, whereas the
save queue is maintained under either of these
conditions.

Managing Disk Space

The system disk contains all of the operating software as well
as the image data. The system disk is intended for temporary
storage of image data for reviewing and filming. Once those
tasks have been completed, archive the images should and
remove them from the system disk.

System Disk Space

Available disk space is always shown in the System Status
Display area (located in the upper left corner of the screen). It
reports how much space is available for 256x256 and 512x512
images, as well as, a percentage of how full the system disk
actually is.

The system posts messages when disk space is low or at a
critical level.

• The Low Image Space message warns that image space is
becoming limited and recommends that you remove
archived exams.
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• The Critical Image Space message warns that image space
is insufficient for the current acquisition and you must
remove archived exams in order to continue.

Something to Think About...

• If image space is less than the predefined minimum,
these messages continue to be displayed after each
completed exam.

• To keep the system performing at normal speed, it is
recommended that you delete images before the disk
space reaches 65% capacity. As the disk space reaches
maximum capacity, all system features slow down.

NOTE: Your system can hold up to 4 gigabyte of hard disk
information. This allows a maximum number of 30,000
images on system hard disk. Through your GE Sales
Representative you can also purchase more gigabytes
for your hard disk. Up to 9 gigabyte are allowed at this
time. This permits up to 90,000 images to be stored on
the system. Ask your GE Sales Representative for more
details about additional disk space.

Removing Images from the System Disk

Eventually, you want to remove an image, series, or entire
exam from the system image disk to make room for others. This
function is performed by using the Remove selection located on
the Browser menu bar.

Something to Think About...

• Once you have deleted an exam, series, or image from
the system disk, it is permanently removed. Use care in
making your decisions.

• Do not delete images which have been networked or
filmed until you verify that these tasks have been
successfully completed.

• The Remove menu title appears in gray and cannot be
used if a selected item is in use by the Viewer or a Mini
Viewer, if it is being used by a network “Push” operation,
or if it is being used by an archiving “Save” operation.
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Networks
Networks link image acquisition systems and workstations
together. By connecting these compatible devices to your
scanner you now have the ability to quickly and easily transfer
images between your scanner, remote workstations, and other
image acquisition systems. With systems networked together,
you may view images supported by your scanner from any
station, or view images from other stations on your scanner.

Advantages to this capability include:

• Increased productivity of your medical imaging system. You
can routinely off-load display, manipulation, and filming
activities from your scanner to another workstation. The
scanner is free to continue scanning patients. This also
eliminates the problems associated with the hand-delivery
of films.

• Increased accessibility to images and patient exams. You
can have any images supported by your scanner available
for additional review at any station on a network, when
needed.

• A quicker access of images to the radiologist. Images can
quickly be networked to another station (such as a GE
workstation), to allow radiologist review prior to your patient
even getting off the scan table.

Networking Terms

The table below contains some terms that are associated with
the process of networking.

Term Definition

Remote Host Image acquisition or workstation connected to the
network. Each host has its own network address.

Transfer The moving of imaging data between stations.

Transmit/Push The action of sending images from one station to
another.

Receive/Pull The action of retrieving images from another station.

Auto Transfer
by Exam

Automatic image transfer of a newly completed
exam.

Auto Transfer
by Series

Automatic image transfer of a newly completed
series.
11-12 2292261-100 Rev. 0 (03/01)



Managing Images
Network Queues

A network queue contains a list of images transferring to or from
an a network medium. The network queue has both send and
receive queues, therefore, it is not necessary to wait for one
send or get request to be carried out before setting up the next
one. When a transmit request is set up, it is sent to the send
queue, and when a receive request is set up, it is sent to the
receive queue. To view the requests waiting in the queues,
access the respective network queue.

If there are send or receive operations taking place, the
Network Queue window opens, displaying network servers
currently performing transfers to both Advantage Net and
DICOM. Other servers not currently perfoming transfers are not
displayed.

• The Send Images window displays the exams, series or
images that are currently being transmitted from your MR
system.

• The Receive Images window displays the exams, series,
images that are currently being retrieved from another
workstation.

Each line in a queue represents a job to be executed as shown
in the table below.

All jobs are followed by the remote server name in parentheses.
After the display of the server name a status message follows.

• (Active) indicates the job is currently being executed.

• (Pending) indicates the job is waiting to be executed.

• (Paused) indicates the job is temporarily paused.

Something to Think About...

• Before sending or receiving images, check to see that
there is enough room on the image disk to
accommodate the images being transferred. Information
about media disk space is displayed at the bottom of the
Browser.

Job Representation

Entire Exam Exam number

Entire Series Exam number/series number

Single Image Exam number/series number/image number
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• Your MR system does not always inform you if the
system has failed to completely transfer all the data
requested. Therefore, check with the source or
destination host to verify that the data has been
transferred successfully. (The system tells if the network
is active.)

• Remote hosts can be configured through the Remote
Host Selection window. The hosts are generally
configured by your GE Service Engineer or your site’s
network personnel. Consult your service engineer or
network personnel for a list of hosts and their assigned
host names.

• While your MR system allows you to remove host
names from the Remote Host Selection list, you should
do so with caution. When a host name is removed, it is
permanently deleted. If a host name is inadvertently
deleted from a configuration file, your service engineer
or network personnel should restore it.

• Images cannot be retrieved from Advantage Windows to
your MR system. The Advantage Windows consoles
with version 1.2 and 2.0 lack the DICOM Query Provider
to enable this functionality. If a connection is attempted,
the Remote Browser for the Advantage Windows
console appears blank. If other remote host cannot be
reached, recheck cables. If problem persists contact
your GE Service Engineer.

• When images are being sent from one Signa
workstation to another Signa workstation, the receiving
station shows the job on the Advantage Receive Queue.
This is also shown in the Feature Status area.

• To network images created from an Advantage
Windows 3.1 system to a Signa 8.3 system or higher,
use the Network DICOM protocol.
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How to Manage Your
Images
This section provides the step-by-step instructions for handling
image data with archive media, managing available disk space
and networking image data to alternate locations. Specifically, it
describes how to:

• Create an Anonymous Patient

• Archive Image Data
° Select an Archive Device
° Label Storage Media
° Save Images
° Restore Images
° Check the Archive Queue
° Detach Storage Media

• Manage Disk Space
° Remove Image Data

• Configure a Remote Host
° Add a Host
° Remove a Host
° Update a Host

• Network Images to Alternate Locations
° Network from the Scan Rx Desktop
° Transmit Images to a Remote Host
° Retrieve Images from a Remote Host

• Check the Network Queue
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Create an Anonymous Patient
Use this procedure to change the patient name of a completed
exam to Anonymous. The following steps guide you through
changing your patient’s name to Anonymous.

1. Click Display Desktop.

• Located on the control panel.

• If you have just booted up your system, the Scan Rx
Desktop is the default menu.

• The patient list appears on the Browser after entering
the Display Desktop.

2. Select the patient you want to be anonymous from the
patient list in the Browser.

• If you want only specific series or images to be
anonymous, carefully select only those series or images
desired.

3. Select Utilities > Create anonymous patient by exam,
series, or image.

• Located on the Browser menu bar.

In Brief: Create an
Anonymous Patient

1. Click Display Desktop.

2. Select the patient you
want to be anonymous.

3. Select Utilities > Create
anonymous patient by
exam, series, or image.

4. Click [OK].
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• The create box appears, prompting a selection to
continue the creation process or to cancel the process.

4. Click [OK].

• The create process begins.

• The listed name changes to anonymous followed by the
exam number.
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Anchor Archive Image Data

Select an Archive Device
Use this procedure to select the archive device before saving or
restoring image data. To save images the archive device can be
the local MaxOptics MOD, or a DICOM networked remote
device. To restore images the selected archive device must be
a local device, such as the MaxOptics MOD, the Pioneer MOD,
or Legacy DAT. The following steps guide you through selecting
an archive device for your system.

1. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

2. Select Archive > Selected Archive Device.

• Located on the Browser menu bar.

In Brief: Select an
Archive Device

1. Click Image Management
Desktop.

2. Select Archive > Selected
Archive Device.

3. Select Archive
Destination > Local or
Remote.

4. Select desired Archive
Device.

5. Click [OK].
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• The Archive Device Selection window appears.

3. Select the Archive Destination > Local or Remote.

• Local accesses the MaxOptics MOD, Legacy DAT or
Pioneer MOD.

• Remote saves images to a remote device.

4. Select the desired archive device by doing one of the
following:

• Select the Archive Device List for local devices.

• Select the Remote Archive Host List for remote
devices.

5. Click [OK].

• The selection enables and the Archive Device Selection
window closes.
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chor Archive Image Data

Label Storage Media

Use this procedure to label an MOD for use on your MR system
or erase a used MOD in preparation for reuse. The MaxOptics
MOD is the media that can be labeled from your MR system.
Brand new MODs must be labeled before they are able to store
image data. Also, use this procedure to relabel a MOD which
contains data that is no longer needed.

1. Insert the MOD desired side up in the MOD drive.

2. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

3. Click Archive > Label.

• Located on the Browser menu bar.

In Brief: Label
Storage Media

1. Insert MOD into MOD
drive.

2. Click Image
Management Desktop.

3. Click Archive > Label.

4. Enter an identification
number in the Media ID
Number text box.

5. Enter notes or remarks in
the Comments text box.

6. Click [Label].

7. Read warning about the
destruction of existing
data (on a used MOD)
and click [OK].
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• The Format Window appears.

• The archive device name is shown in the upper left
corner of the Format Window. The name reflects the
MaxOptics MOD drive. This is set up during installation
and requires no intervention.

4. Enter an identification number in the Media ID Number text
box.

• This value is the MOD label.

5. Enter notes or remarks in the Comments text box.

• Typically, information about the type of images, MOD
side, or pertinent information is entered.

° The entered text appears at the bottom of the
Archive Browser during selection of images to be
restored from this MOD side.

° The maximum number of characters allowed in this
text box is 160.

6. Click [Label].

• The labeling process begins.

• One of the following messages display:

° If this is a new MOD, a confirmation message asks
the you to "Please refer to the Operator Manual for
limitations regarding archive media exchange
between GE Products."

° If there is no media in the drive, an attention
message is displayed.

° If the MOD has previously been labeled, an Erase
message is posted, "Selecting OK will erase the
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contents of the disk. Are you sure you want to
relabel the disk?"

7. Click [OK].

• Acknowledges the message and continues the labeling
process.
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Archive Image DataSave Images

Use this procedure to save images on an MOD. The archiving
feature allows you to save large amounts of image data onto the
local MOD or remote archiving hosts. When saving/writing to
archive media, the system makes a copy of the image data and
does not remove the image data from the main system disk.
The following steps guide you through saving images.

1. Insert the MOD desired side up in the MOD drive.

2. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

3. Select the desired patient exams, series or images to be
saved from the Browser patient list.

• You can select images for saving by:

° Single or multiple examinations.

° Single or multiple series within an examination.

° Single or multiple images within a series.

4. Select Archive > Save Examination, Save Series, or Save
Image.

• Located on the Browser menu bar.

• All items selected on the patient list for saving are
written onto the media in the selected archive device.

In Brief: Save Images

1. Insert MOD into MOD drive.

2. Click Image Management
Desktop.

3. Select the exams, series or
images to be saved.

4. Select Archive > Save
Examination, Save
Series, or Save Images.

5. Click [OK].

6. Select Archive > Detach.
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• The Save message appears requesting confirmation to
save the requested examinations, series, or images.

5. Click [OK].

• Acknowledges the message and continues the save
request.

• The Feature Status area shows Archive (active) in the
lower left corner beside the Archive icon.

• The Archive window remains available for additional
requests.

• The archive status is displayed on the Browser.

° The letter Y (for yes) appears in the Archive column,
indicated by the letter A, of its respective entry in the
images list. When archived images are networked
directly to another Signa workstation, they also
appear as archived on that station’s Browser. This
allows you to keep track of what images have and
have not been saved.

° If the images are received from a non-Signa system,
the letter N (for no) appears in the Archive column,
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regardless of whether or not they had been
previously archived.

6. Click Archive > Detach.

• The MaxOptics MOD ejects from the MOD drive.
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Archive Image Data

Restore Images from Local Archive
Media

This procedure guides you through the restoration process of
images from local archive media. When reading or restoring
from archive media, the system makes a copy of the image data
and does not remove the image data from the archive media.
Images must be restored to be viewed; you cannot view images
directly from archive media. Follow these steps to restore
desired images:

1. Determine which side of the MOD contains the images to be
restored (side A or side B) and insert in the MOD drive
accordingly.

• If you are restoring from a DAT, insert the tape into the
drive.

° See user documentation provided by the
manufacturer of the DAT drive.

2. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

3. Select Archive > Restore.

• Located on the Browser menu bar.

NOTE: See selecting the archive device earlier in this chapter.

In Brief: Restore
Images

1. Insert MOD into MOD
drive.

2. Click Image Management
Desktop.

3. Select Archive >
Restore.

4. Select the desired exams,
series or images.

5. Click Restore.

6. Select Restore
Examination, Restore
Series, or Restore
Images.

7. Click [OK].

8. Select Archive > Detach.

9. Click on a different
desktop to exit.
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• The Archive Browser window appears, displaying the
exams, series, and images on the media of the selected
device.

• Verify that the selected archive device is the device
needed for restoring.

4. Select the desired exams, series or images to be restored
from the disk.

• If necessary, use the Sort menu and Selection menu on
the Archive Browser menu bar to quickly find the
information you are looking for by doing one of the
following:

° Select Selection > Select all of the examinations,
Select all series, or Select all images.

° Select Sort > a sort method.
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5. Select Restore > Restore Examination, Restore Series or
Restore Images, depending on what is to be restored.

• The Restore message appears requesting confirmation
to restore selected examinations, series, images.

6. Click [OK].

• Acknowledges the message and the items selected
begin to restore and read from the media to the
workstation.

• The Feature Status area shows Archive (active) in the
lower left corner.

• The Archive window remains available for additional
requests. Requests are saved in a queue and executed
as soon as the other requests ahead are completed.

• Once requests are completed, the Feature Status area
shows the last restored selection beside the Archive
icon.

• All restored images appear on the main Browser images
list with Y (for yes) in the Archive column.
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7. Select Archive > Detach.

• The media is ejects from the drive.

8. Click on a different desktop icon to close the Archive
Browser.

• The Archive Browser closes automatically when the
detach option in the Archive menu on the main Browser
executes.

Something to Think About...

• You can select multiple entries by selecting one entry
and holding down the Shift key or the Ctrl key on the
keyboard.

° Using the shift key selects all the entries between
the first and second click.

° Using the ctrl key selects only those items you click.

• If you select multiple exams, you cannot select specific
series or images.

• If you select multiple series, you cannot select specific
images.
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Archive Image Data

Check the Archive Queues

Use this procedure to check the status of images waiting to be
archived. It is not necessary to wait for one save or restore
request to be carried out before setting up the next one. When a
save request is set up, it is sent to the Archive Save queue.
When a restore request is set up, it is sent to the Archive
Restore queue. The following steps guide you through viewing,
pausing, resuming and deleting jobs in the archive queue.

1. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

2. Select Queue > Archive.

• Located on the Browser menu bar.

• The contents of the queues shown in the window is up
to date at the moment it appears. To subsequently
update the status of the queues, click [Refresh].

3. From the Archive Queue select one of the following:

• Click [Pause All] to temporarily suspend execution of all
requests in a queue.

° All jobs now have the (Paused) status.

• Select an entry and click [Pause] to temporarily
suspend the execution of a single request.

° One job in the queue has the (Paused) status.

• Click [Resume All] to continue the execution of a
paused queue.

° All jobs return to their original status and execution
continues.

In Brief: Check the
Archive Queues

1. Click Image
Management Desktop.

2. Select Queue > Archive.

3. Select an option to
pause, resume or clear
the items in the Archive
Queue.

4. Click [Quit].
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• Select an entry and click [Resume] to continue the
execution of a single job in the queue.

° The selected job in the queue returns to its original
status and execution continues.

• Select an entry and click [Clear] to permanently remove
a job from the queue.

° The Cancel message appears requesting
confirmation to clear the requested jobs in the
queue.

° Click [OK] to proceed and clear the requested
queue.

4. Click [Quit].

• The Archive Queue window closes.
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Archive Image Data

Detach Storage Media

Use this procedure to detach an archive media from its drive.
Once a local archive media has been used for save and restore
operations, it cannot be ejected from the drive unless you first
detach it. Before using this procedure to detach the MOD, allow
all archive jobs to complete.

1. Confirm that examinations have been archived.

• Check the Archive Queue.

• Check the archive status on the Browser patient list.

2. Click Archive > Detach.

• Located on the Browser menu bar.

3. Push the eject button on the MOD drive.

• The archive media detaches from its drive.

NOTE: If the Detach option on the Archive window appears in
gray lettering, this means that the archive media is
already detached.

NOTE: You cannot detach a remote archive media.

In Brief: Detach
Storage Media

1. Confirm that examinations
have been archived.

2. Click Archive > Detach.

3. Push the eject button on
the MOD drive.
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Manage Disk Space

Remove Image Data

Use this procedure to remove an image, series, or entire exam
from the system image disk to make room for others. Use care
in making your decisions. Once you have deleted an exam,
series, or image from the disk, it is removed permanently from
the system. Before deleting images which have been
networked, filmed, or saved via archive, verify that these tasks
have been successfully completed. The following steps guide
you through the image deletion process.

1. Click Image Management Desktop.

• Located on the control panel.

• Provides access to the Browser.

° The Browser can also be accessed from the Display
Desktop on the control panel.

2. Verify examinations to be removed have been archived.

• This is very important. Once you have deleted an exam,
it is permanently gone from the system.

• Check the archive status in the patient list of the
Browser.

° The archived status column is represented by an A.
Archive status is indicated by a Y (for yes) or a N (for
no).

3. Select the exams, series or images on the patient list that
you wish to remove.

• To select non-consecutive images, hold down the Ctrl
key on your keyboard as you individually select the
exams (series or images).

In Brief: Remove
Image Data

1. Click Image
Management Desktop.

2. Verify examinations to be
removed have been
archived.

3. Select the exams, series
or images on the patient
list that you wish to
remove.

4. Select Remove >
Remove examination,
Remove series or
Remove image.

5. Click [OK].
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• To select sequential images, select the first exam
(series or image) from the patient list, then press Shift
before selecting the last. All exams in between are
selected.

4. Click Remove > Remove examination, Remove series, or
Remove image.

• The Remove message appears requesting a
confirmation to remove the selected examinations,
series, or images.

5. Click [OK].

• Acknowledges the messages and continues the
removing process.

• The system removes the selected item from the system
disk and automatically updates the patient lists.
11-34 2292261-100 Rev. 0 (03/01)



Managing Images
AnchorConfigure a Remote Host

Add a Host
Use this procedure to add a remote host to your MR system to
enable the networking features. This allows you to select where
you are transferring your images to or where you want to pull
images from. This procedure is usually carried out by the
networking personnel at your facility or your local GE Service
Engineer. This personnel usually has the necessary information
needed for the network set-up procedure.

1. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

2. Select Network > Select Remote Host.

• Located on the Browser menu bar.

• Allows you to configure a new host on your system.

In Brief: Add a Host

1. Click Image
Management Desktop.

2. Select Network > Select
Remote Host.

3. Click [Add].

4. Fill-in information that
corresponds to the host
you are adding on the
Remote Host Parameters
window.

5. Click [Save].
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• The Remote Host Selection window appears.

3. Click [Add].

• Allows you to select additional parameters.

• The Remote Host Parameters window appears.
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4. Fill In the parameter information that corresponds with the
host you are adding.

• Host Name is the name that you choose to give your
remote host.

° Using this name is how you select a station from
which to push or pull images.

• Network Address is where the host is found within the
network.

° You must enter this correctly or the connection can
not be made.

• Network Protocol is what the system specifies as the
communicating language between the your MR system
and the host.

° GE imaging systems networked to your MR system
use Advantage NET.

° The Max Optic MOD and other non-GE imaging
systems usually network by using the DICOM
language.

• Port number is predetermined and is specific to the
type of host as well as the protocol used.

• AE Title is predetermined.

• Comment area is where you put information that may
be helpful in the distinction of two or more host closely
related names.

° For example: if your site has two MR systems, you
may input MR#2 Outpatient Unit.

• Archive Node allows you to select a remote host to be
used to remotely archive.

° Yes if the network station is an archive device.

° No if the network station is not an archive device.

° Auto if you want the machine to automatically look
to see if the host is an archive device.

5. Click [Save].

• The Remote Host Parameters window closes and saves
all the selections added.
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Configure a Remote Host

Remove a Host
Use the following procedure to delete a remote host selection
from your system. Before deleting a host, make sure this is
what you would like to do because their is no "undo" button to
correct a removal made by mistake. It is recommended to
contact your GE Service Engineer or your facility’s network
personnel prior to any removal. These steps guide you through
deleting an unwanted host from your system.

1. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

2. Select Network > Select Remote Host.

• Located on the Browser menu bar.

• The Remote Host Selection window appears.

In Brief: Remove a
Host

1. Click Image
Management Desktop.

2. Select Network > Select
Remote Host.

3. Select the host you want
to remove.

4. Click [Remove].

5. Click [OK].

6. Click [Cancel].
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3. Select the host you would like to remove.

4. Click [Remove].

• The Remove Host confirmation message appears.

5. Click [OK].

• Acknowledges the message and continues to remove
the host.

6. Click [OK].

• The Remote Host selection window closes.
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Configure a Remote Host

Update a Host
Use this procedure to update a remote host configured on your
system. An update could include any modifications that were
previously added or left off of the Remote Host Parameters
window. It is recommended that you contact your GE Service
Engineer or your facilities networking personnel prior to any
updates. The following steps guide you through updating a
remote host.

1. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the desktop control panel.

2. Select Network > Select Remote Host.

• Located on the Browser menu bar.

• The Remote Host Selection window appears.

In Brief: Update a
Host

1. Click Image
Management Desktop.

2. Select Network > Select
Remote Host.

3. Select the desired host to
update.

4. Click [Update].

5. Make necessary changes
or additions to the remote
host parameters.

6. Click [Save].
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3. Select the host you would like to update.

4. Click [Update].

• Allows you to access to the Remote Host Parameters
window to update your selected host.

5. Make necessary changes or additions to the remote host
parameters.

6. Click [Save].

• Closes the window and updates remote host
information.
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Network Images To & From Connected Stations

Network from the Scan Rx Desktop

Use this procedure to network images from the Scan Rx
Desktop to another host. It is very important to remember that
you can only push images to another host from the Scan Rx
Desktop. An advantage of this feature, is that you can program
your MR system to push images automatically, after each exam
or series is completed. The following steps guide you through
networking images from the Scan Rx Desktop.

1. Click Scan Rx Desktop.

• Located on the control panel.

• If you have just booted up your system, the Scan Rx
Desktop is always the default menu the system begins.

2. Click [Scan Modes].

• Located on the Rx Manager.

• The Scan Modes window appears.

In Brief: Network from
Scan Rx Desktop

1. Click Scan Rx Desktop.

2. Click [Scan Modes].

3. Select Auto Transfer by
Exam or Auto Transfer
by Series.

4. Specify a remote host
destination on Auto
Transfer by Exam Node
List or Auto Transfer by
Series Node List and
priority level, if applicable.

5. Click [Accept].
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3. Select a transfer option by doing one of the following:

• Select Auto Transfer by Exam to automatically send
the entire exam from your MR system to a single remote
host upon a completion of an exam.

• Select Auto Transfer by Series to automatically send
the series from your MR system to as many as three
remote hosts.

4. Specify a remote host destination by doing one of the
following.

• Select remote host for Auto Transfer by Exam from the
Auto Transfer Node List window.

• Select up to three remote hosts for Auto Transfer by
Series from the Auto Transfer by Series Node List.
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• You can prioritize to specify in which order the hosts
receive the images.

5. Click [Accept].

• Enables selections and closes the window.

NOTE: For additional information on Auto Transfer by Exam or
Auto Transfer by Series, refer to the Scan Rx Desktop
chapter.
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Network Images To & From Connected Stations

Transmit Data to a Remote Host
(Network Send)
Use this procedure to send images from your system to another
selected host. Transmit, or send, is the action taken when
pushing images from one station to another. This is
advantageous for additional review of images at any station on
the network and to off-load display, manipulation, and filming
activities from your system to another workstation. The
following steps guide you through the process of sending
images.

1. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

2. Select Network > Select Remote Host.

• Located on the Browser menu bar.

In Brief: Transmit Data
to a Remote Host

1. Click Image Management
Desktop.

2. Select Network > Select
Remote Host.

3. Select the desired host.

4. Click [OK].

5. Select the desired exam(s),
series or image(s) to
transfer.

6. Select Network > Send
exam, Send series, or
Send image.

7. Click [OK].

8. Select Application > Quit.

9. Click [OK].
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• The Remote Host Selection window appears.

3. Select the desired host where from where you want to
transfer the images.

4. Click [OK].

• Confirms selection of the requested host and closes the
Remote Host Selection window.

5. Select the desired exam(s), series or image(s) to transfer by
doing one of the following:

• To select individual entries, select the exams, series or
images you want to transfer.

• To select a predetermined set, choose Selection >
Select all Examinations, Select all series, Select all
images, Select all archived exams, or Select all
unarchived exams.

NOTE: Typing "ss" at the type-in command line saves the state
of the W/L. The "saved" W/L is networked to a PACs or
any other end destination.

• All of the items on the chosen list on the Browser are
selected.
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6. Click Network > Send examination, Send series, or Send
image.

• The Send message appears requesting a confirmation
to send selected examinations, series, images to remote
host.

7. Click [OK].

• Acknowledges the message and sends the selected
exams, series or images from your system to the remote
host.

NOTE: During the transmitting process, status of the process is
displayed next to the Network status icon in the Feature
Status area of the control panel. For example, the
following figure shows the Network status displaying
exam 50241 has been sent from the main workstation to
the b12a workstation successfully.

8. Click Application > Quit.

• Located on the Browser menu bar.

• A message appears requesting confirmation to quit.

9. Click [OK].

• The Remote Browser closes.
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Network Images To & From Connected Stations

Retrieve Images from a Remote Host
(Network Receive)

Use this procedure to retrieve images from another selected
host to your system. Receive, or get, describes the act of
receiving images from one station to another station. This is
advantageous for additional review of images at any station on
the network and to off-load display, manipulation, and filming
activities from your system to another workstation. The
following steps guide you through the process of getting
images.

1. Click Image Management Desktop.

• Located on the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

2. Select Network > Select Remote Host.

• Located on the Browser menu bar.

3. Select the destination host you from where you want to pull
the images.

4. Click [OK].

• Confirms the selection of the requested host.

5. Select Network > Receive.

• Located on the Browser menu bar.

• Allows you to view the Remote Browser you selected.

In Brief: Retrieve
Images from a Remote
Host

1. Click Image
Management Desktop.

2. Select Network > Select
Remote Host.

3. Select on the desired
destination host.

4. Click [OK].

5. Select Network >
Receive.

6. Select the exams, series,
images to retrieve.

7. Select Get > Get Exam,
Get Series, or Get
Image.

8. Click [OK].

9. Select Application >
Quit.

10. Click [OK].
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• The Remote Browser appears, listing the exams, series
and images found on the host.

6. Select the exams, series, or images to retrieve by doing one
of the following:

• To select individual entries, select the exam, series or
images you want to transfer.

• To select a predetermined set, select Selection >
Select all Examinations, Select all Series, or Select
all Images.

• All of the items selected on the patient list of the Remote
Browser are highlighted.

7. Click Get > Get Exam, Get Series, or Get Images.

• Located on the Remote Browser menu bar.

• The Get message appears requesting confirmation of
the pull transaction.
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8. Click [OK].

• Acknowledges the message and the selected exams,
series, or images on the Remote Browser begin
transferring from the remote host to your system.

• The Browser patient lists update automatically to reflect
the arrival of newly transferred items.

NOTE: During the retrieval process, status of the process is
displayed next to the Network status icon in the Feature
Status Control area of the desktop control panel. For
example, the following figure shows the Network status
of exam 1207. Exam 1207 has been pulled from the
remote MRI-2 workstation to main workstation
successfully.

9. Select Application > Quit.

• Located on the Browser menu bar.

• A message appears requesting confirmation to quit.

10. Click [OK].

• The Remote Browser closes.
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Check the Network Queue
Use this procedure to check the status of images waiting to be
transferred. It is not necessary to wait for one send or receive
operation to be completed before setting up the next one. Each
send or get operation is placed into the Network Queue. The
queue is used to view the waiting network requests to be
carried out. Also, images that have been paused in the queue
can be resent to the desired initial destination from this area.
The following steps guide you through viewing, pausing,
resuming, and deleting jobs in the network queue.

1. Click Image Management Desktop.

• Located the control panel.

• The Browser appears.

° The Browser can also be accessed from the Display
Desktop on the control panel.

2. Select Queue > Network.

• Located on the Browser menu bar.

• The content of the Advantage network queue displays
up to date information. To subsequently update to the
current status of the push and pull queue lists shown in
each window, click [Refresh].

NOTE: If there are no transfers in progress, the message "All
Network Queues are Empty" appears. Click [OK] to
acknowledge the message.

In Brief: Check the
Network Queue

1. Click Image
Management Desktop.

2. Select Queue > Network.

3. Select an option to
pause, resume or clear
the items in the Archive
Queue.

4. Click [Quit].
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• If transfers are in progress, the Advantage network
queue appears.

3. From the Advantage Send or the Advantage Receive
queue do one of the following:

• Click [Pause All] to temporarily suspend execution of all
requests in a queue.

° All jobs now have the (Paused) status.

• Select an entry and click [Pause] to temporarily
suspend the execution of a single request.

° One job in the queue has the (Paused) status.

• Click [Resume All] to continue the execution of a
paused queue.

° All jobs return to their original status and execution
continues.

• Select an entry and click [Resume] to continue the
execution of a single job in the queue.

° The selected job in the queue returns to original
status and the job is executed.

• Select an entry and click [Clear] to permanently remove
a job from the queue.
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° The Cancel message appears requesting
confirmation to clear the requested jobs in the
queue.

° Click [OK] to proceed and clear the requested
network queue.

4. Click [Quit].

• The Advantage network queue window closes.
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Symbols
# of Phases to Reconstruct V2, 13-18

Numerics
2D Mode V1, 3-16
2D PC Oblique Imaging V2, 8-7
2D Phase Contrast (2D PC) V2, 8-6
2D Time of Flight GRE and SPGR V2, 6-3
2DTOFX V2, 6-6
2-Point Tool V3, 5-13, V3, 5-32
3 Plane Localizer V2, 1-1, V2, 1-6
3D Analysis V4, 7-1, V4, 7-2
3D CSI Viewport Layout V4, 8-18
3D Focal CSI V2, 12-32
3D Focal CSI Display Tool Command Window V4, 8-40
3D Mode V1, 3-17
3D MultiSlab V1, 3-19
3D Phase Contrast (3D PC) V2, 8-23
3D TOF GRE/SPGR V2, 6-15
3D Volume Prescription V1, 3-19
3-Point Tool V3, 5-14, V3, 5-32, V3, 5-33

A
A.I. V1, 6-10
A.I. Code V1, 6-30
A.I. Mappings Browser V1, 6-10
Abbreviated Patient Information V1, 3-8
Abdomen Application V3, 5-50
Abort Scan V1, 2-6
About IVI... V4, 5-6
abs N..M V4, 8-45
Accelerator Bar V1, 9-70
Accelerator Command List V1, 9-71
Accelerator Commands V1, 9-18, V1, 9-70
Accept Negative Pixels V4, 3-10
Acoustic Hazards V1, 1-26
Acquire at Current V3, 5-37
Acquire at End V3, 5-34, V3, 5-35
Acquire at Start V3, 5-34, V3, 5-35
Acquire End V3, 5-19
Acquire Start V3, 5-19
Acquire Tab Card Screen V3, 5-6
Acquisition Matrix V1, 3-58
Acquisition Timing V1, 3-58
Active Spectrum V4, 8-32
Adaptive Phased Array V1, 4-8
Add a Host V1, 11-35
Add One or Two Sets of Images V4, 3-12
Add Protocol V4, 5-30
Adding one or two sets of images V4, 3-12
Additional Imaging Options V3, 1-45
Additional Parameters V1, 3-39
Adjust the Receiver Gain to Achieve Optimum Signal V1,

8-17
Adjust the Transmit Gain to Achieve Optimum Flip Angle
V1, 8-12
Adjusting the Composite Overlay V4, 8-59
Advanced Processing V4, 5-7
Advisory Panel V1, 3-84
AE Title V1, 2-19
Algorithms V4, 8-10
Along trace V4, 5-18
Analog Gain R1 V1, 8-17
Analyzing Images V1, 9-36
Angle V4, 5-8
Angle Between Views V4, 5-30
Angle between views V4, 5-33
Annotate V1, 9-48
Annotation V1, 9-16
annotation V1, 9-10
Annotation (system) V1, 9-59
Annotation of an Edited Exam V4, 2-6
Anonymous Patient V1, 11-4
Apply Cut V4, 5-18
Apply Locations V3, 5-19, V3, 5-34, V3, 5-35
Applying Mattes to Images V1, 9-51
Archive Image Data V1, 11-18
Archive Media V1, 11-5
Archive Node V1, 6-35
Archive Queue V1, 11-9
Area V4, 5-8
Arrhythmia Rejection V2, 10-5
Arrhythmia Rejection Window V2, 13-18, V3, 2-40
Arrhythmia Rejection Window (ARW) V3, 2-42
Assign Image Storage V1, 6-34
Audio Trigger Volume V3, 2-34
Auto Archive V1, 3-73
Auto Center Frequency V1, 3-65
Auto Clear V1, 10-15
Auto Clear Page V1, 10-7
Auto Prescan V1, 3-89, V1, 8-4
Auto Printing V1, 10-6, V1, 10-15
Auto Scan V1, 3-83, V1, 7-12
Auto Transfer by Exam V1, 3-74
Auto Transfer by Series V1, 3-74
Auto Window/Level V1, 3-26
Automatically Prescanning V1, 8-9
Autoshim V1, 3-68
AutoStep V1, 3-84, V1, 7-13, V3, 4-6, V3, 4-9
Autoview V1, 3-24
autoview screen V1, 2-2
AutoView Window V1, 3-24
Available Imaging Time (AIT) V3, 2-47, V3, 2-55
Average V4, 8-16
Averages V3, 5-18
2292261-100 Rev. 0 (03/01) IDX-1



Signa® MR/i ™ with Signa Select™ (ASP2) Index
B
Bandwidth V1, 3-38
Basic Problem Resolutions V1, 2-18
Batch Command Window V4, 6-26
Batch Filming/Movies V4, 5-6
Batch Projection V4, 5-28
Bind Images V4, 3-20
Binding Images V4, 3-7
Binding images V4, 3-20
Biomagnetic Hazards V1, 1-23
Birthdate V1, 6-5
Blood Oxygen Level Dependent V4, 8-11
Blood Suppression V3, 1-44
Body Coil V1, 4-7, V1, 4-16
body coil V1, 4-16
BOLD V4, 8-11
Bolus Chasing V3, 4-1
Bookmark V3, 5-39
Bookmark - Recall V3, 5-30
Bookmark - Replace V3, 5-30
Bookmark Images V3, 5-9
Bookmark images V3, 5-11
Bore heating V1, 1-17
Brachial Plexus Application V3, 5-49
Brain Spectrum V2, 12-6
Browser V1, 9-6
Building a Protocol V1, 5-9
Burn Hazards V1, 1-16
Burst Scan Time V3, 3-3
B-Value V2, 11-34

C
Cable Connection Ports V3, 2-17
Cable/Connector Warnings V1, 1-18
Cancel Identify V4, 5-24
Cardiac Array coil V1, 4-24
Cardiac Compensation V3, 1-32
Cardiac Gating V3, 2-6
Cardiac Gating and Triggering V3, 1-33
Cardiac Gating and Triggering Parameters V3, 2-37
Cardiac Gating/Triggering V3, 2-74
Cardiac Phases V3, 2-47
Cardiac Phases to Reconstruct V2, 9-6
Cardiac Pulse Sequences V2, 13-1
Cardiac Sweep Rate V3, 2-29
Cardiac Trigger Level V3, 2-31
Cardiac Trigger Level Annotation V3, 2-33
Cardiac Triggering V3, 2-7
Cardiac Waveform V3, 2-24
Cardiac/Peripheral Display V1, 2-5
CEMRA V3, 3-2
Centric K-space Filling V3, 3-6

Change window width and level V1, 9-27
Check the Archive Queues V1, 11-30
Check the Cryogen Levels V1, 1-46
Chemical Saturation V1, 7-37, V1, 8-7, V3, 1-39
Chemical Shift Imaging (CSI) V2, 12-4
ChemSAT Tune V1, 8-7
Choline V4, 8-43
Choline (Cho) V2, 12-6
Choline/creatine V4, 8-43
Choline/N-acetyl V4, 8-43
CINE V3, 2-5
CINE Acquisitions V3, 2-9
Cine GRE V2, 9-3
Cine Mode V1, 3-21
Cine Paging V1, 9-7, V1, 9-31
Cine PC V2, 9-19
Cine Pulse Sequences V2, 9-1
Cine Screen V1, 3-48
Cine SPGR V2, 9-17
ClariView V4, 1-1, V4, 1-3, V4, 1-10
ClariView and PPS V1, 6-26
ClariView filters and PPS V1, 6-26, V4, 1-4
ClariView Screen V4, 1-6
Classic V3, 1-20
Classic and Improved Fat Saturation V1, 7-39
Clear Trace V4, 5-18
Clinical Hazards V1, 1-23
Closing Real Time Interactive Imaging V3, 5-17
Coil Sensitivity Range V1, 4-8
Coil Type V1, 3-11
Color / Light / Window V4, 5-6
Combined Cardiac and Respiratory Gating/Triggering V3,
2-56
Combined Cardiac and Respiratory Gating/Triggering
Guide V3, 2-58
Combined Cardiac and Respiratory Gating/Triggering
Screen V3, 2-35
Combining Images V4, 3-1
COMP V1, 6-25
compare V1, 9-34
Complete V1, 6-10, V1, 6-25
Complex Difference V2, 8-6
Composite V4, 8-43
composite overlay V4, 8-10
Composition of Archiving Option V1, 11-6
Computer room V1, 2-14
Concatenated SAT V1, 7-34
concatenated spatial saturation V1, 7-73
Configure V1, 10-22
Configure a Remote Host V1, 11-35
Configuring a Remote Host V1, 11-38
Confirguring mobile sites V1, 2-22
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Connect Pro V1, 6-23
ConnectPro V1, 6-7
ConnectPro Plus V1, 6-7, V1, 6-12
Console Room V1, 2-9
Contraindications for Use V1, 1-6
Contrast V1, 3-70
Contrast Mechanism V3, 3-3, V3, 4-4
Contrast resolution V1, 7-15
contrast-enhanced MR angiography V3, 3-1
Control panel V1, 5-4
control room V1, 2-9
Conventional SAT V1, 7-32
copy an entire protocol V1, 5-14
Copy Rx V1, 7-26
Copying a Protocol V1, 5-14
Copying a series in a Protocol V1, 5-22
Correlation Coefficient V4, 8-10, V4, 8-52
Create an Anonymous Patient V1, 11-16
Creatine V4, 8-43
Creatine/phosphocreatine (Cr/PCr) V2, 12-6
Creating a Custom 3D Focal CSI Protocol V4, 8-63
Creating Vascular Projections V4, 5-1
Cross-Reference V1, 9-56
Cross-Reference a Series V1, 9-56
Cryogens V1, 1-11
CTL Array coil V1, 4-21
Cube V4, 5-26
Cursor Location Spectrum V4, 8-33
Cursor Lock V4, 5-6
Curved reformat V4, 6-68
Custom annotation V1, 9-60
Cut Plane Tools V3, 5-13

D
Data Available for Edit V4, 2-3
dB/dt Level V1, 3-87
Defer V1, 6-10, V1, 6-25
Define Cut Planes V3, 5-32
Define Saturation Bands V1, 7-72
Defining a Region of Interest with MIROI V4, 4-1
Defining a Scanning Range V1, 7-22, V1, 7-62
Defining Saturation Bands V1, 7-32, V1, 7-72
deg V4, 5-7, V4, 5-26
Degrees V4, 5-26
Delay After Acquisition V1, 3-50
Delete protocol V4, 5-35
Deleting a Host V1, 11-38
Deleting a Protocol V1, 5-19, V1, 5-20
Deleting a Registered Patient V1, 6-6, V1, 6-22
Deleting an IVI protocol V4, 5-35
Deleting Site Protocols from MOD V1, 5-31
Desktop Organization V1, 2-16
Detach Storage Media V1, 11-32

dev N..M V4, 8-46
Diastole V3, 2-12
Difference Function V4, 8-16, V4, 8-56
Diffusion Coefficient V4, 8-16, V4, 8-54
Diffusion EPI V2, 11-32
Digital Gain R2 V1, 8-17
Discontinue V1, 6-11, V1, 6-25
Display Desktop V1, 2-16
Display Modes V4, 5-6
Display modes V4, 5-32
Display Normal V1, 9-44
Display/Actions Defaults V4, 5-6, V4, 5-17
Displaying 3D Focal CSI Images V4, 8-60
Displaying Images in Viewer V1, 9-25
Displaying the Graphs V4, 8-51
Displaying Valid Image Sets V4, 8-50
Distance V4, 5-8
Double-IR V2, 13-4
Drag and Drop V1, 10-15
Draw Line V3, 5-13, V3, 5-32
Driven Equilibrium Preparation V3, 1-24
DWI Screen V1, 3-50

E
E,S,I V1, 10-15
ECG Gating Warnings V1, 1-20
ECG Gating/Triggering V3, 2-5
ECG Histogram V3, 2-25
ECG Inversion V3, 2-30
ECG Lead Placement V3, 2-18
ECG Lead Selection V3, 2-29
ECG Leads V3, 2-13
ECG Noise Filter V3, 2-28
ECG Waveform V3, 2-9
Echo Planar Imaging (EPI) V2, 11-4
Echo Planar Pulse Sequence V2, 11-1
Echo Time V1, 3-30
Echo Train Length V1, 3-36
Edit Applications screen V4, 2-10
Edit Log V4, 2-8
Edit Patient Data V4, 2-12
Edit Patient Data Screen V4, 2-7
Edit Patient Data screen V4, 2-12
Editing a Protocol V1, 5-16, V1, 9-54
Editing a protocol V1, 5-16
Editing Patient Data V4, 2-10
Eliminate Ferromagnetic Items From The Security Zone
V1, 1-36
Eliminate Magnet Hazards V1, 1-36
Ellipse ROI V4, 8-46
elliptical matte V1, 9-51
Elliptical ROI V4, 8-51
elliptic-centric k-space filling V3, 4-2
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Emergency Magnet Run-Down V1, 1-28
Emergency Off V1, 1-27
emergency off V1, 1-27
Emergency Stop V1, 1-26, V1, 2-4
emergency stop V1, 1-26
End Exam V1, 3-78, V1, 7-10
End Exams with ConnectPro V1, 6-10
End PPS V1, 6-25
Enhancing Images V1, 9-54
Enhancing with Smoothing V4, 1-9
Equipment Hazards V1, 1-26
Erase All V1, 9-42
Erasing an Image From the Film V1, 10-19
Exam Description V1, 6-6
Exam Text Page V1, 10-18
Exclusion Zone V1, 1-10
Explicit V4, 5-25
Explicit Prescription V1, 7-22
Explicit prescription V1, 7-62
Explicitly V1, 7-62, V4, 5-26
Exponential Diffusion Coefficient V4, 8-17, V4, 8-57
Expose Order V1, 10-7
Extended Dynamic Range V3, 1-48
Extract Minimum or Maximum Pixel Values V4, 3-16

One Set of Images V4, 3-16
Two Sets of Images V4, 3-18

Extract the minimum or maximum pixels V4, 3-16
Extremity coil V1, 4-22

F
F Keys V1, 10-8
F1 V1, 10-8, V1, 10-16
F1-F11 V1, 10-8
F1-F4 keys V1, 10-8, V1, 10-16
F2 V1, 10-9, V1, 10-16
F3 V1, 10-9, V1, 10-16
F4 V1, 10-9, V1, 10-17
Factors that Affect Contrast V1, 7-15
Factors that Affect Scan Time V1, 7-17
Factors that Affect SNR V1, 7-18
Factors that Affect Spatial Resolution V1, 7-16
Fallback V1, 7-27
Fan V1, 2-6
Fast 2D Phase Contrast V2, 8-15
Fast 2D Time of Flight GRE/SPGR V2, 7-4
Fast 2DPC V2, 8-15
Fast 3D TOF GRE/SPGR V2, 7-17
Fast Gradient Echo (FGRE) V2, 5-3
Fast Recovery Fast Spin Echo (FRFSE) V2, 3-21
Fast Spin Echo (FSE) V2, 3-3
Fast Spin Echo Pulse Sequences V2, 3-1
Fast Spin Echo-Inversion Recovery (FSE-IR) V2, 3-30
Fast Spoiled Gradient Echo (FSPGR) V2, 5-3

Fast Time of Flight Pulse Sequences V2, 7-1
FastCard V2, 10-3
FastCard Non-sequential V2, 10-5
FastCard Pulse Sequence V2, 10-1
FastCard Sequential V2, 10-4
FastCine V2, 13-15
FastCine PC V2, 13-15
Feature Status Area V1, 11-4
Female Pelvis Application V3, 5-52
Field of View V1, 3-51
Film Composer V1, 10-4, V1, 10-13, V4, 5-6
Film Format V1, 10-5
Filming Queue V1, 10-23
Filming Setup V4, 5-6
filming the text page V1, 10-18
Filter and Save to Database V4, 1-7
Filter Description and Use V4, 1-4
Filter Floaters V4, 5-8
Filter J V4, 1-3
Filter Name V4, 1-4
Final View V4, 5-34
First View V4, 5-33
FLAIR V2, 3-38
Flair EPI V2, 11-26
Flip Angle V1, 3-35, V1, 8-6
flip or rotate V1, 9-47
Flow Analysis V2, 9-28
Flow Compensation V3, 1-26
Flow Compensation Direction V1, 3-67
Flow Encoding Axis V2, 9-34
Flow Recon Type modes V2, 8-6
FOV Center V1, 3-55
FPS V1, 9-32
Fractional Echo V1, 3-31
Frame Rate V3, 5-7
Frames per Second Notification V1, 3-86
free trace V4, 5-17
Frequency Direction V1, 3-64
Frequently Asked Cardiac Questions V3, 2-69
FRFSEOPT V2, 3-23
FSE-XL V2, 3-7
FSE-XL IR with Blood Suppression V2, 13-6
FSE-XL with Blood Suppression V2, 13-4
Full annotation V1, 9-60
Full Echo Train V3, 1-47
Function (F) keys F5-F10 V1, 9-68
Function Algorithms V4, 8-52
Function menu V4, 8-40
FuncTool V4, 8-1
FuncTool Layout V4, 8-5

G
Gated 2D TOF V2, 7-4
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Gating V3, 2-6
Gating Contro V1, 3-75
Gating Control V3, 2-23
Gating Reset V3, 2-34
Gating/Triggering Icon V1, 3-47
Gating/Triggering Screen V1, 3-47
GE Library V1, 5-5, V1, 9-16
GE Protocol Library V1, 7-5
Get Protocol V4, 8-42
GI

HIS/RIS DICOM V1, 6-27
Mobile V1, 2-24, V1, 2-26

Glutamate (Glu) V2, 12-7
Glutamine (Gln) V2, 12-7
GPFlex V1, 4-25
Gradient and Shim Coil Function V1, 4-3
Gradient Coils V1, 4-3
Gradient Echo (GRE) V2, 4-3
Gradient Echo EPI V2, 11-11, V2, 11-19
Gradient Echo Pulse Sequences V2, 4-1
Gradient, Shim, and Imaging Coils V1, 4-1
Graphic Prescription V1, 7-23
Graphic Prescription Screen V1, 3-42
Graphic Rx Icon V1, 3-43
Graphic SAT Prescription V1, 7-41
Graphically V1, 7-65
Graphics V4, 5-8
Greyscale V1, 10-6
Grid V1, 9-41
Grid appearance V1, 9-63
Grid Preferences V1, 9-17, V1, 9-63
Grid spacing V1, 9-63
Guided Install V1, 2-23, V1, 2-26, V1, 6-13, V1, 6-30
Guided Install - HIS/RIS DICOM Mode V1, 6-33
Guided Install for HIS/RIS DICOM V1, 6-13
Guided Install for Mapping Protocols to Action Items V1,
6-13
Guided Install HIS/RIS DICOM Mode V1, 6-27
Guided Install window V1, 6-28

H
Handle V4, 5-26
Handle Contact with Liquid Cryogens V1, 1-48
Hazard Warnings V1, 1-13
Head Coil V1, 4-6
head coil V1, 4-13
Head Coil QA V1, 4-10
Heart Application V3, 5-54
Heart Rate/Update Rate V3, 2-50
Hide and Show V1, 9-43
High Risk Patients V1, 1-24
HIS/RIS V1, 6-7
HIS/RIS Action Item Code V1, 6-32

HIS/RIS DICOM mode V1, 6-13, V1, 6-27
HIS/RIS tab V1, 6-14
Histogram V4, 8-51
histogram V4, 8-10
Home V1, 2-6
Home Images V3, 5-9
Home images V3, 5-9
Hydrogen Proton Precessional Frequency V1, 4-5

I
IAC Application V3, 5-39
Icon labels V1, 10-7
Identify mm./slices V4, 5-6
Identify W/L V4, 5-24
iDrive V3, 5-1, V3, 5-4
iDrive Pro V3, 5-4
IGRx V3, 5-18, V3, 5-19
ilinq Desktop V1, 2-17
Image V1, 10-15
Image Acquisition Delay V3, 3-3
Image Addition V4, 3-4
Image Analysis V4, 7-2
Image Annotation V1, 9-12
Image Buffer V3, 5-20
Image Combination V4, 3-4
Image Combination Menu V4, 3-7
Image Contrast Buttons V3, 5-14
Image Display V1, 3-25
Image Enhance V1, 9-54
Image Enhancement Purpose and Benefits V4, 1-3
Image Management Desktop V1, 2-16
Image Slide Bar V4, 1-6
Image Storage Annotation V1, 6-34
Image Subtraction V4, 3-5
Imaging Coil Function and Classification V1, 4-5
Imaging Mode V1, 3-16
Imaging Option Annotation V1, 9-13
Imaging Options V1, 3-22, V1, 7-14
Imaging Plane V1, 3-13
Implant and Prosthesis Hazards V1, 1-6
Indications for Use V1, 1-5
Individual Spectra V4, 8-33
Infusion Angiography V3, 3-3
inhomogeneities V1, 4-5
INPR V1, 6-25
Inside trace V4, 5-18
Interactive V4, 5-25
Interactive Vascular Imaging V4, 5-1
Interleaved V1, 3-49
Inter-Sequence Delay V3, 2-46
Inter-Sequence Delay (ISD) V3, 2-55
inverse video V1, 9-78
Inversion Recovery (IR) V2, 2-15
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Inversion Recovery Preparation V3, 1-23
Inversion Time V1, 3-34
IP address V1, 2-18, V1, 2-19, V1, 2-23
Isometric voxels V4, 5-3
IVI V4, 5-1, V4, 5-15
IVI Command Window V4, 5-15, V4, 5-20
IVI process V4, 5-1

K
Keyboard & Mouse V1, 2-10
Knee Application V3, 5-46
K-space Filling V3, 4-4

L
Label Storage Media V1, 11-20
Labeling the Storage Media V1, 11-6
Lactate (Lac) V2, 12-7
Lactate lipid V4, 8-43
Landmark V1, 2-6, V1, 3-8, V1, 5-10, V1, 6-6
Landmarking V1, 7-50
Laser Align Light V1, 2-5
Laser Light Hazards V1, 1-13
Lead Display V3, 2-29
level V1, 9-6
Light V1, 2-6
Limit Access to the Exclusion Zone - Screen Patients and
Personnel V1, 1-37
Linking a Protocol to a Patient V1, 6-18
Lipids (Lip) V2, 12-7
Liquid Cryogen Concerns V1, 1-11
List of Previously Entered Hospitals V1, 2-20
Loading Text Pages V1, 10-18
Loading the images V1, 10-8
Loading with Drag and Drop V1, 10-15
Loading With the Function Keys V1, 10-16
Locations per Acquisition V3, 2-68
Locations per Acquisitions V2, 9-5
log N..M V4, 8-46
Lower Left (LL) Viewport V4, 8-35
Lower Right (LR) Viewport V4, 8-38
LX Table V1, 2-8

M
Magnet Emergencies V1, 1-41
magnet enclosure V1, 2-4
Magnet Hazards V1, 1-8
magnet room V1, 2-4
Magnetic Resonance Angiography (MRA) V4, 5-1
Magnetic Resonance Suite V1, 2-3
Magnetization Transfer V3, 1-42
Magnify glass V1, 9-65
Magnifying Glass V1, 9-39
Magnifying Images V1, 9-37
Manage Disk Space V1, 11-33

Managing Disk Space V1, 11-10
Managing Images V1, 11-1
Managing Site Protocols V1, 5-7
Manual Arrhythmia Monitoring V2, 13-18, V3, 2-43
Manual Prescan V1, 3-89, V1, 8-4
Manually Prescan V1, 8-10
Manually Prescanning V1, 8-10
Mapping Protocols V1, 6-30
mask V3, 4-1
masking V3, 4-2
Match Coarse Center Frequency to the Patient V1, 8-10
Match Fine Center Frequency to the Patient V1, 8-15
Matrix Zerofill Interpolation Processing V3, 1-13
Matte V1, 9-51
max N..M V4, 8-46
Maximize/Minimize V1, 3-27
Maximum Difference Function V4, 8-15, V4, 8-56
Maximum intensity pixel V4, 5-4
Maximum Monitor Period V3, 3-3
Maximum Pixel Extraction V4, 3-6
Maximum Slope of Increase V4, 8-14, V4, 8-53
Mean Time to Enhance V4, 8-13, V4, 8-53
Measure V1, 9-53
Merge ROI V4, 8-47
Message area V3, 5-16
Metabolite and Ratio Maps with Sharp Edges V4, 8-48
Metal Heating Warnings V1, 1-21
Meta-series V3, 4-3
meta-series V3, 4-2
Millimeters V4, 5-26
min N..M V4, 8-46
Minimum Pixel Extraction V4, 3-6
MIP V4, 5-1, V4, 5-4
MIROI Basics V4, 4-4
MIROI Layout V4, 4-4
mm V4, 5-26
Mobile Site Configuration V1, 2-18, V1, 2-23
Mobile Site Setup V1, 2-23, V1, 2-24
Mobile Site Setup window V1, 2-24
MOD V1, 2-10
Mode V1, 3-73
Modify Model V4, 5-7, V4, 5-16, V4, 5-21
Modifying the Volume V4, 5-14
Mouse basics V1, 2-13
Move to Scan V1, 2-6
Movement/Rotation Increment buttons V4, 6-25
Movies screen V4, 5-28, V4, 5-29
Movies window V4, 5-29
MPVR V4, 7-1
MR Angio V4, 7-1
MR Compatibility V1, 1-31
MR Spectroscopy Protocols V4, 8-17
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MRA Algorithms V4, 1-9, V4, 1-13
MRA-MIP filter V4, 1-3
MRS Mode V1, 3-21
Multi Phase V3, 1-50
Multi Phase Icon V1, 3-49
Multi Phase Screen V1, 3-48
Multi-Plane Graphic Rx V1, 7-28
multiple stations V3, 4-1
Multi-Slab V2, 6-20
Multi-Station V3, 1-53
Myo-inositol (ml) V2, 12-7

N
N-acetyl V4, 8-43
N-acetylaspartate (NAA) V2, 12-6
Navigate the Schedule Screen V1, 6-8
Navigate through screens and menus V1, 2-30
Negative Enhancement Integral V4, 8-12, V4, 8-53
Netmask V1, 2-19
Network DICOM Devices V1, 2-20
Network from the Scan Rx Desktop V1, 11-42
Network Images To & From Connected Stations V1,
11-42, V1, 11-45
Network Queues V1, 11-13
Networking Terms V1, 11-12
Networks V1, 11-12
Neurovascular coil V1, 4-23
New Save Series V4, 3-8
New Series V1, 3-77, V1, 7-9
NEX and SNR V1, 7-21
niobium-titanium V1, 4-5
No Phase Wrap V3, 1-9
No. of Copies V1, 10-7
Number of Acquisitions Before Pause V1, 3-63
Number of Acquisitions/Locations Before Pause V1, 3-63
Number of Cardiac Phases to Reconstruct V3, 2-48, V3,
2-68
Number of Echoes V1, 3-28
Number of Excitations (NEX) V1, 3-60
Number of Locations Before Pause V1, 3-63
Number of Repititions Before Pause V1, 3-63
Number of Respiratory Intervals V3, 2-51
Number of R-R Interval V3, 2-39
Number of Shots V1, 3-29
Number of Slices/Slabs V1, 3-56
Number of views V4, 5-33

O
Oblique Batch V4, 6-64
Oblique Mode Select V4, 5-7
on-screen trackball V4, 5-25, V4, 5-26
Optimize Chemical Saturation V1, 8-19
Optimizing Image Quality with Prescanning V1, 8-1

Options for Saturation Techniques V3, 1-36
Options that Control Artifacts V3, 1-4
Options that Enhance or Alter Contrast V3, 1-17
Options that Enhance Spatial Resolution V3, 1-12
Options that Minimize the Effects of Motion V3, 1-26
Options to Balance SNR V3, 1-45
Orbit Application V3, 5-42
Orientation Buttons V3, 5-16
Output mode V4, 5-30
Outside trace V4, 5-18

P
PAC (Physiologic Acquisition Control) Unit V1, 2-7
Paging V1, 9-7, V1, 9-31
Pan Cursor V3, 5-11
Parameter Trade-offs V1, 7-15
Parametric images V4, 8-10
Partial annotation V1, 9-60
Partial Radial Spacing V1, 7-29
Patient Age V1, 6-5
patient alert device V1, 2-2
Patient Alert System V1, 1-30
Patient Comfort Module V1, 1-16
Patient Demographics V1, 6-4
Patient Emergencies V1, 1-31, V1, 1-40
Patient Entry V1, 3-11
Patient History V1, 6-6
Patient Information V1, 3-6
Patient Information Edit Log V4, 2-8
Patient Informaton Edit Log V4, 2-14
Patient Log V4, 2-14
Patient Position V1, 3-9
Patient Positioning Warnings V1, 1-16
Patient Preparation and Scan Start Up V3, 3-13
Patient Register V1, 6-21
Patient Screening Form V1, 1-38
Patient transport V1, 2-8
Patient Weight V1, 6-5
Pause Scan V1, 2-6
Pause Scanning V3, 5-18, V3, 5-36
Pause When Ful V3, 5-38
Pause When Full V3, 5-36, V3, 5-37
PC V4, 5-3
PC Monitor V1, 2-10
Perform Arrhythmia Rejection and FastCard V3, 2-42
Performed Procedure Step V1, 6-12
Performing Coil QA V1, 4-10
Performing QA for Other Coils V1, 4-11
Peripheral (photo-pulse) Sensor V3, 2-15
Peripheral Gating Warnings V1, 1-20
Peripheral Gating/Triggering V3, 2-5
Peripheral Nerve Stimulation V1, 1-13
Peripheral nerve stimulation V1, 1-29
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Peripheral Vascular coil V1, 4-24
Phase Acquisition Order V1, 3-49
Phase Contrast V4, 5-3
Phase Contrast (PC) V2, 8-3
Phase Contrast Pulse Sequences V2, 8-1
Phase Correct V1, 3-69
Phase Difference V2, 8-6
Phase FOV V1, 3-61
Phase Offset Multi-Planar V3, 1-45
Phased Array Breast coil V1, 4-23
phased array coils V1, 4-18
Phases of SmartPrep V3, 3-5
Phases Per Location V1, 3-49
Picture This Library V1, 5-6, V1, 9-18
Picture This Protocol Library V1, 7-5
Place Bellows and Route the Tubing V3, 2-84
Place Electrodes and Route the Cable V3, 2-74
Play Backward V3, 5-22
Play Forward V3, 5-22, V3, 5-37
Port No. V1, 2-19
Position the Patient V1, 7-51
Positive Enhancement Integral V4, 8-11, V4, 8-57
Post Process Three Station Runoffs

Acquire Collapsed Images with IVI V4, 3-26
Bind Multiple Series into a Single Series V4, 3-28
Subtractions V4, 3-22

Post Processing Three Station Runoffs V4, 3-22
Power down under emergencies V1, 2-38
Powering down under Emergencies V1, 2-22
PPS V1, 6-12, V1, 6-23
P-R Interval V3, 2-11
Precessional and Transmit Frequency V1, 8-6
Pregnant or Infant Patients V1, 1-23
Prep Scan V1, 3-89
Prepare the Patient for the Exam V1, 7-46
Prepare to Scan V1, 3-82, V1, 7-11
pre-register a patient V1, 6-1
Pre-Registering a Patient V1, 6-16
Pre-Registering Patient V1, 6-4
Prerequisite Skills V1, About-1, V2, About-1
Prescan V1, 3-88
Prescanning V3, 4-6, V3, 4-11
Prescribe Scan Locations For A Series V3, 5-34
Preset buttons V4, 6-19
Preset window widths and window levels V1, 10-25
Presets V1, 9-18, V1, 9-68, V1, 10-25
PRESS V2, 12-10
Preview V4, 5-30
Previewing Command Window for Film Batch or Movie
Loop V4, 6-37
primary viewport V1, 9-5
print options V1, 10-6

Print Queue V1, 10-11, V1, 10-23
Print Series V1, 10-10, V1, 10-17
Print Series window V1, 10-10, V1, 10-17
Printer V4, 5-30
Printing V1, 10-8, V1, 10-20
Printing Images V1, 10-20
Printing Protocols V1, 5-24
Printing Site Protocols V1, 5-24
PROBE/SV V2, 12-4
PROBE-P V2, 12-10
PROBE-S V2, 12-10
Protect the Patient from RF Burns V1, 1-43
Protect the Patient’s Eyes and Ears V1, 1-45
Protocol V1, 3-23, V1, 7-4
Protocol Algorithms V4, 8-55
Protocol Building V1, 5-1, V1, 5-9
Protocol Desktop V1, 2-16
Protocol Libraries V1, 7-4
protocol Libraries V1, 5-14
protocol library V1, 5-14
Protocol Manager V1, 5-4
Pulse Sequence V1, 3-21
Pulse Sequence Annotation V1, 9-15
Pulse Sequence Database Name V1, 3-22
Pulse Sequences V1, 7-13
Purpose and Benefits V1, 8-4
P-Wave V3, 2-10

Q
QA test V1, 2-15
QRS Complex V3, 2-11
Quality Assurance V1, 2-15
Quench V1, 1-11
Quench with Vent Failure V1, 1-42
Quick Step iDrive for 3 Plane Localizer V3, 5-56

R
Radial Batch V4, 6-66
Radial Graphic Rx V1, 7-28
Radial Graphically V1, 7-70
Ramp Pulse V2, 6-16
Ratio (A-B)/(C-D) V4, 8-17, V4, 8-45, V4, 8-54
Ratio Slider V4, 3-9
Raw f ile manager V1, 2-36
Raw file manager V1, 2-37
Real Time V3, 5-5
Real Time Interactive Acquire Tab Card V3, 5-28
Real-Time V3, 1-53
Real-Time Sequence V3, 5-27
Reasons for Auto Prescan Failures V1, 8-5
reboot V4, 1-13
Rebooting During the ClariView Procedure V4, 1-13
Receive V1, 8-7
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Receive Gain V1, 8-7
Receiver Bandwidth and SNR V1, 7-20
Receiver Sensitivity V1, 8-7
rectangular matte V1, 9-51
Redo V3, 5-17
Reference Image V1, 9-8, V1, 9-45
reference image V4, 8-9
Reference Scan V1, 3-90
Reformat

Cursor / Annotations Command Window V4, 6-42
Display / Graphics Options Command Window V4,
6-42
Display / Graphics Options Command window V4,
6-44
File Menu V4, 6-7
Graphics Command Window V4, 6-10
Identify mm. / Slices Command Window V4, 6-39
Layout V4, 6-5
Oblique Mode Select Button V4, 6-18
On View Operations V4, 6-50
Plane Orientation Indicator V4, 6-6
Series/Image Selection V4, 6-5
Tilt/Rotate Mode Select Button V4, 6-17
Valid Image Set V4, 6-4
View Type Buttons V4, 6-20

Reformat Layout V4, 6-5
Reformation Color Window Command V4, 6-46
Reformation Film Command Window V4, 6-48
Refresh V1, 10-24
Refresh List V1, 9-24
Region of Interest V4, 8-46
Region-of-Interest (ROI) V4, 8-19
Regulate Contrast with Cardiac Gating V3, 2-80
Regulate Contrast with Respiratory Gating V3, 2-88
Relative SNR% V1, 3-85
Remote Configure window V1, 10-22
Remote Printer V1, 10-11, V1, 10-21
Remove a Host V1, 11-38
Remove Annotation V1, 9-50
Remove Image Data V1, 11-33
Removing Images from the System Disk V1, 11-11
Repeat a Series V1, 5-22
Repetition Time V1, 3-33
Report Cursor V1, 3-25
Reset Center V1, 7-27
Reset the TPS V1, 2-35
Reset TPS V1, 2-18
Reset Values V1, 3-85
Respiratory Bellows Placement V3, 2-21
Respiratory Compensation V3, 1-28
Respiratory Display V1, 2-4
Respiratory Gating V3, 2-7, V3, 2-16
Respiratory Gating and Triggering V3, 1-30, V3, 2-16

Respiratory Gating and Triggering Parameters V3, 2-50
Respiratory Gating with FastCine/FastCine PC V2, 13-19
Respiratory Gating/Tiggering V3, 2-5
Respiratory Gating/Triggering V3, 2-84
Respiratory Triggering V3, 2-8, V3, 2-17
Respiratory Waveform V3, 2-25
Respond to Emergencies V1, 1-40
Restore Images from Local Archive Media V1, 11-26
Restoring Images from Local Archive Media V1, 11-8
Restoring Protocols from MOD V1, 5-31
Restrictions for Restoring Images from Archive Media V1,
11-8
Restrictions for Saving Images V1, 11-7
Restrictions on Use V1, 1-5
Retrieve Images from a Remote Host (Network Receive)
V1, 11-48
Retrieve Locations V3, 5-19
Reversing the Video V1, 9-78
Review Tab Card V3, 5-22
Reviewing Protocol Parameters V1, 7-60
RF Power V1, 1-22
Right Mouse Button V1, 9-65
Right Mouse button V1, 9-17
Rotate Cursor V3, 5-12
Rotate using first and last image V4, 5-32
Rotating the MIP V4, 5-25
Rotation V4, 5-29
Rotation Increment V4, 5-7
Rotation Movie Loop Command Window V4, 6-33
R-R Interval V3, 2-12
Rx Locations V3, 5-18
Rx Manager V1, 3-71, V1, 7-6
Rx Manager List V1, 3-79, V1, 7-7

S
Safety Information V1, 1-5
Safety Notices V1, About-7, V2, About-5
Safety Review V1, 1-34
SAR Level V1, 3-86
SAR Limits V1, 1-24
SAT Gap V2, 7-8
SAT Icon V1, 3-40
SAT in the FOV V1, 7-35
SAT Prescription Screen V1, 3-40
SAT pulse V2, 6-6
Save V4, 5-30
Save Image V3, 5-38
Save Image button V3, 5-17
Save Images V1, 11-23, V3, 5-38
Save Range V3, 5-38
Save raw data V1, 2-21
Save Rx as Protocol V1, 3-82, V1, 5-19, V1, 7-11
Save Series V1, 3-85
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Save State V1, 9-77
Save Window/Level V1, 3-26
Save/Restore/Print Protocol V1, 5-31
Saveraw data V1, 2-36
Saving a Protocol V1, 5-19, V1, 9-58
Saving a Series V4, 3-8
Saving and Filming Images V4, 8-48
Saving Images V1, 11-7
Saving Protocols to an MOD V1, 5-27
Saving Site Protocols to MOD V1, 5-27
SAVS/Paintbrush V4, 5-7
Scale V4, 8-45
Scalpel V4, 5-14, V4, 5-18
scalpel V4, 5-9
Scan V1, 3-89, V1, 7-75
Scan Desktop V1, 2-16
Scan Modes V1, 3-72
Scan Operations V1, 3-87
Scan Rx Desktop V1, 3-1
Scan Rx Icon V1, 3-2
Scan Timing V1, 3-27, V1, 7-15
Scan TR V1, 8-17
Scan with SmartStep V3, 4-7
Scanning V1, 7-75
Scanning Range V1, 3-51, V1, 7-22
Scanning with a Protocol V1, 7-1
Scanning with SmartPrep V3, 3-13
Schedule V1, 6-6
Schedule Screen V1, 6-7
SCIC V1, 6-11, V1, 6-25
SCIC and PPS V1, 6-11, V1, 6-25
SCP V1, 6-27, V1, 6-29, V1, 6-31, V1, 6-32
SCP tab V1, 6-29
Screen Save V1, 9-58
Scroll V1, 9-40
Scrolling V1, 9-40, V1, 9-65
Security Zone V1, 1-8
segment trace V4, 5-17
Select an Archive Device V1, 11-18
Select Object V4, 5-6
Selecting a Protocol V1, 7-58
Selecting a Registered Patient V1, 6-20
Selecting an Archive Device V1, 11-5
Selecting the Image Set V4, 5-12
Sequential V1, 3-49, V3, 1-49
Series Binding V1, 9-17, V1, 9-66
Series Control V1, 3-84
Series Text Page V1, 10-18
Service Tools Desktop V1, 2-17
Set Batch/Movie Loop V4, 5-6, V4, 5-28
Set End V3, 5-19
Set Range First V3, 5-37

Set Range Last V3, 5-37
Set reference image V4, 8-40
Set Start V3, 5-19
Set up the Gating Control V3, 2-86
Set up the Gating Control Parameters V3, 2-76
Setting a Primary Viewport V1, 9-29
Setting a Secondary Viewport V1, 9-30
Setting the Trigger Point and Trigger Window V3, 2-53
Setting Window and Level Presets V1, 10-25
Sharpening V4, 1-3
Sharpening Algorithms V4, 1-9, V4, 1-13
sharpening algorithms V4, 1-9
Shim Coils V1, 4-5
Shoulder Application V3, 5-47
Shoulder coil V1, 4-22
Shutdown your Signa LX V1, 2-34
Shutting down your Signa LX V1, 2-22
Signa Gating Algorithms V3, 2-26
Signal Enhancement Ratio V4, 8-14, V4, 8-55
Single image save V3, 5-17
Single Shot Fast Spin Echo (SSFSE) V2, 3-50
Single Shot Fast Spin Echo-IR (SSFSE-IR) V2, 3-50
Single-voxel Proton Brain Exam V2, 12-4
Site Library V1, 5-6, V1, 9-5
Site Protocol Library V1, 7-5
Slice Location Limits V3, 5-20
Slice Zerofill Interpolation Processing V3, 1-15
Slide Format V1, 10-6
Slider V1, 3-25
SmartPrep V3, 1-52, V3, 3-1
SmartStep V3, 4-1, V3, 4-2
smoothing V4, 1-3
Smoothing algorithms V4, 1-9
SNR V1, 4-7
Sorting Exams in Numerical Order V1, 9-21
Sorting Images V1, 9-5
Sorting the Patient Register V1, 6-21
Spacing V1, 3-53
Spatial mode V1, 9-7
Spatial Resolution V1, 7-16
Spatial Resolution Parameters and SNR V1, 7-19
Spatial SAT V3, 1-37
Spatial Saturation V1, 7-32
spatial saturation V1, 7-72
SPECIAL V3, 4-3, V3, 4-4
Spectral Inversion at Lipids V3, 1-40
Spectroscopy V2, 12-1
Spectroscopy Single Voxel V2, 12-10
Spectrum Average or Compression Techniques V4, 8-33
Spectrum Colors V4, 8-19
Spin Echo V2, 2-3
Spin Echo EPI V2, 11-11
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Spin Echo Pulse Sequence V2, 2-1
Spine Application V3, 5-45
Split ROI V4, 8-47
Split ROI and Merge ROI V4, 8-6
Spoiled Gradient Echo (SPGR) V2, 4-20
Square Pixel V3, 1-12
Square ROI V4, 8-46, V4, 8-51
Square Viewports V1, 9-17, V1, 9-67
ST Segment V3, 2-11
Standard CINE Screen V3, 2-66
Start V1, 2-6
Start a Scan Prescription V1, 7-48
Start a stationary system V1, 2-28
Start and End Location V1, 3-55
Start your mobile system V1, 2-26
Starting the Reformat Package V4, 6-5
Starting your mobile system V1, 2-22
Starting your stationary system V1, 2-22
Startup V4, 8-43
Status Area V1, 10-7
STEAM V2, 12-10
STL% V1, 3-87
STL% or dB/dt V1, 3-22
Subtract Two Images Within the Same Set or Two Sets of
Images V4, 3-14
Subtracting two images V4, 3-14
Superimposed Spectra V4, 8-33
surface V1, 4-5
Surface and Phased Array Coils V1, 4-7
surface and phased array coils V1, 4-21
Surface Coil Intensity Correction V3, 1-17
Surface Coil Warnings V1, 1-18
surface coils V1, 4-18
Swap Phase/Freq V3, 5-18
System Cabinet Room (Computer Room) V1, 2-14
System Disk Space V1, 11-10
System supplied text V1, 9-10
Systems with a Helium Level Meter V1, 1-46
Systems with a Magnet Monitor Unit V1, 1-47
Systole V3, 2-12

T
T1 FLAIR V2, 3-38
Table Transport Emergency Release V1, 1-29
Tailored RF V3, 1-4
Temporal and Spatial Image Play Modes V3, 5-23
Temporal Lobe Application V3, 5-41
Temporal mode V1, 9-7
Tetramethylsilane (TMS) V2, 12-7
Text Page V1, 10-18
Text pages V1, 10-18
The Chemical Shift or Upper Left (UL) Viewport V4, 8-25
The Metabolite Image or Lower Left (LL) Viewport V4,

8-35
The Reference or Lower Right (LR) Viewport V4, 8-38
Thermal Stress V1, 1-22
Threshold V3, 3-3, V4, 5-8, V4, 5-20, V4, 8-45
Threshold /VOI V4, 5-16
Threshold Range adjustment sliders V4, 5-23
Threshold/VOI V4, 5-7
Tick Marks V1, 9-17
Ticks Marks V1, 9-62
Tilt Cursor V3, 5-12
Tilt/Rotate Mode Select V4, 5-6
Time a Bolus V3, 5-36
Time Display/Patient Position V1, 2-5
Time of Flight V4, 5-3
Time of Flight Pulse Sequences V2, 6-1
time-intensity curves V4, 8-9
Timer V3, 5-17, V3, 5-36
time-varying magnetic fields V1, 4-3
Tips for Adjusting the Gating Trigger Level in ECG Gating
V3, 2-33
Tissue heating V1, 1-22
TMJ Application V3, 5-43
TOF V4, 5-3
Torso Array coil V1, 4-21
Torso Pelvis Array coil V1, 4-24
TPS Reset V1, 2-35
tracker V3, 3-1
Transfer the Patient to the System Table V1, 7-50
Translate Cursor V3, 5-12
Transmit Data to a Remote Host (Network Send) V1,
11-45
Transmit Gain V1, 8-6
Transmit Power V1, 8-6
Trigger Delay V2, 7-6, V3, 2-44
Trigger Delay (TD) V3, 2-44
Trigger Point (TP) V3, 2-52
Trigger Type V2, 9-4, V2, 13-17, V3, 2-38, V3, 2-67
Trigger Window V3, 2-40
Trigger Window (TW) V3, 2-53
Triggering V3, 2-7
Triple-IR V2, 13-6
Tumble V4, 5-8
Turbo Mode V3, 4-4
Turbo mode V3, 4-2
T-Wave V3, 2-11
Two Prescan Programs V1, 8-4

U
Undo V3, 5-17, V4, 5-8, V4, 5-18
Undo Buttons V3, 5-17
Update a Host V1, 11-40
Update BPM V2, 9-5
Update Images V1, 3-26
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Update R-peak Amplitude V3, 2-34
Updating a Host V1, 11-40
Upper Left (UL) Viewport V4, 8-25
User Annot / Trace V4, 5-8
User Control Variables Screen V1, 3-46
User Preferences V1, 9-16
User Training V1, 1-7
Using Accelerator Commands V1, 9-70
Using Connect Pro V1, 6-23

V
Valid Image Set V4, 5-3
Variable Bandwidth V3, 1-6
Vascular Screen V1, 3-45
Velocities V2, 8-5
VENC V2, 8-5
Very Selective Spatial Saturation V2, 12-7
View buttons V4, 5-7
View Edit V1, 3-81, V1, 7-10
View Planes V4, 5-7
Viewer V1, 9-6
Viewing Patient List V1, 9-22
Viewing the Patient Log V4, 2-14
Viewport Control V1, 9-5
viewport layout V4, 5-5
Views per Segment V2, 13-18, V3, 2-48
Views Per Segment (VPS) V3, 2-48
volume controls V1, 2-2
volume of MRA images V4, 5-1
Voxel size V2, 6-8

W
Waveform Display V3, 2-24
window V1, 9-6
window width and level settings V1, 9-27
Window Widths and Window Levels V1, 9-68
Working Safely V1, 1-1
Worklis V1, 6-7
Worklist V1, 6-7, V1, 6-24
Workspace Cabinet V1, 2-10
Workstation components V1, 2-3
workstation components V1, 2-2
Workstation Monitor V1, 2-10
Wrist coil V1, 4-22

X
X-axis, Image Rank and the PPM Scale, and Spectrum
Zooming V4, 8-32

Y
Y-axis and Spectrum Scaling V4, 8-32

Z
Zoom V1, 9-37
Zoom In V3, 5-18
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